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are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury, 
injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety 
design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging 
degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are 
responsible for evaluating the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas 
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of 
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these 
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance 
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How to Use This Manual

This manual describes the role of the CS+ integrated development environment for developing applications and sys-
tems for RL78 family, and provides an outline of its features.

CS+ is an integrated development environment (IDE) for RL78 family, integrating the necessary tools for the develop-
ment phase of software (e.g. design, implementation, and debugging) into a single platform.

By providing an integrated environment, it is possible to perform all development using just this product, without the 
need to use many different tools separately.

Readers This manual is intended for users who wish to understand the functions of the CS+ and 
design software and hardware application systems.

Purpose This manual is intended to give users an understanding of the functions of the CS+ to use 
for reference in developing the hardware or software of systems using these devices.

Organization This manual can be broadly divided into the following units.

1.GENERAL
2.FUNCTIONS
A.WINDOW REFERENCE

How to Read This Manual It is assumed that the readers of this manual have general knowledge of electricity, logic 
circuits, and microcontrollers.

Conventions Data significance: Higher digits on the left and lower digits on the right
Active low representation: XXX (overscore over pin or signal name)
Note: Footnote for item marked with Note in the text
Caution: Information requiring particular attention
Remarks: Supplementary information
Numeric representation: Decimal ... XXXX

Hexadecimal ... 0xXXXX
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1.  GENERAL

CS+ is a platform of an integrated developing environment for RH850 family, RX family, V850 family, RL78 family, 
78K0R microcontrollers, 78K0 microcontrollers. 

CS+ can run all the operations needed for developing the programs such as designing, cording, building, debugging, 
and flash programming.

In this manual, the debugging is explained out of those operations needed for the program development.

Caution When the E2 emulator Lite (abbreviated name: E2 Lite) is used, please read references to "E1" in this 
manual as also meaning "E2 Lite".
When the E2 emulator (abbreviated name: E2) is used, please read references to "E1" in this manual as 
also meaning "E2".

In this chapter, an overview of debugging products that CS+ provides is explained. 

1.1  Summary

You can effectively debug/simulate the program developed for the RL78 family, using the debugger which CS+ provides. 

1.2  Features

The following are the features of the debugger provided by CS+.

- Connecting to the various debug tools
A pleasant debugging environment for target systems is provided by connecting to the full-spec emulator (IECUBE), 
the on-chip debugging emulator (E1/E20/EZ Emulator) and Simulator. 

- C source text and disassembled text are shown mixed
The C source text and the disassembled text are shown mixed on the same panel.

- Source level debugging and instruction level debugging
The source level debugging and the instruction level debugging for a C source program can be done.

- Support of flash self programming emulation (Code flash)
Flash self programming emulation can be performed with IECUBE.

- Data flash memory writing function
When the selected microcontroller incorporates the data flash memory, the contents of data flash memory can be dis-
played and modified by the same access method as an ordinary memory operation (except for Simulator). 

- Real-time display update function
The contents of memory, registers and variables are automatically updated not only when the program execution is 
stopped, but also in execution.

- Save/restore the debugging environment
The debugging environment such as breakpoints, event configuration information, file download information, display 
condition/position of the panel, etc. can be saved. 
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2.  FUNCTIONS

This chapter describes a debugging process of CS+ and main functions for debugging. 

2.1  Overview

The basic debugging sequence for programs using CS+ is as follows: 

(1) Start CS+
Launch CS+ from the [Start] menu of Windows. 

Remark For details on how to start CS+, see "CS+ Integrated Development Environment User's Manual: 
Project Operation".

(2) Set a project
Create a new project, or load an existing one.

Remark For details on "Set a project", see "CS+ Integrated Development Environment User's Manual: Proj-
ect Operation".

(3) Create a load module 
Create a load module by running a build after setting of the active project and the build tool to be used. 

Remark For details on "Create a load module" with CC-RL, see "CS+ Integrated Development Environment 
User's Manual: Project Operation".

(4) Confirm the connection to a host machine
Connect the debug tool (IECUBE, E1, E20, EZ Emulator or Simulator) to be used to a host machine.

(5) Select the debug tool to use
Select the debug tool to be used in a project. 

(6) Configure operating environment of the debug tool
Configure the operating environment of the debug tool selected in steps (5).

- [IECUBE]

- [E1]

- [E20]

- [EZ Emulator]

- [Simulator]

(7) Connect to the debug tool
Connect the debug tool to CS+ to start communication. 

(8) Execute downloading
Download the load module created in steps (3) to the debug tool.

(9) Display source files
Display the contents of the downloaded load module (source files) on the Editor panel or Disassemble panel. 

(10) Execute programs
Execute the program by using the operation method corresponding to a purpose.
If you wish to stop the program at the arbitrary position, set a breakpoint/break eventNote before executing the pro-
gram (see "2.8.3  Stop the program at the arbitrary position (breakpoint)", "2.8.4  Stop the program at the arbitrary 
position (break event)", or "2.8.5  Stop the program with the access to variables/SFRs"). 

Note These functions are implemented by setting events to the debug tool used. 
 See "2.15.7  Notes for setting events", when you use events. 

(11) Stop the program manually
Stop the program currently being executed. 
Note that if a breakpoint or a break event has been set in steps (10), the program execution will be stopped auto-
matically when the set break condition is met. 

(12) Check the result of the program execution
Check the following information that the debug tool acquired by the program execution.

- Display/Change the Memory, Register and Variable
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- Display Information on Function Call from Stack

- Collect Execution History of ProgramsNote

- Measure Execution Time of ProgramsNote

- Measure Coverage [IECUBE][Simulator]

Note These functions are implemented by setting events to the debug tool used. 
 See "2.15.7  Notes for setting events", when you use events. 

Debug the program, repeating steps (9) to (12) as required. 
Note that if the program is modified during debugging, steps (3) and (8) also should be repeated. 

Remark 1. Other than the above, you can also check the result of the program execution by using the following 
functions.

- Set an Action into Programs

- Use Hook Function

- Use the Simulator GUI [Simulator]

Remark 2. The acquired information can be saved to a file. 

- Save the disassembled text contents

- Save the memory contents

- Save the CPU register contents

- Save the SFR contents

- Save the contents of local variables

- Save the contents of watch-expressions

- Save the contents of call stack information

- Save the contents of execution history

(13) Execute uploading
Save the program (the memory contents) to a file in the arbitrary format (e.g. Intel HEX file, Motorola S-record file, 
binary file, and etc), as required. 

(14) Disconnect from the debug tool
Disconnect the debug tool from CS+ to terminate communication. 

(15) Save the project file
Save the setting information of the project to the project file. 

Remark For details on "Save the project file", see "CS+ Integrated Development Environment User's Man-
ual: Project Operation". 
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2.2  Preparation before Debugging

This section describes the preparation to start debugging the created program. 

2.2.1  Confirm the connection to a host machine

Connection examples for each debug tool are shown. 

2.2.1.1  [IECUBE]
2.2.1.2  [E1]
2.2.1.3  [E20]
2.2.1.4  [EZ Emulator]
2.2.1.5  [Simulator]

2.2.1.1  [IECUBE]

Connect a host machine and IECUBE.  If required, connect a target board, too. 
See IECUBE User's Manual for details on the connection method. 

Figure 2.1 Connection Example [IECUBE]

2.2.1.2  [E1]

Connect a host machine and E1.  If required, connect a target board, too. 
See E1 User's Manual for details on the connection method.

Figure 2.2 Connection Example [E1]

Caution Only serial communications are supported as the communication method with the target board (JTAG 
communications is not available).

2.2.1.3  [E20]

Connect a host machine and E20.  If required, connect a target board, too. 
See E20 User's Manual for details on the connection method.

Target board

IECUBE

USB interface cable 

CS+
Host machine

Dedicated adapter
Dedicated probe

Target board
E1

USB interface cable 

CS+
Host machine

Dedicated probe
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Figure 2.3 Connection Example [E20]

Caution Only serial communications are supported as the communication method with the target board (JTAG 
communications is not available).

2.2.1.4  [EZ Emulator]

Connect a host machine and an evaluation kit 
See EZ Emulator User's Manual for details on the connection method.

Figure 2.4 Connection Example [EZ Emulator]

2.2.1.5  [Simulator]

A host machine is only needed for debugging (emulators are not needed). 

Figure 2.5 Connection Example [Simulator]

Target board

E20

USB interface cable 

CS+

Host machine
Dedicated probe

Evaluation kit

USB interface cable 

CS+

Host machine

CS+
Host machine
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2.3  Configuration of Operating Environment of the Debug Tool

This section describes the configuration of the operating environment for each debug tool. 

2.3.1  Select the debug tool to use

You can configure the operating environment in the Property panel corresponding to the debug tool to use. 
Therefore, first, select the debug tool to be used in a project (the debug tool to be used can be specified in the individual 

main projects/subprojects). 
To select or switch the debug tool, use the context menu shown by right clicking on the [RL78 Debug tool name (Debug 

Tool)] node on the Project Tree panel. 

Figure 2.6 Select/Switch Debug Tool to Use

If the Property panel is already open, click the [RL78 Debug tool name (Debug Tool)] node again.  The view switches to 
the Property panel of the selected debug tool. 

If the Property panel is not open, double-click the above mentioned node to open the corresponding Property panel. 

2.3.2  [IECUBE]

Configure the operating environment on the Property panel below when using IECUBE. 

Figure 2.7 Example of Property Panel [IECUBE]

Follow the steps below by selecting the corresponding tab on the Property panel. 
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2.3.2.1  [Connect Settings] tab
2.3.2.2  [Debug Tool Settings] tab
2.3.2.3  [Flash Self Emulation Settings] tab
2.3.2.4  [DataFlash Emulation Settings] tab
2.3.2.5  [Download File Settings] tab
2.3.2.6  [Hook Transaction Settings] tab

2.3.2.1  [Connect Settings] tab

You configure the connection with the debug tool for each one of the following categories. 

(1)  [Internal ROM/RAM]
(2)  [Clock]
(3)  [Connection with Target Board]

(1) [Internal ROM/RAM]
You can configure internal ROM/RAM in this category. 
The size of internal ROM/RAM of the selected microcontroller is specified by default. 
There is no need to change the settings in this category if you wish to debug with the same memory mapping of 
the selected microcontroller.

Caution You should be careful not to overlap the area with other memory mapping area. 

Figure 2.8 [Internal ROM/RAM] Category [IECUBE]

(a) [Size of internal ROM[KBytes]] 
Select the internal ROM size to emulate (unit: Kbytes). 
Change the value only when you perform debugging using IECUBE memory resources after changing the mem-
ory mapping.

(b) [Size of internal RAM[Bytes]]
Select the internal RAM size to emulate (unit: bytes). 
Change the value only when you perform debugging using IECUBE memory resources after changing the mem-
ory mapping. 

(c) [Size of DataFlash memory[KBytes]]
The size of the data flash memory area of the selected microcontroller is displayed (unit: Kbytes). 
You cannot change the value of this property.

(2) [Clock]
You can configure the clock in this category. 

Figure 2.9 [Clock] Category [IECUBE]

(a) [Main clock source]
Specify the main clock source to input to the CPU from the following drop-down list. 

Caution This property cannot be changed when IECUBE is connected to CS+.

Clock socket Uses a clock of the transmitter on the clock socket. 

External Uses a main clock (square wave) on the target board. 

Generate by emulator Uses a clock generated inside IECUBE (default). 
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(b) [Main clock frequency [MHz]]
This property appears only when the [Main clock source] property is set to [Generate by emulator].
Select the main clock frequency (default: [4.00]).

Remark The selectable frequency differs depending on the selected microcontroller. 

(c) [Sub clock source]
Specify the sub clock source to input to the CPU and peripheral devices from the following drop-down list. 

Caution This property cannot be changed when IECUBE is connected to CS+.

(d) [Sub clock frequency[kHz]]
This property appears only when the [Sub clock source] property is set to [Generate by emulator]. 
Select the sub clock frequency (default: [32.768]).

(3) [Connection with Target Board] 
You can configure the connection to the target board in this category. 

Figure 2.10 [Connection with Target Board] Category [IECUBE]

(a) [Connecting with target board]
Select whether the target board is connected to IECUBE or not.
Select [Yes] when the target board is connected to IECUBE (default: [No]).

Caution This property cannot be changed when IECUBE is connected to CS+.

2.3.2.2  [Debug Tool Settings] tab

You configure the basic settings of the debug tool for each one of the following categories.

(1)  [Memory]
(2)  [Access Memory While Running]
(3)  [Set Event While Running]
(4)  [Break]
(5)  [Fail-safe Break]
(6)  [Trace]
(7)  [Timer]
(8)  [Coverage]
(9)  [Mask for Input Signal]
(10)  [Step function]

(1) [Memory]
You can configure the memory in this category. 

Figure 2.11 [Memory] Category [IECUBE]

External Uses a main clock (square wave) on the target board. 

Generate by emulator Uses a clock generated inside IECUBE (default). 



CS+ V8.04.00 2.  FUNCTIONS

R20UT4692EJ0100  Rev.1.00 Page 18 of 411
Jun 01, 2020

(a) [Memory mappings]
Current memory mapping status is displayed for each type of memory area. 

Caution The memory mapping cannot be added/deleted. 

(b) [Verify on writing to memory]
Select whether to perform a verify check when writing to the memory. 
Select [Yes] to perform verification after download or when values are changed in the Memory panel/Watch 
panel (default).

(2) [Access Memory While Running]
You can configure the memory access while executing a program (the real-time display update function) in this 
category.  See "2.9.1.4  Display/modify the memory contents during program execution" for details on the real-
time display update function. 

Figure 2.12 [Access Memory While Running] Category [IECUBE]

(a) [Access by stopping execution]
For a memory area not accessible during execution of a program (e.g. target memory area/SFR area), select 
whether to allow access to the area by temporary stopping the execution.
Select [Yes] to allow access (default: [No]).

(b) [Update display during the execution] 
Select whether to automatically update the contents in the Memory panel/Watch panel display during execution 
of a program.
Select [Yes] to update the display automatically (default). 

Remark The display contents of the Memory panel/Watch panel can be updated manually by clicking the 
 button on the panel. 

(c) [Display update interval[ms]]
This property appears only when the [Update display during the execution] property is set to [Yes]. 
Specify the interval in 100 ms unit to automatically update the contents in the Memory panel/Watch panel dis-
play during execution of a program.
Directly enter the Integer number between 100 and 65500 (rounding up the fractions less than 100ms) (default: 
[500]).

(3) [Set Event While Running]
You can configure the setting of events while executing a program in this category. 

Figure 2.13 [Set Event While Running] Category

(a) [Set event by stopping execution momentarily] 
Select whether to forcibly pause the execution for events that cannot be set while executing a program. 
For details on the event types that are affected by this property, see "2.15.7.2  Event types that can be set and 
deleted during execution".
Select [Yes] to set events above while execution (default: [No]).

(4) [Break]
You can configure the break function. 
See "2.8  Stop Programs (Break)" for details on the break function and this category configuration. 

(5) [Fail-safe Break] 
You can configure the fail-safe break function in this category. 
See "2.8.6  Stop the program when an invalid execution is detected [IECUBE]" for details on the fail-safe break 
function and this category configuration. 

(6) [Trace]
You can configure the trace function in this category. 
See "2.11  Collect Execution History of Programs" for details on the trace function and this category configuration.
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(7) [Timer]
You can configure the timer function in this category. 
See "2.12  Measure Execution Time of Programs" for details on the timer function and this category configuration. 

(8) [Coverage]
You can configure the coverage function in this category. 
See "2.13  Measure Coverage [IECUBE][Simulator]" for details on the coverage function and this category config-
uration. 

(9) [Mask for Input Signal] 
You can configure the input signal masking in this category. 

Figure 2.14 [Mask for Input Signal] Category [IECUBE]

With the properties shown below, select [Yes] to mask the signal from the drop-down list (default: [No]). 

- [Mask WAIT signal]Note

- [Mask TARGET RESET signal]Note

- [Mask INTERNAL RESET signal]

- [Mask NMI signal]

Note If [No] is selected with the [Connection with Target Board] property in the [Connect Setting] tab, 
these properties are fixed to [Yes] after connecting to the debug tool (changes not allowed). 

(10) [Step function]
You can configure the control method of step execution.

Figure 2.15 [Step function] Category [E1]

(a) [Skip target section] 
Select whether to skip the target section.
Select [Yes] to skip the target section (default: [No]).

(b) [Target section] 
This property appears only when the [Skip target section] property is set to [Yes].
To specify a section, select the target property, then open the Specified Section dialog box by clicking the [...] 
button that appears on the right edge of the field.

2.3.2.3  [Flash Self Emulation Settings] tab

You configure the flash self programming emulation (Code flash).
Note that this tab appears only when the selected microcontroller incorporates the flash memory. 

(1)  [Flash Self Emulation]
(2)  [Writing Time/Erasing Time]
(3)  [Macro Service Error]
(4)  [Setting Flash shield window]
(5)  [Security Flag Emulation]

(1) [Flash Self Emulation]
You can configure the flash self programming emulation function in this category. 
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Figure 2.16 [Flash Self Emulation] Category

(a) [Flash self-programming] 
Select whether to use the flash self programming emulation function. 
Select [Yes] to use the flash self programming emulation function (default: [No]). 

(2) [Writing Time/Erasing Time]
You can configure the delay time for writing to and erasing the flash memory in this category. 

Figure 2.17 [Writing Time/Erasing Time] Category

(a) [Writing time]
You can simulate the delay time for writing to the flash memory.
Select the value to simulate the delay time from the following drop-down list.

(b) [Address for writing time]
Specify the target address at which to simulate the delay time for writing.
Directly enter the address in hexadecimal number from 0x0 to 0xFFFFF (default: [0]).

(c) [Address mask value for writing time]
Specify a mask value for the address for writing time.
Directly enter the address in hexadecimal number from 0x0 to 0xFFFFF (default: [0x3]).
The address for the writing time is masked bit-wise with a mask value for which "0" is specified.

Caution The flash library writes to the code flash memory in 4-byte units, so fix the lowest and second-
lowest order bits of the address mask to 1.

Example To set an address for writing time between 0x1000 and 0x1FFF
[Address for writing time]: 0x1000
[Address mask value for writing time]: 0xF003
[Target address]: 0x1000, 0x1004, 0x1008, 0x100C, 0x1010, ..., 0x1ffc

(d) [Erasing time]
You can simulate the delay time for erasing the flash memory.
Select the value to simulate the delay time from the following drop-down list.

No retry Specifies "0" as the number of times of retry.
The delay time is 0 (the writing speed is fastest).

Typical number of times that is assumed by 
flash macro specifications

Specifies the typical number of times that is assumed by flash 
macro specifications (default).

Maximum number of times that is assumed 
by flash macro specifications

Specifies the maximum number of times that is assumed by 
flash macro specifications.

Retries for the maximum number of times 
specified

Specifies the maximum number of times of retry.
The delay time is maximum (the writing speed is longest).

No retry Specifies "0" as the number of times of retry.
The delay time is 0 (the erasing speed is fastest).

Typical number of times that is assumed by 
flash macro specifications

Specifies the typical number of times that is assumed by flash 
macro specifications (default).

Maximum number of times that is assumed 
by flash macro specifications

Specifies the maximum number of times that is assumed by 
flash macro specifications.
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(e) [Address for erasing time]
Specify the target address at which to simulate the delay time for erasing.
Directly enter the address in hexadecimal number from 0x0 to 0xFFFFF (default: [0]).

(f) [Address mask value for erasing time]
Specify a mask value for the address for erasing time.
Directly enter the address in hexadecimal number from 0x0 to 0xFFFFF (default: [0x3FF]).
The address for the writing time is masked bit-wise with a mask value for which "0" is specified.

Caution The flash library erases the code flash memory in block units, so fix the lower-order 10 bits of the 
address mask to 1.

Example To set an address for erasing time between 0x1000 and 0x1FFF
[Address for erasing time]: 0x1000
[Address mask value for erasing time]: 0xF3FF
[Target address]: 0x1000, 0x1400, 0x1800, 0x1C00

(3) [Macro Service Error]
In this category, you can configure the operation of flash functions in the self programming library, that are used for 
the flash macro service when performing the flash self programming. 

Figure 2.18 [Macro Service Error] Category

(a) [Macro Service Errors]
Specify the error to generate in the flash macro service to emulate (errors will not be generated during normal 
emulation). 
Three types of errors to generate ([0]/[1]/[2]) can be specified with subproperties for this property. 
Select any one of the following types from each of the [Generate error] subproperties to return the error values 
forcibly. 

1)  Generate FlashErase Error (Erase)
2)  Generate FlashBlankCheck Error (BlankCheck)
3)  Generate FlashWrite Error (Write)
4)  Generate FlashIVerify Error (IVerify)
5)  Generate FlashSetSecurity / FlashSetFSW Error (Erase)
6)  Generate FlashSetSecurity / FlashSetFSW Error (Write)
7)  Generate FlashSetSecurity / FlashSetFSW Error (IVerify)

If you select one of 1) to 4), furthermore, specify the address within the flash memory and its mask valueNote at 
which the corresponding error is to be generated, with the [Address for error] and [Address mask value for error] 
subproperties that are listed newly in the lower area.  Directly enter the address in hexadecimal number from 
0x0 to 0xFFFFF (default: [0]).

Note When [Generate FlashWrite Error (Write)] is selected, fix the lowest and second-lowest order bits 
of the mask value to 1, because the flash library writes to the code flash memory in 4-byte units.
Also, when [Generate FlashErase Error (Erase)], [Generate FlashBlankCheck Error (Blank-
Check)] or [Generate FlashIVerify Error (IVerify)] is selected, fix the lower-order 10 bits of the 
mask value to 1, because erasure of the code flash memory, blank checking, and internal verifi-
cation proceed in block units. 

(4) [Setting Flash shield window]
You can specify the area that can be written or erased by flash self programming (Flash shield window function), in 
this category.

Caution Settings of this category are applied after CPU reset is generated. 
If you changed these settings, execute the program after reset the CPU.

Retries for the maximum number of times 
specified

Specifies the maximum number of times of retry.
The delay time is maximum (the erasing speed is longest).
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Figure 2.19 [Setting Flash shield window] Category

(a) [Flash shield window start block]
Specify the start block of the area that can be written to and erased by flash self programming. 
Directly enter the value in hexadecimal number from 0x0 to 0xFFFF (default: [0]). 

(b) [Flash shield window end block]
Specify the end block of the area that can be written to and erased by flash self programming. 
Directly enter the value in hexadecimal number from 0x0 to 0xFFFF (default: [FFFF]). 

(5) [Security Flag Emulation]
You can configure the function on the security flag emulation in this category. 
The initial value of the security flag is emulated when the security has been set to the flash memory.

Caution Settings of this category are applied after CPU reset is generated. 
If you changed these settings, execute the program after reset the CPU.

Figure 2.20 [Security Flag Emulation] Category

(a) [Disable block erase]
Specify whether to emulate to disable block erase.
Select [Yes] to emulate to disable block erase (default: [No]).

(b) [Disable program]
Select whether to emulate to disable writing.
Select [Yes] to emulate to disable writing (default: [No]).

(c) [Disable boot block cluster reprogram]
Select whether to emulate to disable rewrite boot area.
Select [Yes] to emulate to disable rewrite boot area (default: [No]).

2.3.2.4  [DataFlash Emulation Settings] tab

You configure the data flash emulation function. 
Note that this tab appears only when the selected microcontroller incorporates the data flash memory. 

(1)  [DataFlash Emulation]
(2)  [Writing Time]
(3)  [Macro Service Error]

(1) [DataFlash Emulation]
You can configure the data flash emulation function in this category.

Figure 2.21 [DataFlash Emulation] Category

(a) [DataFlash emulation]
Select whether to use the data flash emulation function.
Select [Yes] to use the data flash emulation function (default: [No]).

(2) [Writing Time]
You can configure the delay time for writing to the data flash memory in this category. 
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Figure 2.22 [Writing Time] Category

(a) [Writing time]
You can simulate the delay time for writing to the data flash memory.
Select the value to simulate the delay time from the following drop-down list.

(b) [Address for writing time]
Specify the target address at which to simulate the delay time for writing.
Directly enter the address in hexadecimal number from 0xF1000 to 0xFFFFF (default: [F1000]).

(c) [Address mask value for writing time]
Specify a mask value for the address for writing time.
Directly enter the address in hexadecimal number from 0x0 to 0xFFFFF (default: [0]).
The address for the writing time is masked bit-wise with a mask value for which "0" is specified.

Example To set an address for writing time between 0xF1000 and 0xF1FFF
[Address for writing time]: 0xF1000
[Address mask value for writing time]: 0xFF000

(3) [Macro Service Error]
In this category, you can configure the operation of flash functions, that are used for the data flash macro service 
when performing the data flash emulation. 

Figure 2.23 [Macro Service Error] Category

(a) [Macro Service Errors]
Specify the error to generate in the data flash macro service to emulate (errors will not be generated during nor-
mal emulation). 
Four types of errors to generate ([0]/[1]/[2]/[3]) can be specified with subproperties for this property.  Select any 
one of the following types from each of the [Generate error] subproperties to return the error values forcibly, and 
then specify the address within the data flash memory (0xF1000 to 0xFFFFF) and its mask value (0x0 to 
0xFFFFF) at which the corresponding function error is to be generated, with the [Address for error] and 
[Address mask value for error] subproperties that are listed newly in the lower area.
[Address for error]: [F1000]/[Address mask value for error]: [0] is specified by default.

1)  Generate write error for FlashWrite
2)  Generate IVerify error for FlashIVerify
3)  Generate BlankCheck error for FlashBlankCheck

No retry Specifies "0" as the number of times of retry.
The delay time is 0 (the writing speed is fastest).

Typical number of times that is assumed by 
flash macro specifications

Specifies the typical number of times that is assumed by flash 
macro specifications (default).

Maximum number of times that is assumed 
by flash macro specifications

Specifies the maximum number of times that is assumed by 
flash macro specifications.

Retries for the maximum number of times 
specified

Specifies the maximum number of times of retry.
The delay time is maximum (the writing speed is longest).
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2.3.2.5  [Download File Settings] tab

You can configure downloading to the debug tool.
See "2.5.1  Execute downloading" for details on each category configuration. 

2.3.2.6  [Hook Transaction Settings] tab

You can configure hook transaction for the debug tool.
See "2.16  Use Hook Function" for details on each category configuration and the function of the hook transaction. 
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2.3.3  [E1]

Configure the operating environment on the Property panel below when using E1. 

Figure 2.24 Example of Property Panel [E1]

Follow the steps below by selecting the corresponding tab on the Property panel. 

2.3.3.1  [Connect Settings] tab
2.3.3.2  [Debug Tool Settings] tab
2.3.3.3  [Download File Settings] tab
2.3.3.4  [Hook Transaction Settings] tab

2.3.3.1  [Connect Settings] tab

You configure the connection with the debug tool for each one of the following categories. 

(1)  [Internal ROM/RAM]
(2)  [Clock]
(3)  [Connection with Emulator]
(4)  [Connection with Target Board]
(5)  [E2 Expansion Interface] [E2]
(6)  [Flash]
(7)  [Hot Plug-in]

(1) [Internal ROM/RAM]
The configuration of internal ROM/RAM is displayed in this category. 

Figure 2.25 [Internal ROM/RAM] Category [E1]
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(a) [Size of internal ROM[KBytes]] 
The internal ROM size to emulate is displayed (unit: Kbytes). 
You cannot change the value of this property. 

(b) [Size of internal RAM[Bytes]]
The internal RAM size to emulate is displayed (unit: bytes). 
You cannot change the value of this property. 

(c) [Size of DataFlash memory[KBytes]]
The data flash memory size is displayed (unit: Kbytes). 
If the currently selected microcontroller does not incorporate the data flash, [0] is displayed. 
You cannot change the value of this property.

(2) [Clock]
You can configure the clock in this category. 

Figure 2.26 [Clock] Category [E1]

(a) [Main clock frequency [MHz]]
Specify the main clock frequency. 
You can specify the frequency from the drop-down list or by directly entering a frequency value between 0.001 
and 99.999 (unit: MHz) (default: [Using internal clock]).   
When using X1/X2 oscillation, specify the clock frequency. 
When using an external clock oscillation with the embedded PLL circuit, specify the frequency of the transmitter/
resonator (i.e. the frequency before the setting of the PLL clock). 

Remark The main clock frequency is used to synchronize the communication between E1 and the host 
machine.  This specification is not for the frequency of the CPU operation. 

(b) [Sub clock frequency[kHz]] 
Specify the sub clock frequency.
You can specify the frequency from the drop-down list or by directly entering a frequency value number between 
0.001 and 99.999 (unit: kHz) (default: [Using internal clock]).   

Remark The sub clock frequency is used to synchronize the communication between E1 and the host 
machine.  This specification is not for the frequency of the CPU operation. 

(c) [Monitor clock] 
Select a clock for monitor programs to operate while the program is stopped, from the following drop-down list.

(3) [Connection with Emulator]
You can configure the connection between E1 and the host machine in this category. 

Caution You cannot change the property in this category while connected to E1.

Figure 2.27 [Connection with Emulator] Category

(a) [Emulator serial No.]
Serial numbers of all connected E1 emulators are displayed in the drop-down list.
Select the one to be connected to the target system.
The drop-down list is updated every time it is used.

(4) [Connection with Target Board] 
You can configure the connection between E1 and the target board in this category. 

Caution Properties in this category cannot be changed when E1 is connected to CS+.
Only the [Supply voltage] property can be changed when E2 is connected to CS+.

System Operates with main clock (default). 

User Operates with the clock that the program specified.
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Figure 2.28 [Connection with Target Board] Category [E1] 

(a) [Low voltage OCD board]
This property appears only when the selected microcontroller supports a low voltage OCD board. 
Select whether to use a low voltage OCD board. 
Select [Yes] to use a low voltage OCD board (default: [No]).

(b) [Power target from the emulator (MAX 200mA)]
This property appears only when the [Low voltage OCD board] property is set to [No] if it is displayed. 
Select whether to supply power to the target board from E1.
Select [Yes] to supply power to the target board (default: [No]).

(c) [Interface for supplying the power] [E2]
This property appears only when the [Power target from the emulator (MAX 200mA)] property is set to [Yes].
Select the interface for supplying the power to the target board from the emulator (default: [USER I/F]). 

(d) [Supply voltage] 
This property appears only when the [Power target from the emulator (MAX 200mA)] property is displayed and 
also [Yes] is set to it.
Select the power voltage supplied to the target board (default: [3.3V]). 

(5) [E2 Expansion Interface] [E2]
You can configure the E2 expansion interface. 

Figure 2.29 [E2 Expansion Interface] Category [E2]

(a) [Interface for supplying the power]
Select whether to use the E2 expansion interface.
If you want to use the E2 expansion interface, select the power used by the E2 expansion interface.

(6) [Flash]
You can configure the flash memory rewriting in this category. 

Caution Properties in this category cannot be changed when E1 is connected to CS+.

Figure 2.30 [Flash] Category 

(a) [Security ID]
This property appears only when the selected microcontroller supports the ROM security function (on-chip 
debug security ID) for flash memory.
Specify a security ID for reading codes in the internal ROM or internal flash memory.
Directly enter 20 digits hexadecimal number (10 bytes: 0x0 to 0xFFFFFFFFFFFFFFFFFFFE) (default: 
[00000000000000000000]). 
For details on the on-chip debug security ID, see E1 User's Manual. 

(b) [Permit flash programming] 
Select whether to enable the flash memory rewriting.
Select [Yes] to enable flash rewrite (default). 
Note that when [No] is specified with this property, the flash memory area cannot be rewritten at all from the 
debug tool. 

(c) [Use wide voltage mode]
This property appears only when the selected microcontroller supports the wide voltage mode for the flash 
memory rewriting.
Select whether to rewrite the flash memory with the wide voltage mode.
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Select [Yes] to rewrite with the low voltage flash mode (default). 

(d) [Erase flash ROM when starting]
This property appears only when the [Permit flash programming] property is set to [Yes]. 
Select whether to erase flash ROM when connecting to the debug tool. 
Select [Yes] to erase flash ROM (default: [No]). 
Note that this property is set to [No] after connecting to the debug tool. 

Caution When conducting hot plug-in connection, the setting of this property will be ignored and flash 
ROM will not be erased. 

(7) [Hot Plug-in]
You can configure the hot plug-in connection in this category. 
Note that this category appears only when the selected microcontroller incorporates the hot plug-in function.
See "2.4.3  Connect to the debug tool using hot plug-in [E1][E20] for details on hot plug-in function and this cate-
gory configuration.

2.3.3.2  [Debug Tool Settings] tab

You configure the basic settings of the debug tool for each one of the following categories.

(1)  [Memory]
(2)  [Access Memory While Running]
(3)  [E2 Expansion Interface]
(4)  [Break]
(5)  [Trace]
(6)  [Mask for Input Signal]
(7)  [Step function]

(1) [Memory]
You can configure the memory in this category. 

Figure 2.31 [Memory] Category [E1]

(a) [Memory mappings]
Current memory mapping status is displayed for each type of memory area. 

Caution The memory mapping cannot be added/deleted. 

(b) [Verify on writing to memory]
Select whether to perform a verify check when writing to the memory. 
Select [Yes] to perform verification after download or when values are changed in the Memory panel/Watch 
panel (default).

(2) [Access Memory While Running]
You can configure the memory access while executing a program (the real-time display update function) in this 
category.  See "2.9.1.4  Display/modify the memory contents during program execution" for details on the real-time 
display update function. 
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Figure 2.32 [Access Memory While Running] Category [E1]

(a) [Access by stopping execution]
For a memory area not accessible during execution of a program (e.g. target memory area/SFR area), select 
whether to allow access to the area by temporary stopping the execution.
Select [Yes] to allow access (default: [No]). 

(b) [Update display during the execution] 
Select whether to automatically update the contents in the Memory panel/Watch panel display while executing a 
program. 
Select [Yes] to update the display automatically (default). 

Remark The display contents of the Memory panel/Watch panel can be updated manually by clicking the 
 button on the panel. 

(c) [Display update interval[ms]]
This property is valid only when the [Update display during the execution] property is set to [Yes]. 
Specify the interval in 100ms unit to automatically update the contents in the Memory panel/Watch panel display 
while executing a program. 
Directly enter the Integer number between 100 and 65500 (rounding up the fractions less than 100ms) (default: 
[500]). 

(3) [E2 Expansion Interface]
You can configure the E2 Expansion Interface. 

Figure 2.33 [E2 Expansion Interface] Category

(a) [External trigger input]
Set the settings related to the external trigger input.
You can select different actions for each channel.

<1> Channel number
The channel number is displayed.

<2> Use
Specify whether to use the external trigger input for this channel number.
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<3> Input signal
Specify the input signal.

<4> Action when inputting the external trigger
The action when inputting the external trigger is displayed.

(b) [External trigger output]
Set the settings related to the external trigger output.
You can select different actions for each channel.

<1> Channel number
The channel number is displayed.

<2> Use
Specify whether to use the external trigger output for this channel number.

<3> Output timing
The output timing is displayed.

<4> Output signal
The output signal is displayed.

<5> Pulse width [us]
Specify the pulse width.

(4) [Break]
You can configure the break function. 
See "2.8  Stop Programs (Break)" for details on the break function and this category configuration. 

(5) [Trace]
You can configure the trace function in this category. 
Note that this category appears only when the selected microcontroller incorporates the OCD trace function.
See "2.11  Collect Execution History of Programs" for details on the trace function and this category configuration.

(6) [Mask for Input Signal] 
You can configure the input signal masking in this category. 

Caution 1. The settings of the properties in this category are ignored in the case of a hot plug-in connection.  
That is, the program operates as if the specification for the properties is [No] (the settings of them 
become valid again after reconnection with CS+). 

Caution 2. Maskable signals differ depending on the selected microcontroller type (a signal that cannot be 
masked will be hidden).

Figure 2.34 [Mask for Input Signal] Category

With the properties shown below, select [Yes] to mask the signal from the drop-down list (default: [No]). 

- [Mask TARGET RESET signal]

- [Mask INTERNAL RESET signal]

(7) [Step function]
You can configure the control method of step execution.

Figure 2.35 [Step function] Category [E1]

(a) [Skip target section] 
Select whether to skip the target section.
Select [Yes] to skip the target section (default: [No]).

(b) [Target section] 
This property appears only when the [Skip target section] property is set to [Yes].
To specify a section, select the target property, then open the Specified Section dialog box by clicking the [...] 
button that appears on the right edge of the field.
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2.3.3.3  [Download File Settings] tab

You can configure downloading to the debug tool.
See "2.5.1  Execute downloading" for details on each category configuration. 

2.3.3.4  [Hook Transaction Settings] tab

You can configure hook transaction for the debug tool.
See "2.16  Use Hook Function" for details on each category configuration and the function of the hook transaction. 

2.3.4  [E20]

Configure the operating environment on the Property panel below when using E20. 

Figure 2.36 Example of Property Panel [E20]

Follow the steps below by selecting the corresponding tab on the Property panel. 

2.3.4.1  [Connect Settings] tab
2.3.4.2  [Debug Tool Settings] tab
2.3.4.3  [Download File Settings] tab
2.3.4.4  [Hook Transaction Settings] tab

2.3.4.1  [Connect Settings] tab

You configure the connection with the debug tool for each one of the following categories. 

(1)  [Internal ROM/RAM]
(2)  [Clock]
(3)  [Connection with Emulator]
(4)  [Flash]
(5)  [Hot Plug-in]
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(1) [Internal ROM/RAM]
The configuration of internal ROM/RAM is displayed in this category. 

Figure 2.37 [Internal ROM/RAM] Category [E20]

(a) [Size of internal ROM[KBytes]] 
The internal ROM size to emulate is displayed (unit: Kbytes). 
You cannot change the value of this property. 

(b) [Size of internal RAM[Bytes]]
The internal RAM size to emulate is displayed (unit: bytes). 
You cannot change the value of this property. 

(c) [Size of DataFlash memory[KBytes]]
The data flash memory size is displayed (unit: Kbytes). 
If the currently selected microcontroller does not incorporate the data flash, [0] is displayed. 
You cannot change the value of this property.

(2) [Clock]
You can configure the clock in this category. 

Figure 2.38 [Clock] Category [E20]

(a) [Main clock frequency [MHz]]
Specify the main clock frequency. 
You can specify the frequency from the drop-down list or by directly entering a frequency value between 0.001 
and 99.999 (unit: MHz) (default: [Using internal clock]).   
When using X1/X2 oscillation, specify the clock frequency. 
When using an external clock oscillation with the embedded PLL circuit, specify the frequency of the transmitter/
resonator (i.e. the frequency before the setting of the PLL clock). 

Remark The main clock frequency is used to synchronize the communication between E20 and the host 
machine.  This specification is not for the frequency of the CPU operation. 

(b) [Sub clock frequency[kHz]] 
Specify the sub clock frequency.
You can specify the frequency from the drop-down list or by directly entering a frequency value number between 
0.001 and 99.999 (unit: kHz) (default: [Using internal clock]).   

Remark The sub clock frequency is used to synchronize the communication between E20 and the host 
machine.  This specification is not for the frequency of the CPU operation. 

(c) [Monitor clock] 
Select a clock for monitor programs to operate while the program is stopped, from the following drop-down list. 

(3) [Connection with Emulator]
You can configure the connection between E20 and the host machine in this category. 

Caution You cannot change the property in this category while connected to E20.

Figure 2.39 [Connection with Emulator] Category

System Operates with main clock (default). 

User Operates with the clock that the program specified.
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(a) [Emulator serial No.]
Serial numbers of all connected E20 emulators are displayed in the drop-down list.
Select the one to be connected to the target system.
The drop-down list is updated every time it is used.

(4) [Flash]
You can configure the flash memory rewriting in this category. 

Caution Properties in this category cannot be changed when E20 is connected to CS+.

Figure 2.40 [Flash] Category

(a) [Security ID]
This property appears only when the selected microcontroller supports the ROM security function (on-chip 
debug security ID) for flash memory.
Specify a security ID for reading codes in the internal ROM or internal flash memory.
Directly enter 20 digits hexadecimal number (10 bytes: 0x0 to 0xFFFFFFFFFFFFFFFFFFFE) (default: 
[00000000000000000000]). 
For details on the on-chip debug security ID, see E20 User's Manual. 

(b) [Permit flash programming] 
Select whether to enable the flash memory rewriting.
Select [Yes] to enable flash rewrite (default). 
Note that when [No] is specified with this property, the flash memory area cannot be rewritten at all from the 
debug tool. 

(c) [Use wide voltage mode]
This property appears only when the selected microcontroller supports the wide voltage mode for the flash 
memory rewriting.
Select whether to rewrite the flash memory with the wide voltage mode.
Select [Yes] to rewrite with the low voltage flash mode (default). 

(d) [Erase flash ROM when starting]
This property appears only when the [Permit flash programming] property is set to [Yes]. 
Select whether to erase flash ROM when connecting to the debug tool. 
Select [Yes] to erase flash ROM (default: [No]). 
Note that this property is set to [No] after connecting to the debug tool. 

Caution When conducting hot plug-in connection, the setting of this property will be ignored and flash 
ROM will not be erased. 

(5) [Hot Plug-in]
You can configure the hot plug-in connection in this category. 
Note that this category appears only when the selected microcontroller incorporates the hot plug-in function.
See "2.4.3  Connect to the debug tool using hot plug-in [E1][E20] for details on hot plug-in function and this cate-
gory configuration.

2.3.4.2  [Debug Tool Settings] tab

You configure the basic settings of the debug tool for each one of the following categories.

(1)  [Memory]
(2)  [Access Memory While Running]
(3)  [Break]
(4)  [Trace]
(5)  [Mask for Input Signal]
(6)  [Step function]

(1) [Memory]
You can configure the memory in this category. 
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Figure 2.41 [Memory] Category [E20]

(a) [Memory mappings]
Current memory mapping status is displayed for each type of memory area. 

Caution The memory mapping cannot be added/deleted. 

(b) [Verify on writing to memory]
Select whether to perform a verify check when writing to the memory. 
Select [Yes] to perform verification after download or when values are changed in the Memory panel/Watch 
panel (default).

(2) [Access Memory While Running]
You can configure the memory access while executing a program (the real-time display update function) in this 
category.  See "2.9.1.4  Display/modify the memory contents during program execution" for details on the real-time 
display update function. 

Figure 2.42 [Access Memory While Running] Category [E20]

(a) [Access by stopping execution]
For a memory area not accessible during execution of a program (e.g. target memory area/SFR area), select 
whether to allow access to the area by temporary stopping the execution.
Select [Yes] to allow access (default: [No]). 

(b) [Update display during the execution] 
Select whether to automatically update the contents in the Memory panel/Watch panel display while executing a 
program. 
Select [Yes] to update the display automatically (default). 

Remark The display contents of the Memory panel/Watch panel can be updated manually by clicking the 
 button on the panel. 

(c) [Display update interval[ms]]
This property is valid only when the [Update display during the execution] property is set to [Yes]. 
Specify the interval in 100ms unit to automatically update the contents in the Memory panel/Watch panel display 
while executing a program. 
Directly enter the Integer number between 100 and 65500 (rounding up the fractions less than 100ms) (default: 
[500]). 

(3) [Break]
You can configure the break function. 
See "2.8  Stop Programs (Break)" for details on the break function and this category configuration. 

(4) [Trace]
You can configure the trace function in this category. 
Note that this category appears only when the selected microcontroller incorporates the OCD trace function.
See "2.11  Collect Execution History of Programs" for details on the trace function and this category configuration.

(5) [Mask for Input Signal] 
You can configure the input signal masking in this category. 
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Caution 1. The settings of the properties in this category are ignored in the case of a hot plug-in connection.  
That is, the program operates as if the specification for the properties is [No] (the settings of them 
become valid again after reconnection with CS+). 

Caution 2. Maskable signals differ depending on the selected microcontroller type (a signal that cannot be 
masked will be hidden).

Figure 2.43 [Mask for Input Signal] Category

With the properties shown below, select [Yes] to mask the signal from the drop-down list (default: [No]). 

- [Mask TARGET RESET signal]

- [Mask INTERNAL RESET signal]

(6) [Step function]
You can configure the control method of step execution.

Figure 2.44 [Step function] Category [E20]

(a) [Skip target section] 
Select whether to skip the target section.
Select [Yes] to skip the target section (default: [No]).

(b) [Target section] 
This property appears only when the [Skip target section] property is set to [Yes].
To specify a section, select the target property, then open the Specified Section dialog box by clicking the [...] 
button that appears on the right edge of the field.

2.3.4.3  [Download File Settings] tab

You can configure downloading to the debug tool.
See "2.5.1  Execute downloading" for details on each category configuration. 

2.3.4.4  [Hook Transaction Settings] tab

You can configure hook transaction for the debug tool.
See "2.16  Use Hook Function" for details on each category configuration and the function of the hook transaction. 
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2.3.5  [EZ Emulator]

Configure the operating environment on the Property panel below when using EZ Emulator. 

Figure 2.45 Example of Property Panel [EZ Emulator]

Follow the steps below by selecting the corresponding tab on the Property panel. 

2.3.5.1  [Connect Settings] tab
2.3.5.2  [Debug Tool Settings] tab
2.3.5.3  [Download File Settings] tab
2.3.5.4  [Hook Transaction Settings] tab

2.3.5.1  [Connect Settings] tab

You configure the connection with the debug tool for each one of the following categories. 

(1)  [Internal ROM/RAM]
(2)  [Clock]
(3)  [Connection with Target Board]
(4)  [Flash]

(1) [Internal ROM/RAM]
The configuration of internal ROM/RAM is displayed in this category. 

Figure 2.46 [Internal ROM/RAM] Category [EZ Emulator]

(a) [Size of internal ROM[KBytes]] 
The internal ROM size to emulate is displayed (unit: Kbytes). 
You cannot change the value of this property. 

(b) [Size of internal RAM[Bytes]]
The internal RAM size to emulate is displayed (unit: bytes). 
You cannot change the value of this property. 
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(c) [Size of DataFlash memory[KBytes]]
The data flash memory size is displayed (unit: Kbytes). 
If the currently selected microcontroller does not incorporate the data flash, [0] is displayed. 
You cannot change the value of this property.

(2) [Clock]
You can configure the clock in this category. 

Figure 2.47 [Clock] Category [EZ Emulator]

(a) [Main clock frequency [MHz]]
Specify the main clock frequency. 
You can specify the frequency from the drop-down list or by directly entering a frequency value between 0.001 
and 99.999 (unit: MHz) (default: [Using internal clock]).   
When using X1/X2 oscillation, specify the clock frequency. 
When using an external clock oscillation with the embedded PLL circuit, specify the frequency of the transmitter/
resonator (i.e. the frequency before the setting of the PLL clock). 

Remark The main clock frequency is used to synchronize the communication between EZ Emulator and 
the host machine.  This specification is not for the frequency of the CPU operation. 

(b) [Sub clock frequency[kHz]]
Specify the sub clock frequency.
You can specify the frequency from the drop-down list or by directly entering a frequency value number between 
0.001 and 99.999 (unit: kHz) (default: [Using internal clock]).   

Remark The sub clock frequency is used to synchronize the communication between EZ Emulator and 
the host machine. 
This specification is not for the frequency of the CPU operation. 

(c) [Monitor clock]
Select a clock for monitor programs to operate while the program is stopped, from the following drop-down list. 

(3) [Connection with Target Board]
You can configure the connection between EZ Emulator and the target board in this category. 
Note that this category does not appear if no property displayed exists according to the type of the selected micro-
controller.

Figure 2.48 [Connection with Target Board] Category [EZ Emulator]

(a) [Low voltage OCD board]
This property appears only when the selected microcontroller supports a low voltage OCD board.
Select whether to use a low voltage OCD board. 
Select [Yes] to use a low voltage OCD board (default: [No]).

(4) [Flash]
You can configure the flash memory rewriting in this category. 

Figure 2.49 [Flash] Category [EZ Emulator]

System Operates with main clock (default). 

User Operates with the clock that the program specified.
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(a) [Security ID]
This property appears only when the selected microcontroller supports the ROM security function (on-chip 
debug security ID) for flash memory.
Specify a security ID for reading codes in the internal ROM or internal flash memory.
Directly enter 20 digits hexadecimal number (10 bytes: 0x0 to 0xFFFFFFFFFFFFFFFFFFFE) (default: 
[00000000000000000000]). 
For details on the on-chip debug security ID, see EZ Emulator User's Manual. 

Caution This property cannot be changed when EZ Emulator is connected to CS+.

(b) [Permit flash programming] 
Select whether to enable the flash memory rewriting.
Select [Yes] to enable flash rewrite (default). 
Note that when [No] is specified with this property, the flash memory area cannot be rewritten at all from the 
debug tool. 

(c) [Use wide voltage mode]
This property appears only when the selected microcontroller supports the wide voltage mode for the flash 
memory rewriting.
Select whether to rewrite the flash memory with the wide voltage mode.
Select [Yes] to rewrite with the low voltage flash mode (default). 

Caution This property cannot be changed when EZ Emulator is connected to CS+.

(d) [Erase flash ROM when starting] 
This property appears only when the [Permit flash programming] property is set to [Yes]. 
Select whether to erase flash ROM when connecting to the debug tool. 
Select [Yes] to erase the flash ROM (default: [No]). 
Note that this property is set to [No] after connecting to the debug tool. 

Caution This property cannot be changed when EZ Emulator is connected to CS+.

2.3.5.2  [Debug Tool Settings] tab

You configure the basic settings of the debug tool for each one of the following categories.

(1)  [Memory]
(2)  [Access Memory While Running]
(3)  [Break]
(4)  [Trace]
(5)  [Mask for Input Signal]
(6)  [Step function]

(1) [Memory]
You can configure the memory in this category. 

Figure 2.50 [Memory] Category [EZ Emulator]

(a) [Memory mappings]
Current memory mapping status is displayed for each type of memory area. 

Caution The memory mapping cannot be added/deleted. 
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(b) [Verify on writing to memory]
Select whether to perform a verify check when writing to the memory. 
Select [Yes] to perform verification after download or when values are changed in the Memory panel/Watch 
panel (default).

(2) [Access Memory While Running]
You can configure the memory access while executing a program (the real-time display update function) in this 
category.  See "2.9.1.4  Display/modify the memory contents during program execution" for details on the real-time 
display update function. 

Figure 2.51 [Access Memory While Running] Category [EZ Emulator]

(a) [Access by stopping execution]
For a memory area not accessible during execution of a program (e.g. target memory area/SFR area), select 
whether to allow access to the area by temporary stopping the execution.
Select [Yes] to allow access (default: [No]).

(b) [Update display during the execution] 
Select whether to automatically update the contents in the Memory panel/Watch panel display while executing a 
program. 
Select [Yes] to update the display automatically (default). 

Remark The display contents of the Memory panel/Watch panel can be updated manually by clicking the 
 button on the panel. 

(c) [Display update interval[ms]]
This property is valid only when the [Update display during the execution] property is set to [Yes]. 
Specify the interval in 100ms unit to automatically update the contents in the Memory panel/Watch panel display 
while executing a program. 
Directly enter the Integer number between 100 and 65500 (rounding up the fractions less than 100ms) (default: 
[500]). 

(3) [Break]
You can configure the break function. 
See "2.8  Stop Programs (Break)" for details on the break function and this category configuration. 

(4) [Trace]
You can configure the trace function in this category. 
Note that this category appears only when the selected microcontroller incorporates the OCD trace function.
See "2.11  Collect Execution History of Programs" for details on the trace function and this category configuration.

(5) [Mask for Input Signal] 
You can configure the input signal masking in this category. 

Caution Maskable signals differ depending on the selected microcontroller type (a signal that cannot be 
masked will be hidden).

Figure 2.52 [Mask for Input Signal] Category [EZ Emulator] 

With the properties shown below, select [Yes] to mask the signal from the drop-down list (default: [No]). 

- [Mask TARGET RESET signal]

- [Mask INTERNAL RESET signal]

(6) [Step function]
You can configure the control method of step execution.
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Figure 2.53 [Step function] Category [EZ Emulator]

(a) [Skip target section] 
Select whether to skip the target section.
Select [Yes] to skip the target section (default: [No]).

(b) [Target section] 
This property appears only when the [Skip target section] property is set to [Yes].
To specify a section, select the target property, then open the Specified Section dialog box by clicking the [...] 
button that appears on the right edge of the field.

2.3.5.3  [Download File Settings] tab

You can configure downloading to the debug tool.
See "2.5.1  Execute downloading" for details on each category configuration. 

2.3.5.4  [Hook Transaction Settings] tab

You can configure hook transaction for the debug tool.
See "2.16  Use Hook Function" for details on each category configuration and the function of the hook transaction. 

2.3.6  [Simulator]

Configure the operating environment on the Property panel below when using Simulator. 

Figure 2.54 Example of Property Panel [Simulator]

Follow the steps below by selecting the corresponding tab on the Property panel. 

2.3.6.1  [Connect Settings] tab
2.3.6.2  [Debug Tool Settings] tab
2.3.6.3  [Download File Settings] tab
2.3.6.4  [Hook Transaction Settings] tab

Caution The following cautions apply to the instruction simulator for RL78:

- The data flash is not supported. 

- The Pipeline is not supported.

- The CPU operation clock operates by the specification of RL78/G13.
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- When using Multiplier and Divider/Multiply-Accumulator by division mode, the division processing will 
be finished in by 1 clock.

- When using Multiplier and Divider/Multiply-Accumulator by division mode, the interrupt for the end of 
division operation is not occurred.  But DIVST bit of Multiplication/Division Control Register "MDUC" is 
changed (DIVST bit displays division operation status). 

Remark When Simulator to be used corresponds to peripheral function simulations, you can use the Simulator 
GUI.  See "2.18  Use the Simulator GUI [Simulator]" for details on the Simulator GUI. 

2.3.6.1  [Connect Settings] tab

You configure the connection with the debug tool for each one of the following categories.   

(1)  [Internal ROM/RAM]
(2)  [Clock]
(3)  [Configuration]

(1) [Internal ROM/RAM]
You can configure internal ROM/RAM in this category. 
The size of internal ROM/RAM of the selected microcontroller is specified by default. 
There is no need to change the settings in this category if you wish to debug with the same memory mapping of 
the selected microcontroller. 

Caution You should be careful not to overlap the area with other memory mapping area. 

Figure 2.55 [Internal ROM/RAM] Category [Simulator] 

(a) [Size of internal ROM[KBytes] 
Select the internal ROM size to simulate (unit: Kbytes). 
Change the value only when you perform debugging after changing the memory mapping.

(b) [Size of internal RAM[Bytes]]
Select the internal RAM size to simulate (unit: bytes). 
Change the value only when you perform debugging after changing the memory mapping. 

Remark The data flash memory is not supported by Simulator. 

(2) [Clock]
You can configure the clock in this category. 

Figure 2.56 [Clock] Category [Simulator]

(a) [Main clock frequency [MHz]]
Specify the main clock frequency. 
You can specify the frequency from the drop-down list or by directly entering a frequency value between 0.001 
and 99.999 (unit: MHz) (default: [4.00]).   

(b) [Sub clock frequency[kHz]]
Specify the sub clock frequency.
You can specify the frequency from the drop-down list or by directly entering a frequency value between 0.001 
and 99.999 (unit: kHz) (default: [32.768]).   

(c) [Select Timer/Trace clock frequency]
Select the clock frequency for using timer/trace function, from the following drop-down list. 
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(d) [Unit of Timer/Trace clock frequency]
This property appears only when the [Select Timer/Trace clock frequency] property is set to [Specify clock fre-
quency]. 
Select the unit of the clock frequency for timer/trace, from the following drop-down list.

(e) [Timer/Trace clock frequency] 
The operation of this property differs depending on the specification of the [Select Timer/Trace clock frequency] 
property. 

- When [CPU clock frequency] is selected:
The following value is displayed (this cannot be changed).
While disconnected from the debug tool: "---_---"
While connected to the debug tool: "CPU clock frequency" 

- When [Specify clock frequency] is selected:
Specify the clock frequency for timer/trace.
Directly enter the value between 1 [kHz] and 99.999 [MHz] (default: [4.00]). 
Unit is depending on the specification with the [Unit of Timer/Trace clock frequency] property. 

(3) [Configuration] 
You can configure the customization of the simulator in this category. 

Caution Properties in this category cannot be changed when Simulator is connected to CS+.

Figure 2.57 [Configuration] Category

(a) [Use simulator configuration file]
Select whether to use the simulator configuration file to perform user customization (adding of user models) of 
the simulator. 
Select [Yes] to use the simulator configuration file (default: [No]). 

(b) [Simulator configuration file]
This property appears only when the [Use simulator configuration file] property is set to [Yes]. 
Specify the simulator configuration file to use. 
Directly enter the file name, or select the file with the Select Simulator Configuration File dialog box that is 
opened by clicking on the [...] button that appears on the right end of the setting field. 

2.3.6.2  [Debug Tool Settings] tab

You configure the basic settings of the debug tool for each one of the following categories. 

(1)  [Memory]
(2)  [Access Memory While Running]
(3)  [Break]
(4)  [Trace]
(5)  [Timer]
(6)  [Coverage]
(7)  [Virtual Board]
(8)  [Simulator GUI]
(9)  [Step function]

(1) [Memory]

CPU clock frequency Uses the CPU clock frequency (default).

Specify clock frequency Specifies an arbitrary frequency (property items to specify become valid in the 
lower area). 

MHz The unit of the frequency is in MHz (default).

kHz The unit of the frequency is in kHz.
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You can configure the memory in this category. 

Figure 2.58 [Memory] Category [Simulator]

(a) [Memory mappings]
Current memory mapping status is displayed for each type of memory area. 

Caution The memory mapping cannot be added/deleted. 

(2) [Access Memory While Running]
You can configure the memory access while executing a program (the real-time display update function) in this 
category.  See "2.9.1.4  Display/modify the memory contents during program execution" for details on the real-time 
display update function. 

Figure 2.59 [Access Memory While Running] Category [Simulator]

(a) [Update display during the execution] 
Select whether to automatically update the contents in the Memory panel/Watch panel display during a program 
execution. 
Select [Yes] to update the display automatically (default). 

Remark The display contents of the Memory panel/Watch panel can be updated manually by clicking the 
 button on the panel. 

(b) [Display update interval[ms]]
This property is valid only when the [Update display during the execution] property is set to [Yes]. 
Specify the interval in 100ms unit to automatically update the contents in the Memory panel/Watch panel display 
while executing a program. 
Directly enter the Integer number between 100 and 65500 (rounding up the fractions less than 100ms) (default: 
[500]). 

(3) [Break]
You can configure the break function. 
See "2.8  Stop Programs (Break)" for details on the break function and this category configuration. 

(4) [Trace]
You can configure the trace function in this category. 
See "2.11  Collect Execution History of Programs" for details on the trace function and this category configuration. 

(5) [Timer]
You can configure the timer function in this category. 
See "2.12  Measure Execution Time of Programs" for details on the timer function and this category configuration. 

(6) [Coverage]
You can configure the coverage function in this category. 
See "2.13  Measure Coverage [IECUBE][Simulator]" for details on the coverage function and this category config-
uration. 

(7) [Virtual Board]
You can configure the virtual board function in this category. 

(a) [Use the same virtual board as the web simulator] 
Select whether to use the same virtual board as the web simulator.
Select [Yes] to use the virtual board (default: [No]).
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(8) [Simulator GUI]
You can configure the Simulator GUI function in this category. 
See "2.18  Use the Simulator GUI [Simulator]" for details on the Simulator GUI function and this category configu-
ration. 

(9) [Step function]
You can configure the control method of step execution.

Figure 2.60 [Step function] Category [Simulator]

(a) [Skip target section] 
Select whether to skip the target section.
Select [Yes] to skip the target section (default: [No]).

(b) [Target section] 
This property appears only when the [Skip target section] property is set to [Yes].
To specify a section, select the target property, then open the Specified Section dialog box by clicking the [...] 
button that appears on the right edge of the field.

2.3.6.3  [Download File Settings] tab

You can configure downloading to the debug tool.
See "2.5.1  Execute downloading" for details on each category configuration. 

2.3.6.4  [Hook Transaction Settings] tab

You can configure hook transaction for the debug tool.
See "2.16  Use Hook Function" for details on each category configuration and the function of the hook transaction. 
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2.4  Connect to/Disconnect from the Debug Tool

This section describes how to connect to/disconnect from the debug tool. 

2.4.1  Connect to the debug tool

By selecting [Connect to Debug Tool] from the [Debug] menu, CS+ starts communicating with the debug tool selected in 
the active project.

After succeeding in the connection to the debug tool, the Statusbar of the Main window changes as follows: 
For details on each item displayed on the Statusbar, see the section of the "Main window". 

Figure 2.61 Statusbar Indicating Successful Connection to Debug Tool

Caution If the version of compiler being used is not supported by CS+, [Connect to Debug Tool] will be disabled. 

Remark 1. When the  button on the Debug toolbar is clicked, the specified file is downloaded automatically after 
connecting to the debug tool (see "2.5.1  Execute downloading"). 
When the  button on this toolbar is clicked, the project is built automatically, and then the built file is 
downloaded after connecting to the debug tool. 

Remark 2. [Simulator]
When a microcontroller whose Simulator supports peripheral function simulations is selected, the Simu-
lator GUI window is automatically opened after connecting to the debug tool (default). 

2.4.2  Disconnect from the debug tool

By clicking the  button on the Debug toolbar, CS+ cuts off the communication with the connected debug tool. 
After disconnecting from the debug tool, the Statusbar of the Main window changes as follows: 

Figure 2.62 Statusbar Indicating Disconnection from Debug Tool

Caution The debug tool cannot be disconnected from CS+ while the program is running.

Remark Disconnecting the debug tool will close all the panels and dialog boxes that can be displayed only during 
the connection. 

2.4.3  Connect to the debug tool using hot plug-in [E1][E20]

With hot plug-in function, you can connect the debug tool to the target board during execution of a program (without 
having to turn off the system) and debug the program while it is in execution.

Follow the steps below to establish hot plug-in connection.

Caution 1. The hot plug-in connection is enabled only when the selected microcontroller incorporates the hot plug-in 
function.

The information of the debug tool appears at this area.

"DISCONNECT" is displayed.This area is left blank.
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Caution 2. When a hot plug-in connection is made, the settings of the following properties are ignored (i.e. the pro-
gram operates as if the specification for them is [No]).  The settings of them become valid again after 
reconnection with CS+.
 - [Mask TARGET RESET signal]
 - [Mask INTERNAL RESET signal]
 - [Power target from the emulator (MAX 200mA)]
 - [Erase flash ROM when starting]

Caution 3. When a hot plug-in connection is made, events currently being set in the project are ignored.
They become valid again after reconnection with CS+.

(1) Set the number of times and interval to retry
Set the interval and number of times to retry connection when the emulator fails to communicate with the micro-
controller on the target board.
You can configure this settings in [Hot Plug-in] category on the [Connect Settings] tab of the Property panel. 

Figure 2.63 [Hot Plug-in] Category 

(a) [Retrying interval[ms]]
Specify an interval in 1 ms unit to retry the connection. 
Directly enter the decimal number between 0 and 60000 (default: [1000]). 

(b) [Number of times of retrying]
Specify the number of times to retry the connection. 
Directly enter the decimal number between 0 and 3 (default: [3]). 

(2) Execute the program
Execute the program which has been downloaded onto the microcontroller on the target board without connecting 
to the emulator.

(3) Select the debug tool
In the active project, select the debug tool which supports hot plug-in connection (E1/ E20).

(4) Connect the debug tool to CS+ using hot plug-in
Select [Hot Plug-in] from [Debug] menu to initiate the preparation for hot plug-in connection.

(5) Connect to the target board
Following message will appear once you are ready to start hot plug-in connection.  Connect the emulator to the 
target system and click [OK].  This will start the communication with the debug tool which is selected in the cur-
rently active project.

Figure 2.64 Message Indicating that Hot Plug-in Connection Is Ready to Be Started 

(6) Hot plug-in connection completed
Once the connection to the debug tool is successfully completed, the Statusbar on the Main window will change 
as shown below.  For details on each item displayed on the statusbar, see the section of the "Main window".
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Figure 2.65 Statusbar Indicating Successful Hot plug-in Connection to Debug Tool

This area shows information on the currently active debug tool.“RUN“ indicates that the program is running.
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2.5  Download/Upload Programs

This section describes how to download programs (such as load module files) to debug to CS+ and how to upload the 
memory contents being debugged from CS+ to files. 

2.5.1  Execute downloading

Download the load module file to be debugged to the debug tool that is currently connected. 
Follow the steps below on the [Download File Settings] tab in the Property panel for the downloading, and then execute 

the downloading.

Caution By default, CPU reset automatically occurs after downloading the file, and then the program is executed 
to the specified symbol position.  If this operation above is not needed, specify [No] with both of the [CPU 
Reset after download] and [Execute to the specified symbol after CPU Reset] property. 

(1) [Download] category setting

Figure 2.66 [Download] Category 

Caution Properties displayed in this category differ depending on the debug tool used in the project. 

(a) [Download files]
The names of files to be downloaded and download conditions are displayed (the number enclosed with "[ ]" 
indicates the number of files to be download). 
Files that are specified as build target files in the main project or subprojects will automatically be selected as 
the files to be downloadedNote. 
However, you can manually change the download files and the condition.  In this case, see "2.5.2  Advanced 
downloading". 

Note To download the load module files created by an external build tool (e.g., compilers and assem-
blers other than the build tools supplied with CS+), a debug-dedicated project needs to be cre-
ated.
If you use a debug-dedicated project as the subject to debug, add your a download file to Down-
load files node on project tree.  The file to be downloaded will be reflected in this property.
See "CS+ Integrated Development Environment User's Manual: Project Operation" for details on 
the using an external build tool and a debug-dedicated project. 

(b) [CPU Reset after download]
Specify whether to reset the CPU after downloading. 
Select [Yes] to reset the CPU (default). 
Note, however, that this property does not appear if the selected microcontroller always resets the CPU after 
downloading.

(c) [Download Mode] (except [Simulator])
Specify the download mode for downloading to the flash ROM.
Select one of the options from the following drop-down list. 

Speed priority Fills free space between the first data and the final data with FFH (the previous value in 
free space before the first data and after the final data is retained).
Download speed will be faster because the writing data is reduced (default).
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(d) [Erase flash ROM before download] (except [Simulator])
This property is valid only when the [Download Mode] (except [Simulator]) property is set to [Speed priority] 
(default).
Specify whether to erase the flash ROM before downloading. 
Select [Yes] to erase the flash ROM (default: [No]). 
Note that the erase operation differs depending on the emulator when [Yes] is selected.

- [IECUBE]
The internal ROM area will be always erased.  For the other area, an erase will be performed in the area 
where the downloaded data exists. 

- [E1][E20][EZ Emulator]
For all flash area, an erase will be performed in the area where the downloaded data exists. 

Caution Flash ROM is erased by writing FFH so the flash ROM will not be blank.

(e) [Automatic change method of event setting position]
If the file is downloaded again during debugging then the location (address) set for the currently configured 
event may change to midway in the instruction. 
Specify with this property how to handle the target event in this circumstance. 
Select one of the options from the following drop-down list. 

Note, however, that this property setting only applies to the location setting of events without debugging infor-
mation. The location setting of events with debug information is always moved to the beginning of the source 
text line. 

(f) [Check reserved area overwriting when downloading] [E1][E20][EZ Emulator]
Specify whether to output a message when overwriting to an area reserved for use by the emulator is attempted 
at the time of downloading. 
Select [Yes] to output a message (default). 

(2) [Debug Information] category setting

Figure 2.67 [Debug information] Category

(a) [Execute to the specified symbol after CPU Reset]
Specify from the drop-down list whether to execute the program to the specified symbol position after CPU reset 
or downloading (for only when the [CPU Reset after download] property is set to [Yes]). 
Select [Yes] to execute the program to the specified symbol position after CPU reset (default). 

Remark When the [CPU Reset after download] property is set to [Yes], the operation after downloading is 
as follows: 
If [Yes] is selected for this property, the Editor panel will open automatically with displaying 
source text of the position specified with the [Specified symbol] property after downloading.
If [No] is selected for this property, the Editor panel will open with displaying source text of the 
reset address (when if the source text has not been allocated to the reset address, the contents 
of the reset address is displayed in the Disassemble panel).

(b) [Specified symbol]
This property appears only when the [Execute to the specified symbol after CPU Reset] property is set to [Yes].  
Specify the position at which the program is stop after CPU reset. 
Directly enter an address expression between 0 and "last address in address space" (default: [_main]). 
Note, however, that the program will not be executed if the specified address expression cannot be converted 
into an address. 

Data priority Retains the previous value in free space.
Download speed will be very slow because data in free space are read once.

Move to the head of instruction Resets the subject event at the beginning address of the instruction. 

Suspend event Leaves the subject event pending (default). 
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Remark Normally, specify the following.
For assembler source: Start label corresponding to main function 
For C source: Symbol assigned to the start of the main function name 

(c) [The upper limit size of the memory usage [Mbytes]]
Specify the upper limit on the amount of memory to be used in reading the debug information.
When the amount of memory being used exceeds the upper limit specified here, memory is made available by 
discarding debug information that has been read until the amount of memory in use is reduced to half of this 
upper limit (lowering the upper limit might improve the situation when shortages of memory are arising).
Directly enter a decimal number between 100 and 1000 (unit: Mbyte) (default: [500]).

Caution In some cases, lowering the upper limit may lead to poorer responsiveness since it leads to more 
frequent discarding and re-reading of debug information.

(3) Execute download
Click the  button on the Debug toolbar.
If this operation is performed while disconnecting from the debug tool, the application automatically connects to 
the debug tool, and then performs the download. 

Remark When a program that has been modified during debugging is re-downloaded, you can easily build 
and download it by selecting [Build & Download] from the [Debug] menu on the Main window. 

(4) Canceling a download
To cancel a download, click the [Cancel] button on the Progress Status dialog box, which displays the progress of 
downloading, or press the [Esc] key.

If the load module file is successfully downloaded, the Editor panel opens automatically, and the contents of the down-
loaded file's source text are displayed. 

Remark You can automatically overwrite the value of SFR/CPU register with the specified values before and after 
performing the download (see "2.16  Use Hook Function" for details). 

2.5.2  Advanced downloading

You can change the download files and the condition to download. 
With CS+, the following file types can be downloaded. 

Table 2.1 Downloadable File Formats

You can change the download files or download conditions in the following Download Files dialog box. 
The Download Files dialog box is opened by clicking the [...] button that appears at the right edge in the column of the 

[Download files] property when you select it in the [Download] category on the [Download File Settings] tab of the Property 
panel. 

Downloadable File Extension File Format

Load module file .abs Load module format

Intel Hex file .hex Intel Hex file format 

Motorola S-record file .mot Motorola S-record file format

- (S0, S1, S9 - 16 bit-address)

- (S0, S2, S8 - 24 bit-address)

- (S0, S3, S7 - 32 bit-address)

Binary file .bin Binary format
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Figure 2.68 Opening Download Files Dialog Box

Figure 2.69 Advanced Downloading (Download Files Dialog Box)

This section describes how to configure on the Download Files dialog box above when the following cases. 
For details on the contents and function in each area, see the section for the Download Files dialog box. 

2.5.2.1  Change download conditions for load module files
2.5.2.2  Add download files (*.hex/*.mot/*.bin)
2.5.2.3  Perform source level debugging with files other than the load module file format

2.5.2.1  Change download conditions for load module files

Follow the steps below in the Download Files dialog box to change the download conditions (object information and 
symbol information) for load module files.

(1) Select a load module file
Select a load module file to download in the [Download file list] area. 

(2) Change download conditions
Current download conditions for the selected load module file are displayed in the [Download file property] area. 
Change each items displayed in the property. 

Download object Specify whether to download the object information from the specified file. 

Default Yes

Modifying Select from the drop-down list.

Available 
values

Yes Downloads object information.

No Does not download object information.

[Download file property] area

[Download file list] area 
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Note 1. If the symbol information have not been downloaded, the source level debugging cannot be per-
formed. 

Note 2. When [Yes] is selected, the time taken for downloading and the memory usage on the host machine 
will increase.  We recommend selecting [No] in this item if you do not intend to use the symbol 
name completion function.

(3) Click the [OK] button
Enable all the configuration in this dialog box and change the download conditions. 

2.5.2.2  Add download files (*.hex/*.mot/*.bin)

Follow the steps below to add download files other than the load module format (Intel HEX file (*.hex), Motorola S-
record file (*.mot) or binary file (*.bin)) in the Download Files dialog box. 

(1) Click the [Add] button
When the [Add] button is clicked, a blank list item "-" is displayed in the last line of the [Download file list] area. 

(2) Property configuration of the download files to add 
Configure the download conditions for the download file to add in the [Download file property] area. 
Configure each item displayed with the following condition. 
When the configuration is completed, the file name specified in this property is displayed in the blank list of the 
[Download file list] area. 

Download symbol 
information

Specify whether to download the symbol information from the specified fileNote 1. 

Default Yes

Modifying Select from the drop-down list.

Available 
values

Yes Downloads symbol information.

No Does not download symbol information.

Generate the infor-
mation for
input completion

Select whether to generate the information for the Symbol name completion function 
when downloadingNote 2. 

Default Yes

Modifying Select from the drop-down list.

Available 
values

Yes Generates the information for the symbol name completion 
function. (i.e. uses the symbol name completion function.)

No Does not generate the information for the symbol name com-
pletion function. (i.e. does not use the symbol name comple-
tion function.)

File Specify the download file (Intel HEX file (*.hex), Motorola S-record file (*.mot) or binary file 
(*.bin)) to download (up to 259 characters). 

Default Blank

Modifying Directly enter from the keyboard, or specify with the Select Download File 
dialog box that is opened by clicking the [...] button.

Available 
values

See "Table 2.1  Downloadable File Formats".
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Remark The settings of whether to download the object information or symbol information can be made only 
when the type of the file to download is load module files.

(3) Check the order of download 
The order of the download is the display order of the files displayed in the [Download file list] area. 
If you want to change the order, use the [Up]/[Down] button. 

(4) Click the [OK] button
Enable all the configuration in this dialog box and add a download file (the file name is displayed in the [Download] 
category on the [Download File Settings] tab of the Property panel).

2.5.2.3  Perform source level debugging with files other than the load module file format

Even when an Intel HEX file (*.hex), Motorola S-record file (*.mot) or binary file (*.bin) is specified to be the subject file 
to download, it is possible to do source level debugging by downloading symbol information for the load module file from 
which the subject file was created, along with the subject file that you download.

To do so, follow the steps below on the Download Files dialog box. 

(1) Click the [Add] button
When the [Add] button is clicked, a blank list item "-" is displayed in the last line of the [Download file list] area. 

(2) Property configuration of the load module file to add
Configure each item displayed with the following condition in the [Download file property] area. 

File type Specify the type of the file to download. 
Select [Hex file] or [Binary data file].

Default Load module file

Modifying Select from the drop-down list.

Available 
values

Either one of the following

- Load module file

- Hex file

- S record file

- Binary data file

Offset Specify the offset from the address at which the file's download is to start. 
Note that this item appears only when [File type] or [S record file] is set to [Hex file].

Default 0

Modifying Directly enter from the keyboard. 

Available 
values

0x0 to 0xFFFFF in hexadecimal number

Start address Specify the address at which to start the file's download. 
Note that this item appears only when [File type] is set to [Binary data file].

Default 0

Modifying Directly enter from the keyboard. 

Available 
values

0x0 to 0xFFFFF in hexadecimal number

File Specify a load module file from which the Intel HEX file (*.hex), Motorola S-record file 
(*.mot) or binary file (*.bin) that you want to download was created.
Directly enter from the keyboard, or specify with the Select Download File dialog box that 
is opened by clicking the [...] button that appears at right by selecting this property. 

File type Select [Load module file] (default).

Download object Specify [No]. 
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Note When [Yes] is selected, the time taken for downloading and the memory usage on the host machine 
will increase.  We recommend selecting [No] in this item if you do not intend to use the symbol 
name completion function.

(3) Click the [OK] button
Enable all the configuration in this dialog box and add the specified load module file (Only the symbol information 
included in the load module file will be downloaded). 

2.5.3  Execute uploading

The contents of the memory of the debug tool currently connected can be saved (uploaded) in an arbitrary file. 
You can upload the data in the Data Save dialog box that is opened by selecting the [Debug] menu >> [Upload...]. 
In this dialog box, follow the steps below. 

Figure 2.70 Execute Uploading (Data Save Dialog Box)

(1) Specify [File Name] 
Specify the name of the file to save. 
You can either type a filename directly into the text box (up to 259 characters), or select one from the input history 
via the drop-down list (up to 10 items).  You can also specify the file by clicking the [...] button, and selecting a file 
via the Select Download File dialog box. 

(2) Specify [File Type] 
Select the format in which to save the file from the following drop-down list. 
The following file formats can be selected. 

Table 2.2 Type of Files That Can be Uploaded 

Download symbol 
information

Select [Yes] (default).

Generate the infor-
mation for
input completion

Select whether to generate the information for the Symbol name completion function 
when downloadingNote. 

Default Yes

Modifying Select from the drop-down list.

Available 
values

Yes Generates the information for the symbol name completion 
function. (i.e. uses the symbol name completion function.)

No Does not generate the information for the symbol name com-
pletion function. (i.e. does not use the symbol name comple-
tion function.)

Displayed List Items File Format

Intel Hex format (*.hex) Intel Hex format

Motorola Hex format (*.hex) Motorola S type format 
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(3) Specify [Save Range Address/Symbol] 
Specify the range of addresses to save via "start address" and "end addresses". 
Directly enter hexadecimal number/address expression in each text box or select from the input history displayed 
in the drop-down list (up to 10 items). 

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space] 
key in each text box (see "2.19.2  Symbol name completion function"). 

(4) Click the [Save] button
Save the contents of the memory in the specified file in specified format as upload data. 

Binary data (*.bin) Binary format

Displayed List Items File Format
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2.6  Display/Change Programs

This section describes how to display and change programs when a load module file with the debug information is 
downloaded to a debug tool. 

Downloaded programs can be displayed in the following panels. 

- Editor panel
The source file is displayed and can be edited. 
Furthermore, the source level debugging/instruction level debugging (see "2.7.3  Execute programs in steps") and the 
display of the code coverage measurement result (see "2.13.2  Display the coverage measurement result") can be 
performed in this panel. 

- Disassemble panel
The result of disassembling the downloaded program (the memory contents) is displayed and can be edited (line 
assemble). 
Furthermore, the instruction level debugging (see "2.7.3  Execute programs in steps") and the display of the code 
coverage measurement result (see "2.13.2  Display the coverage measurement result") can be performed in this 
panel.  In this panel, the disassemble results can be displayed with the corresponding source text (default). 

Remark It is normally necessary to download a load module file with debugging information in order to perform 
the source level debugging, but it is also possible to do so by downloading an Intel HEX file (*.hex), 
Motorola S-record file (*.mot) or binary file (*.bin) (see "2.5.2.3  Perform source level debugging with files 
other than the load module file format").

2.6.1  Display source files

The source file is displayed in the Editor panel below.  The Editor panel automatically opens with displaying source text 
of the specified position (see "2.5.1  Execute downloading") when a load module file is successfully downloaded. 

If you want to open the Editor panel manually, double-click on the source file in the Project Tree panel. 
For details on the contents and function in each area, see the section for the Editor panel. 

Figure 2.71 Display Source File (Editor Panel)

2.6.2  Display the result of disassembling

The result of disassembling the downloaded program (disassembled text) is displayed in the Disassemble panel below. 
Select [View] menu >> [Disassemble] >> [Disassemble1 - 4]. 
The maximum of 4 Disassemble panels can be opened.  Each panel is identified by the names "Disassemble1", 

"Disassemble2", "Disassemble3" and "Disassemble4" on the titlebar. 
For details on the contents and function in each area, see the section for the Disassemble panel. 
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Figure 2.72 Display Result of Disassembling (Disassemble Panel)

(1): Event area
(2): Address area
(3): Disassemble area

Remark You can set the scroll range of the vertical scroll bar on this panel via the Scroll Range Settings dialog 
box that is opened by clicking the  button from [View] on the toolbar. 

This section describes the following. 

2.6.2.1  Change display mode
2.6.2.2  Change display format
2.6.2.3  Move to the specified address
2.6.2.4  Move to the symbol defined location
2.6.2.5  Save the disassembled text contents

2.6.2.1  Change display mode

You can change the display mode of the Disassemble panel by clicking the  button (toggle) on the toolbar.

(1) Mixed display mode
In this display mode (default), the disassembled text is displayed combined with the source text.

Figure 2.73 Mixed Display Mode (Disassemble Panel)

(2) Disassemble display mode
In this display mode, the source text is hidden and only the disassembled text is displayed. 

(2) (3)(1)

Toolbar

Source text

Disassembled text
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Figure 2.74 Disassemble Display Mode (Disassemble Panel)

2.6.2.2  Change display format

The display format of the disassemble area can be changed using buttons below on the toolbar. 

2.6.2.3  Move to the specified address

You can move to the specified address in the disassembled text in the Go to the Location dialog box which opens when 
selecting [Go to...] from the context menu. 

In this dialog box, follow the steps below. 

Figure 2.75 Move to Specified Address in Disassembled Text (Go to the Location Dialog Box)

(1) Specify [Address/Symbol]
Specify the address you want to move the caret to. 
You can either type an address expression directly into the text box (up to 1024 characters), or select them from 
the input history via the drop-down list (up to 10 items). 

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space] 
key in this text box (see "2.19.2  Symbol name completion function"). 

(2) Click the [OK] button
Caret is moved to the specified address. 

2.6.2.4  Move to the symbol defined location

You can move the caret to the address where the symbol is defined. 
Click the  button on the toolbar after moving the caret to the instruction which refers to the symbol. 

View The following buttons to change the display format are displayed. 

 Show Offset Displays the offset value of the label. The offset value from the nearest label is dis-
played when a label is defined for the address. 

 Show Symbol Displays the address value as the result of disassembling in the format "symbol + off-
set value" (default). 
Note that when a symbol has been defined as the address value, only the symbol is 
displayed. 

 Show Function Name Displays the name of the register by its function name (default). 

 Show Absolute Name Displays the name of the register by its absolute name. 

Disassembled text
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Furthermore, click the  button on the toolbar following the previous operation returns the caret to the instruction 
which refers to the symbol at previous caret is defined. 

2.6.2.5  Save the disassembled text contents

Contents of the disassembled text can be saved in text files (*.txt)/CSV files (*.csv). 
When saving to the file, the latest information is acquired from the debug tool, and it is saved in accordance with the dis-

play format on this panel. 
The Data Save dialog box can be opened by selecting the [File] menu >> [Save Disassemble Data As...] (when this 

operation takes place with the range selected on the panel, the disassembled data can be saved only for the selected 
range).

In this dialog box, follow the steps below. 

Figure 2.76 Save Disassembled Text Contents (Data Save Dialog Box)

(1) Specify [File Name] 
Specify the name of the file to save.
You can either type a filename directly into the text box (up to 259 characters), or select one from the input history 
via the drop-down list (up to 10 items). 
You can also specify the file by clicking the [...] button, and selecting a file via the Select Data Save File dialog box. 

(2) Specify [File Type] 
Select the format in which to save the file from the following drop-down list. 
The following file formats can be selected. 

Note The data is saved with entries separated by commas (,). 
If the data contains commas, each entry is surrounded by double quotes "" in order to avoid illegal 
formatting. 

(3) Specify [Save Range Address/Symbol]
Specify the range of addresses to save via "start address" and "end addresses". 
Directly enter hexadecimal number/address expression in each text box or select from the input history displayed 
in the drop-down list (up to 10 items). 
If a range is selected in the panel, that range is specified as the default.  If there is no selection, then the range 
currently visible in the panel is specified. 

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space] 
key in each text box (see "2.19.2  Symbol name completion function"). 

(4) Click the [Save] button
Disassembling data is saved in the specified file with the specified format. 

List Item Format

Text files (*.txt) Text format (default)

CSV (Comma-Separated Variables)(*.csv) CSV formatNote
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Figure 2.77 Output Example of Disassembling Data

Remark 1. When the contents of the panel are overwritten and saved by selecting the [File] menu >> [Save 
Disassemble Data], the Disassemble panels (Disassemble1-4) are handled individually for these 
respectively.  In addition, saving range is same as the previously specified address range. 

Remark 2. You can print the current screen image of this panel by selecting the [File] menu >> [Print...]. 

2.6.3  Run a build in parallel with other operations

CS+ can automatically start a build when one of the following events occurs (rapid build function).

- For other than the debug-only project

- When any one of the following files that are added to the project is updated:
(C source file, assembler source file, header file, link directive file, symbol information file, object module file, 
and library file)

- When a build target file has been added to or removed from the project

- When the link order of object module files and library files is changed

- When the property of the build tool or the build target file is changed

- For the debug-only project

- When you have edited and saved the C source file, assembler source file and header file that are added to the 
debug-dedicated project

- When a C source file, assembler source file, or header file has been added to or removed from the debug-dedi-
cated project

- When the property of the debug-dedicated project is changed

If a rapid build is enabled, it is possible to perform a build in parallel with the above operations.
To enable/disable a rapid build, select [Rapid Build] from the [Build] menu.  A rapid build is enabled by default.

Caution When an external text editor is used, check the [Observe registered files changing] check box on the 
[General - Build] category in the Option dialog box to enable this function. 

Remark 1. After editing source files, it is recommend to save frequently by pressing the [Ctrl] + [S] key.

Remark 2. Enable/Disable setting of the rapid build applies to the entire project (main project and subprojects).

Remark 3. If you disable a rapid build while it is running, it will be stopped at that time.

2.6.4  Perform line assembly

Instructions and code displayed in the Disassemble panel can be edited (line assembly). 
This section describes the following. 

2.6.4.1  Edit instructions
2.6.4.2  Edit code

2.6.4.1  Edit instructions

Follow the steps below to edit instructions. 

--------------------------------------------------------
Label (symbol name)
   :              
File name Line number C language source text
   :             :                 :             
Address Offset Code Result of Disassembling
   :     :       :                 :          

  Label (symbol) line

  Source text line

 Disassembling line
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(1) Switch to edit mode
Double-click the instruction to edit or select [Edit Disassemble] from the context menu after moving the caret to the 
instruction to edit.

(2) Edit instructions
Use keyboard to directly edit the instructions. 

(3) Write to memory
Press the [Enter] key to line assemble the edited instructions after editing.  The code is automatically written to the 
memory. 
If the edited instruction is invalid, the instruction is shown in red and will not be written to the memory. 

If there is a space because of overwriting the displayed result of disassembling by another instruction, its byte number is 
automatically compensated with NOP instruction as follows: 

Example 1. MOVW instruction (4-byte instruction) in the second line is overwritten by DEC instruction (1-byte instruc-
tion). 

Example 2. ADDW instruction (3-byte instruction) in the first line is overwritten by MOVW instruction (4-byte instruc-
tion). 

2.6.4.2  Edit code

Follow the steps below to edit code. 

(1) Switch to edit mode
Double-click the code to edit or select [Edit Code] from the context menu after moving the caret to the code to edit. 

(2) Edit code
Use keyboard to directly edit the code. 

(3) Write to memory
Press the [Enter] key to write the code to the memory after editing. 
If the edited instruction is invalid, the instruction is shown in red and will not be written to the memory. 
When the code is written to the memory, the result of disassembling is also updated. 

Before editing 0461CF          ADDW AX,#0CF61H
CBF820FE        MOVW SP,#0FE20H
FC8E1800        CALL    !!_funcA
53C0            MOV  B, #0C0H

After editing 0461CF          ADDW AX,#0CF61H
93              DEC  B
00              NOP
00              NOP
00              NOP
FC8E1800        CALL    !!_funcA
53C0            MOV  B, #0C0H

Before editing 0461CF          ADDW AX,#0CF61H
CBF820FE        MOVW SP,#0FE20H
FC8E1800        CALL    !!_funcA
53C0            MOV  B, #0C0H

After editing CBF820FE        MOVW SP, #0FE20H
00              NOP
00              NOP
00              NOP
FC8E1800        CALL    !!_funcA
53C0            MOV  B, #0C0H
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2.7  Execute Programs

This section describes how to execute programs.
Main operations in this section are taken place from the debug toolbar or the [Debug] menu in the Main window, where 

commands to control the execution of programs are included.

Caution Items of the debug toolbar and the [Debug] menu are valid only while connected to the debug tool.

Figure 2.78 Debug Toolbar

Figure 2.79 [Debug] Menu

2.7.1  Reset microcontroller (CPU)

To reset CPU, click the  button on the debug toolbar. 
When CPU is reset, the current PC value is set to the reset address. 

Remark You can automatically overwrite the value of SFR/CPU register with the specified values after CPU reset 
under breaking (see "2.16  Use Hook Function" for details). 

2.7.2  Execute programs

The following types of CS+ execution functions are provided. 
Select any of the following operations according to the purpose of debugging. 
See "2.8  Stop Programs (Break)" for details on how to stop the program in execution. 

2.7.2.1  Execute after resetting microcontroller (CPU)
2.7.2.2  Execute from the current address
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2.7.2.3  Execute after changing PC value

Remark You can automatically overwrite the value of SFR/CPU register with the specified values before starting 
program execution (see "2.16  Use Hook Function" for details). 

2.7.2.1  Execute after resetting microcontroller (CPU)

Click the  button on the debug toolbar. 
Reset CPU and start execution of the program from the reset address. 
When this operation is performed, the program continues to be executed until either of the following occurs:

- The  button has been clicked (see "2.8.2  Stop the program manually").

- The PC has reached a breakpoint (see "2.8.3  Stop the program at the arbitrary position (breakpoint)").

- A break event condition has been met (see "2.8.4  Stop the program at the arbitrary position (break event)" or "2.8.5  
Stop the program with the access to variables/SFRs").

- A fail-safe break has occurred (see "2.8.6  Stop the program when an invalid execution is detected [IECUBE]").

- Other break causes have occurred. 

Remark This operation is the same as when the  button is clicked after clicking the  button. 

2.7.2.2  Execute from the current address

Perform any of the following operations to start executing the program from the address at the current PC value. 

(1) Normal execution
Click the  button on the debug toolbar. 
When this operation is performed, the program continues to be executed until either of the following occurs:

- The  button has been clicked (see "2.8.2  Stop the program manually").

- The PC has reached a breakpoint (see "2.8.3  Stop the program at the arbitrary position (breakpoint)").

- A break event condition has been met (see "2.8.4  Stop the program at the arbitrary position (break event)" or 
"2.8.5  Stop the program with the access to variables/SFRs").

- A fail-safe break has occurred (see "2.8.6  Stop the program when an invalid execution is detected [IECUBE]").

- Other break causes have occurred. 

(2) Execution ignoring break-related events
Click the  button on the debug toolbar. 
When this operation is performed, the program continues to be executed until either of the following occurs:

- The  button has been clicked (see "2.8.2  Stop the program manually").

- A fail-safe break has occurred (see "2.8.6  Stop the program when an invalid execution is detected [IECUBE]").

- Other break causes have occurred. 

Remark If you have started the execution with this operation, the occurrence of Action event will also be 
ignored.

(3) Execution to the caret position
To start this operation, move the caret to the line/instruction to stop the program in the Editor panel/Disassemble 
panel, then select [Go to Here] from the context menu.
When this operation is performed, the program continues to be executed until either of the following occurs:

- The PC has reached the address of the caret position. 

- The  button has been clicked (see "2.8.2  Stop the program manually").

- A fail-safe break has occurred (see "2.8.6  Stop the program when an invalid execution is detected [IECUBE]").

- Other break causes have occurred. 

Caution When the corresponding address of the line at the caret position does not exist, the program is exe-
cuted to the corresponding address of the lower valid line (if the corresponding address does not 
exist, an error message will appear). 
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Remark If you have started the execution with this operation, the occurrence of Action event will also be 
ignored.

2.7.2.3  Execute after changing PC value

The program is executed after forcibly changing the current PC value to an arbitrary address.
To start this operation, move the caret to the line/instruction to start the program in the Editor panel/Disassemble panel, 

then select [Set PC to Here] from the context menu (the current PC value is set to the address of the line/instruction where 
the caret currently exists). 

Then execute either one of the execution method described in "2.7.2.2  Execute from the current address".

2.7.3  Execute programs in steps

When either of the following operation has occurred, the program will stop automatically after conducting step execution 
in the source level (1 line of source text) or in the instruction level (1 instruction).

Once the program is stopped, the contents of each panel will be updated automatically.  As such, step execution is 
suited for debugging the program execution in transition either in source or instruction level.

The unit in which the program is step-executed depends on the setting of the Editor panel as follows: 

- When the  button on the toolbar is invalid (default):
Step execution is conducted in source level.
Note, however, that when the focus is in the Disassemble panel or the line information does not exist in the address 
specified by the current PC value, the step execution is conducted in instruction level.

- When the  button on the toolbar is valid:
Step execution is conducted in instruction level.

Remark The  button is only enabled if the mixed display mode is selected on the Editor panel (see "CS+ Inte-
grated Development Environment User's Manual: Editor").

Step execution is divided into the following types:

2.7.3.1  Step in function (Step in execution)
2.7.3.2  Step over function (Step over execution)
2.7.3.3  Execute until return is completed (Return out execution)

Caution 1. Breakpoints, break events, and action events that have been set do not occur during step execution. 

Caution 2. If an instruction to move to standby mode (HALT/STOP) is executed during step execution, the program 
will break at the next instruction after the standby mode instruction.
This behavior differs depending on the debug tool used. 

- For other than [Simulator]
It will not go into standby mode during step execution. 

- [Simulator]
It will go into standby mode during step execution. 
It will appear that standby mode has been released.  Check the CPU status on the Main window's sta-
tusbar to see if standby mode has been released.

Caution 3. For other than [Simulator]

- Interrupts are not acknowledged and fail-safe breaks [IECUBE] do not occur during step execution. 

- If step execution is performed in source level, CS+ determines whether an interrupt is being processed 
via the NP, EP, and ID flags in the PSW register.  For this reason, if the above register or flags are 
changed (e.g. when using multiple interrupts), then Return out execution may be incorrect.

Caution 4. [Simulator]
You may jump to an interrupt handler during step execution.

Caution 5. During source-level stepping, the debugger may appear to be executing instructions that are not sup-
posed to be executed.
However, the reason for these problems is a difference between the debugging information generated by 
the compiler and the actual code. The result of executing the code generated by the compiler is correct.
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Example In the program code shown below, it seems that the position indicated by the current PC 
might be moved to position (*1) after the execution of (*2), although (*1) is never actually 
executed in the generated code.

Note that this caution may be eliminated by making either or both of the following settings on the [Com-
pile Options] tab in the Property panel of the build tool.

- Set the [Enhance debug information with optimization] property to [Yes(-g_line)] in the [Debug Informa-
tion] category.

- Set the [Level of optimization] property to [Debug precedence(-Onothing)] in the [Optimization] cate-
gory.

2.7.3.1  Step in function (Step in execution)

When the function is called, the program is stopped at the top of the called function. 
Click the  button on the debug toolbar to perform Step in execution. 

Caution 1. Step in execution for a function without the debug information is not possible. 

Caution 2. If Step in execution is performed for the longjmp function, program execution may not complete and may 
wait for a time-out.

Caution 3. The beginning of the function (prologue processing) is not skipped.  To skip prologue processing, perform 
Step in execution again.

2.7.3.2  Step over function (Step over execution)

In the case of a function call by the CALL instruction, all the source lines/instructions in the function are treated as one 
step and executed until the position where execution returns from the function (step execution will continue until the same 
nest is formed as when the CALL instruction has been executed). 

Click the  button on the debug toolbar to perform Step over execution.
In the case of an instruction other than CALL, operation is the same as Step in execution. 

Caution If Step over execution is performed for the longjmp function, program execution may not complete and 
may wait for a time-out.

2.7.3.3  Execute until return is completed (Return out execution)

Step-execute the program so that the program will stop when it returns from the current function to the caller function. 
When the execution of source line/instruction that require checking has been completed, you can perform step execution 
using this instruction so that you can make the program return to the caller function without step executing the remaining 
instructions inside the function. 

void main(void);
int x, y, z1, z2, z3;
void func(int i)
{
    if (i == 0) {
        ++x; // <-(*1)
        ++z1;++z2;++z3;
    } else {
        ++y; // <-(*2)
        ++z1;++z2;++z3;
    }
}
int one = 1;
void main(void)
{
  while (1)
  {
    func(one);
  }
}
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Click the  button on the debug toolbar to perform Return out execution. 

Caution 1. If Return out execution is performed in the main function, the program is stopped in the startup routine. 

Caution 2. If Return out execution is performed in a function that called the longjmp function, breaks may not occur.

Caution 3. Return out execution cannot be performed immediately after a function return.

2.8  Stop Programs (Break)

This section describes how to stop the program in execution.
CS+ can stop the program in execution at the arbitrary position by using the following functions.

(1) Forced break function
Stops the program forcibly.

(2) Hardware break function
The debug tool consecutively checks the break condition while the program is in execution and stops the program 
when the condition is met.  This function is implemented using the debug tool resources.
There are two types of Hardware Break event: "execution type" which stops the program at the arbitrary position; 
and "access type" which stops the program when an arbitrary variable and so on is accessed with the specified 
type.

Remark 1. [IECUBE]
There are two types of Hardware Break event (execution type): "before execution break" which 
breaks before the instruction at the specified address is executed; and "after execution break" 
which breaks after the instruction at the specified address is executed.  CS+ starts by using "before 
execution break" resource to set Hardware Break events, and as soon as that resource becomes 
unavailable, uses "after execution break" resource (see "2.15.7.1  Maximum number of enabled 
events").  For this reason, you cannot select between before and after execution. 

Remark 2. [E1][E20][EZ Emulator]
Hardware Break events (execution type) break the program after the instruction at the specified 
address is executed. 

Remark 3. [Simulator]
For a Hardware Break event (execution type), you can select between "before execution break" 
which breaks before the instruction at the specified address is executed and "after execution break" 
which breaks after the instruction at the specified address is executed (see "2.8.1.3  [Simulator]"). 

(3) Software break function (except for [Simulator])
Temporarily replaces the instruction code for a specified address with a break instruction and stops the program 
when this instruction is executed.

Caution 1. If a forced break is performed while in standby mode (HALT/STOP), the current PC position will indicate 
the address of the next instruction after the standby mode instruction.
This behavior differs depending on the debug tool used. 

- For other than [Simulator]
The forced break will release standby mode.

- [Simulator]
The forced break will not release standby mode.
It will appear that standby mode has been released.  Check the CPU status on the Main window's sta-
tusbar to see if standby mode has been released.

Caution 2. [E1][E20][EZ Emulator]
Do not decrease the voltage of the target system during a break.  A reset that is generated by the low-
voltage detector (LVI) or by power-on-clear (POC) during a break causes an incorrect operation of CS+ 
or communication errors. 
A break during emulation of power supply off also causes communication errors.

Remark When the program in execution is stopped, a statement of the cause of the break appears on the Status-
bar in the Main window. 

2.8.1  Configure the break function

Before the break function can be used, it is necessary to make settings relating to the operation of a break.
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This break operation can be configured in the [Break] category on the [Debug Tool Settings] tab of the Property panel. 
The setting method differs depending on the debug tool used. 

2.8.1.1  [IECUBE]
2.8.1.2  [E1]/[E20]/[EZ Emulator]
2.8.1.3  [Simulator]

2.8.1.1  [IECUBE]

Figure 2.80 [Break] Category [IECUBE]

(1) [First using type of breakpoint] 
Specify the type of preferential breakpoint with a single click of the mouse in the Editor panel/Disassemble panel. 
Select from the drop-down list below for each use of the breakpoint.

Caution If the number of the set breakpoints of the specified type exceeds the limit settable (see "2.15.7.1  
Maximum number of enabled events"), a breakpoint of another type will be used. 

(2) [Stop emulation of timer group when stopping]
Select whether to terminate the peripheral emulation of timers while stopping the program execution (Peripheral 
Break).
Select [Yes] to terminate (default: [No]).

(3) [Stop emulation of serial group when stopping]
This property appears only when the selected microcontroller supports the function that terminates the peripheral 
emulation of serials (Peripheral Break). 
Select whether to terminate the peripheral emulation of serials while stopping the program execution. 
Select [Yes] to terminate (default: [No]).

(4) [Use open break function]
This property appears only when the selected microcontroller supports the open break function.
Select from the following drop-down list whether to use the open break function. 
The default value depends on the type of the selected microcontroller. 

2.8.1.2  [E1]/[E20]/[EZ Emulator]

Figure 2.81 [Break] Category [E1][E20][EZ Emulator]

(1) [First using type of breakpoint] 
This property appears only when the selected microcontroller supports multiple types of breakpoint. 
Specify the type of preferential breakpoint with a single click of the mouse in the Editor panel/Disassemble panel. 

Hardware break Sets hardware breakpoint with priority, by using the Hardware break function. 
Once set, it is treated as a Hardware Break event (execution system).

Software break Sets software breakpoint with priority, by using the Software break function (except for 
[Simulator]) (default).
Once set, it is treated as a Software Break event.

Yes(Hi-Z) The open break target pin becomes the Hi-Z state after the CPU is stopped.

No(Output signal) The open break target pin outputs the signal even after the CPU is stopped.
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Select from the drop-down list below for each use of the breakpoint.

Caution If the number of the set breakpoints of the specified type exceeds the limit settable (see "2.15.7.1  
Maximum number of enabled events"), a breakpoint of another type will be used. 

(2) [Stop emulation of timer group when stopping]
Select whether to terminate the peripheral emulation of timers while stopping the program execution (Peripheral 
Break). 
Select [Yes] to terminate (default: [No]). 
In the case of the selected microcontroller that provides the open break function, when this property is set to [Yes], 
the open break target pin becomes the Hi-Z state after the CPU is stopped (when this property is set to [No], the 
open break target pin outputs the signal even after the CPU is stopped). 

(3) [Stop emulation of serial group when stopping]
This property appears only when the selected microcontroller supports the function that terminates the peripheral 
emulation of serials (Peripheral Break). 
Select whether to terminate the peripheral emulation of serials while stopping the program execution. 
Select [Yes] to terminate (default: [No]). 

(4) [Restore the breakpoint when pin reset occurs]
This property only appears if the selected microcontroller supports the function of restoring breakpoints after a pin 
reset and the [Permit flash programming] property in the [Flash] category on the [Connect Settings] tab is set to 
[Yes].
Select whether to restore the breakpoints when a pin reset occurs.
When [Yes] is selected, the CPU is briefly halted for restoration of the breakpoints after a pin reset (default).
When [No] is selected, the breakpoints are ignored and not restored after a pin reset, but are restored when the 
program is stopped.

2.8.1.3  [Simulator]

Figure 2.82 [Break] Category [Simulator]

(1) [Execute instruction at breakpoint when break]
You can specify the timing to stop the program execution by breakpoints whether after or before the execution of 
the instruction at the breakpoint.  Specify in this property whether to break after executing the instruction. 
Select [Yes] to break after execution of the instruction (default: [No]). 
All set breakpoints are handled as Hardware Break events. 

Caution When [Yes] is selected, all of action events currently being set are handled as Hardware Break 
events (see "2.14  Set an Action into Programs").

2.8.2  Stop the program manually

The program in execution is forcibly stopped by clicking the  button on the debug toolbar. 

2.8.3  Stop the program at the arbitrary position (breakpoint)

The program in execution can be stopped at the arbitrary position by setting a breakpoint.  A breakpoint can be set by 
one-clicking with the mouse.

You need to configure the type of breakpoints to use before setting a breakpoint. 
This section describes the following operations. 

2.8.3.1  Set a breakpoint

Hardware break Sets hardware breakpoint with priority, by using the Hardware break function. 
Once set, it is treated as a Hardware Break event (execution system).

Software break Sets software breakpoint with priority, by using the Software break function (except for 
[Simulator]) (default).
Once set, it is treated as a Software Break event.
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2.8.3.2  Edit a breakpoint
2.8.3.3  Delete a breakpoint

2.8.3.1  Set a breakpoint

Breakpoints can be set via the Editor panel/Disassemble panel in which the source text/disassembly text is displayed.  
Within the Main area (Editor panel) or Event area (Disassemble panel) in which a valid address is displayed, click on the 

location where you want to set a breakpoint.  A breakpoint whose type is being selected in the [First using type of break-
point] property is set to the instruction at the start address corresponding to the clicked line. 

When a breakpoint is set, the following event mark appears at the breakpoint location, and the source text line/disas-
sembled text line is highlighted. 

It is interpreted as if a break event (Software Break or Hardware Break) has been set at the target address, and it is 
managed in the Events panel (see "2.15  Manage Events" for details). 

Table 2.3 Event Marks of Breakpoint

Note In the [Name] area of the Events panel, "Break" is displayed as the event type name. 

Figure 2.83 Breakpoint Setting Example (Disassemble Panel)

Figure 2.84 Example of Setting Breakpoint in Events Panel

Caution 1. Since a breakpoint is set as a break event and managed as a event, restrictions apply to the number of 
breakpoints that can be simultaneously set.  Also see "2.15.7  Notes for setting events" for details on 
breakpoints (e.g. limits on the number of enabled events). 

Caution 2. No software breakpoints can be set to the data flash memory area.

Caution 3. Breakpoints can only be set at lines that have valid addresses. 

Remark 1. Event marks differ depending on the event state (see "2.15.1  Change the state of set events (valid/
invalid)"). 
When an event is set at the point where other event is already set, the event mark (  ) is displayed 
meaning more than one event is set at the point. 

Remark 2. [Simulator]
The type of breakpoint that can be set is locked to hardware breakpoints. 

Type of Breakpoint Event Type Event Mark

Hardware breakpoint Hardware Break eventNote

Software breakpoint
(except [Simulator])

Software Break eventNote

Event area

Indicates that a software 
breakpoint has been set.

Indicates that a hardware 
breakpoint has been set.
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Remark 3. For other than [Simulator]
You can set hardware breakpoints/software breakpoints without depending on the specification of "2.8.1  
Configure the break function" by following the step below. 
Note, however, that "Operation 1" is only available in the Disassemble panel. 

2.8.3.2  Edit a breakpoint

It is possible to edit a breakpoint you have set. 
For details on how to do it, see "2.15.4.1  Edit execution-related events". 

Caution This function applies to only a breakpoint whose type is Hardware Break. 

2.8.3.3  Delete a breakpoint

Click event marks displayed in the Editor panel/Disassemble panel to delete set breakpoints (the event mark will be 
erased). 

2.8.4  Stop the program at the arbitrary position (break event) 

The program in execution can be stopped at the arbitrary position by setting a break event (execution type).
This section describes the following operations.

2.8.4.1  Set a break event (execution type)
2.8.4.2  Edit a break event (execution type)
2.8.4.3  Delete a break event (execution type)

2.8.4.1  Set a break event (execution type)

Perform this operation in the Editor panel/Disassemble panel in which the source text/disassembly text is displayed.
Follow the operation listed below from the context menu, in accordance with your desired event type, after moving the 

caret to the target line that has a valid address.

Note [E1][E20]
This function is enabled only when the selected microcontroller supports a combination break event.

A break event is set to the instruction at the start address corresponding to the line of the caret position.  When a break 
event (execution type) is set, the following event mark appears at the break event location, and the source text line or dis-
assembled text line will be highlighted.

When you have performed this operation, the set break event is managed in the Events panel as a Hardware Break 
event (execution type)/Software Break event (execution type) or a execution-related event in the detailed information on a 

Type Operation 1 Operation 2

Hardware breakpoint [Ctrl] + mouse click Select [Break Settings] >> [Set Hardware Break] 
from the context menu.

Software breakpoint [Shift] + mouse click Select [Break Settings] >> [Set Software Break] 
from the context menu.

Event Type Operation Description

Hardware Break Select [Break Settings] >> [Set Hardware 
Break]

Sets a Hardware Break event by using the Hard-
ware break function.

Software Break
(except [Simulator])

Select [Break Settings] >> [Set Software 
Break]

Sets a Software Break event by using the Soft-
ware break function (except for [Simulator]).

Combination Break
[E1][E20]

Select [Break Settings] >> [Set Combina-
tion Break]

A combined break event, that is, a break condi-
tion that is a combination of multiple break 
events, may be set as the target event condition 
on the E1 and E20Note (see "Edit combination 
conditions of events [E1] [E20]"). 
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Combination Break event (see "2.15  Manage Events" for details). 

Table 2.4 Event Marks of Break Event

Figure 2.85 Break event Setting Example (Disassemble Panel)

Figure 2.86 Example of Setting Hardware Break Event (Execution Type) in Events Panel 

Figure 2.87 Example of Setting Combination Break Event (Execution Type) in Events Panel [E1][E20]

Caution 1. When setting a break event (execution type), also see "2.15.7  Notes for setting events" for details (e.g. 
limits on the number of valid events).

Caution 2. No software breakpoints can be set to the data flash memory area.

Remark Event marks differ depending on the event state (see "2.15.1  Change the state of set events (valid/
invalid)").  When an event is set at the point where other event is already set, the event mark (  ) is 
displayed meaning more than one event is set at the point. 

Event Type Event Mark

Hardware Break

Software Break
(except [Simulator])

Combination Break
[E1][E20]

Event area

Indicates that a software 
break event has been set.

Indicates that a hardware 
break event has been set.
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2.8.4.2  Edit a break event (execution type)

It is possible to edit a break event (execution type) you have set. 
For details on how to do it, see "2.15.4.1  Edit execution-related events" or "2.15.4.3  Edit combination conditions of 

events [E1] [E20]". 

Caution This function applies to only a break event (execution type) whose type is Hardware Break or Combina-
tion Break [E1][E20]. 

2.8.4.3  Delete a break event (execution type)

To delete a break event (execution type) you have set, click the event mark displayed in the Editor panel/Disassemble 
panel. 

Also, there is another way to delete a set break event.  Select a Software Break event/Hardware Break event, or Com-
bination Break event [E1][E20] in the Events panel, and then click the  button in the toolbar (see "2.15.5  Delete 
events"). 

Caution In the Events panel, you cannot delete a break event (execution type) selectively in the combination 
breaks. All the break events (including access type) displayed in the detailed information on the combina-
tion break will be deleted.

2.8.5  Stop the program with the access to variables/SFRs

By setting a break event with the access, the program can be stopped when an arbitrary variable or SFR is accessed 
with the specified type. 

You can also limit the accessed value. 
The following types can be specified with the access. 

Table 2.5 Types of Accesses to Variables

Caution [IECUBE][E1][E20][EZ Emulator]
The program is stopped with the access via DMA (Direct Memory Access).

This section describes the following. 

2.8.5.1  Set a break event (access type)
2.8.5.2  Edit a break event (access type)
2.8.5.3  Delete a break event (access type)

2.8.5.1  Set a break event (access type)

Use one of the following methods to set a break event (access type) that stops programs with the access to a variable/
SFR. 

Caution 1. Also see "2.15.7  Notes for setting events" for details on breakpoints (e.g. limits on the number of 
enabled events). 

Caution 2. For other than [Simulator]
The access break events described here cannot be set for 32-bit (4-byte) variables. 
Additionally, accessing a single byte of a 16-bit (2-byte) variable will not be detected as an access. 

(1) Set a break event to a variable/SFR in the Editor panel/Disassemble panel
Perform this operation in the Editor panel/Disassemble panel in which the source text/disassembly text is dis-
played. 

Access Type Description 

Read The program is stopped with the read access to (after reading) the specified variable/SFR.

Write The program is stopped with the write access to (after writing) the specified variable/SFR.

Read/Write The program is stopped with the read access/write access to (after reading or writing) the 
specified variable/SFR.
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Follow the operation listed below from the context menu, in accordance with your desired access type, after 
selecting an arbitrary variable or SFR on the source text/disassembled text.  Note, however, that only global vari-
ables, static variables inside functions, and file-internal static variables can be used. 

Note [E1][E20]
A combined break event, that is, a break condition that is a combination of multiple break events, 
may be set as the target event condition on the E1 and E20 (see "2.15.4.3  Edit combination condi-
tions of events [E1] [E20]"). 
Note, however, that this function is enabled only when the selected microcontroller supports a com-
bination break event.

At this time, if you have specified a value in the text box in the context menu, break will occur only when the spec-
ified value is used for the reading, writing or reading/writing.  On the other hand, if no value is specified, reading., 
writing or reading/writing the selected variable by any value will cause the break to occur.

Caution 1. Variables within the current scope can be specified. 

Caution 2. Variables or SFR at lines that have no valid addresses cannot be used for break events. 

Figure 2.88 Example of Setting Break Event (Access Type) on Variable in Editor Panel

Access Type Operation

Read Select [Break Settings] >> [Set Read Break to]/[Set Read Combination Break to]Note, and 
then press the [Enter] key. 

Write Select [Break Settings] >> [Set Write Break to]/[Set Write Combination Break to]Note, and 
then press the [Enter] key. 

Read/Write Select [Break Settings] >> [Set R/W Break to]/[Set R/W Combination Break to]Note, and then 
press the [Enter] key. 

From the context menu above the variable "data1" 
enter a value in [Break Settings] >> [Set Writ 
Break to], then press the [Enter] key. 
Here, the program will break when the value "0xb" 
is written to the variable "data1".
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Figure 2.89 Example of Setting Combination Break Event (Access Type) on Variable in Editor Panel [E1][E20]

(2) Set a break event (access type) to a registered watch-expression
You can set break events in the Watch panel. 
Follow the operation listed below from the context menu, in accordance with your desired access type, after 
selecting the registered watch-expression (multiple selections not allowed). 
Note, however, that only global variables, static variables inside functions, file-internal static variables, and SFR 
can be used. 

Note [E1][E20]
A combined break event, that is, a break condition that is a combination of multiple break events, 
may be set as the target event condition on the E1 and E20 (see ”2.15.4.3  Edit combination condi-
tions of events [E1] [E20]”). 
Note, however, that this function is enabled only when the selected microcontroller supports a com-
bination break event.

At this time, if you have specified a value in the text box in the context menu, break will occur only when the spec-
ified value is used for the reading., writing or reading/writing.  On the other hand, if no value is specified, reading., 
writing or reading/writing the selected watch-expression by any value will cause the break to occur.

Caution A watch-expression within the current scope can be specified. 
To target a watch-expression outside the current scope, select a watch-expression with a specified 
scope. 

Access Type Operation

Read Select [Access Break] >> [Set Read Break to]/[Set Read Combination Break to]Note, and 
then press the [Enter] key. 

Write Select [Access Break] >> [Set Write Break to]/[Set Write Combination Break to]Note, and then 
press the [Enter] key. 

Read/Write Select [Access Break] >> [Set R/W Break to]/[Set R/W Combination Break to]Note, and then 
press the [Enter] key. 

From the context menu above the variable "data1", 
enter a value in [Break Settings] >> [Set Writ Com-
bination Break to], then press the [Enter] key. 
Here, the program will break when the value "0xb" 
is written to the variable "data1". 
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Figure 2.90 Example of Setting Hardware Break Event (Access Type) on Watch-Expression

Figure 2.91 Example of Setting Combination Break Event (Access Type) on Watch-Expression [E1][E20]

When you have performed the above operation, the set break event (access type) is managed in the Events panel 
as a Hardware Break event (access type) or a execution-related event in the detailed information on a Combina-
tion Break event (see "2.15  Manage Events" for details). 

Figure 2.92 Example of Setting Hardware Break Event (Access Type) in Events Panel 

From the context menu above the watch-expression "data1", 
enter a value in [Access Break] >> [Set Write Break to], then 
press the [Enter] key. 
Here, the program will break when the value "0xb" is written to 
the watch-expression "data1". 

From the context menu above the watch-expression "data1", 
enter a value in [Access Break] >> [Set Write Combination 
Break to], then press the [Enter] key. 
Here, the program will break when the value "0xb" is written to 
the watch-expression "data1". 
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Figure 2.93 Example of Setting Combination Break Event (Access Type) in Events Panel [E1][E20]

2.8.5.2  Edit a break event (access type)

It is possible to edit a break event (access type) you have set. 
For details on how to do it, see "2.15.4.1  Edit execution-related events" or "2.15.4.3  Edit combination conditions of 

events [E1] [E20]". 

2.8.5.3  Delete a break event (access type)

To delete a break event (access type) you have set, select a Hardware Break event, or Combination Break event 
[E1][E20] in the Events panel, and then click the  button in the toolbar (see "2.15.5  Delete events"). 

For a Combination Break event [E1][E20], it is also possible to delete a break event (access type) by clicking on the 
event mark on the Editor panel/Disassemble panel. 

Caution In the Events panel, you cannot delete a break event (execution type) selectively in the combination 
breaks. All the break events (including access type) displayed in the detailed information on the combina-
tion break will be deleted.

2.8.6  Stop the program when an invalid execution is detected [IECUBE]

The system forcibly breaks the program execution when unexpected program behavior such as invalid access to inter-
nal ROM/internal RAM/SFR/external memory is detected (fail-safe break function). 

This function has various break conditions.  Enable/disable each break condition in the [Fail-safe Break] category on the 
[Debug Tool Settings] tab of the Property panel. 

Caution The fail-safe break function becomes invalid during step execution.

Figure 2.94 [Fail-safe Break] Category

In the following property setting, select [Yes] to enable and [No] to disable the function from the drop-down list. 
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All the properties are set to [Yes] by default (with some exceptions). 

- [Stop when fetched from fetch protected area]

- [Stop when wrote to write protected area]

- [Stop when read from read protected SFR]

- [Stop when wrote to write protected SFR]

- [Stop when overflowed user stack]Note 

- [Stop when underflowed user stack]Note 

- [Stop when operated uninitialized stack pointer]

- [Stop when read from uninitialized RAM]

- [Stop when accessed to non-mapping area]

- [Stop when word miss-align accessed]

- [Stop when received fail safe from peripheral]

- [Stop when occurred flash illegal]

Note [No] is selected by default. 
To set to [Yes], the [User stack section] property on the bottom must be set to the address of the user 
stack section (default: [.stack_bss]). 

2.8.7  Other break causes

The cause of the break other than the described above is as follows: 
You can confirm the break cause with the Status message on the statusbar in the Main window. 

Table 2.6 Other Break Causes 

Note 1. The operation depends on the setting of the [Operation after trace memory is full] property in the [Trace] 
category on the [Debug Tool Settings] tab of the Property panel.

Break Cause Debug Tool to Use

IECUBE E1/E20
EZ Emulator

E2 Simulator

Full of the trace memoryNote 1 - -

An occurrence of Trace Delay Break - - -

Execution time-over detected - - -

An access to non-mapped area - -

A writing to write-protected area - -

An access to the odd number address by the word 
width

- -

An occurrence of Temporary BreakNote 2

An occurrence of Flash Illegal Break - - -

Illegal action of program related to the peripheral chip 
functionNote 3

- - -

Failure to execute/uncertain cause -

Full of the current consumption bufferNote 4 - - -

E2 expansion function - - -

Fully used the storage memory - - -
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Note 2. A break that is internally used by CS+. (Users cannot use it.)

Note 3. See the documentation on peripheral emulation board to use.

Note 4. The operation is supported only by the simulator that supports the current consumption measurement.

2.9  Display/Change the Memory, Register and Variable

This section describes how to display/change the memory, register and variable.

2.9.1  Display/change the memory

The contents of the memory can be displayed and its values can be changed in the Memory panel below.
Select the [View] menu >> [Memory] >> [Memory1 - 4]. 
The maximum of 4 Memory panels can be opened.  Each panel is identified by the names "Memory1", "Memory2", 

"Memory3" and "Memory4" on the titlebar. 
For details on the contents and function in each area, see the section for the Memory panel. 

Figure 2.95 Display the Contents of Memory (Memory Panel)

(1): Address area
(2): Memory value area
(3): Character strings area

Remark You can set the scroll range (as start and end address) of the vertical scroll bar on this panel via the 
Scroll Range Settings dialog box that is opened by clicking the  button from [View] on the toolbar. 

This section describes the following. 

2.9.1.1  Specify the display position
2.9.1.2  Change display format of values
2.9.1.3  Modify the memory contents
2.9.1.4  Display/modify the memory contents during program execution
2.9.1.5  Search the memory contents
2.9.1.6  Modify the memory contents in batch (initialize)
2.9.1.7  Save the memory contents

2.9.1.1  Specify the display position

It is possible to specify the display start position of the memory contents by specifying an address expression in the dis-
play position specification area (starting with address 0x0 by default). 

Remark An offset value of the display start position of memory values can be set via the Address Offset Settings 
dialog box that is opened by selecting [Address Offset Value Settings...] from the context menu.

(2) (3)(1)

Toolbar

Display position specification area
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Figure 2.96 Display Position Specification Area (Memory Panel)

(1) Specify an address expression 
Directly enter the address expression of the memory value address to display in the text box. You can specify an 
input expression with up to 1024 characters.  The result of the expression is treated as the display start position 
address. 
Note that if an address value greater than the microcontroller address space is specified, the high-order address 
value is masked. 
An address value greater than the value expressed within 32 bits cannot be specified. 

Remark 1. A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space] 
key in this text box (see "2.19.2  Symbol name completion function").

Remark 2. If the specified address expression is the symbol and its size can be recognized, everything from 
the start address to the end address of that symbol is displayed selected.

(2) Specify automatic/manual evaluation of the address expression 
The timing to change the display start position can be determined by specifying in the [Move when Stop] check 
box and the [Move] button. 

2.9.1.2  Change display format of values

The display format of the address area/memory value area/character strings area can be changed using buttons below 
on the toolbar. 

[Move when Stop] The caret is moved to the address which is automatically calculated from the 
address expression after the program is stopped. 

The address expression is not automatically evaluated after the program is stopped. 
Click the [Move] button to manually evaluate the address expression. 

[Move] When the [Move when Stop] check box is not checked, click this button to evaluate 
the address expression and move the caret to the result address of the evaluation. 

Notation The following buttons to change the notation of memory values are displayed. 

 Hexadecimal Displays memory values in hexadecimal number (default).

 Signed Decimal Displays memory values in signed decimal number.

 Unsigned Decimal Displays memory values in unsigned decimal number.

 Octal Displays memory values in octal number.

 Binary Displays memory values in binary number.

Size Notation The following buttons to change the notation of sizes of memory values are dis-
played. 

 4 Bits Displays memory values in 4-bit width. 

 1 Byte Displays memory values in 8-bit width (default). 

 2 Bytes Displays memory values in 16-bit width. 
Values are converted depending on the endian of the target memory area.

 4 Bytes Displays memory values in 32-bit width. 
Values are converted depending on the endian of the target memory area.

 8 Bytes Displays memory values in 64-bit width. 
Values are converted depending on the endian of the target memory area.

Encoding The following buttons to change the encoding of character strings are displayed. 
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Note For details on the display of a floating-point value, see the section for the Memory panel. 

2.9.1.3  Modify the memory contents

The memory values can be edited. 
Directly edit from the keyboard after moving the caret to the line to modify in memory value area/characters area. 
The color of the memory value changes when it is in editing.  Press the [Enter] key to write the edited value to the target 

memory (if the [Esc] key is pressed before the [Enter] key is pressed, the editing is cancelled). 
However, the character string that can be inputted during the editing is limited to that character string that can be han-

dled by the display notation that has been currently specified.  In the character strings area, modification can only be made 
with "ASCII" character code. 

This operation can be taken place while the program is in execution.  See "2.9.1.4  Display/modify the memory contents 
during program execution" for details on how to operate it. 

When you modify the values, be aware of the following examples.

Example 1. The value exceeds the upper limit of the display bit wide
If you edit the display value "105" as "1" to "3" in the decimal 8-bit display, the value will be changed to 
the upper limit of "127".

Example 2. The symbol, "-" is entered between numbers 
If you edit the display value "32768" as "32-68" with signed decimal 16-bit display, "3" and "2" are 
changed to the blank and the value is changed to "-68". 

Example 3. The blank symbol (space) is entered between numbers 
If you edit the display value "32767" as "32 67", "3" and "2" are changed to the blank and the value is 
changed to "67". 

 ASCII Displays character strings in ASCII code (default).

 Shift_JIS Displays character strings in Shift_JIS code.

 EUC-JP Displays character strings in EUC-JP code.

 UTF-8 Displays character strings in UTF-8 code.

 UTF-16 Displays character strings in UTF-16 code.

 Half-Precision Float Displays character strings as a half-precision floating-point value. 

 Float Displays character strings as a single-precision floating-point valueNote. 

 Double Displays character strings as a double-precision floating-point valueNote. 

 Float Complex Displays character strings as a complex number of single-precision floating-
pointNote. 

 Double Complex Displays character strings as a complex number of double-precision floating-
pointNote. 

 Float Imaginary Displays character strings as an imaginary number of single-precision floating-
pointNote. 

 Double Imaginary Displays character strings as an imaginary number of double-precision floating-
pointNote. 

View The following buttons to change the display format are displayed.

 Settings Scroll Range... Opens the Scroll Range Settings dialog box to set the scroll range for this panel.

Column Number Settings... Opens the Column Number Settings dialog box to set the number of view col-
umns in the memory value area.

Address Offset Value Settings... Opens the Address Offset Settings dialog box to set an offset value for 
addresses displayed in the address area.
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Example 4. The same value is entered 
Even if the same value as the current memory value is specified, the specified value is written to the 
memory. 

2.9.1.4  Display/modify the memory contents during program execution

The Memory panel/Watch panel has the real-time display update function that can update/modify the display contents of 
the memory/watch-expression in real-time while executing the program.

Using the real-time display update function allows you to display/modify the value of memory/watch-expression not only 
while the program is stopped, but also in execution. 

The real-time display update function is realized by the RRM function (reading) [IECUBE][Simulator], a RAM monitor 
function (reading) (other than [Simulator]) or by the DMM function (modifying).  Each function has a different area that can 
be used for reading and writing.

Firstly, enable the real-time display update function by making the basic settings below on the [Debug Tool Settings] tab 
of the Property panel. 

Table 2.7 Basic Settings for Real-time Display Update Function

Caution Local variables are not subject to the real-time display update function.

Remark See "2.9.1.3  Modify the memory contents" or "2.9.6.6  Modify the contents of watch-expressions" for 
details on how to modify values in the Memory panel/Watch panel. 

(1) RRM function (reading) [IECUBE][Simulator]
This function is used to read the contents of the memory or of watch-expressions in real-time during execution of a 
program. 
The following area can be read by the RRM function.
Memory and watch-expressions allocated to this area can always be displayed in real-time. 

Table 2.8 Target Area of RMM Function

Note 1. This refers to data that were in the cache before execution, to the values are not real-time. 

Note 2. Possible only for general-purpose registers and PC

Note 3. Impossible during tracer/timer execution

(2) RAM monitor function (reading) (other than [Simulator])
This function is used to read the contents of memory or a watch-expression through software emulation by briefly 
halting the program. 
The following area can be read by the RAM monitor function.

Caution If CPU status shifts to the standby mode (HALT/STOP/IDLE) mode, a monitor time-out error will 
occur. 

Category Property Set Value

[Access memory while running] [Update display during the execution] [Yes] (default)

[Display update interval[ms]] [Integer number between 100 and 
65500]

Area IECUBE Simulator

Internal ROM Note 1

Internal RAM (except register area)

Data flash -

Emulation memory -

Target memory -

CPU register Note 2 Note 3

SFR - Note 3
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Table 2.9 Target Area of RAM Monitor Function

Note 1. When it is available, priority is given to the RRM function. That is, the RAM monitor function is not 
used in such cases.

Note 2. This only applies to the general-purpose registers corresponding to the bank specification.

Note 3. This does not apply to BCDADJ.

Note that to enable the RAM monitor function, the setting below is required in addition to the Basic Settings for 
Real-time Display Update Function. 

(3) DMM function (modifying)
This function is used to write to the memory or watch-expressions in real-time during execution of a program.
The following area can be modified by the DMM function.

Caution If CPU status shifts to the standby mode (HALT/STOP/IDLE) mode, a monitor time-out error will 
occur. 

Table 2.10 Target Area of DMM Function

: Possible by briefly halting execution
: Possible without briefly halting execution

Note 1. This only applies to the general-purpose registers corresponding to the bank specification.

Note 2. Impossible during tracer/timer execution 

Note 3. Possible only for standard SFRs

To enable the DMM function, the setting below is required in addition to the Basic Settings for Real-time Display 
Update Function. 

Area IECUBE E1/E20/EZ Emulator

Internal ROM -Note 1 -

Internal RAM (except register area) -Note 1

Data flash -Note 1

Emulation memory - -

Target memory -

CPU register Note 2

SFR Note 3

Category Property Set Value

[Access memory while running] [Access by stopping execution] [Yes]

Area IECUBE E1/E20/EZ Emulator Simulator

Internal ROM - -

Internal RAM (except register area)

Emulation memory - -

Target memory -

CPU register Note 1 Note 2

SFR Note 3 Note 2

Debug Tool Property Set Value

Simulator No setting is required.
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Caution When a 2-, 4-, or 8-byte variable is to be read through the RRM or RAM monitor function, the process of 
assigning a value to the variable may be divided into two steps. 
If reading of the variable takes place between the two steps, an incorrect value may be read out because 
the assignment is not completed.
Example)
In the following example, if reading takes place before "(2)" is executed, the value of variable "value_a" in 
which only the assignment to the two lower-order bytes has been completed is read out.

[C source text]

[Assembly instructions for the assignment processing above]

On the Memory panel/Watch panel, the memory values/watch-expressions updated by the real-time display update 
function are highlighted in pink. 

Figure 2.97 Example of Memory Display by Real-time Display Update Function

Moreover, on the Memory panel using IECUBE, the background color of the memory values updated by the RRM func-
tion are highlighted as follows in accordance with the access status (character colors and background colors depend on 
the configuration in the [General - Font and Color] category of the Option dialog box).

Other than above [Access memory while running] category
 >> [Access by stopping execution]

[Yes]

long int    value_a = 0;    // Definition of a 4-byte variable
void func(void)
{
    value_a = 4000000000;   // Assignment to a 4-byte variable
}

MOVW    AX, #2800H
MOVW    !_value_a, AX       ;(1): Assignment to the two lower-order bytes of variable 
"value_a"
MOVW    AX, #0EE6BH
MOVW    !_value_a+2, AX     ;(2): Assignment to the two high-order bytes of variable 
"value_a"

Access Condition Display Example

Read

Write

Read and write

Debug Tool Property Set Value

 00  00  00  

 00  00  00  

 00  00  00  
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Figure 2.98 Example of Memory Display by Real-time Display Update Function (RRM Function) [IECUBE]

2.9.1.5  Search the memory contents

Values of memory can be searched in the Memory Search dialog box that is opened by selecting [Find...] from the con-
text menu.  The search is operated either in the memory value area or character strings area, in which the caret exists.  In 
this dialog box, follow the steps below. 

Figure 2.99 Search Memory Contents (Memory Search Dialog Box)

Caution 1. The contents of the memory cannot be searched during execution of a program. 

Caution 2. Character strings displayed as floating-point values cannot be searched. 

(1) Specify [Search Data]
Specify data to search. 
You can either type a value directly into the text box (up to 256 bytes), or select one from the input history via the 
drop-down list (up to 10 items). 
If the search is performed in the memory value area, the value must be entered in the same display format (nota-
tion and size) as that area. 
If the search is performed in the character strings area, then the target of the search must be a string.  The speci-
fied string is converted into the encoding format displayed in that area, and searched for. 
If a memory value was selected immediately prior to opening this dialog box, then that value will appear as default. 

(2) Specify [Search Range]
Select the range to search from the following drop-down list. 

(3) Specify [Address] 
This item is only enabled if [Specify address range] is selected in the (2)  Specify [Search Range]. 
Specify the range of memory address to search via the start and end addresses.  You can either type address 
expressions directly into the text boxes (up to 1024 characters), or select them from the input history via the drop-
down list (up to 10 items). 

Specify address range Searches in the address range specified in the [Address] area. 

Memory mapping Searches within the selected memory mapping range.
This list item displays individual memory mapping configured in the Memory Map-
ping dialog box (except the non-mapped area). 

Display format: <memory type>  <address range>  <size>
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The results of calculating the address expressions you have entered are treated as start and end addresses, 
respectively. 
Note that if an address value greater than the microcontroller address space is specified, the high-order address 
value is masked. 
An address value greater than the value expressed within 32 bits cannot be specified. 

Remark 1. A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space] 
key in each text box (see "2.19.2  Symbol name completion function"). 

Remark 2. If the start address field is left blank, it is treated as if "0x0" were specified.

Remark 3. If the end address field is left blank, then it is treated as if the maximum value in the microcon-
troller's address space were specified.

(4) Click the [Search Backward]/[Search Forward] button
When the [Search Backward] button is clicked, search will start in the order from the large address number to 
small and the search results are displayed selected in the Memory panel. 
When the [Search Forward] button is clicked, search will start in the order from the small address number to small 
and the search results are displayed selected in the Memory panel. 

2.9.1.6  Modify the memory contents in batch (initialize)

Contents of the memory can be modified in batch (initialize).
When [Fill...] from the context menu is selected, the Memory Initialize dialog box opens to modify the memory value of 

the specified address range in batch. 
In this dialog box, follow the steps below. 

Figure 2.100 Modify Memory Contents in Batch (Memory Initialize Dialog Box)

(1) Specify [Start address/symbol] and [End address/symbol]
Specify the range of memory address to initialize via the [Start address/symbol] and [End address/symbol].  You 
can either type address expressions directly into the text boxes (up to 1024 characters), or select them from the 
input history via the drop-down list (up to 10 items). 
The results of calculating the address expressions you have entered are treated as start and end addresses, 
respectively. 
Note that address values greater than the microcontroller address space cannot be specified. 

Caution You cannot specify the range of address aligned across the different endian area.

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space] 
key in each text box (see "2.19.2  Symbol name completion function"). 

(2) Specify [Initialize data] 
Specify the initializing data to write to the memory. 
You can either type the initial value into the text box directly in hexadecimal number, or select one from the input 
history via the drop-down list (up to10 items). 
You can specify more than one initial value.  Specify up to 16 values of up to 4 bytes (8 characters) each, sepa-
rated by spaces. 
Each initial value is parsed from the end of the string, with each two characters interpreted as a byte. 
If the string has an odd number of characters, then the first character is interpreted as one byte.
Note that if a initial value consists of more than one byte, then the target memory is overwritten with the value con-
verted into an array of bytes of the specified address range's endian, as follows.
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(3) Click the [OK] button
Click the [OK] button. 
The memory area in the specified address range is repeatedly overwritten with the specified initial data pattern.  If 
the end address is reached in the middle of the pattern, then writing ends at that point. 
Note that if an illegal value is specified, a message will appear, and the memory value will not be initialized. 

2.9.1.7  Save the memory contents

Contents of the memory can be saved with range selection in text files (*.txt)/CSV files (*.csv). 
When saving to the file, the latest information is acquired from the debug tool, and it is saved in accordance with the dis-

play format on this panel. 
The Data Save dialog box can be opened by selecting the [File] menu >> [Save Memory Data As...] (when this opera-

tion is taken place with range selection on the panel, the memory data only in the selected range is saved).
In this dialog box, follow the steps below. 

Figure 2.101 Save Memory Data (Data Save Dialog Box)

(1) Specify [File Name] 
Specify the name of the file to save. 
You can either type a filename directly into the text box (up to 259 characters), or select one from the input history 
via the drop-down list (up to 10 items). 
You can also specify the file by clicking the [...] button, and selecting a file via the Select Data Save File dialog box. 

(2) Specify [File Type] 
Select the format in which to save the file from the following drop-down list. 
The following file formats can be selected. 

Note The data is saved with entries separated by commas (,). 
If the data contains commas, each entry is surrounded by double quotes "" in order to avoid illegal 
formatting. 

Input Character Strings 
(Initial Value)

How Data is Overwritten (in Bytes)

Little Endian Big Endian

1 01 01

0 12 00 12 00 12

00 012 345 00 12 00 45 03 00 00 12 03 45

000 12 000345 00 00 12 45 03 00 00 00 12 00 03 45

List Item Format

Text files (*.txt) Text format (default)

CSV (Comma-Separated Variables)(*.csv) CSV formatNote
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(3) Specify [Save Range Address/Symbol]
Specify the range of addresses to save via "start address" and "end addresses". 
Directly enter hexadecimal number/address expression in each text box or select from the input history displayed 
in the drop-down list (up to 10 items). 
If a range is selected in the panel, that range is specified as the default.  If there is no selection, then the range 
currently visible in the panel is specified. 

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space] 
key in each text box (see "2.19.2  Symbol name completion function"). 

(4) Click the [Save] button
Saves the memory data to a file with the specified filename, in the specified format. 

Figure 2.102 Output Example of Memory Data

- [Text files (*.txt)] (Hexadecimal notation/8-bit width/ASCII code)

- [CSV files (*.csv)] (Hexadecimal notation/8-bit width/ASCII code)

Remark When the contents of the panel are overwritten by selecting the [File] menu>> [Save Memory Data], 
each Memory panel (Memory1-4) is treated as a different panel. 
In addition, saving range is same as the previously specified address range. 

2.9.2  Display/change the CPU register

The contents of the CPU register (general-purpose register/control register) can be shown and the value can be 
changed in the CPU Register panel below. 

Select the [View] menu >> [CPU Register]. 
For details on the contents and function in each area, see the section for the CPU Register panel. 

Figure 2.103 Display the Contents of CPU Register (CPU Register Panel)

(1): [Register Name] area
(2): [Value] area

This section describes the following. 

2.9.2.1  Change display format of values
2.9.2.2  Modify the CPU register contents
2.9.2.3  Display/modify the CPU register contents during program execution
2.9.2.4  Save the CPU register contents

       +0 +1 +2 +3 +4 +5 +6 +7 +8 +9 +a +b +c +d +e +f 
0000 | 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 | 
0010 | 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 | 

0000,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,
0010,11,11,11,11,11,11,11,11,11,11,11,11,11,11,11,11,

(1) (2)

Toolbar
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2.9.2.1  Change display format of values

The display format of the [value] area can be changed using buttons below on the toolbar. 

2.9.2.2  Modify the CPU register contents

The CPU register values can be edited. 
Select the value of the CPU register to edit in the [Value] area, then click on it again to switch the value to edit mode 

(press the [Esc] key to cancel the edit mode). 
To write the edited value to the target memory, directly enter the value from the keyboard then press the [Enter] key.

Caution This operation cannot be performed during program execution.

2.9.2.3  Display/modify the CPU register contents during program execution

By registering a CPU register to the Watch panel as a watch-expression, the value of the CPU register can be dis-
played/modified not only while the program is stopped, but in execution.

See "2.9.6  Display/change watch-expressions" for details on the watch-expression. 

2.9.2.4  Save the CPU register contents

The Save As dialog box can be opened by selecting the [File] menu >> [Save CPU Register Data As...], and all the con-
tents in the CPU register can be saved to a text file (*.txt) or CSV file (*.csv). 

When saving to files, retrieve the latest information from the debug tool. 

Figure 2.104 Output Example of CPU Register Data

Notation The following buttons to change the notation of a data value are displayed. 

 AutoSelect Displays the value of the selected item (including sub-items) in the default notation 
(default). 

 Hexadecimal Displays the value of the selected item (including sub-items) in hexadecimal number. 

 Signed Decimal Displays the value of the selected item (including sub-items) in signed decimal number. 

 Unsigned Decimal Displays the value of the selected item (including sub-items) in unsigned decimal number. 

 Octal Displays the value of the selected item (including sub-items) in octal number. 

 Binary Displays the value of the selected item (including sub-items) in binary number. 

 ASCII Displays the character strings of the selected item (including sub-items) in ASCII code. 
If the character size is 2 bytes and above, it is displayed with the characters for each 1 
byte arranged side-by-side. 

 Float Displays the value of the selected item in Float.
Note that when the value is not 4-byte data, displays it in the default notation.

 Double Displays the value of the selected item in Double.
Note that when the value is not 8-byte data, displays it in the default notation.

Adds the value in hexadecimal number enclosing with "()" at the end of the value. 

Register name           Value
----------------------------------------------------------------------
Category name           
 -Register name         Value
      :                   :
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2.9.3  Display/change the SFR

Contents of the SFR can be displayed and its values can be changed in the SFR panel below. 
Select the [View] menu >> [SFR]. 
For details on the contents and function in each area, see the section for the SFR panel. 

Figure 2.105 Display the Contents of SFR (SFR Panel)

(1): [SFR] area
(2): [Value] area
(3): [Type (Byte Size)] area
(4): [Address] area

This section describes the following. 

2.9.3.1  Search for a SFR
2.9.3.2  Organize SFRs
2.9.3.3  Change display format of values
2.9.3.5  Display/modify the SFR contents during program execution
2.9.3.5  Display/modify the SFR contents during program execution
2.9.3.6  Save the SFR contents

2.9.3.1  Search for a SFR

A SFR can be searched for. 
Specify the SFR name to search with the text box in the search area (case-insensitive).  You can either type character 

strings directly from the key board (up to 512 characters), or select one from the input history via the drop-down list (up to 
10 items).

Then, click either one of the following button. 

Remark 1. The hidden SFR name being classified with a category can be searched (the category is opened and the 
SFR is selected).

Remark 2. After typing character strings to search, to press the [Enter] key is the same function as clicking the  
button, and to press the [Shift] + [Enter] key is the same function as clicking the  button.

2.9.3.2  Organize SFRs

The each SFR can be categorized (by folders) and displayed in the tree view. 

Searches up for the SFR name containing the string specified in the text box, and selects the SFR that 
is found.

Searches down for the SFR name containing the string specified in the text box, and selects the SFR 
that is found.

(3) (4)(1) (2)

Toolbar

Search area
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Caution 1. Categories cannot be created within categories. 

Caution 2. SFRs cannot be added or deleted. 

(1) Create new category 
Move the caret to the SFR name to create a new category then click the  button in the toolbar and directly 
enter the new category name. 

(2) Edit category name 
Click the category name to edit, and click it again, then directly modify the category name from the keyboard. 

(3) Delete categories 
Select categories to delete then click the  button in the toolbar. 
However, the categories that can be deleted are only the empty categories. 

(4) Change the display order
SFR name is categorized when SFR is dragged and dropped in the category. 
Also, the display order of the categories and the SFR names (upper or lower position) can be changed easily by 
drag and drop operation. 

2.9.3.3  Change display format of values

The display format of the [value] area can be changed using buttons below on the toolbar. 

2.9.3.4  Modify the SFR contents

The SFR values can be edited. 
Select the value of the SFR to edit in the [Value] area, then click on it again to switch the value to edit mode (press the 

[Esc] key to cancel the edit mode).
To write the edited value to the target memory, directly enter the value from the keyboard then press the [Enter] key.

Caution 1. This operation cannot be performed during program execution.

Caution 2. The value of the read-only SFR cannot be edited.

Remark 1. If a number with fewer digits than the size of the SFR is entered, the higher-order digits will be padded 
with zeroes.

Remark 2. If a number with more digits than the size of the SFR is entered, the higher-order digits will be masked. 

Remark 3. ASCII characters can be entered to the SFR value. 

- When the numeric "0x41" is written to the SFR "DMC0" 
>> "0x41" is written in the port "DMC0".

- When the ASCII character "'A'" is written to the SFR "DMC0" 
>> "0x41" is written in the port "DMC0".

2.9.3.5  Display/modify the SFR contents during program execution

By registering a SFR to the Watch panel as a watch-expression, the value of the SFR can be displayed/modified not 
only while the program is stopped, but in execution.

Notation The following buttons to change the notation of a data value are displayed. 

 Hexadecimal Displays the value of the selected item in hexadecimal number (default).

 Signed Decimal Displays the value of the selected item in signed decimal number.

 Unsigned Decimal Displays the value of the selected item in unsigned decimal number.

 Octal Displays the value of the selected item in octal number.

 Binary Displays the value of the selected item in binary number.

 ASCII Displays the value of the selected item in ASCII code.

Adds the value in hexadecimal number enclosing with "()" at the end of the value of the 
selected item. 
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See "2.9.6  Display/change watch-expressions" for details on the watch-expression. 

2.9.3.6  Save the SFR contents

The Save As dialog box can be opened by selecting the [File] menu >> [Save SFR Data As...], and all the contents of 
the SFR can be saved in a text file (*.txt) or CSV file (*.csv).  At this time, the values of all SFRs become targets irrespec-
tive of the setting of display/non-display on this panel. 

When saving the contents to the file, the values of the SFR are reacquired and save the latest values acquired. 
Note that the values of read-protected SFR are not re-read.  If you want to save the latest values of those, select [Force 

Read Value] from the context menu then save the file. 

Figure 2.106 Output Example of SFR

2.9.4  Display/change global variables/static variables

Global variables or static variables are displayed and its values can be changed in the Watch panel.
Register the variables to display/modify their values to the Watch panel as the watch-expressions. 
For details, see "2.9.6  Display/change watch-expressions". 

2.9.5  Display/change local variables

Contents of local variables can be displayed and its values can be changed in the Local Variables panel below. 
Select the [View] menu >> [Local Variable]. 
Specify the scope in the scope area to display the contents of the target local variable.
In the Local Variables panel, the name of local variables and functions are displayed. The argument of the function is 

also displayed as the local variable. 
For details on the contents and function in each area, see the section for the Local Variables panel. 

Figure 2.107 Display the Contents of Local Variables (Local Variables Panel)

(1): [Name] area
(2): [Value] area
(3): [Type (Byte Size)] area
(4): [Address] area

Caution Nothing is displayed on this panel during execution of a program. 
When the program is stopped, items in each area are displayed. 

This section describes the following. 

2.9.5.1  Change display format of values
2.9.5.2  Modify the contents of local variables

SFR name        Value      Type (Byte Size)    Address    
-------------------------------------------------------------
Category name           
 -SFR name      Value      Type (Byte Size)    Address    
    :             :              :                :          

(3)(1) (2) (4)

Toolbar

Scope area
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2.9.5.3  Save the contents of local variables

2.9.5.1  Change display format of values

The display format of the [value] area can be changed using buttons below on the toolbar. 

2.9.5.2  Modify the contents of local variables

Values and arguments of local variables can be edited. 
Select the value of the local variables/arguments to edit in the [Value] area, then click on it again to switch the value to 

edit mode (press the [Esc] key to cancel the edit mode). 
To write the edited value to the target memory, directly enter the value from the keyboard then press the [Enter] key.  At 

this time, the edited value is checked and if it is incompatible with the type, the editing is invalidated. 

Caution This operation cannot be performed during program execution.

Remark 1. If a number with fewer digits than the size of the variable is entered, the higher-order digits will be padded 
with zeroes. 

Remark 2. If a number with more digits than the size of the variable is entered, the higher-order digits will be 
masked. 

Remark 3. If the display format of a character array (type char or unsigned char) is set to ASCII, then the value can 
also be entered as a string (ASCII/Shift_JIS/EUC-JP/Unicode (UTF-8/UTF-16)). 

Remark 4. ASCII characters can be entered to values of local variables. 

Notation The following buttons to change the notation of a data value are dis-
played. 

 AutoSelect Displays values on this panel in the default notation according to the 
type of variable (default). 

 Hexadecimal Displays values on this panel in hexadecimal number.

 Decimal Displays values on this panel in decimal number.

 Octal Displays values on this panel in octal number.

 Binary Displays values on this panel in binary number.

 Decimal Notation for Array Index Displays array indexes on this panel in decimal number (default).

 Hexadecimal Notation for Array Index Displays array indexes on this panel in hexadecimal number.

 Float Displays values on this panel in Float.
Note that when the value is not 4-byte data, or has the type informa-
tion, displays it in the default notation. 

 Double Displays values on this panel in Double.
Note that when the value is not 4-byte data, or has the type informa-
tion, displays it in the default notation. 

Adds the value in hexadecimal number enclosing with "()" at the end 
of the value. 

Encoding The following buttons to change the encoding of character variables 
are displayed. 

 ASCII Displays character variables in ASCII code (default).

 Shift_JIS Displays character variables in Shift_JIS code.

 EUC-JP Displays character variables in EUC-JP code.

 UTF-8 Displays character variables in UTF-8 code.

 UTF-16 Displays character variables in UTF-16 code.
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- Entering via an ASCII character 
In the [Value] area for the variable "ch", enter "'A'"
>> "0x41" will be written to the memory area allocated to "ch" 

- Entering via a numeric value 
In the [Value] area for the variable "ch", enter "0x41" 
>> "0x41" will be written to the memory area allocated to "ch" 

- Entering via an ASCII string 
Set the display format of character array "str" to ASCII, and in the [Value] area, enter ""ABC"" 
>> "0x41, 0x42, 0x43, 0x00" will be written to the memory area allocated to "str" 

2.9.5.3  Save the contents of local variables

The Save As dialog box can be opened by selecting the [File] menu >> [Save Local Variables Data As...], and all the 
contents in the local variables can be saved in a text file (*.txt) or CSV file (*.csv). 

When saving to files, retrieve the latest information from the debug tool.  If arrays, pointer type variables, structures/
unions, and CPU registers (only those with the part name) are displayed expanded, the value of each expanded element 
is also saved.  When they are not expanded, "+" mark is added on the top of the item and the value becomes blank. 

Figure 2.108 Output Example of Local Variables

2.9.6  Display/change watch-expressions

By registering C language variables, CPU register, SFR, and assembler symbols to the Watch panel as watch-expres-
sions, you can always retrieve their values from the debug tool and monitor the values in batch. 

The values of watch-expressions can be updated during the program is in execution (see "2.9.6.7  Display/modify the 
contents of watch-expressions during program execution"). 

Select the [View] menu >> [Watch] >> [Watch1 - 4] to open the Watch panel. 
The Watch panel can be opened up to 4 panels.  Each panel is identified by the names "Watch1", "Watch2", "Watch3" 

and "Watch4" on the titlebar, and the watch-expressions can be registered/deleted/moved individually, and they are saved 
as the user information of the project. 

For details on the contents and function in each area, see the section for the Watch panel. 

Figure 2.109 Display the Contents of Watch-Expression (Watch Panel)

(1): [Watch] area
(2): [Value] area
(3): [Type (Byte Size)] area
(4): [Address] area

Scope : Current scope    
[V]Variable  [P]Parameter  [F]Function  
Name                       Value   Type (Byte Size)   Address    
--------------------------------------------------------
[V]Variable name[1]        Value   Type               Address     
  - [V]Variable name[0]    Value   Type               Address     
           :                 :      :                    :    

(1) (4)(3)(2) (5)

Toolbar
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(5): [Memo] area

This section describes the following. 

2.9.6.1  Register a watch-expression
2.9.6.2  Organize the registered watch-expressions
2.9.6.3  Edit the registered watch-expressions
2.9.6.4  Delete a watch-expression
2.9.6.5  Change display format of values
2.9.6.6  Modify the contents of watch-expressions
2.9.6.7  Display/modify the contents of watch-expressions during program execution
2.9.6.8  Export/import watch-expressions
2.9.6.9  Save the contents of watch-expressions

2.9.6.1  Register a watch-expression

There are three ways as follows to register watch-expressions (watch-expressions are not registered as default). 

Remark 1. Each watch-expression registered in each watch panel (Watch1 to Watch4) is managed in each panel 
and saved as the user information of the project. 

Remark 2. More than one watch-expression with the same name can be registered. 

(1) Register from other panels 
Watch-expressions can be registered from other panel in CS+. 
In other panel, drag and drop the watch-expression to register in any watch panel (Watch1 to Watch4).
For the relationship between panels that can use this operation and targets that can be registered as watch-
expressions, see "Table A.4  Relationship between Panels and Targets That Can be Registered as Watch-
Expressions". 

Figure 2.110 Registering Watch-Expressions from Other Panels

Remark You can also add a watch-expression by doing the following. First, select the target for which you 
wish to register a watch-expression, or move the caret to one of the target strings (the target is 
determined automatically). Next, from the context menu, select [Register Watch1] (but this is limited 
to the Watch panel (Watch 1)). 

(2) Directly register in the Watch panel
Click the  button in the toolbar in any the Watch panel (Watch1 to Watch4) to display the following entry box in 
the [Watch] area. 

Figure 2.111 Entry Box of Watch-Expression

Here, the variable "data1" in the Disassemble panel 
will be registered as a watch-expression. 
Drag and drop on the Watch panel after selecting 
the variable "data1" in the Disassemble panel. 

Directly enter a watch-expression in this area. 
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Directly input a watch-expression from the keyboard in the entry box then press the [Enter] key. 
For the input forms of watch-expressions entered this way, see the tables listed below.

- "Table 2.28  Basic Input Format of Watch-expressions"

- "Table A.5  Handling of a C Language Function When Registered in Watch by Specifying Scope"

- "Table A.6  Handling of a C Language Variable When Registered in Watch by Specifying Scope"

- "Table A.7  Handling of a CPU Register When Registered in Watch by Specifying Scope"

- "Table A.8  Handling of a SFR when Registered in Watch by Specifying Scope"

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space] 
key in this area (see "2.19.2  Symbol name completion function").

(3) Register from other application 
Select the character strings of C language variables/CPU registers/SFR/assembler symbols from an external edi-
tor and drag and drop it in the Watch panel (Watch 1 to Watch 4). 
The dropped character strings are registered as a watch-expression. 

2.9.6.2  Organize the registered watch-expressions

Registered watch-expressions can be organized in categories (folders) and displayed in tree view (there is no category 
as default). 

Caution 1. Categories cannot be created within categories. 

Caution 2. Up to 64 categories can be created in one watch panel (if this restriction is violated, a message appears). 

(1) Create new category 
Move the caret to the position to create a new category then click the  button in the toolbar and directly enter 
the new category name. 

(2) Edit category name 
Click the category name to edit, and click it again, then directly modify the category name from the keyboard. 

(3) Delete categories 
Select categories to delete then click the  button in the toolbar. 

(4) Change the display order
Registered watch-expressions are categorized when they are dragged and dropped in the category. 
Also, the display order of the categories and the watch-expressions (upper or lower position) can be changed eas-
ily by drag and drop operation. 

Remark Drag and drop the watch-expressions/categories in other watch panel (Watch1 to Watch4) to copy them. 

2.9.6.3  Edit the registered watch-expressions

Registered watch-expressions can be edited. 
Double-click the watch-expression to edit to switch the watch-expression to edit mode (press the [Esc] key to cancel the 

edit mode). 
Directly edit from the keyboard and then press the [Enter] key. 

2.9.6.4  Delete a watch-expression

To delete watch-expressions, select the one you want to delete in the Watch panel then click the  button in the tool-
bar. 

2.9.6.5  Change display format of values

The display format of the [value] area can be changed using buttons below on the toolbar. 
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2.9.6.6  Modify the contents of watch-expressions

The values of watch-expressions can be edited. 
Double-click the value of the watch-expression to edit in the [Value] area to switch the value to edit mode (press the 

[Esc] key to cancel the edit mode). 
To write the edited value to the target memory, directly enter the value from the keyboard then press the [Enter] key.
Note that only those values that correspond one by one to variables of C language, CPU registers, SFR or assembler 

symbols can be edited.  In addition, read-only SFR values cannot be edited.
This operation can be taken place while the program is in execution.  See "2.9.1.4  Display/modify the memory contents 

during program execution" for details on how to operate it. 

Remark 1. If a number with fewer digits than the size of the variable is entered, the higher-order digits will be padded 
with zeroes. 

Remark 2. If a number with more digits than the size of the variable is entered, the higher-order digits will be 
masked. 

Remark 3. If the display format of a character array (type char or unsigned char) is set to ASCII, then the value can 
also be entered as a string (ASCII/Shift_JIS/EUC-JP/Unicode (UTF-8/UTF-16)). 

Remark 4. ASCII characters can be entered to values of watch-expressions. 

- Entering via an ASCII character 
In the [Value] area for the variable "ch", enter "'A'"
>> "0x41" will be written to the memory area allocated to "ch" 

- Entering via a numeric value 
In the [Value] area for the variable "ch", enter "0x41" 
>> "0x41" will be written to the memory area allocated to "ch" 

- Entering via an ASCII string 
Set the display format of character array "str" to ASCII, and in the [Value] area, enter ""ABC"" 
>> "0x41, 0x42, 0x43, 0x00" will be written to the memory area allocated to "str" 

2.9.6.7  Display/modify the contents of watch-expressions during program execution 

The Memory panel/Watch panel has the real-time display update function that can update/modify the display contents of 
the memory/watch-expression in real-time while executing the program.

Notation The following buttons to change the notation of a data value are displayed. 

 AutoSelect Displays the value of the selected watch-expression in the default notation (see "Table 
A.9  Display Format of Watch-Expressions (Default)") according the type of variable 
(default). 

 Hexadecimal Displays the value of the selected item in hexadecimal number.

 Signed Decimal Displays the value of the selected item in signed decimal number.

 Unsigned Decimal Displays the value of the selected item in unsigned decimal number.

 Octal Displays the value of the selected item in octal number.

 Binary Displays the value of the selected item in binary number.

 ASCII Displays the value of the selected item in ASCII code.

 Float Displays the value of the selected item in Float.
Note that this item becomes valid only when the selected watch-expression value is 4-
byte data.

 Double Displays the value of the selected item in Double.
Note that this item becomes valid only when the selected watch-expression value is 8-
byte data.

Adds the value in hexadecimal number enclosing with "()" at the end of the value of the 
selected item (except the item displayed in hexadecimal number). 
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Using the real-time display update function allows you to display/modify the value of memory/watch-expression not only 
while the program is stopped, but also in execution. 

See "2.9.1.4  Display/modify the memory contents during program execution" for details on how to operate it. 

2.9.6.8  Export/import watch-expressions

This feature is for the export of currently registered watch-expressions to a file and the importing of such files, enabling 
the re-registration of watch-expressions.

To do this, follow the procedure described below. 

(1) Export watch-expressions
Save watch-expressions currently being registered (including categories) in a file format that is possible to import.
With the Watch panel in focus, select [Save Watch Data As...] from the [File] menu. 
On the Save As dialog box that is automatically opened, specify the following items, and then click the [Save] but-
ton.

- [File name]: Specify the name of a file to be saved (the file extension must be "csv").

- [Save as type]: Select "Importable CSV (Comma-Separated Variables)(*.csv)"

Caution Neither values nor the type information of watch-expressions can be saved.
Items that are expanded after analyzing watch-expressions (i.e. an array, structure, and so on) can-
not be saved. 

Figure 2.112 Export of Watch-Expressions

(2) Import watch-expressions
Import the file that exported in (1) to the Watch panel. 
On the Watch panel to which you want to import watch-expressions, select [Import Watch Expression] from the 
context menu. 
On the Open Watch Expression Data File dialog box that is automatically opened, specify the file that exported 
previously, and then click the [Open] button. 

Remark If watch-expressions have been already registered, then imported watch-expressions will be regis-
tered at the bottom of them. 
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Figure 2.113 Import of Watch-Expressions

2.9.6.9  Save the contents of watch-expressions

By selecting the [File] menu >> [Save Watch Data As...] or selecting [Save Expanded Watch Data…] from the context 
menu, the Save As dialog box can be opened, and all the contents of the watch-expression and its value can be saved in 
a text file (*.txt) or CSV file (*.csv). 

When saving the contents to the file, all the values of the watch-expression are reacquired and save the latest values 
acquired. 

Note that the values of read-protected SFR are not re-read.  If you want to save the latest values of those, select [Force 
Read Value] from the context menu then save the file. 

Note that for watch-expressions that can be displayed expanded, such as arrays, pointer type variables, structures/
unions, and CPU registers (only those with the part name), the behavior differs depending on whether the watch-expres-
sion is saved with [Save Watch Data As...] or [Save Expanded Watch Data…].

- When saved with [Save Watch Data As...]
If arrays, pointer type variables, structures/unions, and CPU registers (only those with the part name) are displayed 
expanded, the value of each expanded element is also saved.  When they are not expanded, "+" mark is added on 
the top of the item and the value becomes blank. 

- When saved with [Save Expanded Watch Data…]
The watch-expression is expanded up to the maximum 255 nests regardless of the expanded state, and the value of 
each expanded element is also saved.

Figure 2.114 Output Example of Watch Data

Remark When the contents of the panel are overwritten by selecting the [File] menu >> [Save Watch Data], each 
watch panel (Watch1 to Watch4) is treated as a different panel. 

Watch-expression    Value      Type(Byte Size)    Address     Memo
------------------------------------------------------------------
 Watch-expression   Value      Type(Byte Size)    Address     Memo
-Category name
  Watch-expression  Value      Type(Byte Size)    Address     Memo
       :               :               :             :          :
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2.10  Display Information on Function Call from Stack

This section describes how to show the information on function call from the stack. 
The CS+ compiler (CC-RL) pushes function-call information onto the stack, in accordance with the ANSI standard. 
It is thus possible to learn the function call depth, the location of the caller, parameters, and other information by analyz-

ing the function-call information.
This "function-call information" is called the call stack information; this term will be used in the rest of this document. 

2.10.1  Display call stack information

Call stack information is displayed in the Call Stack panel below. 
Select the [View] menu >> [Call Stack]. 
For details on the contents and function in each area, see the section for the Call Stack panel. 

Caution 1. Nothing is displayed on this panel during execution of a program. 
When the program is stopped, items in each area are displayed. 

Caution 2. Except for [Simulator]
If step execution is performed in source level, CS+ determines whether an interrupt is being processed 
via the NP, EP, and ID flags in the PSW register.  For this reason, if the above register or flags are 
changed (e.g. when using multiple interrupts), then call stack information may be incorrect.

Figure 2.115 Display Call Stack Information (Call Stack Panel)

(1): [Depth] area
(2): [Call Stack] area

This section describes the following. 

2.10.1.1  Change display format of values
2.10.1.2  Jump to the source line
2.10.1.3  Display local variables
2.10.1.4  Save the contents of call stack information

2.10.1.1  Change display format of values

The display format of this panel can be changed using buttons below on the toolbar. 
Note that these buttons are disabled during execution of a program. 

Notation The following buttons to change the notation of a data value are displayed. 

 AutoSelect Displays values on this panel in the default notation according to the type of variable (default). 

 Hexadecimal Displays values on this panel in hexadecimal number.

 Decimal Displays values on this panel in decimal number.

 Octal Displays values on this panel in octal number.

 Binary Displays values on this panel in binary number.

(1) (2)

Toolbar
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2.10.1.2  Jump to the source line

Double-clicking on the line will open the Editor panel with the caret moved to the source line of the calling function indi-
cated by the selected line (If the panel is already open, the screen will jump to the editor panel). 

Remark Selecting [Jump to Disassemble] from the context menu will open the Disassemble panel (Disassemble 
1) with the caret moved to address of the calling function indicated by the selected line (If the panel is 
already open, the screen will jump to the Disassemble panel (Disassemble 1)). 

2.10.1.3  Display local variables

Selecting [Jump to Local Variable at This Time] from the context menu will open the Local Variables panel that displays 
the local variables indicated by the currently selected line.

2.10.1.4  Save the contents of call stack information

By selecting the [File] menu >> [Save Call Stack Data As...], the Save As dialog box can be opened, and all the contents 
in the call stack information can be saved in a text file (*.txt) or CSV file (*.csv). 

When saving to files, retrieve the latest information from the debug tool. 

Figure 2.116 Output Example of Call Stack Information

Note If old information has been obtained from stack data that has lost its reliability, the information on that line 
is shown in parentheses "( )". 

Encoding The following buttons to change the encoding of character variables are displayed. 

 ASCII Displays character variables in ASCII code (default).

 Shift_JIS Displays character variables in Shift_JIS code.

 EUC-JP Displays character variables in EUC-JP code.

 UTF-8 Displays character variables in UTF-8 code.

 UTF-16 Displays character variables in UTF-16 code.

Depth      Call stack
----------------------------------------------------------------------
 0         Call stack information
 1         Call stack information
 :                :
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2.11  Collect Execution History of Programs

This section describes how to collect the execution history of the program.
A history of program execution is generally called a trace; this term will be used in the remainder of this document. 
It is nearly impossible to find the cause of runaway program execution from the memory contents, stack information, and 

the like after the runaway has occurred.  The collected trace data, however, can be used to trace program execution up to 
the runaway directly, making this an effective tool for discovering hidden bugs. 

Caution 1. [E1][E20][EZ Emulator]
The trace function is supported only when the selected microcontroller incorporates the OCD trace func-
tion.

Caution 2. [Simulator]
4 bytes of the final address of the code flash area (when a code flash area is 0x0 - 0x1FFFF, 0x1FFFC - 
1FFFFF corresponds to it) and the RAM area which can be fetched cannot be fetched (a message of 
"Stopped by accessing to no map area." will appear). 

2.11.1  Configure the trace operation

When the trace function starts, trace data which has recorded in it an execution history of the currently executed pro-
gram is collected in trace memory (when program execution stops, the trace function also automatically stops).

Before the trace function can be used, it is necessary to make settings relating to the operation of a trace.
Note that the method on how to set differs depending on the debug tool used.

2.11.1.1  [IECUBE]
2.11.1.2  [E1]/[E20]/[EZ Emulator]
2.11.1.3  [Simulator]

2.11.1.1  [IECUBE]

This trace operation can be configured in the [Trace] category on the [Debug Tool Settings] tab in the Property panel. 

Figure 2.117 [Trace] Category [IECUBE]

(1) [Clear trace memory before running]
Select whether to clear (initialize) the trace memory before tracing starts in this property. 
Select [Yes] to clear the memory (default). 

Remark You can forcibly clear the trace memory when clicking the  button in the toolbar in the Trace 
panel. 

(2) [Operation after trace memory is full]
Select the operation after the trace memory is full with the collected trace data, from the following drop-down list. 
The trace memory size is 128K frames (fixed).

(3) [Rate of frequency division of trace time tag]
Specify the frequency division ratio of the counter to be used for time tag display (i.e. display of the [Time] item in 
the Trace panel) (default: [1/1(4ns/0.3min)]). 

Remark Values in "()" on the drop-down list indicate the resolution and the maximum measurement time.

Non stop and overwrite 
to trace memory

Continues overwriting the older trace data after the trace memory is full (default). 
When the [Clear trace memory before running] property is set to [Yes], at the time of 
a resumption, trace data is collected after clearing the trace memory. 

Stop trace When the trace memory is full, CS+ stops writing trace data (the program does not 
stop execution). 

Stop When the trace memory is full, CS+ stops writing trace data and the program stops 
execution. 
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Caution An error occurs in trace time tag due to the following causes:

- When the RAM monitor function is used during user program execution

- When a hardware or software breakpoint is set during user program execution

- When a value is written to memory using the DMM function during user program execution

Caution Information on access to the SFRs and memory by the DMAC is also output with information on data to 
which access is normal.

2.11.1.2  [E1]/[E20]/[EZ Emulator]

This trace operation can be configured in the [Trace] category on the [Debug Tool Settings] tab of the Property panel. 

Caution This category appears only when the selected microcontroller incorporates the OCD trace function.

Figure 2.118 [Trace] Category [E1][E20][EZ Emulator]

(1) [Use trace function] 
Select whether to use trace function.
Select [Yes] to use the trace function (default: [No]). 

(2) [Operation after trace memory is full]
Select the operation after the trace memory is full with the collected trace data, from the following drop-down list. 

(3) [Trace memory size[frames]]
The size of trace memory (i.e. the number of trace frames) is displayed. 
You cannot change the value of this property.
The trace frame is a unit of trace data.  One trace frame is used for each operation in fetch/write/read. 

Operation specifications of the OCD trace function are as follows: 

Table 2.11 Operation Specifications of OCD Trace Function

Non stop and overwrite 
to trace memory

Continues overwriting the older trace data after the trace memory is full (default). 

Stop trace When the trace memory is full, CS+ stops writing trace data (the program does not 
stop execution). 

Item Description

Clearing the trace 
memory

The trace memory is cleared when:

- The program is executed.

- The external reset signal is generated (the internal reset signal does not cause 
clearing the trace memory).

Operation after the 
trace memory is full

The trace full break is not supported. 
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2.11.1.3  [Simulator]

This trace operation can be configured in the [Trace] category on the [Debug Tool Settings] tab of the Property panel. 

Figure 2.119 [Trace] Category [Simulator]

(1) [Use trace function] 
Select whether to use trace function.
Select [Yes] to use the trace function (default: [No]). 

(2) [Clear trace memory before running]
Select whether to clear (initialize) the trace memory before tracing starts.
Select [Yes] to clear the memory (default). 

Remark You can forcibly clear the trace memory when clicking the  button in the toolbar in the Trace 
panel. 

(3) [Operation after trace memory is full]
Select the operation after the trace memory is full with the collected trace data, from the following drop-down list. 

Target of trace data Branch origin instructions (internal ROM only)
For a branch instruction with a condition, it will be traced only when the condition is 
met.  Complement display of instructions between branch instructions cannot be per-
formed. 
Note that, for the following instructions, an instruction of the next address of its cor-
rect position will be displayed.

- BT ES:[HL].bit, $addr20

- BF ES:[HL].bit, $addr20

- BTCLR ES:[HL].bit, $addr20
The following items are supported on the Trace panel.

- [Number]

- [Line/Address]

- [Source/Disassemble]

Trace event See "2.15.7  Notes for setting events".

Notes The following items cannot be traced.

- Interrupt vectors

- Instructions during a step execution

- Skip instructions with a condition

Non stop and overwrite 
to trace memory

Continues overwriting the older trace data after the trace memory is full (default). 
When the [Clear trace memory before running] property is set to [Yes], at the time of 
a resumption, the trace data is collected after clearing the trace memory. 

Stop trace When the trace memory is full, CS+ stops writing trace data (the program does not 
stop execution). 

Stop When the trace memory is full, CS+ stops writing trace data and the program stops 
execution. 

Item Description
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(4) [Accumulate trace time] 
Select whether to display the trace time with accumulated time.
Specify [Yew] to display trace time with accumulated time.  Specify [No] to display the trace time with differential 
time (default). 

(5) [Trace memory size[frames]]
Select the trace memory size (trace frame number) (default: [4K]). 
The trace frame is a unit of trace data.  One trace frame is used for each operation in fetch/write/read. 

2.11.2  Collect execution history until stop of the execution

In the debug tool, there is a function to collect the execution history from the start of program execution to the stop.
Therefore, the trace data collection is automatically started when the program starts executing and stopped when the 

program stops. 
See "2.11.6  Display the collected execution history" for how to check the collected trace data. 

Remark This function is actuated by an Unconditional Trace event, one of the built-in events that are set in the 
debug tool by default.
Consequently, if the Unconditional Trace event is set to Invalid state by clearing the check box in the 
Events panel, trace data linked to the start of program execution will not be collected (the Unconditional 
Trace event is set to Valid state by default). 
Note that Unconditional Trace event and Trace event described later (see "2.11.3  Collect execution his-
tory in a section") are used exclusively of each other.  Therefore, if Trace event with Valid state is set, 
Unconditional Trace event is automatically set to Invalid state. 

2.11.3  Collect execution history in a section

The execution history is collected as trace data only for a section while the program is in execution by setting a Trace 
event.

This Trace event consists of a trace start event and a trace end event. 
To use this function, follow the procedure described below. 

2.11.3.1  Set a Trace event
2.11.3.2  Execute the program
2.11.3.3  Edit a Trace event
2.11.3.4  Delete a Trace event

Caution 1. Also see "2.15.7  Notes for setting events" for details on Trace events (e.g. limits on the number of 
enabled events). 

Caution 2. The event type (execution type/access type) that can be set as trace start and end events differ with each 
debug tool used.

Caution 3. [Simulator]
Trace start events and trace stop events cannot be set/deleted while a tracer is running. 

Caution 4. [Simulator]
If you perform a trace from a trace start event until a trace end event, the simulator will not include the 
trace end event in the results of the trace. For this reason, if you are using a simulator, set the trace end 
event one line below the range for which you require display of the trace data.

2.11.3.1  Set a Trace event

To set a Trace event, set a trace start event and a trace end event that starts/stops collecting the trace data.
Use one of the following methods to set a trace start event and a trace end event.

(1) For execution-related events
By setting execution-related events for a trace start event and a trace end event, it is possible to start and stop the 
collection of trace data at any place. 
Perform this operation in the Editor panel/Disassemble panel in which the source text/disassembly text is dis-
played. 
Follow the operation listed below from the context menu, in accordance with your desired event type, after moving 
the caret to the target line that has a valid address.
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Caution [Simulator]
Simulator will not display a trace end event as the results of a trace.  For this reason, set a trace 
end event to one line below the range that you wish to display as the trace data.

A trace start event or a trace end event is set to the instruction at the start address corresponding to the line of the 
caret position.
Once a trace start event or a trace end event is set, the following event mark is displayed in the event area of the 
line that an event is set.

Table 2.12 Event Marks of Trace Start Event and Trace End Events

Figure 2.120 Trace Start and Trace End Events Setting Example (Disassemble Panel)

(2) For access-related events [E1][E20]
By setting access-related events for a trace start event and a trace end event, it is possible to start and stop the 
collection of trace data when a specified access is made to any variable or SFR. 

Remark The types of access that can be set by using methods described here are only a read/write (see 
“Table 2.5  Types of Accesses to Variables“). 
To change the access type to a read or write, after setting trace start and end events, edit their 
[access type] item (see "2.15.4.2  Edit access-related events").

(a) To set events for variables or SFR in the Editor panel/Disassemble panel
Perform this operation in the Editor panel/Disassemble panel in which the source text/disassembly text is dis-
played. 
Follow the operation listed below from the context menu, in accordance with your desired event type, after 
selecting an arbitrary variable or SFR on the source text/disassembled text. 
Note, however, that only global variables, static variables inside functions, and file-internal static variables can 
be used.

At this time, if you have specified a value in the text box in the context menu, collection of trace data is started or 
finished only when a read/write is performed with a specified value.  On the other hand, if no value is specified, 
reading/writing the selected variable or SFR by any value will cause the break to occur.

Caution 1. Variables within the current scope can be specified. 

Event Type Operation

Trace start Select [Trace Settings] >> [Start Tracing] 

Trace end Select [Trace Settings] >> [Stop Tracing] 

Event Type Event Mark

Trace start

Trace end

Event Type Operation

Trace start Select [Trace Settings] >> [Record Start R/W Value], and then press the [Enter] key. 

Trace end Select [Trace Settings] >> [Record End R/W Value], and then press the [Enter] key. 

Event area

Indicates that a trace 
start event has been set.

Indicates that a trace 
end event has been set.
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Caution 2. Variables or SFR at lines that have no valid addresses cannot be used for trace start events and 
trace end events.

(b) To set events for registered watch-expressions
Perform this operation in the Watch panel. 
Follow the operation listed below from the context menu after selecting the registered watch-expression (multi-
ple selections not allowed). 
Note, however, that only global variables, static variables inside functions, file-internal static variables, and SFR 
can be used. 

At this time, if you have specified a value in the text box in the context menu, collection of trace data is started or 
finished only when a read/write is performed with a specified watch-expression.  On the other hand, if no value 
is specified, reading/writing the selected watch-expression by any value will cause the break to occur.

Caution A watch-expression within the current scope can be specified. 
To target a watch-expression outside the current scope, select a watch-expression with a speci-
fied scope. 

When a trace start event and a trace end event are set, they are managed collectively on the Events panel as one 
instance of a Trace event (see "2.15  Manage Events").  When you click the "+" mark at a Trace event item, detailed infor-
mation on the trace start event and the trace end event you have set is displayed. 

Figure 2.121 Example of Trace Start and Trace End Events (Execution Type) in Events Panel 

Remark 1. If either one of a trace start event and a trace end event is set as Valid state, the check box of Uncondi-
tional Trace event in the Events panel is automatically cleared, therefore, trace data collection does not 
automatically start with the start of the program execution (the tracer will not run until the condition of the 
trace start event that has been set is met). 

Remark 2. A trace end event is not indispensable for a Trace event. 

Remark 3. Event marks differ depending on the event state (see "2.15.1  Change the state of set events (valid/
invalid)"). 
When an event is set at the point which other event is already set, the event mark (  ) is displayed 
meaning more than one event is set at the point. 

Remark 4. [Simulator]
If either one of a trace start event and a trace end event is set to Valid state, the [Use trace function] 
property in the [Trace] category on the [Debug Tool Settings] tab of the Property panel is automatically 
set to [Yes] and the trace function will be enabled. 

Event Type Operation

Trace start Select [Trace Output] >> [Record Start R/W Value], and then press the [Enter] key. 

Trace end Select [Trace Output] >> [Record End R/W Value], and then press the [Enter] key. 
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2.11.3.2  Execute the program

Execute the program (see "2.7  Execute Programs"). 
Collection of trace data is started or finished when the condition set for a trace start event or a trace end event is met.
See "2.11.6  Display the collected execution history" for how to check the collected trace data. 

2.11.3.3  Edit a Trace event

It is possible to edit a trace start event or a trace end event you have set. 
For details on how to do it, see "2.15.4.1  Edit execution-related events" or "2.15.4.2  Edit access-related events". 

2.11.3.4  Delete a Trace event

To delete a Trace event you have set, on the Editor panel/Disassemble panel, right-click the event mark in the event 
area and select [Delete Event] from the context menu that is displayed. 

Also, there is another way to delete a set event.  Select the Trace event you want to delete on the Events panel, and 
then click the  button in the toolbar (see "2.15.5  Delete events").

Caution It is not possible to delete only a trace start event or a trace end event (i.e. if either a trace start event or 
a trace end event is deleted from the event marks on the event area, all of the corresponding event 
marks are deleted).

2.11.4  Collect execution history only when the condition is met [IECUBE][Simulator]

The program execution history can be collected only when a condition is met. 
By setting a Point Trace event, the execution history is collected as trace data only when an arbitrary variable or SFR is 

accessed with the specified type.
To use this function, follow the procedure described below.

2.11.4.1  Set a Point Trace event
2.11.4.2  Execute the program
2.11.4.3  Edit a Point Trace event
2.11.4.4  Delete a Point Trace event

Caution [E1][E20][EZ Emulator]
This function is not supported. 

2.11.4.1  Set a Point Trace event

Use one of the following methods to set a Point Trace event. 

Caution 1. Also see "2.15.7  Notes for setting events" for details on Point Trace events (e.g. limits on the number of 
enabled events). 

Caution 2. [IECUBE]
Point Trace events cannot be set for 32-bit (4-byte) variables. 
Additionally, see "(3)  For access to a variable/SFR of 16-bit (2-byte) size [IECUBE]" for setting of Point 
Trace events for 16-bit (2-byte) variables. 

Caution 3. [Simulator]
Point Trace events cannot be set/deleted while a tracer is running. 

Remark 1. [IECUBE]
Accesses via DMA can be traced.

Remark 2. [Simulator]
When a Point Trace event is set to Valid state, the [Use trace function] property in the [Trace] category on 
the [Debug Tool Settings] tab of the Property panel is automatically set to [Yes] and the trace function will 
be enabled. 

(1) For access to a variable/SFR on the Editor panel/Disassemble panel
Perform this operation in the Editor panel/Disassemble panel in which the source text/disassembly text is dis-
played. 
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Follow the operation listed below from the context menu, in accordance with your desired access type, after 
selecting the variable or SFR as the subject to access. 
Note, however, that only global variables, static variables inside functions, and file-internal static variables can be 
used. 

Caution Variables within the current scope can be specified. 

(2) For access to a registered watch-expression 
Perform this operation in the Watch panel. 
Select the watch-expression as the subject to access and perform the following operation from the context menu.
Note, however, that only global variables, static variables inside functions, file-internal static variables, and SFR 
can be used. 

Caution A watch-expression within the current scope can be specified. 
To target a watch-expression outside the current scope, select a watch-expression with a specified 
scope. 

(3) For access to a variable/SFR of 16-bit (2-byte) size [IECUBE]
If you want to set a Point Trace event to a variable/SFR of 16-bit (2-byte) size when using IECUBE, register each 
address of the higher 8-bit and the lower 8-bit of the variable/SFR in the Watch panel directly as watch-expres-
sions (see "2.9.6.1  Register a watch-expression"). 
Then, set a Point Trace event to each watch-expression by using the method described in "(2)  For access to a 
registered watch-expression".

Figure 2.122 How to Set Point Trace Event for 16-bit (2-byte) Variable/SFR [IECUBE]

By performing the above operation, it is interpreted as if a Point Trace event has been set at the target variable/
SFR/watch-expression, and it is managed in the Events panel (see "2.15  Manage Events" for details). 

Access Type Operation

Read Select [Trace Settings] >> [Record Reading Value]. 

Write Select [Trace Settings] >> [Record Writing Value]. 

Read/Write Select [Trace Settings] >> [Record R/W Value]. 

Access Type Operation

Read Select [Trace Output] >> [Record Reading Value]. 

Write Select [Trace Output] >> [Record Writing Value]. 

Read/Write Select [Trace Output] >> [Record R/W Value]. 

This example shows how to set a Point Trace event for the 2-byte SFR (ADCR).
Directly register 0xfff1e (lower 8-bit address) and 0xfff1f (higher 8-bit address) as 
watch-expressions, and then set a Point Trace event to each watch-expression.
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Figure 2.123 Example of Setting Point Trace Event in Events Panel 

2.11.4.2  Execute the program

Execute the program (see "2.7  Execute Programs"). 
If the conditions for a Point Trace event that you have set are met while the program is executing, that information is col-

lected as trace data. 
See "2.11.6  Display the collected execution history" for details on checking trace data. 

Figure 2.124 Example of Point Trace Event Results View 

Figure 2.125 Example of Point Trace Event Results View (For 16-bit (2-byte) Variable/SFR) [IECUBE]

2.11.4.3  Edit a Point Trace event

It is possible to edit a Point Trace event you have set. 
For details on how to do it, see "2.15.4.2  Edit access-related events". 

2.11.4.4  Delete a Point Trace event

To delete a Point Trace event you have set, select the Point Trace event you want to delete on the Events panel, and 
then click the  button in the toolbar (see "2.15.5  Delete events").

Example of the result of the point 
trace event with read-access to 
the variable "global_a". 

Example of the result of the Pint Trace event 
with read-access to the 2-byte SFR (ADCR).

An access address of trace shows 
a defined SFR name or address.

The data is displayed 
each 1 byte.
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2.11.5  Stop/restart collection of execution history [IECUBE][Simulator]

It is possible to temporarily stop or restart the collection of execution history during program execution.

2.11.5.1  Stop collection of execution history temporarily

By clicking the  button on the toolbar in the Trace panel during program execution, it is possible to temporarily stop 
collection of trace data without stopping program execution.

Use this function when you want to stop only the trace function without halting the program and check the trace data that 
has been collected until you stop it. 

2.11.5.2  Restart collection of execution history

If you have halted the trace function during program execution, you can start collection of trace data again by clicking 
the  button on the toolbar in the Trace panel. 

Note that the trace data that has been collected before you restart is cleared once.

2.11.6  Display the collected execution history

The collected trace data is displayed in the Trace panel below. 
Select the [View] menu >> [Trace]. 
The trace data displays by mixing the disassembled text and source text by default, but it is also possible to display 

either one of these by selecting the Display mode. 
For details on the contents and function in each area, see the section for the Trace panel. 

Figure 2.126 Display Trace Data (Trace Panel)

(1): [Number] area
(2): [Time (h:min:s,ms,s,ns)] area 
(3): [Line/Address] area
(4): [Source/Disassemble] area
(5): [Address] area
(6): [Data] area

This section describes the following. 

2.11.6.1  Change display mode
2.11.6.2  Change display format of values
2.11.6.3  Link with other panels

2.11.6.1  Change display mode

Display mode can be changed to the purpose when clicking the buttons below in the toolbar. 
Note that these buttons are disabled while the tracer is running. 

(3) (6)(5)(4)(1) (2)

Toolbar
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Table 2.13 Display Modes of Trace Panel

Figure 2.127 Example of Source Display Mode View (Trace Panel)

2.11.6.2  Change display format of values

The display format of the [Line Number/Address], [Address] [IECUBE][Simulator] and [Data] [IECUBE][Simulator] 
area can be changed using buttons below on the toolbar. 

Note that these buttons are disabled while the tracer is running.

2.11.6.3  Link with other panels

Items in the trace panel can be linked to other panels using the currently selected line address as a pointer (window 
focus will not move). 

Click the  button on the toolbar to start linking to the Editor panel.  Click the  button on the toolbar to start linking 
to the Disassemble panel. 

If the button is clicked again, the link is disconnected. 

Remark The Editor panel/Disassemble panel opens when selecting the [Jump to Source]/[Jump to Disassemble] 
from the context menu with moving the caret to the source line/address corresponding to the address of 
the currently selected line (focus is moved). 

Button Display Mode Displayed Content

Mixed display mode Displays the instruction (disassemble results), labels, source text (corre-
sponding source line), point trace results [IECUBE][Simulator], reset 
causes [IECUBE], and break causes (default). 

Disassemble display mode Displays the instruction (disassemble results), labels, point trace results 
[IECUBE][Simulator], reset causes [IECUBE], and break causes. 

Source display mode Displays the source text (corresponding source line), reset causes 
[IECUBE], and break causes.
However, when a place where no debugging information is present is exe-
cuted, "<No Debug Information>" is displayed. 

Notation The following buttons to change the notation of a data value are displayed. 

 Hexadecimal Displays values on this panel in hexadecimal number (default).

 Decimal Displays values on this panel in decimal number.

 Octal Displays values on this panel in octal number.

 Binary Displays values on this panel in binary number.
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2.11.7  Clear the trace memory

To clear the collected trace data contents, click the  button on the toolbar. 
Note that this button is disabled while a tracer is running. 

Remark 1. [IECUBE][Simulator]
When [Yes] is specified in the [Clear trace memory before running] property in the [Trace] category on 
the [Debug Tool Settings] tab of the Property panel, the trace memory is cleared each time a program is 
executed. 

Remark 2. [E1][E20][EZ Emulator]
The trace memory is cleared each time a program is executed (fixed). 

2.11.8  Search the trace data

To search the collected trace data, click the  button to open the Trace Search dialog box (note that the search is dis-
abled during execution of a program). 

In this dialog box, follow the steps below. 
When the tab on the tab selection area is selected, the trace data can be searched in instruction level/source level. 
Note however, that if you search the trace data at the instruction level, the display mode must be set in the Trace panel 

to the Mixed display mode or Disassemble display mode. 
When searching at the source level, the mode must be set to the Mixed display mode or Source display mode. 

Figure 2.128 Search Trace Data (Trace Search Dialog Box)

This section describes the following. 

2.11.8.1  Search in the instruction level
2.11.8.2  Search in the source level

2.11.8.1  Search in the instruction level

Search the trace data in the instruction level. 
Select the [Instruction Level] tab and then follow the steps below. 

Tab selection area
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Figure 2.129 Search Trace Data in Instruction Level

(1) Specify [Fetch Address] 
Specify the fetch address if it is a required search parameter. 
You can either type address expressions directly into the text boxes, or select it from the input history via the drop-
down list (up to 10 items). 
The fetch address can also be specified as a range.  In this case, specify a range by specifying address expres-
sions in both the left and right text boxes. 
If the right-hand text box is blank or contains the text [(Input when range is specified)], then the fixed address 
specified in the left-hand text box will be searched. 
Note that if an address value greater than the microcontroller address space is specified, the high-order address 
value is masked. 
An address value greater than the value expressed within 32 bits cannot be specified. 

(2) Specify [Mnemonic] 
Specify the mnemonic if it is a required search parameter. 
The specified character strings in this area is searched within the [Source/Disassemble] area of the Trace panel.
You can either type a mnemonic directly into the text boxes, or select one from the input history via the drop-down 
list (up to 10 items). 
Searches are case-insensitive, and partial matches are also allowed. 

(3) Specify [Access Address] [IECUBE][Simulator]
Specify the access address if it is a required search parameter. 
You can either type the address value directly into the text boxes (in hexadecimal number), or select it from the 
input history via the drop-down list (up to 10 items). 
The access address can also be specified as a range.  In this case, specify a range by specifying address expres-
sions in both the left and right text boxes. 
If the right-hand text box is blank or contains the text [(Input when range is specified)], then the fixed address 
specified in the left-hand text box will be searched. 
Note that if an address value greater than the microcontroller address space is specified, the high-order address 
value is masked. 
An address value greater than the value expressed within 32 bits cannot be specified. 

(4) Specify [Access Status] [IECUBE][Simulator]
This item is only enable if a value for Specify [Access Address] [IECUBE][Simulator] is specified. 
Select the access type (Read/Write, Read, Write, Vector Read and DMA) from drop-down list. 
Select [(No Specification)] if you do not wish to limit access types. 
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(5) Specify [Data] [IECUBE][Simulator]
This item is only enable if a value for Specify [Access Address] [IECUBE][Simulator] is specified. 
Specify the access data. 
You can either type the data directly into the text boxes (in hexadecimal number), or select it from the input history 
via the drop-down list (up to 10 items). 
The data can also be specified as a range.  In this case, specify a range by specifying data in both the left and right 
text boxes. 
If the right-hand text box is blank or contains the text [(Input when range is specified)], then the fixed data specified 
in the left-hand text box will be searched. 

(6) Specify [Number] 
Specify the range within the trace data to search via the number displayed in the [Number] area of the Trace 
panel. 
Specify the starting number in the left text box, and the ending number in the right text box ("0" to "last number" are 
specified by default). 
You can either type the numbers directly into the text boxes (in base-10 format), or select them from the input his-
tory via the drop-down list (up to 10 items). 
If the left-hand text box is left blank, it is treated as if "0" were specified. 
If the right-hand text box is left blank, it is treated as if the last number were specified. 

(7) Click the [Search Backward]/[Search Forward] button
When the [Search Backward] button is clicked, search is taken place in the order from the large number to small 
and the search results are shown selected in the Trace panel. 
When the [Search Backward] button is clicked, search is taken place in the order from the small number to large 
and the search results are shown selected in the Trace panel. 

2.11.8.2  Search in the source level

Search the trace data in the source level. 
Select the [Source Level] tab. 

Figure 2.130 Search Trace Data in Source Level

(1) Search with specifying the source line (default)
Select the [The execution part is retrieved specifying the source line] item in the [Search object] area and then fol-
low the operation below. 
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(a) Specify [Source and Line] 
The specified character strings in this area is searched within the [Line/Address] area of the Trace panel.
You can either type the character strings of the source line to be find directly into the text box, or select them 
from the input history via the drop-down list (up to 10 items). 
Searches are case-insensitive, and partial matches are also allowed. 

Example 1. main.c#40

Example 2. main.c

Example 3. main

(b) Specify [Number] 
Specify the range within the trace data to search via the number displayed in the [Number] area of the Trace 
panel. 
Specify the starting number in the left text box, and the ending number in the right text box ("0" to "last number" 
are specified by default). 
You can either type the numbers directly into the text boxes (in base-10 format), or select them from the input 
history via the drop-down list (up to 10 items). 
If the left-hand text box is left blank, it is treated as if "0" were specified. 
If the right-hand text box is left blank, it is treated as if the last number were specified. 

(c) Click the [Search Backward]/[Search Forward] button
When the [Search Backward] button is clicked, search is taken place in the order from the large number to small 
and the search results are shown selected in the Trace panel. 
When the [Search Backward] button is clicked, search is taken place in the order from the small number to large 
and the search results are shown selected in the Trace panel. 

(2) Search with specifying the function name
Select the [The execution part is retrieved specifying the function] item in the [Search object] area and then fol-
low the operation below. 

(a) Specify [Function Name] 
You can either type the function name to be find directly into the text box, or select it from the input history via 
the drop-down list (up to 10 items). 
Searches are case-insensitive, and only complete matches are retrieved. 

(b) Specify [Number] 
Specify the range within the trace data to search via the number displayed in the [Number] area of the Trace 
panel. 
Specify the starting number in the left text box, and the ending number in the right text box ("0" to "last number" 
are specified by default). 
You can either type the numbers directly into the text boxes (in base-10 format), or select them from the input 
history via the drop-down list (up to 10 items). 
If the left-hand text box is left blank, it is treated as if "0" were specified. 
If the right-hand text box is left blank, it is treated as if the last number were specified. 

(c) Click the [Search Backward]/[Search Forward] button
When the [Search Backward] button is clicked, search is taken place in the order from the large number to small 
and the search results are shown selected in the Trace panel. 
When the [Search Backward] button is clicked, search is taken place in the order from the small number to large 
and the search results are shown selected in the Trace panel. 

(3) Search with specifying the global variable [IECUBE][Simulator]
Select the [The execution part is retrieved specifying the global variable] item in the [Search object] area and 
then follow the operation below. 

(a) Specify [Variable Name] 
You can either type the variable name to be find directly into the text box, or select it from the input history via 
the drop-down list (up to 10 items). 
Searches are case-insensitive, and only complete matches are retrieved. 

(b) Specify [Kind] 
Select the access type ([Reference/Substitution], [Reference], or [Substitution]) from the drop-down list. 

(c) Specify [Value] 
You can either type the accessed variable value directly into the text box, or select one from the input history via 
the drop-down list (up to 10 items). 
The variable value can also be specified as a range.  In this case, specify a range by specifying variable values 
in both the left and right text boxes. 
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If the right-hand text box is blank, then access locations with the fixed variable values specified in the left-hand 
text box will be searched for. 

(d) Specify [Number] 
Specify the range within the trace data to search via the number displayed in the [Number] area of the Trace 
panel. 
Specify the starting number in the left text box, and the ending number in the right text box ("0" to "last number" 
are specified by default). 
You can either type the numbers directly into the text boxes (in base-10 format), or select them from the input 
history via the drop-down list (up to 10 items). 
If the left-hand text box is left blank, it is treated as if "0" were specified. 
If the right-hand text box is left blank, it is treated as if the last number were specified. 

(e) Click the [Search Backward]/[Search Forward] button
When the [Search Backward] button is clicked, search is taken place in the order from the large number to small 
and the search results are shown selected in the Trace panel. 
When the [Search Backward] button is clicked, search is taken place in the order from the small number to large 
and the search results are shown selected in the Trace panel. 

2.11.9  Save the contents of execution history

Contents of the collected trace data can be saved with range selection in text files (*.txt)/CSV files (*.csv). 
When saving to the file, the latest information is acquired from the debug tool, and it is saved in accordance with the dis-

play format on this panel. 
The following Data Save dialog box can be opened by selecting the [File] menu >> [Save Trace Data As...]. 
In this dialog box, follow the steps below. 

Figure 2.131 Save Execution History (Data Save Dialog Box)

(1) Specify [File Name] 
Specify the name of the file to save. 
You can either type a filename directly into the text box (up to 259 characters), or select one from the input history 
via the drop-down list (up to 10 items). 
You can also specify the file by clicking the [...] button, and selecting a file via the Select Data Save File dialog box. 

(2) Specify [File Type] 
Select the format in which to save the file from the following drop-down list. 
The following file formats can be selected. 

Note The data is saved with entries separated by commas (,). 
If the data contains commas, each entry is surrounded by double quotes "" in order to avoid illegal 
formatting. 

(3) Specify [Save Range Number] 
Specify the range of the number to save via "start number" and "end number".

List Item Format

Text files (*.txt) Text format (default)

CSV (Comma-Separated Variables)(*.csv) CSV formatNote
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Directly enter decimal number in each text box or select from the input history displayed in the drop-down list (up 
to 10 items). 
When saving all the trace data, select the [All Trace Data] item in the drop-down list at the left (the right text box 
becomes invalid). 
If a range is selected in the panel, that range is specified as the default.  If there is no selection, then the range 
currently visible in the panel is specified. 

(4) Click the [Save] button
Trace data is saved in the specified file with the specified format. 

Figure 2.132 Output Example of Trace Data

Number    Time    Line Number/Address    Source/Disassemble    Address   Data
------------------------------------------------------------------------------
Number    Time    Line Number/Address    Source/Disassemble    Address   Data
   :       :              :                      :                :       :
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2.12  Measure Execution Time of Programs

This section describes how to measure the execution time of the program.

2.12.1  Configure the timer operation

Before the timer function can be used, it is necessary to make settings relating to the operation of a timer.
Note that the method on how to set differs depending on the debug tool used.

2.12.1.1  [IECUBE]
2.12.1.2  [Simulator]

2.12.1.1  [IECUBE]

This timer operation can be configured in the [Trace] category on the [Debug Tool Settings] tab in the Property panel. 

Figure 2.133 [Timer] Category [IECUBE]

(1) [Rate of frequency division of timer]
Select the frequency division ratio of the timer counter (120 MHz) used for timer measurement (default: [1/1(8ns/
0.6min)]).

Caution It is not possible to divide the timer counter for the Run-Break time (see "2.12.2  Measure execution 
time until stop of the execution").

2.12.1.2  [Simulator]

This timer operation can be configured in the [Trace] category on the [Debug Tool Settings] tab in the Property panel. 

Figure 2.134 [Timer] Category [Simulator]

(1) [Use timer function]
Select whether to use the timer function.
Select [Yes] to use the timer function (default: [No]). 

2.12.2  Measure execution time until stop of the execution

In the debug tool, there is a function to measure the program execution time (Run-Break time) from the start to the stop.
Therefore, when the program starts its execution, the execution time is automatically measured. 
You can check the result of the measurement by either one of the following. 

Caution The execution time cannot be measured when Step In or Step Over is performed.

Remark This function is operated by a Run-Break Timer event, which is one of the built-in events set by default in 
the debug tool.The Run-Break timer event is always Valid state (settings not changeable).

(1) Check in the status bar 
After the program is stopped, the result of the measurement is displayed in the status bar on the Main window 
(when measurements have not been performed yet, "Not measured" is displayed). 

Figure 2.135 Example of Result of Run-Break Timer Event (Status Bar) 

The result of the measurement 
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(2) Check on the Events panel
After the program is stopped, the result of the measurement is displayed in the Events panel that is opened by 
selecting the [View] menu >> [Event], in event type as "Run-Break Timer".

Figure 2.136 Example of Result of Run-Break Timer Event (Events Panel)

2.12.3  Measure execution time in a section [IECUBE][Simulator]

In the program execution process, the execution time in a section can be measured by setting Timer Result event.  This 
Timer Result event consists of a timer start event and a timer end event. 

To use this function, follow the procedure described below. 

2.12.3.1  Set a Timer Result event
2.12.3.2  Execute the program
2.12.3.3  Edit a Timer Result event
2.12.3.4  Delete a Timer Result event

Caution 1. [E1][E20][EZ Emulator]
Timer Result event is not supported. 

Caution 2. Also see "2.15.7  Notes for setting events" for details on Timer Result events (e.g. limits on the number of 
enabled events). 

2.12.3.1  Set a Timer Result event

To set a Timer Result event, set a timer start event and a timer end event that starts/stops a timer measurement. 
Use one of the following methods to set a timer start event and a timer end event.

(1) For execution-related events
Perform this operation in the Editor panel/Disassemble panel in which the source text/disassembly text is dis-
played. 
Follow the operation listed below from the context menu, in accordance with your desired event type, after moving 
the caret to the target line that has a valid address.

Caution [Simulator]
Simulator will not include the time for a timer end event in the measurement results.  For this rea-
son, set a timer end event to one line below the range for which you wish to measure the run time.

A timer start event or a timer end event is set to the instruction at the start address corresponding to the line of the 
caret position.
Once a timer start event or a timer end event is set, the following event mark is displayed in the event area of the 
line that an event is set.

Event Type Operation

Timer start Select [Timer Settings] >> [Start Timer] 

Timer end Select [Timer Settings] >> [Stop Timer] 
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Table 2.14 Event Marks of Timer Start Event/Timer End Event

Figure 2.137 Timer Start and Timer End Events Setting Example (Disassemble Panel)

(2) For access-related events 
In this product version, this function is not supported. 

When a timer start event and a timer end event are set, they are managed collectively on the Events panel as one 
instance of a Timer Result event (see "2.15  Manage Events").  When you click the "+" mark at a Timer Result event item, 
detailed information on the timer start event and the timer end event you have set is displayed. 

Figure 2.138 Example of Timer Start and Timer End Events (Execution Type) in Events Panel 

Remark Event marks differ depending on the event state (see "2.15.1  Change the state of set events (valid/
invalid)"). 
When an event is set at the point which other event is already set, the event mark (  ) is displayed 
meaning more than one event is set at the point. 

2.12.3.2  Execute the program

Execute the program (see "2.7  Execute Programs"). 
When an instruction for which a timer start event or a timer end event has been set is executed, a timer measurement is 

started or finished.
After the program is stopped, the result of the measurement is displayed in the Events panel that is opened by selecting 

the [View] menu >> [Event], in event type as "Timer Result". 
This Timer Result is a particular type of event that is displayed on only the Events panel when either a timer start event 

or a timer end event has been set. 

Event Type Event mark

Timer start

Timer end

Event area

Indicates that a timer 
start event has been set.

Indicates that a timer 
end event has been set.
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Figure 2.139 Example of Result of Timer Result Event (Timer Start Event/Timer End Event) 

2.12.3.3  Edit a Timer Result event

It is possible to edit a timer start event or a timer end event you have set. 
For details on how to do it, see "2.15.4.1  Edit execution-related events".

2.12.3.4  Delete a Timer Result event

To delete a Timer Result event you have set, on the Editor panel/Disassemble panel, right-click the event mark in the 
event area and select [Delete Event] from the context menu that is displayed. 

Also, there is another way to delete a set event.  Select the Timer Result event you want to delete on the Events panel, 
and then click the  button in the toolbar (see "2.15.5  Delete events").

Caution It is not possible to delete only a timer start event or a timer end event (i.e. if either a timer start event or 
a timer end event is deleted from the event marks on the event area, all of the corresponding event 
marks are deleted).

2.12.4  Measurable time ranges

The scope of time that can be measured via timers using Run-Break Timer events (see "2.12.2  Measure execution time 
until stop of the execution" for details) or Timer Result events (see "2.12.3  Measure execution time in a section 
[IECUBE][Simulator]" for details) is shown below. 

If the maximum measurable length of time is exceeded, a timer-over break is generated, and program execution stops. 

Table 2.15 Measurable Time Ranges

Debug Tool Run-Break Timer Event Timer Result Event

IECUBE Min. 8 ns Min. 8 ns 

Max. Approx. 40 hours 43 min
Overflow detection included

Max. Approx. 40 hours 43 min (time for 4K 
cycles)
Maximum pass count: 4294967295 times
Overflow detection included

E1/E20
EZ Emulator

Min. 100 s -

Max. Approx. 119 hours 18 min 

Simulator Depends on the clock frequency for timer/
trace

Depends on the clock frequency for timer/trace
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2.13  Measure Coverage [IECUBE][Simulator]

This section describes coverage measurements that are conducted using the coverage function. 
There are several kinds of coverage measurement methods.  Of these, CS+ performs, in areas designated below, a 

code coverage measurement of fetch-related operations on source lines and functions (C0 coverage) and a data cover-
age measurement of access-related operations on variables. 

The area in which CS+ performs coverage measurements are as follows:

Table 2.16 Subject Areas of Coverage Measurement 

Caution [E1][E20][EZ Emulator]
The coverage function is not supported. 

Remark C0 coverage: Instruction coverage (statement coverage)
For example, if all instructions (statements) in code are executed at least once, then C0 = 100%.

2.13.1  Configure the coverage measurement

You need to configure the code coverage measurement before using the coverage function. 
The setting method differs depending on the debug tool used.

2.13.1.1  [IECUBE]
2.13.1.2  [Simulator]

2.13.1.1  [IECUBE]

You can configure the coverage measurement in the [Coverage] category on the [Debug Tool Settings] tab of the Prop-
erty panel as follows:

Figure 2.140 [Coverage] Category [IECUBE]

(1) [Reuse coverage result]
The currently obtained results of code coverage measurements are automatically saved when CS+ is discon-
nected from the debug tool.  The next time it is connected to the debug tool, specify from the drop-down list 
whether or not you want to reproduce the contents of saved measurement results.
Select [Yes] to reproduce the contents of previously obtained code coverage measurement results (default: [No]).
The file that saves results of code coverage measurements (raw.csr.cv) will be created in the folder where the load 
module file currently being downloaded exists.

2.13.1.2  [Simulator]

You can configure the coverage measurement function in the [Coverage] category on the [Debug Tool Settings] tab of 
the Property panel as follows:

Figure 2.141 [Coverage] Category [Simulator]

(1) [Use coverage function]
Select whether to use the coverage function.
Select [Yes] to use the coverage function (default: [No]). 

Debug Tool Code Coverage Measurement Area

IECUBE Internal ROM/RAM, DataFlash, Target memory

Simulator Internal ROM/RAM, Emulation ROM/RAM, Target memory
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(2) [Reuse coverage result]
This property appears only when the [Use coverage function] property is set to [Yes]. 
The currently obtained results of code coverage measurements are automatically saved when CS+ is discon-
nected from the debug tool.  The next time it is connected to the debug tool, select whether or not you want to 
reproduce the contents of saved measurement results.
Select [Yes] to reproduce the contents of previously obtained code coverage measurement results (default: [No]). 

2.13.2  Display the coverage measurement result

When the program starts running, a coverage measurement is automatically begun, and when the program stops run-
ning, the coverage measurement is terminated at the same time.

(1) Code coverage rates

(a) Display of code coverage rates for source text lines and disassembled text lines
The code coverage rates are indicated on the Editor panel/Disassemble panel that is displaying the target pro-
gram. 
On each panel, the target source text lines and disassembled result lines are shown in color-coded background 
(see "Table 2.18") according to their code coverage rate that was calculated based on the formula described in 
"Table 2.17".
Note that the results are not shown when disconnected from the debug tool or during the program execution.
Selecting [Clear coverage information] from the context menu in the Editor panel/Disassemble panel will reset 
all the coverage information acquired, including the color-coded display on each panel.

Table 2.17 Method for Calculating Code Coverage Rates for Source Lines and Disassemble Lines

Table 2.18 View of Code Coverage Measurement Result (Default)

Remark 1. The code coverage measurement result displayed on each panel is automatically updated at 
every program break. 

Remark 2. The above background colors depend on the configuration in the [General - Font and Color] cat-
egory of the Option dialog box. 

Remark 3. The above background colors do not apply to the lines that are outside of the subject area (see 
"Table 2.16  Subject Areas of Coverage Measurement"). 

Remark 4. If the downloaded lode module file is older than the source file currently being open, the display-
ing of the code coverage measurement result is not performed in the Editor panel. 

Panel Calculation Method

Editor panel "Number of bytes of code executed in the address range corresponding to the source 
text line" / "Total number of bytes of code in the address range corresponding to the 
source text line"

Disassemble panel "Number of bytes of code executed in the address range corresponding to the disas-
sembled text line" / "Total number of bytes of code in the address range correspond-
ing to the disassembled text line"

Code Coverage Background Color

100 %

1 to 99 %

0 % (not yet executed)

 Source text/disassembled text

 Source text/disassembled text

 Source text/disassembled text
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Figure 2.142 View of Code Coverage Measurement Result (Editor Panel)

Figure 2.143 View of Code Coverage Measurement Result (Disassemble Panel)

(b) Display of code coverage rates for each function 
Code coverage rates of each function can be checked via the [Code Coverage[%]] item in the Function List 
panel of the analyze tool.  For details on "the code coverage rates of the function", see "CS+ Integrated Devel-
opment Environment User's Manual: Analysis". 

(2) Data coverage rates 
Data coverage rates of each variable can be checked via the [Data Coverage[%]] item in the Variable List panel of 
the analyze tool.  For details on "the data coverage rates of the variable", see "CS+ Integrated Development Envi-
ronment User's Manual: Analysis". 

Code on this line has been executed by 100%

Code on this line has been executed by 0%
 (not yet executed)

Code on this line has been executed by 100%

Code on this line has been executed by 0%
 (not yet executed)
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2.14  Set an Action into Programs

This section describes how to set the specified action into the program.

2.14.1  Inset printf

By setting a Printf event that is one of "action events", the value of the specified variable expression can be output to the 
Output panel by executing a printf command after temporarily stopping the program in execution at an arbitrary position. 

To use this function, follow the steps below. 

Caution 1. Also see "2.15.7  Notes for setting events" for details on action events (e.g. limits on the number of 
enabled events). 

Caution 2. No action events occur during step execution (  /  /  ) or execution ignoring break-related 
events (  ).

Caution 3. [Simulator]
When [Yes] is specified with the [Execute instruction at breakpoint when break] property in the [Break] 
category on the [Debug Tool Settings] tab in the Property panel, all of action events currently being set 
are handled as Hardware Break events (i.e. no Printf events occur).

(1) Set a Printf event
Set a Printf event to the position where you want to execute the printf command in the Editor panel/Disassemble 
panel. 
On each panel, select [Register Action Event...] from the context menu after moving the caret to the line that has a 
valid address to open the Action Events dialog box below. 
In this dialog box, follow the steps below. 

Figure 2.144 Set Printf Event (Action Events Dialog Box: [Printf event] tab)

(a) Specify [Output string] 
Directly enter from the keyboard the characters to add when output to the Output panel. 
Characters must be in one line (spaces allowed). 

(b) Specify [Variable expression] 
Specify the variable expression for the Printf event to take place. 
Type a variable expression directly into the text box (up to 1024 characters). 
You can specify up to 10 variable expressions for a single Printf event by separating them with commas ",". 
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If this dialog box opens with a variable expression selected in the Editor panel/Disassemble panel, the selected 
variable expression appears as the default. 
For the basic input format that can be specified as variable expressions and the values output by Printf event, 
see "Table A.13  Relationship between Variable Expressions and Output Value (Printf Event)". 

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + 
[Space] key in this text box (see "2.19.2  Symbol name completion function"). 

(c) Specify [Address] 
Specify the address at which to set the Printf event.
The address of the location currently being specified is displayed by default. 
If you want to edit this area, you can either type an address expression directly into the text box (up to 1024 
characters), or select them from the input history via the drop-down list (up to 10 items). 

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + 
[Space] key in this text box (see "2.19.2  Symbol name completion function"). 

(d) Click the [OK] button
Set the Printf event to the line/address at the caret position in the Editor panel/Disassemble panel. 
When the Printf event is set, the  mark is displayed in the event area on the Editor panel/Disassemble panel, 
and the set Printf event is managed in the Events panel (see "2.15  Manage Events"). 

(2) Execute the program 
Execute the program (see "2.7  Execute Programs"). 
By executing the program, the program momentarily stops immediately before executing the instruction at the 
location where this event is set, and the value of the variable expression specified in this dialog box is output to the 
Output panel. 

(3) Check the output result
The output result format from the Printf event in the [Debug Tool] tab of the Output panel are as follows (see "Fig-
ure A.23  Output Result Format of Printf Event").

Figure 2.145 Example of Output Result of Printf Event 

(4) Edit the Printf event
You can edit the Print event that has been set once. 
To do this, on the Events panel, select [Edit Condition...] from the context menu after selecting the Printf event to 
be edited.  On the Action Events dialog box opened automatically, edit the items, and then click the [OK] button. 

[Output string]:         Sample= 
[Variable expression]:   global_a
The result of the specification above 
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2.15  Manage Events

An event represents a certain status of the target system when debugging such as "Address 0x1000 is fetched" and 
"Data is written to address 0x2000". 

In CS+, these events are used as the action trigger of the debug function such as breakpoint, start/stop the tracing, and 
start/stop the timer. 

This section describes how to manage those events. 
Select the [View] menu >> [Event]. 
Events are all managed in the Events panel.  In the Events panel, you can confirm the details of the currently set events 

in a list, and they can be deleted and changed enable/disable status. 
For details on the contents and function in each area, see the section for the Events panel. 

Figure 2.146 Manage Events (Events Panel) 

(1): [Name] area
(2): [Detail Information] area
(3): [Comment] area

Remark For details on how to set various events, see the section below:

- Set a breakpoint

- Set a break event (execution type)

- Set a break event (access type)

- Set a Trace event

- Set a Point Trace event

- Set a Timer Result event

2.15.1  Change the state of set events (valid/invalid)

By changing the check on the check box of the event name, the setting state of the event can be changed (the Event 
mark is changed depending on the setting state of the event). 

The following are types of the setting state of the event. 

Figure 2.147 Event Name Check Box

(1): Check box
(2): Event mark
(3): Event name

(2)(1) (3)

Toolbar

(1) (2) (3)
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Table 2.19 Setting State of Event

Remark 1. Both of the timer start event and the timer end event is must be set for the Timer Result event.  There-
fore, it is not possible to set a particular event to a valid state by only the setting of one of these (at the 
same time as both events are set, they are treated as grouped events as a Timer Result). 

Remark 2. It is not possible to set the Run-Break Timer event to an invalid/suspended state. 

Remark 3. The setting state of the event can be changed from the menu displayed by right clicking on the Event 
mark in the Editor panel/Disassemble panel. 

Remark 4. The setting of the Unconditional Trace event and the Trace event to valid or invalid state is exclusively 
controlled.  Therefore, the Unconditional Trace event, which is a built-in event, is valid state by default, 
but if either a trace start event/trace end event is set, it automatically becomes invalid state, and the 
Trace event, which is a event name that is collectively called with a trace start event and a trace end 
event, becomes valid state.  Conversely, if the set Trace event is invalid state, the Unconditional Trace 
event automatically becomes valid state.

2.15.2  Display only particular event types

Click on the toolbar button to display only the particular event type. 

Note [E1][E20][EZ Emulator]
This button is available only when the selected microcontroller incorporates the OCD trace function.

2.15.3  Jump to the event address

Clicking the following buttons jumps to each panel which selected events address exist. 
Note however, that when a Trace event/Timer Result event/ Unconditional Trace event/ Run-Break Timer event is 

selected, these buttons are disabled. 

Valid state Event occurs when the specified condition is met. 
It is possible to set the event to an invalid state by removing the check. 

Invalid state Event does not occur when the specified condition is met. 
It is possible to set the event to a valid state by removing the check. 

Suspended State The conditions that have been specified cannot be set with the program of the debug-
ging target.  It is not possible to operate the check box. 

Displays events related to the Hardware Break.

(except [Simulator])
Displays events related to the Software Break. 

Displays events related to the traceNote. 

[IECUBE][Simulator]
Displays events related to the timer.

Displays events related to the action event (Printf event). 

Displays the built-in events (Unconditional Trace event and Run-Break Timer event). 

Opens the Editor panel and jumps to the source line corresponding to the address 
where the selected event is being set. 

Opens the Disassemble panel and jumps to the disassemble results corresponding to 
the address where the selected event is being set. 

Opens the Memory panel and jumps to the source line corresponding to the address 
where the selected event is being set. 
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2.15.4  Edit detailed settings of events

This section describes how to edit detailed settings of various events. 

2.15.4.1  Edit execution-related events
2.15.4.2  Edit access-related events
2.15.4.3  Edit combination conditions of events [E1] [E20]

Remark For information on editing of action events (Printf events and interrupt events), see "2.14  Set an Action 
into Programs".

2.15.4.1  Edit execution-related events

The address condition and pass count condition [IECUBE][Simulator] for execution-related events you have set can be 
edited.

Perform this operation in the Detail dialog box (for execution events) that is opened by selecting [Edit Condition...] from 
the context menu after moving the caret to an execution-related eventNote you want to edit on the Events panel. 

Note An execution-related event refers to any one of the following events in the Events panel.

- Hardware Break event (execution type)

- Execution-related break event in detailed information on Combination Break event [E1][E20]

- Execution-related event as start and end condition in detailed information on Trace event

- Execution-related event as start and end condition in detailed information on Timer Result event 
[IECUBE][Simulator]

Figure 2.148 Example of Detail Dialog Box (for Execution Events) [Simulator]

(1) Editing [Address Condition]
You can edit the address condition for an execution-related event in this area. 

Figure 2.149 [Address Condition] [IECUBE]

Figure 2.150 [Address Condition] [E1][E20][EZ Emulator]
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Figure 2.151 [Address Condition] [Simulator]

- For [IECUBE][Simulator]
From the [Compare condition] drop-down list, select the type of condition for address comparison. 
After that, specify the address for use with the selected type of condition in the field displayed under the list.

It is possible to specify the value of an address mask for the specified address value [Simulator]. 
In this case, specify [Yes] in the [Use the address mask], and specify the mask value in the [Mask value] field 
under the list by directly entering a hexadecimal address.

- For [E1][E20][EZ Emulator]
In [Address], the address at which the execution-related event is currently set is displayed. 
To edit this address, directly enter an address expression for the address value at which you want to set the 
event. 

(2) Editing [Pass Count] [IECUBE][Simulator]
You can edit the pass count condition for an execution-related event in this area. 
Directly enter a pass count value in decimal notation between 1 and 65535.

Figure 2.152 [Pass Count]

Caution [IECUBE]
A value other than "1" cannot be specified as the pass count condition for an execution-related 
event (before execution). 

2.15.4.2  Edit access-related events

The address condition, data condition and pass count condition [IECUBE][Simulator] for access-related events you 
have set can be edited.

Perform this operation in the Detail dialog box (for access events) that is opened by selecting [Edit Condition...] from the 
context menu after moving the caret to an access-related eventNote you want to edit on the Events panel. 

Note An access-related event refers to any one of the following events in the Events panel.

- Hardware Break event (access type)

- Access-related break event in detailed information on Combination Break event [E1][E20]

- Access-related event as start and end condition [E1][E20] in detailed information on Trace event

- Access-related event in detailed information on Point Trace event 

List of [Compare condition] Setting Method

Specified address (==) After selecting any of these conditions, directly enter an address 
expression as the address value in the [Address] field displayed under 
the list for selection of the type of comparison.Greater than or equal to (>=)

Less than or equal to (<=)

Inside the range (<=Values<=) After selecting any of these conditions, directly enter an address 
expression as the address range in the [Start address] and [End 
address] field displayed under the list for selection of the type of com-
parison.

Outside the range !(<=Values<=)
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Figure 2.153 Example of Detail Dialog Box (for Access Events) [Simulator]

(1) Editing [Address Condition]
You can edit the address condition for an execution-related event in this area. 

Figure 2.154 [Address Condition] [IECUBE]

Figure 2.155 [Address Condition] [E1][E20][EZ Emulator]

Figure 2.156 [Address Condition] [Simulator]

- For [IECUBE][Simulator]
From the [Compare condition] drop-down list, select the type of condition for address comparison. 
After that, specify the address for use with the selected type of condition in the field displayed under the list.

It is possible to specify the value of an address mask for the specified address value [Simulator]. 

List of [Compare condition] Setting Method

Specified address (==) After selecting any of these conditions, directly enter an address 
expression as the address value in the [Address] field displayed under 
the list for selection of the type of comparison.Greater than or equal to (>=)

Less than or equal to (<=)

Inside the range (<=Values<=) After selecting any of these conditions, directly enter an address 
expression as the address range in the [Start address] and [End 
address] field displayed under the list for selection of the type of com-
parison.

Outside the range !(<=Values<=)
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In this case, specify [Yes] in the [Use the address mask], and specify the mask value in the [Mask value] field 
under the list by directly entering a hexadecimal address.

- For [E1][E20][EZ Emulator]
In [Address], the address at which the access-related event is currently set is displayed. 
To edit this address, directly enter an address expression for the address value at which you want to set the 
event.

(2) Editing [Data Condition]
You can edit the data condition for an access-related event in this area. 

Figure 2.157 [Data Condition]

(a) Specify an access type
In [Access type], select an access type from the following drop-down list. 

(b) Specify an access size
In [Access size], select an access size from the following drop-down list. 

(c) Specify a data comparison condition
From the [Compare condition] drop-down list, select the type of condition for data comparison. 
After that, specify the value of data for use with the selected type of condition in the field displayed under the list.

- For [IECUBE][Simulator]

- For [E1][E20][EZ Emulator]

Read When a read access occurs, the condition holds true.

Write When a write access occurs, the condition holds true.

Read/Wrote When a read or write access occurs, the condition holds true.

No conditions When an access in any size occurs, the condition holds true.

1byte When an access in 1-byte size occurs, the condition holds true.

2byte When an access in 2-byte size occurs, the condition holds true.

No conditions Comparison data is not specified.

Specified value (==) After selecting any of these conditions, directly enter a value in hexa-
decimal number in the [Data] field displayed under the list for selection 
of the type of comparison.Any other value (!=)

Greater than or equal to (>=)

Less than or equal to (<=)

Inside the range (<=Values<=) After selecting any of these conditions, directly enter values in hexa-
decimal number for the data range in the [Data] field displayed under 
the list for selection of the type of comparison.Outside the range !(<=Values<=)

No conditions Comparison data is not specified.

Specified value (==) After selecting this, directly enter a value in hexadecimal number in the 
[Data] field displayed under this field. 
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(d) Specify a data mask
Select [Yes] in the [Use the data mask] field to specify a mask value for the matching of data values. When [Yes] 
is selected, a [Mask value] field appears below the [Use a data mask] field. Specify a hexadecimal value with no 
more than five digits for the data mask by directly entering it in the [Mask value] field.

(3) Editing [Pass Count] [IECUBE][Simulator]
You can edit the pass count condition for an access-related event in this area. 
Directly enter a pass count value in decimal notation between 1 and 65535.

Figure 2.158 [Pass Count]

2.15.4.3  Edit combination conditions of events [E1] [E20]

Edit the combination condition for a combination break event comprised of multiple events set. 

Caution This function is enabled only when the selected microcontroller supports combination break events.

Perform this operation in the Combination Condition dialog box [E1][E20] that is opened by selecting [Edit Condition...] 
from the context menu after moving the caret to a combination break event you want to edit on the Events panel. 

Figure 2.159 Example of Combination Condition Dialog Box

(1) Editing [Combination] area
Select the combination condition from the following drop-down list. 

Caution When [OR] is selected, up to two break events can be specified.
When [Sequential] is selected, break event can be specified for the 1st to the 2nd position.

(2) Editing [Object event] area
This area displays details on the break event set as a combination break event.

OR The condition is satisfied when one of the set events is encountered (default).

Sequential The condition is satisfied when the set events are encountered in the specified sequence.



CS+ V8.04.00 2.  FUNCTIONS

R20UT4692EJ0100  Rev.1.00 Page 134 of 411
Jun 01, 2020

When [Sequential] is specified in the [Combination] area, the order of display here corresponds to the order in 
which the conditions are to be satisfied.  To change the order, select a target event and click on the [Up] or [Down] 
buttons.

(3) Editing [Reset event] area
Reset events are always enabled.

2.15.5  Delete events

To delete any event and event condition you have set, select the event and click the  button on the toolbar. 
Note that it is not possible to delete the built-in events (Unconditional Trace event and Run-Break Timer event). 

Remark 1. For the Break event of execution type, it is possible to delete the set event to click the event mark dis-
played in the Editor panel/Disassemble panel. 

Remark 2. To delete all of the events and event conditions you have set at a time, select [Select All] from the context 
menu, then click the  button (note, however, that it is not possible to delete the built-in events). 

2.15.6  Write comment to events

The user can write comments for each event that has been set. 
To input comments, click the [Comment] area after selecting the event to input comments, then input directly the desired 

text from the keyboard (the edit mode is cancelled by pressing the [Esc] key). 
After editing the comments, complete the editing by pressing the [Enter] key or moving the focus to outside the edit 

region. 
Up to 256 characters can be inputted for the comments, and this is saved as the settings of the user during use. 

2.15.7  Notes for setting events

This section describes notes for setting each type of event. 

2.15.7.1  Maximum number of enabled events
2.15.7.2  Event types that can be set and deleted during execution
2.15.7.3  Other notes

2.15.7.1  Maximum number of enabled events

The number of events that can be set to Valid state simultaneously are subject to the following limitations.
Therefore, if this limit is exceeded when you set one or more new valid state events, some of the events that are already 

set need to be Invalid state before you can set a new one.
The meaning of numbers in the table below is as follows:

Table 2.20 Maximum Number of Enabled Events

x + y "Hardware Break (after execution): x" + "Hardware Break (access): y"

Event Type Debug Tool to Use

IECUBE E1/E20/EZ Emulator Simulator

Without OCD Trace Function With OCD 
Trace Function

8-bit bus width 
products

Except for 8-bit 
bus width products

Hardware Break
(before execution) 

4 to 8Note 1 0 0 0 64Note 4

Hardware Break
(after execution) 

8 2 1Note 2 2Note 3

Hardware Break
(access) 

8 0
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Note 1. Depending on the address and instruction to which the event is set (however, Hardware Break (before 
execution) cannot be used in RAM area). 

Note 2. A Hardware Break (after execution) and a Software Break are combined use.

Note 3. A Hardware Break and a Trace are exclusive of each other (i.e. if one is set, then the other will become 
invalid).  Total of 2 events (a trace start and a trace end) are available for a Trace.

Note 4. The before break/after break can be specified in the Property panel.

Note 5. In this version, only one group can be set (however, two or more Start/Stop events can be set).

Note 6. In this version, only one can be set (however, two or more conditions for this event can be set).

Note 7. Combination with Software Break events (however, up to 100 can be set regardless of their valid/invalid 
state). 

Note 8. Combination with Hardware Break events (before execution) (however, up to 64 can be set regardless of 
their valid/invalid state).

2.15.7.2  Event types that can be set and deleted during execution

Types of events that can be set or removed during execution of the program or during execution of the tracer/timer are 
described below. 

The meaning of each mark in the table below is as follows:

Software Break 2000 0 2000 -

Trace 
(trace start/trace end)

4 + 4Note 5 - - 2Note 3 32Note 5

Point Trace 8 + 8Note 6 - - 0 64Note 6

Timer Result 
(timer start/timer end)

4 + 4Note 5 - - - 1

Action (Printf) 100Note 7 0 100Note 7 64Note 8

Possible

Possible, if the program execution is allowed to pause for events
(Property panel >> [Debug Tool Settings] tab >> [Set Event While Running] category >> [Set 
event by stopping execution momentarily] property >> [Yes])

Impossible while tracer or timer is executing 

- Impossible, or not supported

Event Type Debug Tool to Use

IECUBE E1/E20/EZ Emulator Simulator

Without OCD Trace Function With OCD 
Trace Function

8-bit bus width 
products

Except for 8-bit 
bus width products
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Table 2.21 Event Types That Can be Set and Deleted during Execution

2.15.7.3  Other notes

- No events can be set to local variables. 

- Events do not occur during step execution (including return execution) and program execution by selecting [Go to 
Here] from the context menu. 

- If the location set for an existing event changes to midway in an instruction because the program to debug has been 
downloaded again, re-set the event using the following method.

- If debugging information is available:
The location setting of events is always moved to the beginning of the source text line. 

- If debugging information is not available:
Depends on the [Automatic change method of event setting position] property in the [Download] category on the 
[Download File Settings] tab of the Property panel. 

- If a change to internal ROM/RAM changes the location the event is set to a non-mapped area, then set events will not 
occur (they will also not change to Invalid state /Suspended State on the Events panel).

- If you differentiate function or variable names by leading underscores, then CS+ may misrecognize them, and convert 
symbols or make break event settings invalid. This applies for cases like when you have two functions, one named 
"_reset" and the other named "__reset".

- If there is code (text sections) to be ROMified, any software break event set for that code will be deleted during copy 
to RAM.  For this reason, no break will occur. 

- For other than [Simulator]
Use a hardware break event. 

- [Simulator]
Execution will not break even if a hardware break event is used, but it will break if the trace function or the timer 
function is valid (on the [Debug Tool Settings] tab of the Property panel, specify [Yes] with the [Use trace func-

Event Type Debug Tool to Use

IECUBE E1/E20/EZ Emulator Simulator

Without OCD Trace Function With OCD 
Trace Function

8-bit bus width 
products

Except for 8-bit 
bus width products

Hardware Break
(before execution) 

- - -

Hardware Break
(after execution) 

Hardware Break
(access) 

-

Software Break - - - -

Trace 
(trace start/trace end)

- - - -

Point Trace - - - -

Timer Result 
(timer start/timer end)

- - - -

Action (Printf) - - - -
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tion]/[Use timer function] property on the [Trace]/[Timer] category). 

- For other than [IECUBE]
If a software break event is set in a boot-swap area, then a break instruction will be written to the flash ROM.
For this reason, a break instruction will remain after the boot swap.

- [E1][E20][EZ Emulator]
Use a hardware break event in a boot-swap area if you wish to.

- [Simulator]
Do not use a break event in a boot-swap area.

- For other than [Simulator]
Hardware Break events with access conditions and Point Trace events [IECUBE] cannot be set for 32-bit (4-byte) 
variables. 
Additionally, Hardware Break events with access conditions and Point Trace events [IECUBE] cannot be detected if a 
single byte of a 16-bit (2-byte) variable is accessed. 
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2.16  Use Hook Function

This section describes how to set hooks in the debug tool by using the hook function. 
By setting a hook transaction, you can automatically change the values of the SFR/CPU register before and after down-

loading a load module or after resetting the CPU. 
Configure the hook transaction in the [Hook Transaction Settings] category on the [Hook Transaction Settings] tab of the 

Property panel. 

Remark By setting a SFR by using the [Before download] property, for example, downloading can be executed at 
high speeds. Downloading to the external RAM is also facilitated by using this function. 

Figure 2.160 [Hook Transaction Settings] Category

Table 2.22 Properties in [Hook Transaction Settings] Category

The properties in the [Hook Transaction Settings] category indicate the timing with which the hook process will be per-
formed.  "[]" indicates the current number of specified processes (no hook processes are configured by default). 

Specify the target process in the property for which you want the hook process to be performed. 
To specify a process, select the target property, then open the Text Edit dialog box by clicking the [...] button that 

appears on the right edge of the field. 

Figure 2.161 Opening Text Edit Dialog Box

Figure 2.162 Use Hook Function (Text Edit Dialog Box)

In this dialog box, directly enter the desired process from the key board. 

Property Description 

Before download Perform the specified process immediately before downloading the load module 
file. 

After download Perform the specified process immediately after downloading the load module file. 

After CPU reset under breaking Perform the specified process immediately after resetting the CPU under breaking. 

Before running Perform the specified process immediately before starting program execution. 

After breaking Perform the specified process immediately after breaking program execution. 
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The format for specifying processes is as follows:

[Process 1]:
Automatically overwrites the value of SFR with Value.
Specification format:

[Process 2]:
Automatically overwrites the value of CPU register with Value.
Specification format:

[Process 3]:
Automatically executes a script file which is specified with Python script path (absolute path or relative path from the 
project folder).
Specification format:

Caution You can use the following commands when you execute the Python script in the Hook process of the 
debugger.  Note that if you want to use other Python command, please use Hook command in the Python 
console.

- debugger.Register.GetValue

- debugger.Register.SetValue

- debugger.Memory.GetValue

- debugger.Memory.SetValue

Remark 1. When specifying hook processes, lines starting with a hash mark "#" will be treated as comments. 

Remark 2. A tab character can be used instead of the space character. 

Up to 64 characters for one process, and up to 128 processes for each property can be set (one line in the [Text] area in 
the Text Edit dialog box is equivalent to one processing). 

After the specification of the process is complete, click the [OK] button to set the process to the Property panel. 

Figure 2.163 Example of Hook Transaction

SFR-name Value

CPU-register-name Value

Source Python-script-path
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2.17  Measuring Current Consumption [E2][Simulator]

Measurement of current consumption refers to measuring the amount of current consumption by a whole system to be 
debugged [E2] or peripheral modules of within the MCU [Simulator].

Remark Measuring current consumption by the simulator is only available for devices that have peripheral 
function simulations. Check which products are supported on the Renesas Web site.

[How to use]
The target for measurement differs between the use of the E2 emulator and the simulator.
The following explains the usage in both cases.

- With the E2 emulator

- With the simulator

- With the E2 emulator
In using the E2 emulator to measure current consumption, the current values in the target system as a whole are 
measured.
For measurement of current consumption, the facility for supplying power to the target by the E2 emulator and the E2 
expansion interface are used.
Accordingly, to use this facility, be sure to specify [Yes] for the [Power target from the emulator (MAX 200mA)] 
property and [Use supplied power from the emulator] for the [Interface for supplying the power] property on the 
[Connect Settings] tab in the Property panel before connecting the debug tool.

(1) Open the Measuring Current Consumption panel
Select [RL78 E2] as the debug tool, open the Solution List panel, and click on the [GO] button for measuring 
current consumption. The Measuring Current Consumption panel [E2][Simulator] will open.

Figure 2.164 Measuring Current Consumption Panel [E2]

(2) Set the conditions (measurement conditions, trigger conditions, and monitoring points)
In measuring current consumption, you can acquire the pattern of transitions for the current value to be detected 
by setting conditions in advance. The main settings that can be made in advance are measurement conditions, 
trigger conditions, and monitoring points.

Remark Conditions are set as follows by default.
Operation after record memory is full: Overwrite to the record memory and continue execution
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Sampling time: 10us
Acquisition condition: All
No external trigger is used.
No monitoring points are set.

If you only want to measure the current as a trial, start the procedure from "(3)  Start 
measurement".

(a) Set the measurement conditions
Set conditions regarding the recording of the measured current values in the Current Consumption 
Measurement Condition Setting dialog box [E2] which is displayed by clicking on  on the toolbar in the 
Measuring Current Consumption panel [E2][Simulator].

Figure 2.165 Current Consumption Measurement Condition Setting Dialog Box

<1> Select the operation after recording memory becomes full
Select any operation from among the following after the memory used to record the current values in the E2 
emulator becomes full.

- Overwrite to the record memory and continue execution

- Stop recording (continue to execute the program)

- Stop program

<2> Select the sampling time
Select the sampling time for use in measurement from among the following.

1us, 2us, 5us, 10us, 20us, 50us, 100us, 200us, 500us, 1ms

<3> Select the acquisition condition
An acquisition condition for recording the current values in the memory of the E2 emulator can be set so that 
recording only starts when the specific condition has been satisfied.
The condition can be selected as one of the following.

- All
Record all current values that have been sampled after starting measurement without specifying specific 
conditions.

- During detecting an external trigger input
This item selects recording in memory in response to the external trigger input facility of the E2 expansion 
interface only while the specified signal is being detected.
When this is specified, the channel for input of the external trigger to be detected and the level of the signal 
to be detected must be specified.
In addition, the external trigger input must have been correctly set before the debug tool is connected.

Remark For details on setting the external trigger input facility of the E2 expansion interface, refer to 
the Application Note on the Current Consumption Tuning Solution (E2 Emulator, CS+).

- During monitor points
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Specify the monitoring point to serve as the start condition in the left entry field and that to serve as the end 
condition in the right entry field against [Monitor points range].
The current values will be recorded from detection of the monitoring point specified as the start condition 
until detection of the monitoring point specified as the end condition.
For details on the monitoring points, refer to "(c)  Set monitoring points".

(b) Set the trigger condition
The E2 emulator is able to stop the program or output an external trigger signal in response to the value for 
current being measured satisfying a specific condition.
Set the trigger condition in the Current Consumption Measurement Trigger Condition Setting dialog box [E2], 
which is displayed by clicking on  on the toolbar in the Measuring Current Consumption panel 
[E2][Simulator].

Figure 2.166 Current Consumption Measurement Trigger Condition Setting Dialog Box

<1> Specify whether to use the trigger facility
Select the checkbox for [Use trigger function] to use the trigger facility.
This checkbox is de-selected by default.

<2> Set the trigger action
Select the operation when a trigger is detected as either of the following.

- Stop program
Stop execution of the program.
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- Output external trigger signal
Output an external trigger through the E2 expansion interface.

Also make the following settings if an external trigger is to be output.

- Select a channel
Specify the channel for output of the external trigger through the E2 expansion interface.

- Select the type of signal to be output
Select whether a high pulse is to be output in response to the condition being satisfied or output of the high 
level is to continue as long as the condition is being satisfied.
When a high pulse is to be output, also specify the pulse width.

Remark For details on the external trigger output facility, refer to the Application Note on the Current 
Consumption Tuning Solution (E2 Emulator, CS+).

<3> Set the trigger condition
Select the trigger condition for the current value as [Over Threshold], [Under Threshold], [In Range], or [Out of 
Range].
Specify the current value or range of current values to be detected as the trigger.

Caution For a range of current values, the value entered in the left field for entry must be lower than 
that in the right field.

As well as the condition for the current value, a sub-condition (condition for the detection width) regarding the 
time over which the condition is satisfied can be set. Specifying a width for detection can eliminate the 
detection of noise that temporarily satisfies the condition.
The condition for the detection width is selectable as [Over threshold] (detecting the current value when the 
condition continues to be satisfied for more than a specified time) or [In range] (detecting the current value 
when the condition is satisfied over a time within the specified range).

Specify a multiple of the sampling time as the detection width.
Note that the actual time for detection also depends on the sampling time.

(c) Set monitoring points
A monitoring point is a facility for recording a timestamp when a specified line of source code is run.
When monitoring points are set, transitions of the execution time and the current values at the monitoring points 
can be confirmed on a graph for measuring current consumption.
The monitoring points are indicated by colored vertical lines on the graph.

Remark Monitoring points are not supported for RL78/G10 devices.

Figure 2.167 Monitoring Point
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Monitoring points are set from [Monitor Point Setting] in the context menu after placing the cursor on the line of 
the target source code that was opened in the Editor panel.

Figure 2.168 Context Menu in the Editor Panel

A list of the monitoring points that are currently set is displayed under the Measuring Current Consumption 
panel [E2][Simulator].
The monitoring points that have been set are enabled or disabled by the leftmost checkbox in this list or from the 
context menu of the Editor panel.

Figure 2.169 List of Monitoring Points
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Monitoring points must be set at the addresses of NOP instructions. An attempt to set monitoring points at other 
instructions or the debug tool not being able to detect the NOP instruction even if it is set as a monitoring point 
leads to the monitoring points being forcibly disabled when measurement is started.
However, when the compiler in use for the project is V1.05.00 or later of CC-RL and when the source file is reg-
istered in the active project, the NOP instructions can be automatically inserted at the addresses where the 
monitoring points are set before measurement, rebuilding and downloading are enabled. In this case, 
monitoring points that have been set at any addresses are enabled. However, when the [CPU Reset after down-
load] property in the [Download] category on the [Download File Settings] tab in the Property panel is set to 
[Yes], note that the monitoring points are forcibly reset by rebuilding and downloading.

(3) Start measurement
Start measuring current consumption by the target system by using the facilities of the E2 emulator.
Click on  or  on the toolbar in the Measuring Current Consumption panel [E2][Simulator].

Figure 2.170 Toolbar in the Measuring Current Consumption panel [E2]

Caution Current consumption is not measured by clicking on  in the Main window.

(a) Clicking on 
The project is rebuilt and downloaded before measurement starts.
However, if the device does not support monitoring points or the compiler used in the active project is a version 
of CC-RL earlier than V1.05.00, rebuilding and downloading do not proceed.
When [Hold the build options for monitor point specified when measuring] in the Measuring Current 
Consumption panel [E2][Simulator] is selected, the options which are specified for rebuilding and downloading 
before measurement are reflected in the [Parameters of NOP instruction insertion for measuring current con-
sumption] property of the build tool.

(b) Clicking on 
The project is not rebuilt and downloaded before measurement starts.
Select this button when you want to measure current consumption without resets due to rebuilding and 
downloading.
Note that this button is not displayed if the device does not support monitoring points or the compiler used in the 
active project is a version of CC-RL earlier than V1.05.00.

(4) End measurement
Measurement ends at the same time as execution of the program is stopped.
Execution of the program can be stopped by setting a breakpoint or a trigger condition, or by clicking on .

(5) Display a graph
At the same time as measurement ends, a graph of current values showing the results of measurement is 
displayed in the graph display area of the Measuring Current Consumption panel [E2][Simulator].
Check that the current values that are shown are as intended.

In the panel, dragging a cursor (the red vertical line) shows the time and the current value at the cursor location in 
the information display area.
When the search facility is used, since the cursor is moved to the location where the search condition was 
satisfied, the time and the current value at that location can be confirmed.
Markers A and B (green vertical dashed lines) can also be dragged to confirm the average current and maximum 
current between the markers.
When a monitoring point is the target of the search, the location where processing to be confirmed was executed 
can be identified immediately.

- With the simulator
When current consumption is measured on the simulator, the current values in the MCU are simulated and displayed.

(1) Open the Measuring Current Consumption panel
Select [RL78 Simulator] as the debug tool, open the Solution List panel, and click on the [GO] button for 
measuring current consumption. The Measuring Current Consumption panel [E2][Simulator] will open.
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Figure 2.171 Measuring Current Consumption Panel [Simulator]

(2) Enable measurement of the current consumption
The facility for measuring current consumption is enabled or disabled by clicking on  on the toolbar in the 
Measuring Current Consumption panel [E2][Simulator].
Enabling the facility simulates the current values when the program is executed.

Figure 2.172 Toolbar in the Measuring Current Consumption Panel [Simulator]

Remark The facility for measuring current consumption is disabled immediately after the debug tool is 
connected.

(3) Start measurement
After the facility for measuring current consumption is enabled, measurement proceeds during normal execution 
of the debugger initiated by, for example, clicking on  or  on the toolbar in the Main window.

Remark Furthermore, measurement also proceeds in response to operations that place the debug tool in 
the execution state, e.g. source-level step execution.

(4) End measurement
Measurement ends at the same time as execution of the program is stopped.
Execution of the program can be stopped by setting a breakpoint, or by clicking on .

(5) Display a graph
At the same time as measurement ends, a graph of current values showing the results of measurement is 
displayed in the graph display area of the Measuring Current Consumption panel [E2][Simulator].
Check that the current values that are shown are as intended.

In the panel, dragging a cursor (the red vertical line) shows the time and the current value at the cursor location in 
the information display area.
When the search facility is used, since the cursor is moved to the location where the search condition was 
satisfied, the time and the current value at that location can be confirmed.
Markers A and B (green vertical dashed lines) can also be dragged to confirm the average current and maximum 
current between the markers.
In addition, hovering the mouse cursor over a point on the graph displays a pop-up window showing the current 
value in each peripheral module at that point. This makes it possible to confirm that the intended modules have 
been enabled.
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Figure 2.173 Displaying the Values for Current Consumption by Individual Modules
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2.18  Use the Simulator GUI [Simulator]

This section describes how to use the Simulator GUI. 
Note that the function of the Simulator GUI described in this section is only supported when a microcontroller whose 

Simulator supports peripheral function simulations is selected. Control the Simulator GUI via the Simulator GUI window 
below. 

This window appears automatically by default after connecting to the debug tool when a microcontroller whose Simula-
tor supports peripheral function simulations is selected and [Simulator] is selected as the debug tool to use.

Remark The Simulator GUI window and windows opened from it cannot be docked to the CS+ Main window. 

Figure 2.174 Using Simulator GUI (Simulator GUI Window) 

The setting of the display of the Simulator GUI window can be configured in the [Simulator GUI] category on the [Debug 
Tool Settings] tab of the Property panel as follows: 

Configure the appropriate settings. 

Caution After connecting to the debug tool, all the properties in this category will become invalid if a microcon-
troller whose Simulator does not support peripheral function simulations (instruction simulation version) 
is selected.

Figure 2.175 [Simulator GUI] Category

(1) [Display Simulator GUI]
Specify whether to display the Simulator GUI window from the drop-down list. 
Select [Yes] to use the function of the Simulator GUI (default). 
When you do not need to use the Simulator GUI, select [No] to close the Simulator GUI window. 

(2) [Display Simulator GUI on top of other windows]
This property appears only when the [Display Simulator GUI] property is set to [Yes]. 
Specify whether to display the Simulator GUI window in the forefront when program execution starts. Select [Yes] 
to display it in the forefront (default). 

2.18.1  Check the I/O waveform of the microcontroller

It is possible to check the I/O waveform of the microcontroller by clicking the  button on the Simulator GUI window's 
toolbar and opening the Timing Chart window (shown below). 

This window displays a timing chart of the input and output signals of the microcontroller's pins. 
See the section on the Timing Chart window for details about controlling the window. 
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Figure 2.176 Checking I/O Waveform of Microcontroller (Timing Chart Window)

2.18.2  Input signals to the pins

To configure the input signal to a pin, click the  on the Simulator GUI window's toolbar. The following Signal Data 
Editor window opens. 

You can use this window to set the input signal data for the input pin to a numerical value, to be input at an arbitrary 
time. 

See the section on the Signal Data Editor window for details about controlling the window. 

Figure 2.177 Configuring Input Signal to Pin (Signal Data Editor Window)

2.18.3  Perform serial communication

To configure serial communication, click the  on the Simulator GUI window's toolbar. The following Serial window 
opens. 

This window provides serial I/O features for communicating with the CPU's built-in serial interface. This enables you to 
input data to the microcontroller's serial receiver pin, and acquire output data from its serial transmitter pin. 

See the section on the Serial window for details about controlling the window. 
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Figure 2.178 Performing Serial Communication (Serial Window) 

2.18.4  Use buttons, LEDs, level gauges, and other components

The Simulator GUI allows input manipulation and output display simulation by providing standard connected parts (but-
tons, LEDs, level gauges, etc.) in which the I/O block for peripheral I/O designed as a GUI interface.

To configure connected parts, click the  on the Simulator GUI window's toolbar. The following I/O Panel window 
opens. 

This window enables you to configure the various connected parts, building a dummy target system. 
See the section on the I/O Panel window for details about controlling the window. 

Figure 2.179 Configuring Connected Parts (I/O Panel Window)
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2.19  About Input Value

This section describes consideration to take when inputting values in each panel and dialog box. 

2.19.1  Input rule

Following is the rules for input to each panel/dialog box. 

(1) Character set
Character sets that are allowed to input are as follows:

Table 2.23 List of Character Set

(2) Escape sequence
Escape sequences that are allowed to input are as follows:

Table 2.24 Escape Sequence List

(3) Number
Notations allowed when entering numbers are as follows:

Table 2.25 Notation List

Character Set Outline

ASCII 1- byte alphabets, numbers, symbols

Shift-JIS 2-byte alphabet, number, symbol, Hiragana, Katakana, Kanji and 1-byte Katakana. 

EUC-JP 2-byte alphabet, number, symbol, Hiragana, Katakana, Kanji and 1-byte Katakana. 

UTF-8 2-byte alphabet, number, symbol, Hiragana, Katakana, Kanji (include Chinese charac-
ters) and 1-byte Katakana. 

UTF-16 2-byte alphabet, number, symbol, Hiragana, Katakana, Kanji (include Chinese charac-
ters) and 1-byte Katakana. 

Escape Sequence Value Outline

\0 0x00 null character

\a 0x07 Alert

\b 0x08 Backspace

\t 0x09 Horizontal tab

\n 0x0A New line

\v 0x0B Vertical tab

\f 0x0C Form feed

\r 0x0D Carriage return

\" 0x22 Double-quotation mark

\' 0x27 Single-quotation mark

\? 0x3F Question mark handled as a question mark if ? is entered.

\\ 0x5C Backslash

Notation Outline

Binary number Start with 0b and continues with the numbers from 0 to 1.
(Case insensitive for alphabets)
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(4) Expression and operator
Expression represents constants, register name, SFR name and symbols and those connected with operators. 
An expression comes in two types: an address expression and a watch-expression. The expression that requires 
the address of a symbol is referred to as an address expression, and the one that requires the value of a symbol is 
referred to as a watch-expression.

(a) An address expression and operators
With an address expression, the address of a symbol is used to perform operations. Only when a CPU register 
name is written, the value of the symbol is used to perform operations.
The basic input formats of address expressions are as follows:

Table 2.26 Basic Input Format of Address Expressions

Note 1. It represents C language (C89/C99) variables.

Note 2. If the register is assigned the value of a C variable, an error results.

Note 3. The expression that is input as an index to an array is parsed as a watch-expression.

Note 4. If the label name or EQU symbol name includes a "$", be sure to enclose the name in "{ }" (e.g.  
{$Label}).
When you specify the CPU register name "I", add ":REG" (e.g. I:REG) to distinguish it from the 
keyword "I" that indicates an imaginary number.

From "2.19.2  Symbol name completion function", the following expressions with operator can be constructed. 

Table 2.27 Construction of Expressions with Operators

Octal number Start with 0 and continues with the numbers from 0 to 7.

Decimal Start without 0 and continues with the numbers from 0 to 9.

Hexadecimal number Start with 0x and continues with the numbers from 0 to 9 and alphabets a to f. 
(Case insensitive for alphabets) 
In the input area with the  mark, prefix 0x is not needed. 

Expression Description 

Name of a C language variableNote 1,2 Address of a C language variable

Expression [ExpressionNote 3] Address of an array

Expression.Member name Address of a structure/union/class member

Expression->Member name Address of a structure/union/class member that is pointed to

Name of a CPU register Value of the CPU register

Name of a SFR Address of the SFR

Label nameNote 4, EQU symbol nameNote 4 
and [immediate value]

Address of a label, a value of an EQU symbol, and an immedi-
ate address

Integer constant Address

Expression Description

(Expression) Value of the parenthetical watch-expression

! Expression Inverts symbol

- Expression Logical negation

~ Expression Bit inversion

Expression * ExpressionNote Multiplication

Notation Outline
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Note Variables and functions can be combined by an operator only with variables, functions and inte-
ger constants. 
Example: C variable name + SFR name

(b) Watch-expression and operator
With watch-expression, the value of a symbol is used to perform operations. Only when the value does not 
exist, the address of the symbol is used to perform operations (e.g. main( ) + 1). 
The basic input formats of watch-expressions are as follows:

Table 2.28 Basic Input Format of Watch-expressions

Note 1. It represents C language (C89/C99) variables.

Note 2. If the label name or EQU symbol name includes a "$", be sure to enclose the name in "{ }" (e.g. 
{$Label}). 
Any imaginary number must be multiplied by an uppercase "I" (e.g. 1.0 + 2.0*I). When you spec-
ify the CPU register name "I", add ":REG" (e.g. I:REG) to distinguish it from the keyword "I" that 
indicates an imaginary number.

From "Table 2.28  Basic Input Format of Watch-expressions", the following watch-expressions with operator 
can be constructed. For the operators listed in the table below, the expression is parsed according to C lan-
guage specifications.

Expression / ExpressionNote Division

Expression % ExpressionNote Remainder calculation

Expression + ExpressionNote Addition

Expression . ExpressionNote Subtraction

Expression & ExpressionNote Logical multiplication by bits

Expression ^ ExpressionNote Exclusive disjunction by bits

Expression | ExpressionNote Logical sum by bits

Expression Description 

Name of a C language variableNote 1 Address of a C language variable

Expression [Expression Element of an array

Expression.Member name Value of a structure/union/class member

Expression->Member name Value of a structure/union/class member that is pointed to

*Expression Value of pointer variable

&Expression Location address

Name of a CPU register Value of the CPU register

Name of a SFR Value of the SFR

Label nameNote 2, EQU symbol nameNote 2 
and [immediate value]

Values of a label, a value of an EQU symbol, and an immedi-
ate address

Integer constant Integer constant value

Floating constant Floating point constant value

Character constant Character constant value

Expression Description
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Table 2.29 Construction of Expressions with Operators

Note Variables and functions can be combined by an operator only with variables, functions and inte-
ger constants.
Example: C variable name + SFR name

Caution 1. When a char-type one-dimensional array is assigned to multiple locations in registers or memory as 
shown below, no character string will be displayed in the value column of the Watch panel or Local Vari-
ables panel even after the array "array" has been registered with the panel.
char array[5] = "ABCD";

Caution 2. When the selection for [Scope] in the Local Variables panel is not [Current], the values of variables 
assigned to registers are not displayed correctly. Editing these values is also not possible.

Caution 3. When a defined variable satisfies both of the conditions given below, the Watch panel and Local Vari-
ables panel indicate the location of the entire variable rather than the location of its member variables.

[Conditions]

<1> The variable is assigned to two or more addresses or registers (i.e. two or more addresses or registers are 
displayed in the address column).

<2> A structure-, class-, array-, or union-type member is defined in the variable.

[Example]

Display in the Watch and Local Variables panels:

Expression Description

(Expression) Specifies the order in which operations are performed

! Expression Inverts symbol

- Expression Logical negation

Expression * ExpressionNote Multiplication

Expression / ExpressionNote Division

Expression % ExpressionNote Remainder calculation

Expression + ExpressionNote Addition

Expression . ExpressionNote Subtraction

Expression & ExpressionNote Logical multiplication by bits

Expression ^ ExpressionNote Exclusive disjunction by bits

Expression | ExpressionNote Logical sum by bits

struct Mem {
    long m_base;
};
struct Sample {
    long m_a;
    struct Mem m_b; <- Condition <2>
};

main () {
    struct Sample obj;
}

"obj"                        -    { R1:REG, R2:REG }      (struct Sample)
    L m_a           0x00000000    { R1:REG }              (long)
    L m_b                    -    { R1:REG, R2:REG }      (struct Base)
        L m_base    0x00000000    { R2:REG }              (long)
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Caution 4. In case of a variable with the size beyond 0x10000, Value, Style and Address indicate "?" in the Watch 
panel.

2.19.2  Symbol name completion function

This function helps users input data by selecting one of the listed symbol names that exist in the program, when specify-
ing an address expression and so on.

The list of symbol names appears by pressing the [Ctrl] + [Space] keys when a part of the target symbol name is being 
input in the text box that supports this function.  In this list, double-click the target symbol name (or press the [Space]/
[Enter] key after selecting it by using the [Up]/[Down] key) to complement the symbol name currently being input.

At this time, if a key other than the [Space]/[Enter] key is pressed or the focus moves to outside the panel/dialog box cur-
rently being operated, then the list of symbol names will disappear (the symbol name completion will not be performed).

Caution 1. If there are no character strings in the text box or there are no candidates of the symbol, then the list of 
symbol names will not appear. 

Caution 2. Since the information for use by the symbol name completion function is generated while symbols are 
being downloaded, the time taken for downloading and the memory usage on the host machine will 
increase when this function is enabled.  Therefore, if you do not intend to use the symbol name comple-
tion function, we recommend invalidating this function by selecting [No] in the [Generate the information 
for input completion] item in the Download Files dialog box ([Yes] is selected by default).

Remark See the explanation of the corresponding panel/dialog box as to whether this function can be used or not 
when inputting a symbol name.

Figure 2.180 Symbol Name Completion Function

2.19.3  Icons for invalid input 

In some of the dialogs in CS+, the  icon will appear at a point where incorrect characters are entered as a warning 
sign.

Remark Placing the cursor over the  icon will pop up the information that indicates the characters to be 
entered.

Press the [Ctrl] + [Space] keys.

Select the target symbol name 
from this list displayed.
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A.  WINDOW REFERENCE

Appendix A provides detailed explanations of windows/panels/dialog boxes used for debugging with CS+.

A.1  Description

Windows/panels/dialog boxes for debugging are listed below. 

Table A.1 Window/Panel/Dialog Box List

Window/Panel/Dialog Box Name Description

Main window Controls the program execution.  Various windows, panels and dialogs 
can be opened from this window.

Project Tree panel Selects the debug tool to use. 

Property panel Displays detailed information on the debug tool currently selected in the 
Project Tree panel, and enables the settings of the tool to be changed.

Memory panel Displays and modifies memory values.

Disassemble panel Displays the results of memory value disassemble and is used to execute 
line assemble and instruction level debug.

CPU Register panel Displays the contents of CPU registers, and modifies register values.

SFR panel Displays and modifies SFR values.

Local Variables panel Displays and modifies local variables.

Watch panel Displays and modifies registered watch-expression values.

Call Stack panel Displays call stack information on function calls.

Trace panel Displays trace data acquired from the debug tool.

Events panel Displays detailed information on set events, switches the events between 
enabled and disabled, or deletes them.

Output panel Displays messages output from the build tool/debug tool/plug-ins, or the 
results of batch searches carried out using the Find and Replace dialog 
box.

Memory Mapping dialog box Sets the memory mapping.

Download Files dialog box Selects files to be downloaded and sets the download conditions.

Action Events dialog box Sets action events.

Column Number Settings dialog box Specifies the number of view columns of memory values on the Memory 
panel.

Address Offset Settings dialog box Specifies an offset value for the address display on the Memory panel. 

Memory Initialize dialog box Initializes memory.

Memory Search dialog box Searches memory.

Print Address Range Settings dialog box Sets the address range to print the contents of the Disassemble panel.

Trace Search dialog box Searches trace data.

Combination Condition dialog box 
[E1][E20]

Displays and modifies detailed information on a Combination Break event

Detail dialog box (for execution events) Displays and modifies detailed information on an execution-related event. 

Detail dialog box (for access events) Displays and modifies detailed information on an access-related event. 
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Table A.2 Simulator GUI Block-Dedicated Window/Dialog Box List

Scroll Range Settings dialog box Sets the scroll range for the Memory panel/Disassemble panel.

Go to the Location dialog box Moves the caret to the specified position.

Data Save dialog box Saves the settings and other data displayed in the respective windows/
panels/dialogs or saves upload data.

Specified Section dialog box Specifies the range for skipping step execution.

Functions and Variables Access Table 
panel

Displays the functions that access variables in the form of an orthogonal 
table.

Measuring Current Consumption panel 
[E2][Simulator]

This panel is central to the functionality of the solution for measuring cur-
rent consumption.

Current Consumption Measurement 
Condition Setting dialog box [E2]

This dialog box is used to set measurement conditions in the Measuring 
Current Consumption panel [E2][Simulator].

Current Consumption Measurement 
Trigger Condition Setting dialog box [E2]

This dialog box is used to set trigger conditions in the Measuring Current 
Consumption panel [E2][Simulator].

Current Consumption Measurement 
Search dialog box [E2][Simulator]

This dialog box is used to specify and search the detailed conditions in 
the Measuring Current Consumption panel [E2][Simulator].

Save Current Values dialog box [E2] This dialog box is used to save the values for current in the Measuring 
Current Consumption panel [E2][Simulator].

Virtual Board panel [Simulator] This panel is used to configure the virtual target system and operate the 
virtual components.

Window/Dialog Box Name Description

Simulator GUI window Opens and controls various simulator GUI's windows and dialog boxes. 

Customize dialog box Setting of window colors and fonts

Signal Data Editor window Setting of input signal data

Loop dialog box Setting of loop information for the Signal Data Editor window

Select Pin dialog box Selection of display pins in the Signal Data Editor window and Timing 
Chart window

Timing Chart window Timing chart display of input and output signals

Search Data dialog box Detailed search of the Timing Chart window

I/O Panel window Creation of dummy target system

Parts Button Properties dialog box Setting of button pin connection information

Analog Button Properties dialog box Setting of analog button pin connection information

Parts Key Properties dialog box Setting of key matrix LED pin information

Parts Level Gauge Properties dialog box Setting of level gauge pin connection information

Parts Led Properties dialog box Setting of key matrix LED pin information

Parts Segment LED Properties dialog 
box

Setting of 7/14-segment LED pin connection information

Parts Matrix Led Properties dialog box Setting of matrix LED pin connection information

Window/Panel/Dialog Box Name Description
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Parts Buzzer Properties dialog box Setting of buzzer pin connection information

Pull up/Pull down dialog box Setting of pull-up/pull-down resistor pin connection information

Object Properties dialog box Setting of connection information for figure, character, and bitmap pins

Parts List dialog box List display of object pin connection status in the I/O Panel window

Serial window Serial interface communication window

Format (UART) dialog box Setting of serial format (UART)

Format (CSI) dialog box Setting of serial format (CSI)

Format (IIC) dialog box Setting of serial format (IICA)

Window/Dialog Box Name Description
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This window is automatically opened when CS+ is started up. 
In this window, you can control the program execution and open panels for the debugging process. 

Figure A.1 Main Window

This section describes the following. 

- [How to open]

- [Description of each area]

[How to open]

- From the Windows [Start] menu, select [All Programs] >> [Renesas Electronics CS+] >> [CS+ for CC]. 

Remark In Windows 8.1, select [CS+ for CC (RL78,RX,RH850)] on the start screen.
In Windows 10, select Windows [Start] menu >> [All apps] >> [Renesas Electronics CS+] >> [CS+ for CC 
(RL78,RX,RH850)].

[Description of each area]

(1) Menubar
Menu items related to the debugging are as follows:

Remark The items that can be selected in each menu can be customized using the User Setting dialog box. 

(a) [View]
The [View] menu provides the following items and functions (default). 

Main window

Watch The following cascade menus are displayed to open the Watch panel.
These items are disabled when disconnected from the debug tool. 

(2)

(1)

(3)

(4)
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Watch1 Opens the Watch panel (Watch1).

Watch2 Opens the Watch panel (Watch2).

Watch3 Opens the Watch panel (Watch3).

Watch4 Opens the Watch panel (Watch4).

Local Variable Opens the Local Variables panel. 

Call Stack Opens the Call Stack panel. 

Memory The following cascade menus are displayed to open the Memory panel.
These items are disabled when disconnected from the debug tool. 

Memory1 Opens the Memory panel (Memory1).

Memory2 Opens the Memory panel (Memory2).

Memory3 Opens the Memory panel (Memory3).

Memory4 Opens the Memory panel (Memory4).

SFR Opens the SFR panel. 
This item is disabled when disconnected from the debug tool. 

CPU Register Opens the CPU Register panel. 
This item is disabled when disconnected from the debug tool.

Trace Opens the Trace panelNote. 
This item is disabled when disconnected from the debug tool.

Disassemble The following cascade menus are displayed to open the Disassemble panel.
These items are disabled when disconnected from the debug tool. 

Disassemble1 Opens the Disassemble panel (Disassemble1).

Disassemble2 Opens the Disassemble panel (Disassemble2).

Disassemble3 Opens the Disassemble panel (Disassemble3).

Disassemble4 Opens the Disassemble panel (Disassemble4).

Event Opens the Events panel. 
This item is disabled when disconnected from the debug tool.

Virtual Board
[Simulator]

Opens the Virtual Board panel [Simulator].
This item is disabled when disconnected from the debug tool.
This item is also disabled even if a device for which the debug tool for the active proj-
ect does not support peripheral function simulations is currently connected to the 
debug tool.

Show Current PC 
Location

Displays the current PC position in the Editor panel. 
This item is disabled when disconnected from the debug tool.

Back to Last Cursor 
Position

Goes back to the position before jumping (see "2.6.2.4  Move to the symbol defined 
location") to the defined location. 
This item is disabled when disconnected from the debug tool.

Forward to Next Cur-
sor Position

Forwards to the position before operating [Back to Last Cursor Position]. 

Tag Jump Jumps to the corresponding line/column in the corresponding file if the information of 
a file name/line number/column number exists in the line at the caret position on the 
Editor panel/Output panel (see "CS+ Integrated Development Environment User's 
Manual: Editor"). 
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Note [E1][E20][EZ Emulator]
This item is available only when the selected microcontroller incorporates the OCD trace func-
tion.

(b) [Debug]
The [Debug] menu provides the following items and functions (default). 

Download Downloads the specified file(s) into the debug tool currently selected in the active 
project.
If CS+ is disconnected from the debug tool at this time, it is automatically connected 
to the debug tool before a download is executed. 
This item is disabled during program execution/build (not including rapid build) exe-
cution.

Build & Download Builds a project and executes a download to the debug tool currently selected in the 
active project after the build is complete.  If CS+ is disconnected from the debug tool 
at this time, it is automatically connected to the debug tool before a download is exe-
cuted.
This item is disabled during program execution/build (not including rapid build) exe-
cution.
When the build has failed, download will not be executed. 

Rebuild & Download Rebuilds a project and executes a download to the debug tool currently selected in 
the active project after the rebuild is complete.  If CS+ is disconnected from the 
debug tool at this time, it is automatically connected to the debug tool before a down-
load is executed.
This item is disabled during program execution/build (not including rapid build) exe-
cution.
When the rebuild has failed, download will not be executed. 

Connect to Debug 
Tool

Connects to the debug tool currently selected in the active project.
This item is disabled while connected to the debug tool, during build (not including 
rapid build) execution or if the version of compiler being used is not supported by 
CS+.

Hot Plug-in
[E1][E20]

Connects to the debug tool currently selected in the active project via the hot plug-in 
function, in order to debug the target system currently running (see "2.4.3  Connect 
to the debug tool using hot plug-in [E1][E20]").
This item is disabled while connected to the debug tool.

Upload... Opens the Data Save dialog box to save the memory contents. 
This item is disabled during program execution/build (not including rapid build) exe-
cution or when disconnected from the debug tool. 

Disconnect from 
Debug Tool

Disconnects from the currently connected debug tool. 
This item is disabled during program execution/build (not including rapid build) exe-
cution or when disconnected from the debug tool. 

Using Debug Tool The following cascade menus are displayed to select the debug tool to use.
This item is disabled while connected to the debug tool.

RL78 IECUBE Uses IECUBE as the debug tool.

RL78 E2 Uses E2 as the debug tool.

RL78 E2 Lite Uses E2 Lite as the debug tool.

RL78 E1(Serial) Uses E1 with serial communication method as the debug tool.

RL78 E20(Serial) Uses E20 with serial communication method as the debug tool.

RL78 EZ Emulator Uses EZ Emulator with an evaluation kit and so on.

RL78 Simulator Uses Simulator as the debug tool.

Stop Forcibly stops the program currently being executed. 
This item is disabled when the program is already halted or disconnected from the 
debug tool. 



CS+ V8.04.00 A.  WINDOW REFERENCE

R20UT4692EJ0100  Rev.1.00 Page 162 of 411
Jun 01, 2020

Note Step execution can be carried out either in units of source lines or in units of instructions. 
For details, see "2.7.3  Execute programs in steps". 

(2) Debug toolbar
The debug toolbar includes the buttons that control the execution of programs.
The debug toolbar provides the following buttons and functions (default). 

Go Executes the program from the current PC position. 
Execution of the program will be stopped when the condition of a set break event is 
met. 
This item is disabled during program execution/build (not including rapid build) exe-
cution or when disconnected from the debug tool.   

Ignore break and go Executes the program from the current PC position. 
Execution of the program continues, ignoring set break events and action events.
This item is disabled during program execution/build (not including rapid build) exe-
cution or when disconnected from the debug tool. 

Step In Executes the program step by stepNote from the current PC position (Step in execu-
tion). 
However, in the case of a function call, the program is stopped at the beginning of the 
function having been called. 
This item is disabled during program execution/build (not including rapid build) exe-
cution or when disconnected from the debug tool. 

Step Over Executes the program step by stepNote from the current PC position (Step over exe-
cution). 
In the case of a function call by the CALL instruction, all the source lines/instructions 
in the function are treated as one step and executed until the position where execu-
tion returns from the function (step-by-step execution will continue until the same 
nest is formed as when the CALL  instruction has been executed). 
In the case of an instruction other than CALL, operation is the same as when [Step 
In] is selected.
This item is disabled during program execution/build (not including rapid build) exe-
cution or when disconnected from the debug tool. 

Return Out Executes the program until execution returns from the current function (or returns to 
the calling function)Note(Return out execution). 
This item is disabled during program execution/build (not including rapid build) exe-
cution or when disconnected from the debug tool. 

CPU Reset Resets the CPU (does not execute a program) 
This item is disabled during build (not including rapid build) execution or when dis-
connected from the debug tool. 

Restart Resets the CPU and then executes the program from the reset address. 
This item is disabled during build (not including rapid build) execution or when dis-
connected from the debug tool.

Rewind debug tool 
state

Rewinds the debug tool to the last state that was automatically saved.
Note that the data to be rewound is limited to memory and register values that can be 
read or written.
To use this debugging function, it has to be set so in the Option dialog box.

Save debug tool state The following menus are relevant to saving and restoring of the state of the debug 
tool.
Note that the data to be saved is limited to memory and register values that can be 
read or written.

Restore debug tool 
state n

Restores the state of the debug tool from the n-th data file.

Save debug tool 
state n

Saves the current state of the debug tool in a file as the n-th data.
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Remark 1. The buttons on the toolbar can be customized using the User Setting dialog box.  Furthermore, a 
new toolbar can be created using the same dialog box. 

Remark 2. A Group of toolbar displayed can be selected with the context menu that is displayed by right-click-
ing on the toolbar. 

Executes the build of a project and downloads the file into the debug tool currently selected in the 
active project.  If CS+ is disconnected from the debug tool at this time, it is automatically con-
nected to the debug tool before a download is executed.
This item is disabled during program execution/build (not including rapid build) execution.
When the build has failed, download will not be executed. 
The function of this item is the same as that of [Build & Download] in the [Debug] menu. 

Downloads the specified file(s) into the debug tool currently selected in the active project.
If CS+ is disconnected from the debug tool at this time, it is automatically connected to the debug 
tool before a download is executed. 
This item is disabled during program execution/build (not including rapid build) execution.
The function of this item is the same as that of [Download] in the [Debug] menu. 

Resets the CPU (does not execute a program) 
This item is disabled during build (not including rapid build) execution or when disconnected from 
the debug tool. 
The function of this item is the same as that of [CPU Reset] in the [Debug] menu. 

Forcibly stops the program currently being executed. 
This item is disabled when the program is already halted or disconnected from the debug tool. 
The function of this item is the same as that of [Stop] in the [Debug] menu. 

Executes the program from the current PC position. 
Execution of the program will be stopped when the condition of a set break event is met. 
This item is disabled during program execution/build (not including rapid build) execution or when 
disconnected from the debug tool. 
The function of this item is the same as that of [Go] in the [Debug] menu. 

Executes the program from the current PC position. 
Execution of the program continues, ignoring set break events and action events.
This item is disabled during program execution/build (not including rapid build) execution or when 
disconnected from the debug tool. 
The function of this item is the same as that of [Ignore break and go] in the [Debug] menu. 

Resets the CPU and then executes the program from the reset address. 
This item is disabled during build (not including rapid build) execution or when disconnected from 
the debug tool. 
The function of this item is the same as that of [Restart] in the [Debug] menu. 

Executes the program step by stepNote from the current PC position (Step in execution). 
However, in the case of a function call, the program is stopped at the beginning of the function 
having been called. 
This item is disabled during program execution/build (not including rapid build) execution or when 
disconnected from the debug tool.   
The function of this item is the same as that of [Step In] in the [Debug] menu. 

Executes the program step by stepNote from the current PC position (Step over execution). 
In the case of a function call by the CALL instruction, all the source lines/instructions in the func-
tion are treated as one step and executed until the position where execution returns from the 
function (step-by-step execution will continue until the same nest is formed as when the CALL 
instruction has been executed). 
In the case of an instruction other than CALL, operation is the same as when the  button is 
clicked. 
This item is disabled during program execution/build (not including rapid build) execution or when 
disconnected from the debug tool. 
The function of this item is the same as that of [Step Over] in the [Debug] menu. 
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Note Step execution can be carried out either in units of source lines or in units of instructions. 
For details, see "2.7.3  Execute programs in steps". 

(3) Panel display area
This area displays the various panels. 
For details on the display content, see the sections describing the individual panels. 

(4) Statusbar
Statusbar displays the following items of information. 

Figure A.2 Statusbar

(a) Status message
This area displays the following messages and other information. 

- A brief explanation of the selected menu item 

- A message reporting that an invalid value has been input in the panel/dialog 

- A message reporting that the specified character string has not been found as a result of a search using the 
Find and Replace dialog box

- A statement of the cause of the break when a break has occurred (see "2.8  Stop Programs (Break)")

(b) Focus panel status information 
This area displays status information on the panel currently having the focus. 
Note that nothing is displayed here for a panel that has no status information. 

(c) Running state
This area displays the state of the program with the following icons and character strings. 
Note that nothing is displayed here when the debug tool is not connected. 

(d) CPU status
This area displays the current CPU status of the debug tool.  When there is the possibility that the CPU is in two 
or more statuses, the corresponding display contents are displayed separated by "&". 
Note that nothing is displayed here when the debug tool is not connected. 

Executes the program until execution returns from the current function (or returns to the calling 
function)Note (Return out execution). 
This item is disabled during program execution/build (not including rapid build) execution or when 
disconnected from the debug tool. 
The function of this item is the same as that of [Return Out] in the [Debug] menu. 

Disconnects from the currently connected debug tool. 
This item is disabled during program execution/build (not including rapid build) execution or when 
disconnected from the debug tool. 
The function of this item is the same as that of [Disconnect from Debug Tool] in the [Debug] 
menu. 

State of Program Displayed Content

Under execution  RUN

Now halted  BREAK

Step execution in progress  STEP

(a) (h)(b) (c) (d) (f) (g)(e)
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Remark Nothing is displayed here when the CPU is in status other than those listed above.

(e) Current PC position
This area displays the current PC position with a hexadecimal value.  When this area is clicked, the caret moves 
to the current PC position on the Editor panel. 
In addition, when the mouse pointer is placed over this area, a pop-up window appears to display the following 
information.  Note, however, that nothing is displayed here when the debug tool is not connected. 

- Current PC: 0x current PC value (source name#line countNote) 

Note "symbol name+offset value" is displayed when acquisition of information is impossible. 

Remark "Running" is displayed in this area during execution of a program. 

(f) Connection state
This area displays the current state of connection with the debug tool using the following icons and character 
strings. 

(g) Run-Break Timer measurement result 
This area displays the result of measurement by the Run-Break Timer event (the unit of value used differs 
depending on the measurement amount).  See "2.12.2  Measure execution time until stop of the execution". 
Note that nothing is displayed here when the debug tool is not connected. 

(h) Debug tool state [IECUBE][Simulator]
This area displays the current state of debug tool's functions using the following icons and character strings. 
When a function is stopped, clicking the appropriate icon enables the state to be switched between "Use" and 
"Not use"Note. 
Note that nothing is displayed here when the debug tool is not connected. 

Debug Tool Displayed Content CPU Status

IECUBE Halt In HALT mode 

Stop In STOP mode

Wait In wait state

Reset In reset state

Pow Off Power not supplied to the target 

E1/E20
EZ Emulator

Reset In reset state

Pow Off Power not supplied to the target 

Simulator Halt In HALT mode

Stop In STOP mode

Reset In reset state

Connection State Displayed Content

Connected  Debug tool name

Disconnected  DISCONNECTED

Condition Displayed Content

Un-measuring Not measured

Under measurement Measuring

When a timer measurement overflow has 
occurred 

OVERFLOW

Function Being Executed Stopped (Use) Not Use

Trace
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Note [IECUBE]
Switching is impossible because the trace function, the timer function and the coverage function 
are always used (the icon for "Not use" is not displayed). 
[Simulator]
The result of switching will be reflected in the setting of the [Use trace function]/[Use timer func-
tion]/[Use coverage function] property in the [Trace]/[Timer]/[Coverage] category on the [Debug 
Tool Settings] tab of the Property panel. 

Timer

Coverage

Function Being Executed Stopped (Use) Not Use
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This panel is used to display the project components (microcontroller, build tool, debug tool, etc.) in a tree structure.
On this panel, you can select or change the debug tool to use.

Figure A.3 Project Tree Panel

The following items are explained here.

- [How to open]

- [Description of each area]

- [Context menu]

[How to open]

- From the [View] menu, select [Project Tree].

[Description of each area]

(1) Project tree area
Project components are displayed in tree view with the following given node.

Select the debug tool node to configure with the Property panel.  If the Property panel is not being opened, double-
click the node to open the corresponding Property panel.

Project Tree panel

Node Description

RL78 Debug tool name (Debug tool) Debug tool name:
The debug tool (IECUBE, E2, E2 Lite, E1(Serial), E20(Serial), 
EZ Emulator or Simulator) currently being used in the project 
is displayed.
[Simulator] is selected by default.

(1)
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[Context menu]

Using Debug Tool The following cascade menus are displayed to select the debug tool to use.

RL78 IECUBE Uses IECUBE as the debug tool.

RL78 E2 Uses E2 as the debug tool.

RL78 E2 Lite Uses E2 Lite as the debug tool.

RL78 E1(Serial) Uses E1 with serial communication method as the debug tool.

RL78 E20(Serial) Uses E20 with serial communication method as the debug tool.

RL78 EZ Emulator Uses EZ Emulator with an evaluation kit and so on.

RL78 Simulator Uses Simulator as the debug tool.

Property Displays the selected category node's property in the Property panel. 
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This panel is used to display and set the debug tool operation environment that is selected in the Project Tree panel. 

Figure A.4 Property Panel (When IECUBE Is Selected)

This section describes the following. 

- [How to open]

- [Description of each area]

- [[Edit] menu (Property panel-dedicated items)]

- [Context menu]

[How to open]

- On the Project Tree panel, select the [RL78 Debug tool name (Debug Tool)] node to use, and then select [Property] from 
the [View] menu or the context menu. 

- On the Project Tree panel, double-click the [RL78 Debug tool name (Debug Tool)] node to use.

Remark If this panel has been opened, the detailed information on the debug tool is displayed by selecting the 
[RL78 Debug tool name (Debug Tool)] node on the Project Tree panel. 

[Description of each area]

(1) Detailed information display/change area 
In this area, the detailed information on the debug tool that is selected in Project Tree panel is displayed by cate-
gory in the list.  Also, you can directly change its settings. 
The  mark is indicates all the items in the category are expanded.  The  mark indicates all the items are col-
lapsed.  You can expand/collapse the items by clicking these marks or double-clicking the category name. 
Note that only the hexadecimal number is allowed in the text box if the  mark is displayed in the property con-
figuration area. 
For details on the information/how to setup in the category and property items contained in it, see the section 
explaining the corresponding tab. 

(2) Tab selection area
Categories for the display of the detailed information are changed when each tab is selected. 
In this panel, following tabs are contained (see the section explaining each tab for details on the display/setting on 
the tab). 

Property panel

(1)

(2)
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-   [Connect Settings] tab

-   [Debug Tool Settings] tab

-   [Flash Self Emulation Settings] tab [IECUBE]

-   [DataFlash Emulation Settings] tab [IECUBE]

-   [Download File Settings] tab

-   [Hook Transaction Settings] tab

[[Edit] menu (Property panel-dedicated items)]

[Context menu]

[While not editing the property value]

[While editing the property value]

Undo Undoes the latest property value editing being done. 

Cut Deletes the selected character string(s) and copies them to the clipboard while editing the 
property value. 

Copy Copies the contents of the selected range to the clipboard as character string(s). 

Paste Pastes the contents of the clipboard to the property value while editing the property value. 

Delete Deletes the selected character string(s) while editing the property value. 

Select All Selects all the character strings in the selected property while editing the property value. 

Reset to Default Restores the selected setting of the property item to default value.

Reset All to Default Restores all the selected settings of the property items on the tab to default value. 

Undo Undoes the latest property value editing being done. 

Cut Deletes the selected character string(s) and copies them to the clipboard while editing the 
property value. 

Copy Copies the contents of the selected range to the clipboard as character string(s). 

Paste Pastes the contents of the clipboard to the property value while editing the property value. 

Delete Deletes the selected character string(s) while editing the property value. 

Select All Selects all the character strings in the selected property while editing the property value. 
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[Connect Settings] tab

This tab is used to display the detailed information categorized by the following and the configuration can be changed. 

(1)  [Internal ROM/RAM]
(2)  [Clock]
(3)  [Connection with Emulator] [E1] [E20]
(4)  [Connection with Target Board] [IECUBE][E1][EZ Emulator]
(5)  [E2 Expansion Interface] [E2]
(6)  [Flash] [E1][E20][EZ Emulator]
(7)  [Hot Plug-in] [E1][E20]
(8)  [Configuration] [Simulator]

[Description of each category]

(1) [Internal ROM/RAM]
The detailed information on internal ROM/RAM is displayed and its configuration can be changed. 

Caution You should be careful not to overlap the area with other memory mapping area. 

(2) [Clock]
The detailed information on clocks is displayed and its configuration can be changed. 

Size of internal 
ROM[KBytes]

Display and change the internal ROM size of the selected microcontroller. 

Default Internal ROM size of the selected microcontroller

Modifying [IECUBE][Simulator]
Select from the drop-down list.

[E1][E20][EZ Emulator]
Changes not allowed

Available 
values

Depends on the selected microcontroller.

Size of internal 
RAM[Bytes]

Display and change the internal RAM size of the selected microcontroller. 

Default Internal RAM size of the selected microcontroller

Modifying [IECUBE][Simulator]
Select from the drop-down list.

[E1][E20][EZ Emulator]
Changes not allowed

Available 
values

Depends on the selected microcontroller.

Size of DataFlash 
memory[KBytes]
(except [Simulator])

Displays the size of the data flash memory area of the selected microcontroller. 

Default Data flash memory size of the selected microcontroller

Modifying Changes not allowed
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Main clock source
[IECUBE]

Select the main clock source to input to the CPU. 

Default Generate by emulator 

Modifying Select from the drop-down list.
Note that changes can be made only when disconnected from the debug 
tool. 

Available 
values

Generate by emulator Uses a clock generated inside IECUBE. 

External Uses a main clock (square wave) on the target 
board. 

Clock socket Uses a clock of the transmitter on the clock 
socket. 

Main clock frequency 
[MHz]

Specify the main clock frequency in MHz unit. 
[IECUBE]

This property appears only when the [Main clock source] property is set to [Generate 
by emulator]. 

Default [IECUBE][Simulator]
4.00

[E1][E20][EZ Emulator]
Using internal clock

Modifying Select from the drop-down list or directly enter from the keyboard.

Available 
values

[IECUBE]

- Either one of the following from the drop-down listNote 1

1.00, 2.00, 3.00, 3.57, 4.00, 4.19, 4.91, 5.00, 6.00, 8.00, 8.38, 10.00, 
12.00, 16.00, 20.00 (unit: MHz)

[E1][E20][EZ Emulator]Note 2

- Either one of the following from the drop-down list 
Using internal clock, 2.00, 3.00, 3.57, 4.00, 4.19, 4.91, 5.00, 6.00, 8.00, 
8.38, 10.00, 12.00, 16.00, 20.00 (unit: MHz)

- Directly enter the numbers ranged below 
0.001 to 99.999 (unit: MHz)

[Simulator]

- Either one of the following from the drop-down list 
2.00, 3.00, 3.57, 4.00, 4.19, 4.91, 5.00, 6.00, 8.00, 8.38, 10.00, 12.00, 
16.00, 20.00 (unit: MHz)

- Directly enter the numbers ranged below 
0.001 to 99.999 (unit: MHz)

Sub clock source
[IECUBE]

Select the sub clock source to input to the CPU and peripheral microcontrollers. 

Default Generate by emulator 

Modifying Select from the drop-down list.
Note that changes can be made only when disconnected from the debug 
tool. 

Available 
values

Generate by emulator Uses a clock generated inside IECUBE. 

External Uses a main clock (square wave) on the target 
board. 
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Sub clock fre-
quency[kHz]

Specify the sub clock frequency in kHz unit. 
[IECUBE]

This property appears only when the [Sub clock source] property is set to [Generate 
by emulator]. 

Default [IECUBE][Simulator]
   32.768
[E1][E20][EZ Emulator]
   Using internal clock

Modifying Select from the drop-down list or directly enter from the keyboard.

Available 
values

[IECUBE]
32.768 or 38.40 (unit: kHz)

[E1][E20][EZ Emulator]

- Either one of the following from the drop-down list 
Using internal clock, 32.768, 38.40 (unit: kHz)

- Directly enter the numbers ranged below 
0.001 to 99.999 (unit: kHz)

[Simulator]

- Either one of the following from the drop-down list 
32.768 or 38.40 (unit: kHz)

- Directly enter the numbers ranged below 
0.001 to 99.999 (unit: kHz)

Monitor clock
[E1][E20]
[EZ Emulator]

Select a clock for monitor programs to operate while the program is stopped. 

Default System

Modifying Select from the drop-down list.

Available 
values

System Operates with main clock.

User Operates with the clock that the program speci-
fied.

Select Timer/Trace 
clock frequency 
[Simulator]

Select the clock frequency for using timer/trace function. 

Default CPU clock frequency

Modifying Select from the drop-down list.

Available 
values

CPU clock frequency Uses the CPU clock frequency. 

Specify clock fre-
quency 

Specifies an arbitrary frequency (property items to 
specify become valid in the lower area). 

Unit of Timer/Trace 
clock frequency 
[Simulator]

Select the unit of the clock frequency for timer/trace.
This property appears only when the [Select Timer/Trace clock frequency] property is 
set to [Specify clock frequency]. 

Default MHz

Modifying Select from the drop-down list.

Available 
values

MHz The unit of the frequency is in MHz.

kHz The unit of the frequency is in kHz.
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Note 1. You can also select the frequency greater than 20.00 MHz, depending on the selected microcon-
troller. 

Note 2. When using X1/X2 oscillation, specify the clock frequency.
When using an external clock oscillation with the embedded PLL circuit, specify the frequency of 
the transmitter/resonator (the frequency before the setting of the PLL clock). 

(3) [Connection with Emulator] [E1] [E20]

Note If an attempt is made to connect the emulator when this category is blank, the serial number of the 
emulator that is found first by search will be automatically selected and connection is made. The 
serial number of the emulator that is automatically selected in such a case will not be saved in the 
project information.

(4) [Connection with Target Board] [IECUBE][E1][EZ Emulator]
The detailed information on the connection to the target board is displayed and its configuration can be changed. 
Note that this category does not appear if no property displayed exists according to the type of the selected micro-
controller.

Timer/Trace clock 
frequency 
[Simulator]

The operation of this property differs depending on the specification with the [Select 
Timer/Trace clock frequency] property. 

- When [Specify clock frequency] is specified
Specify the clock frequency for timer/trace.

- When [CPU clock frequency] is specified, displays the following (changes not 
allowed)
While disconnected from the debug tool: [---_---]
While connected to the debug tool: [CPU clock frequency] 

Default 4.00

Modifying Directly enter from the keyboard. 

Available 
values

1 kHz to 99.999 MHz
Unit is depending on the specification with the [Unit of Timer/Trace clock 
frequency] property. 

Emulator serial No. Select the serial No. of the emulator to be connected.Note

Default Blank

How to 
change

By selecting from the drop-down list
However, changeable only when disconnected from the debug tool

Specifiable 
value

Depends on the emulator used.

Connecting with tar-
get board
[IECUBE]

Select if the target board is connected to IECUBE or not.

Default No

Modifying Select from the drop-down list.
Note that changes can be made only when disconnected from the debug 
tool.

Available 
values

Yes Target board is connected.

No Target board is not connected.
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(5) [E2 Expansion Interface] [E2]
The detailed information on the E2 expansion interface is displayed and its configuration can be changed. 

Low voltage OCD 
board
[E1]
[EZ Emulator]

Select whether to use a low voltage OCD board. 
This property appears only when the selected microcontroller supports a low voltage 
OCD board.

Default No

Modifying Select from the drop-down list.

Available 
values

Yes Uses a low voltage OCD board. 

No Does not use a low voltage OCD board. 

Power target from 
the emulator (MAX 
200mA)
[E1]

Select whether to supply power to the target board from E1.
This property appears only when the [Low voltage OCD board] property is set to [No] if 
it is displayed. 

Default No

Modifying Select from the drop-down list.
Note that changes can be made only when disconnected from the debug 
tool.

Available 
values

Yes Supplies power to the target board.

No Does not supply power to the target board.

Interface for supply-
ing the power
[E2]

Select the interface for supplying the power to the target board from the emulator.

Default USER I/F

Modifying Select from the drop-down list.

Available 
values

USER I/F Uses the user interface.

E2 expansion I/F Uses the E2 expansion interface.

Supply voltage
[E1]

Select the power voltage supplied to the target board. 
This property appears only when the [Power target from the emulator (MAX 200mA)] 
property is set to [Yes]. 

Default 3.3V

Modifying [E1]
Select from the drop-down list.

[E2]
Select from the drop-down list or directly enter from the keyboard.

Available 
values

[E1]
3.3, 5.0

[E2 Lite]
3.3

[E2]

- Either one of the following from the drop-down list 
3.3, 5.0

- Directly enter the numbers ranged below 
1.8 to 5.0, or 0 (unit: V)
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(6) [Flash] [E1][E20][EZ Emulator]
The detailed information on the flash memory writing is displayed and its configuration can be changed. 

Interface for supply-
ing the power
[E2]

Select whether to use the E2 expansion interface.

Default No use

Modifying Select from the drop-down list.

Available 
values

No use Does not use the E2 expansion interface.

Use the power sup-
plied from the target

Uses the E2 expansion interface by the power 
supplied to the target.

Use supplied power 
from the emulator

Uses the E2 expansion interface by the supplied 
power from the emulator.

Security ID Specify a security ID for reading codes in the internal ROM or internal flash memo-
ryNote.
This property appears only when the selected microcontroller supports the ROM secu-
rity function (security ID) for flash memory.

Default 00000000000000000000

Modifying Directly enter from the keyboard. 
Note that changes can be made only when disconnected from the debug 
tool. 

Available 
values

0x0 to 0xFFFFFFFFFFFFFFFFFFFE in hexadecimal number

Permit flash pro-
gramming 

Select whether to enable flash rewrite.

Default Yes

Modifying Select from the drop-down list.

Available 
values

Yes Enables flash rewrite.

No Disables flash rewrite.
The flash memory area cannot be rewritten at all from the debug 
tool. 

Use wide voltage 
mode 

Select whether to rewrite the flash memory with the wide voltage mode.
This property appears only when the selected microcontroller supports the wide voltage 
mode for the flash memory rewriting.

Default Yes

Modifying Select from the drop-down list.
Note that changes can be made only when disconnected from the debug 
tool. 

Available 
values

Yes Rewrites the flash memory with the wide voltage mode.

No Rewrites the flash memory with the normal mode.
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Note For details on the on-chip debug security ID, see User's Manual of the emulator. 

(7) [Hot Plug-in] [E1][E20]
The detailed information on hot plug-in connection is displayed and its configuration can be changed.
Note that this category appears only when the selected microcontroller incorporates the hot plug-in function.

(8) [Configuration] [Simulator]
The detailed information when customizing the simulator is displayed and its configuration can be changed. 

Erase flash ROM 
when starting

Select whether to erase flash ROM when connecting to the debug tool. 
This property appears only when the [Permit flash programming] property is set to 
[Yes]. 
[E1][E20]

When conducting hot plug-in connection, the setting of this property will be ignored 
and flash ROM will not be erased.

Default No

Modifying Select from the drop-down list.
Note that changes can be made only when disconnected from the debug 
tool. 

Available 
values

Yes Erases the flash ROM when connecting to the debug tool. 
Note that after connecting to the debug tool, this property auto-
matically selects [No]. 

No Does not erase flash ROM when connecting to the debug tool. 

Retrying interval[ms] Specify the interval in 1-ms units for retrying connection in the case of hot plug-in con-
nection when the emulator fails to communicate with the microcontroller on the target 
board.

Default 1000

Modifying Directly enter from the keyboard. 
Note that changes can be made only when disconnected from the debug 
tool. 

Available 
values

0 to 60000 in decimal number

Number of times of 
retrying

Specify the number of times for retrying connection in the case of hot plug-in connection 
when the emulator fails to communicate with the microcontroller on the target board.

Default 3

Modifying Directly enter from the keyboard. 
Note that changes can be made only when disconnected from the debug 
tool. 

Available 
values

0 to 3 in decimal number

Use simulator config-
uration file

Select whether to use the simulator configuration file to perform user customization 
(adding of user models) of the simulator. 

Default No

Modifying Select from the drop-down list.
Note that changes can be made only when disconnected from the debug 
tool. 

Available 
values

Yes Uses the simulator configuration file.

No Does not use the simulator configuration file.
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Simulator configura-
tion file

Specify the simulator configuration file to be use. 
This property appears only when the [Use simulator configuration file] property is set to 
[Yes]. 

Default Blank

Modifying Directly enter from the keyboard, or specify with the Select Simulator Con-
figuration File dialog box that is opened by clicking the [...] button.
Note that changes can be made only when disconnected from the debug 
tool.
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[Debug Tool Settings] tab

This tab is used to display the detailed information categorized by the following and the configuration can be changed. 

(1)  [Memory]
(2)  [Access Memory While Running]
(3)  [Set Event While Running] [IECUBE]
(4)  [E2 Expansion Interface] [E2]
(5)  [Break]
(6)  [Fail-safe Break] [IECUBE]
(7)  [Trace]
(8)  [Timer] [IECUBE][Simulator]
(9)  [Coverage] [IECUBE][Simulator]
(10)  [Mask for Input Signal] (except [Simulator])
(11)  [Virtual Board] [Simulator]
(12)  [Simulator GUI] [Simulator]
(13)  [Step function]

[Description of each category]

(1) [Memory]
The detailed information on memories is displayed and its configuration can be changed. 

Note The type is of the memory mapping area registered in the device file. 

(2) [Access Memory While Running]
The detailed information on memory accesses while executing a program (real-time display update function: see 
"2.9.1.4  Display/modify the memory contents during program execution") is displayed and its configuration can be 
changed. 

Memory mappings Current memory mapping status is displayed by the types of memory areaNote. 

Default [Sum total by microcontroller's inherent type of memory mapped area] 

Modifying Changes not allowed

Displayed 
Content

Displays the memory mapping status by the types of memory area. 
The following detailed information is displayed by clicking the "+" mark of 
each memory type. 

- Memory type

- Start address

- End address

- Access width[bits]

Verify on writing to 
memory 
(except [Simulator])

Select whether to perform a verify check when the memory value is initialized.

Default Yes

Modifying Select from the drop-down list.

Available 
values

Yes Executes the verify check. 

No Does not execute the verify check. 
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Note [E1][E20][EZ Emulator]
When [1 line type (TOOL0)] is specified with the [Communication method] property in the [Connec-
tion with Target Board] [IECUBE][E1][EZ Emulator] category, if this property is set to [Yes], the 
debug tool's response speed will be greatly slow. 

(3) [Set Event While Running] [IECUBE]
The detailed information on the function of the event setting during program execution is displayed and its config-
uration can be changed. 

(4) [E2 Expansion Interface] [E2]
The detailed information on the E2 expansion interface is displayed and its configuration can be changed. 

Access by stopping 
execution
(except [Simulator])

[IECUBE]
For a memory area not accessible during execution of a program, select whether 
access to the area is permitted (target memory area/SFR area/CPU registers). 

[E1][E20][EZ Emulator]
Select whether to allow access to the memory area while executing a programNote. 

Default No

Modifying Select from the drop-down list.

Available 
values

Yes Temporarily stops execution and reads/writes. 

No Does not access to the memory during execution of a program. 

Update display dur-
ing the execution 

Select whether to update the display in the Memory panel/Watch panel during a pro-
gram execution. 

Default Yes

Modifying Select from the drop-down list.

Available 
values

Yes Updates the display during program execution. 

No Does not update the display during program execution. 

Display update inter-
val[ms] 

Specify the interval in 100ms unit to update the contents in the Memory panel/Watch 
panel display while executing a program. 
This property appears only when the [Update display during the execution] property is 
set to [Yes]. 

Default 500

Modifying Directly enter from the keyboard. 

Available 
values

Integer number between 100 and 65500 (rounding up the fractions less 
than 100 ms). 

Set event by stop-
ping execution 
momentarily

Select whether to forcibly pause the execution for events that cannot be set while exe-
cuting the program. 
For details on the event types that are affected by this property, see "2.15.7.2  Event 
types that can be set and deleted during execution".

Default No

Modifying Select from the drop-down list.

Available 
values

Yes Sets these events by stopping the program execution momen-
tarily.

No Does not allow to set these events during program execution. 

External trigger input Set the settings related to the external trigger input.
You can select different actions for each channel.
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Channel number
(Subproperty)

The channel number is displayed.

Default  0 or 1

Modifying Changes not allowed

Use
(Subproperty)

Specify whether to use the external trigger input for this channel number.

Default No

Modifying Select from the drop-down list.

Available 
values

Yes Uses the external trigger signal input through the selected chan-
nel.

No Does not use the external trigger signal input through the 
selected channel.

Input signal
(Subproperty)

Specify the input signal.

Default Rising Edge

Modifying Select from the drop-down list.

Available 
values

Rising Edge Detects rising edges of the external trigger signal input 
through the selected channel.

Falling Edge Detects falling edges of the external trigger signal input 
through the selected channel.

Both Edges Detects both rising and falling edges of the external 
trigger signal input through the selected channel.

High Detects the high level of the external trigger signal 
input through the selected channel.

Low Detects the low level of the external trigger signal input 
through the selected channel.

Action when input-
ting the external trig-
ger
(Subproperty)

The action when inputting the external trigger is displayed.

Default Stop program

Modifying Changes not allowed

External trigger out-
put

Set the settings related to the external trigger output.
You can select different actions for each channel.

Channel number
(Subproperty)

The channel number is displayed.

Default  0 or 1

Modifying Changes not allowed

Use
(Subproperty)

Specify whether to use the external trigger output for this channel number.

Default No

Modifying Select from the drop-down list.

Available 
values

Yes Uses the external trigger signal output through the selected chan-
nel.

No Does not use the external trigger signal output through the 
selected channel.
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(5) [Break]
The detailed information on break functions is displayed and its configuration can be changed. 

Output timing
(Subproperty)

The output timing is displayed.

Default Stop program

Modifying Changes not allowed

Output signal
(Subproperty)

The output signal is displayed.

Default High Pulse

Modifying Changes not allowed

Pulse width [us]
(Subproperty)

Specify the pulse width.

Default 1

Modifying Directly enter from the keyboard. 

Available 
values

Integer number between 1 and 65535

First using type of 
breakpoint
(except [Simulator])

Select the type of the breakpoint to use with priority when setting it at the source line or 
the execution address with a one click operation of the mouse in the Editor panel/Disas-
semble panel. 
This property does not appear when the selected microcontroller supports only one 
breakpoint type. 

Default Software break

Modifying Select from the drop-down list.

Available 
values

Software break Sets software breakpoint with priority. 

Hardware break Sets hardware breakpoint with priority. 

Stop emulation of 
timer group when 
stopping
(except [Simulator])

Select whether to terminate the peripheral emulation of timers while stopping the pro-
gram execution (Peripheral Break). 

Default No

Modifying Select from the drop-down list.

Available 
values

Yes Terminates the peripheral emulation of timersNote 1. 

No Does not terminate the peripheral emulation of timers. 

Stop emulation of 
serial group when 
stopping
(except [Simulator])

Select whether to terminate the peripheral emulation of serials while stopping the pro-
gram execution (Peripheral Break). 
This property appears only when the selected microcontroller supports this function. 

Default No

Modifying Select from the drop-down list.

Available 
values

Yes Terminates the peripheral emulation of serials. 

No Does not terminate the peripheral emulation of serials. 
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Note 1. [E1][E20][EZ Emulator]
In the case of the selected microcontroller that provides the open break function, when this property 
is set to [Yes], the open break target pin becomes the Hi-Z state after the CPU is stopped (when 
this property is set to [No], the open break target pin outputs the signal even after the CPU is 
stopped). 

Note 2. When [Yes] is selected, all of action events currently being set are handled as Hardware Break 
events (see "2.14  Set an Action into Programs").

(6) [Fail-safe Break] [IECUBE]
The detailed information on fail-safe break functions is displayed and its configuration can be changed. 

Use open break 
function 
[IECUBE]

Select whether to use the open break function. 
This property appears only when the selected microcontroller supports the open break 
function. 

Default Depends on the selected microcontroller.

Modifying Select from the drop-down list.

Available 
values

Yes(Hi-Z) The open break target pin becomes the Hi-Z state after 
the CPU is stopped.

No(Output sig-
nal)

The open break target pin outputs the signal even after 
the CPU is stopped.

Restore the break-
point when pin reset 
occurs
[E1][E20]
[EZ Emulator]

Select whether to restore the breakpoints when a pin reset occurs.
This property appears only when the selected microcontroller supports this function, 
and [Yes] is specified for the [Permit flash programming] property.

Default Yes

Modifying Select from the drop-down list.

Available 
values

Yes The CPU is briefly halted for restoration of the breakpoints after a 
pin reset. 

No The breakpoints are ignored and not restored after a pin reset, 
but are restored when the program is stopped. 

Execute instruction 
at breakpoint when 
break
[Simulator]

Select the timing to stop the program execution by breakpoints either after or before the 
execution of the instruction at the breakpoint. 

Default No

Modifying Select from the drop-down list.

Available 
values

Yes Breaks after executing the instructionNote 2. 

No Breaks before executing the instruction. 

Stop when fetched 
from fetch protected 
area

Select whether to stop the execution right after fetching from the fetch protected area.

Default Yes

Modifying Select from the drop-down list.

Available 
values

Yes Stops right after fetching. 

No Does not stop even after fetching. 

Stop when wrote to 
write protected area

Select whether to stop the execution right after writing to the write protected area.

Default Yes

Modifying Select from the drop-down list.

Available 
values

Yes Stops right after writing. 

No Does not stop even after writing. 
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Stop when read from 
read protected SFR

Select whether to stop the execution right after reading from the read protected SFR. 

Default Yes

Modifying Select from the drop-down list.

Available 
values

Yes Stops right after reading. 

No Does not stop even after reading. 

Stop when wrote to 
write protected SFR

Select whether to stop the execution right after writing to the write protected SFR.

Default Yes

Modifying Select from the drop-down list.

Available 
values

Yes Stops right after writing. 

No Does not stop even after writing. 

Stop when over-
flowed user stack

Select whether to stop the execution right after the user stack overflow occurs.

Default No

Modifying Select from the drop-down list.

Available 
values

Yes Stops right after the occurrence. 

No Does not stop even after the occurrence. 

Stop when under-
flowed user stack

Select whether to stop the execution right after the user stack underflow occurs.

Default No

Modifying Select from the drop-down list.

Available 
values

Yes Stops right after the occurrence. 

No Does not stop even after the occurrence. 

User stack section Specify the section of the user stack. 

Default .stack_bss

Modifying Directly enter from the keyboard. 

Available 
values

Address expression from 0 to the "end address of the address space". 

Stop when operated 
uninitialized stack 
pointer

Select whether to stop the execution right after the operation of the stack pointer that is 
not initialized. 

Default Yes

Modifying Select from the drop-down list.

Available 
values

Yes Stops right after the operation. 

No Does not stop even after the operation. 

Stop when read from 
uninitialized RAM 

Select whether to stop the execution right after reading from the RAM that is not initial-
ized. 

Default Yes

Modifying Select from the drop-down list.

Available 
values

Yes Stops right after reading. 

No Does not stop even after reading. 
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(7) [Trace] 
The detailed information on trace functions is displayed and its configuration can be changed. 

Caution [E1]E20][EZ Emulator]
This category appears only when the selected microcontroller incorporates the OCD trace function.

Stop when accessed 
to non-mapping area

Select whether to stop the execution right after accessing to the areas where are not 
memory mapped in the [Memory Mappings] property in the [Memory] category. 

Default Yes

Modifying Select from the drop-down list.

Available 
values

Yes Stops right after accessing. 

No Does not stop even after accessing. 

Stop when word 
miss-align accessed

Select whether to stop the execution right after accessing to the odd number address by 
the word width. 

Default Yes

Modifying Select from the drop-down list.

Available 
values

Yes Stops right after accessing. 

No Does not stop even after accessing. 

Stop when received 
fail safe from periph-
eral 

Select whether to stop the execution right after the fail safe from the peripheral occurs. 

Default Yes

Modifying Select from the drop-down list.

Available 
values

Yes Stops right after the occurrence. 

No Does not stop even after the occurrence. 

Stop when occurred 
flash illegal 

Select whether to stop the execution right after the flash illegal occurs. 

Default Yes

Modifying Select from the drop-down list.

Available 
values

Yes Stops right after the occurrence. 

No Does not stop even after the occurrence. 

Use trace function 
[E1][E20]
[EZ Emulator]
[Simulator]

Select whether to use the trace functionNote 1. 

Default No

Modifying Select from the drop-down list.

Available 
values

Yes Uses trace functions. 

No Does not use trace functions. 

Clear trace memory 
before running 
[IECUBE]
[Simulator]

Select whether to clear the trace memory before executing. 

Default Yes

Modifying Select from the drop-down list.

Available 
values

Yes Clears the trace memory. 

No Does not clear the trace memory. 
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Note 1. This property is automatically set to [Yes] when selecting [Start Tracing]/[Stop Tracing] from the 
context menu in the Editor panel/Disassemble panel. 
[E1]E20][EZ Emulator]
This property is automatically changed in accordance with the property setting of the build tool 
used. 

Note 2. The trace frame is a unit of trace data.  Each fetch/write/read uses one trace frame. 

Note 3. [Simulator]
The trace memory is cleared when you change the setting of this property.

Operation after trace 
memory is full

Select the operation after the trace memory is full with the collected trace data.

Default Non stop and overwrite to trace memory

Modifying Select from the drop-down list.

Available 
values

Non stop and over-
write to trace memory

Continues overwriting trace data even after trace 
memory is used up.

Stop trace Stops overwriting trace data when trace memory 
is used up (the program execution will not be 
stopped). 

Stop
[IECUBE]
[Simulator]

Stops running the program and overwriting trace 
data when trace memory is used up.

Rate of frequency 
division of trace time 
tag
[IECUBE]

Select the frequency division ratio of the counter to be used for time tag display.

Default 1/1(4ns/0.3min)

Modifying Select from the drop-down list.

Available 
values

1/1(4ns/0.3min)1/2(8ns/0.6min)1/4(17ns/1.2min)
1/8(33ns/2.4min)1/16(67ns/4.8min)1/32(133ns/9.5min)
1/64(267ns/19.1min)1/128(533ns/38.2min)1/256(1067ns/1.3h)
1/512(2133ns/2.5h)1/1024(4267ns/5.1h)1/2048(8533ns/10.2h)
1/4096(17067ns/20.4h)
(Values in "()" indicate the resolution and the maximum measurement 
time.)

Accumulate trace 
time 
[Simulator]

Select whether to display the accumulated tracing time in the Trace panel. 

Default No

Modifying Select from the drop-down list.

Available 
values

Yes Displays the accumulated tracing time. 

No Displays the trace time with differential value. 

Trace memory 
size[frames] 
[E1][E20]
[EZ Emulator]
[Simulator]

Select the size of memory that stores trace data by the number of trace framesNote 2, 3. 

Default [E1][E20][EZ Emulator]
Depends on the selected microcontroller.

[Simulator]
4K

Modifying [E1][E20][EZ Emulator]
Changes not allowed

[Simulator]
Select from the drop-down list.

Available 
values

[Simulator]
4K, 8K, 12K, 16K, 20K, 24K, 28K,32K, 36K, 40K, 44K, 48K, 52K,56K, 
60K, 64K, 128K, 192K, 256K, 320K, 384K, 448K, 512K, 576K, 640K, 
704K, 768K, 832K, 896K, 960K, 1M, 2M, 3M



R20UT4692EJ0100  Rev.1.00 Page 187 of 411
Jun 01, 2020

CS+ V8.04.00 A.  WINDOW REFERENCE

(8) [Timer] [IECUBE][Simulator]
The detailed information on timer functions is displayed and its configuration can be changed. 

Note It is not possible to divide the timer counter for the Run-Break time.

(9) [Coverage] [IECUBE][Simulator] 
The detailed information on coverage functions is displayed and its configuration can be changed. 

(10) [Mask for Input Signal] (except [Simulator])
The detailed information on the masking input signal is displayed and its configuration can be changed. 

Caution 1. [E1][E20]
The properties in this category are disabled in the case of a hot plug-in connection. 
That is, the program operates as if the specification for the properties is [No] (the properties 
become enabled again after reconnection with CS+).

Caution 2. [E1][E20]
Maskable signals differ depending on the selected microcontroller type (a signal that cannot be 
masked will be hidden).

Rate of frequency 
division of timer
[IECUBE]

Select the frequency division ratio of the timer counter (120 MHz) used for timer mea-
surementNote. 

Default 1/2(17ns/1.2min) (Resolution/maximum measurement time are displayed 
in "()").

Modifying Select from the drop-down list.

Available 
values

1/1(8ns/0.6min),1/2(17ns/1.2min),1/4(33ns/2.4min),
1/8(67ns/4.8min),1/16(133ns/9.5min),1/32(267ns/19.1min),
1/64(533ns/38.2min),1/128(1067ns/1.3h),1/256(2133ns/2.5h),
1/512(4267ns/5.1h),1/1024(8533ns/10.2h),1/2048(17067ns/20.4h),
1/4096(34133ns/40.7h

Use timer function 
[Simulator]

Select whether to use the timer function. 

Default No

Modifying Select from the drop-down list.

Available 
values

Yes Uses timer functions. 

No Does not use timer functions. 

Use coverage func-
tion
[Simulator]

Select whether to use the coverage function. 

Default No

Modifying Select from the drop-down list.

Available 
values

Yes Uses coverage functions

No Does not use coverage functions

Reuse coverage 
result

Select whether to load/save the coverage measurement result when connecting to or 
disconnecting from the debug tool. 
[Simulator]

This property appears only when the [Use coverage function] property is set to [Yes]. 

Default No

Modifying Select from the drop-down list.

Available 
values

Yes Loads/saves the coverage measurement result. 

No Does not load/save the coverage measurement result. 



CS+ V8.04.00 A.  WINDOW REFERENCE

R20UT4692EJ0100  Rev.1.00 Page 188 of 411
Jun 01, 2020

Note [IECUBE]
When the [Connecting with target board] property in the [Connection with Target Board] 
[IECUBE][E1][EZ Emulator] category on the [Connect Settings] tab is set to [No], this property is 
fixed to [Yes] automatically after connecting to the debug tool (changes not allowed). 

(11) [Virtual Board] [Simulator] 
The detailed information on the virtual board is displayed and its configuration can be changed. 

Caution After connecting to the debug tool, all the properties in this category will become invalid when a 
microcontroller whose Simulator does not support peripheral function simulations (instruction simu-
lation version) is selected.

(12) [Simulator GUI] [Simulator] 
The detailed information on the Simulator GUI is displayed and its configuration can be changed. 

Mask WAIT signal
[IECUBE]

Select whether to mask WAIT signal to prevent the signal input to emulators. 

Default NoNote 

Modifying Select from the drop-down list.

Available 
values

Yes Masks WAIT signal.

No Does not mask WAIT signal.

Mask TARGET 
RESET signal

Select whether to mask TARGET RESET signal to prevent the signal input to emula-
tors. 

Default NoNote

Modifying Select from the drop-down list.

Available 
values

Yes Masks TARGET RESET signal.

No Does not mask TARGET RESET signal.

Mask INTERNAL 
RESET signal

Select whether to mask INTERNAL RESET signal to prevent the signal input to emula-
tors. 

Default No

Modifying Select from the drop-down list.

Available 
values

Yes Masks INTERNAL RESET signal.

No Does not mask INTERNAL RESET signal.

Mask NMI signal
[IECUBE]

Select whether to mask NMI signal to prevent the signal input to emulators. 

Default No

Modifying Select from the drop-down list.

Available 
values

Yes Masks NMI signal.

No Does not mask NMI signal.

Use the same virtual 
board as the web 
simulator

Select whether to use the same virtual board as the web simulator.
See "Virtual Board panel [Simulator]" for details on the function of the virtual board.

Default No

Modifying Select from the drop-down list.
(Changes not allowed during connecting to the debug tool.)

Available 
values

Yes Uses the same virtual board as the web simulator.

No Does not use the same virtual board as the web simulator.
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Caution After connecting to the debug tool, all the properties in this category will become invalid when a 
microcontroller whose Simulator does not support peripheral function simulations (instruction simu-
lation version) is selected.

(13) [Step function]
The detailed information on the control method of step execution is displayed and its configuration can be 
changed. 

Display Simulator 
GUI

Select whether to display the Simulator GUI window to use the Simulator GUI. 

Default Yes

Modifying Select from the drop-down list.
(Changes not allowed during execution of a program.)

Available 
values

Yes Uses the function of the Simulator GUI.

No Does not use the function of the Simulator GUI.

Display Simulator 
GUI on top of other 
windows

Select whether to display the Simulator GUI window in the forefront when program exe-
cution starts. 
This property appears only when the [Display Simulator GUI] property is set to [Yes]. 

Default Yes

Modifying Select from the drop-down list.

Available 
values

Yes Displays it in the forefront. 

No Does not display it in the forefront. 

Skip target section Select whether to skip the target section.

Default No

Modifying Select from the drop-down list.

Available 
values

Yes Skips the target section.

No Does not skip the target section.

Target section Specify the target section.
This property appears only when the [Skip target section] property is set to [Yes].

Default [Number of sections to skip]

Modifying Specify with the Specified Section dialog box.
The Specified Section dialog box is opened by clicking the [...] button that 
appears at right edge of this field when you select this property (The sec-
tions to be skipped cannot be specified from this panel.).
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[Flash Self Emulation Settings] tab [IECUBE]

This tab is used to display the detailed information categorized by the following and the configuration can be changed. 
Note that this tab appears only when the selected microcontroller incorporates the flash memory. 

(1)  [Flash Self Emulation]
(2)  [Writing Time/Erasing Time]
(3)  [Macro Service Error]
(4)  [Setting Flash shield wIndow]
(5)  [Security Flag Emulation]

[Description of each category]

(1) [Flash Self Emulation]
The detailed information on flash self programming emulation functions is displayed and its configuration can be 
changed. 

(2) [Writing Time/Erasing Time]
The detailed information on the time for writing to and erasing the flash memory is displayed and its configuration 
can be changed. 

Flash self-program-
ming 

Select whether to use the flash self programming emulation function. 

Default No

Modifying Select from the drop-down list.

Available 
values

Yes Uses the flash self programming emulation function. 

No Does not use the flash self programming emulation function. 

Writing time Select the value to simulate the delay time for writing to the flash memory. 

Default Typical number of times that is assumed by flash macro specifications

Modifying Select from the drop-down list.

Available 
values

No retry Specifies "0" as the number of times of retry.
The delay time is 0 (the writing speed is fast-
est).

Typical number of times 
that is assumed by flash 
macro specifications

Specifies the typical number of times that is 
assumed by flash macro specifications.

Maximum number of 
times that is assumed by 
flash macro specifications

Specifies the maximum number of times that 
is assumed by flash macro specifications.

Retries for the maximum 
number of times specified

Specifies the maximum number of times of 
retry.
The delay time is maximum (the writing speed 
is longest).

Address for writing 
time

Specify the target address at which to simulate the delay time for writing.

Default 0

Modifying Directly enter from the keyboard. 

Available 
values

0x0 to 0xFFFFF in hexadecimal number 
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Note 1. The flash library writes to the code flash memory in 4-byte units, so fix the lowest and second-low-
est order bits of the address mask to 1.

Note 2. The flash library erases the code flash memory in block units, so fix the lower-order 10 bits of the 
address mask to 1.

(3) [Macro Service Error]
The detailed information on the flash macro service is displayed and its configuration can be changed.
The error values that are not returned during normal emulation can be forcibly returned by setting the properties of 
this category. 

Address mask value 
for writing time

Specify a mask value for the address for writing time.

Default 0x3

Modifying Directly enter from the keyboard. 

Available 
values

0x0 to 0xFFFFF in hexadecimal numberNote 1

Erasing time Select the value to simulate the delay time for erasing the flash memory. 

Default Typical number of times that is assumed by flash macro specifications

Modifying Select from the drop-down list.

Available 
values

No retry Specifies "0" as the number of times of retry.
The delay time is 0 (the erasing speed is fast-
est).

Typical number of times 
that is assumed by flash 
macro specifications

Specifies the typical number of times that is 
assumed by flash macro specifications.

Maximum number of 
times that is assumed by 
flash macro specifications

Specifies the maximum number of times that 
is assumed by flash macro specifications.

Retries for the maximum 
number of times specified

Specifies the maximum number of times of 
retry.
The delay time is maximum (the erasing 
speed is longest).

Address for erasing 
time

Specify the target address at which to simulate the delay time for erasing.

Default 0

Modifying Directly enter from the keyboard. 

Available 
values

0x0 to 0xFFFFF in hexadecimal number 

Address mask value 
for erasing time

Specify a mask value for the address for erasing time.

Default 0x3FF

Modifying Directly enter from the keyboard. 

Available 
values

0x0 to 0xFFFFF in hexadecimal numberNote 2

Macro Service Errors Specify the error to generate in the flash macro service to emulate. 
Up to three types of errors to generate ([0]/[1]/[2]) can be specified with subproperties 
for this property. 
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Note In the [Generate error] subproperty, when [Generate FlashWrite Error (Write)] is selected, fix the 
lowest and second-lowest order bits of the mask value to 1, because the flash library writes to the 
code flash memory in 4-byte units.
Also, when [Generate FlashErase Error (Erase)], [Generate FlashBlankCheck Error (BlankCheck)] 
or [Generate FlashIVerify Error (IVerify)] is selected, fix the lower-order 10 bits of the mask value to 
1, because erasure of the code flash memory, blank checking, and internal verification proceed in 
block units.

(4) [Setting Flash shield wIndow] 
The detailed information on the flash shield window function is displayed and its configuration can be changed. 

Caution Settings of this category are applied after CPU reset is generated. 
If you changed these settings, execute the program after reset the CPU. 

Generate error
(Subproperty)

Select the type of error to generate. 

Default None

Modifying Select from the drop-down list.

Available 
values

None

Generate FlashErase Error (Erase)

Generate FlashBlankCheck Error (BlankCheck)

Generate FlashWrite Error (Write)

Generate FlashIVerify Error (IVerify)

Generate FlashSetSecurity / FlashSetFSW Error (Erase)

Generate FlashSetSecurity / FlashSetFSW Error (Write)

Generate FlashSetSecurity / FlashSetFSW Error (IVerify)

Address for error
(Subproperty)

Specify an address at which the error is to be generated, within the flash memory area. 
This property appears only when the [Generate error] subproperty is set to [Generate 
erase error for FlashErase]/[Generate write error for FlashWrite]/[Generate IVerify error 
for FlashIVerify]/[Generate BlankCheck error for FlashBlankCheck].

Default 0

Modifying Directly enter from the keyboard. 

Available 
values

0x0 to 0xFFFFF in hexadecimal number 

Address mask value 
for error
(Subproperty)

Specify a mask value for the address, at which the error is to be generated. 
This property appears only when the [Generate error] subproperty is set to [Generate 
erase error for FlashErase]/[Generate write error for FlashWrite]/[Generate IVerify error 
for FlashIVerify]/[Generate BlankCheck error for FlashBlankCheck].

Default 0

Modifying Directly enter from the keyboard. 

Available 
values

0x0 to 0xFFFFF in hexadecimal numberNote

Flash shield window 
start block

Specify the start block of the area that can be written to and erased by flash self pro-
gramming. 

Default 0

Modifying Directly enter from the keyboard. 

Available 
values

0x0 to 0xFFFF in hexadecimal number 
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(5) [Security Flag Emulation] 
The detailed information on the security flag emulation function is displayed and its configuration can be changed. 

Caution Settings of this category are applied after CPU reset is generated. 
If you changed these settings, execute the program after reset the CPU.

Flash shield window 
end block

Specify the end block of the area that can be written to and erased by flash self pro-
gramming. 

Default FFFF

Modifying Directly enter from the keyboard. 

Available 
values

0x0 to 0xFFFF in hexadecimal number 

Disable block erase Select whether to emulate to disable block erase. 

Default No

Modifying Select from the drop-down list.

Available 
values

Yes Emulates to disable block erase. 

No Does not emulate to disable block erase. 

Disable program Select whether to emulate to disable writing. 

Default No

Modifying Select from the drop-down list.

Available 
values

Yes Emulates to disable writing. 

No Does not emulate to disable writing. 

Disable boot block 
cluster reprogram

Select whether to emulate to disable rewrite boot area. 

Default No

Modifying Select from the drop-down list.

Available 
values

Yes Emulates to disable rewrite boot area.

No Does not emulate to disable rewrite boot area. 
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[DataFlash Emulation Settings] tab [IECUBE]

This tab is used to display the detailed information categorized by the following and the configuration can be changed. 
Note that this tab appears only when the selected microcontroller incorporates the data flash memory. 

(1)  [DataFlash Emulation]
(2)  [Writing Time]
(3)  [Macro Service Error]

[Description of each category]

(1) [DataFlash Emulation]
The detailed information on the data flash emulation functions is displayed and its configuration can be changed. 

(2) [Writing Time]
The detailed information on the time for writing to the data flash memory is displayed and its configuration can be 
changed. 

DataFlash emulation Select whether to use the data flash emulation function.

Default No

Modifying Select from the drop-down list.

Available 
values

Yes Uses data flash emulation functions.

No Does not use data flash emulation functions.

Writing time Select the value to simulate the delay time for writing to the data flash memory.

Default Typical number of times that is assumed by flash macro specifications

Modifying Select from the drop-down list.

Available 
values

No retry Specifies "0" as the number of times of retry.
The delay time is 0 (the writing speed is fastest).

Typical number of times 
that is assumed by flash 
macro specifications

Specifies the typical number of times that is 
assumed by flash macro specifications.

Maximum number of 
times that is assumed 
by flash macro specifi-
cations

Specifies the maximum number of times that is 
assumed by flash macro specifications.

Retries for the maximum 
number of times speci-
fied

Specifies the maximum number of times of retry.
The delay time is maximum (the writing speed is 
longest).

Address for writing 
time

Specify the target address at which to simulate the delay time for writing.

Default F1000

Modifying Directly enter from the keyboard. 

Available 
values

0xF1000 to 0xFFFFF in hexadecimal number 

Address mask value 
for writing time

Specify a mask value for the address for writing time.

Default 0

Modifying Directly enter from the keyboard. 

Available 
values

0x0 to 0xFFFFF in hexadecimal number 
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(3) [Macro Service Error]
The detailed information on the data flash macro service is displayed and its configuration can be changed.
The error values that are not returned during normal emulation can be forcibly returned by setting the properties of 
this category. 

Macro Service Errors Specify the error to generate in the data flash macro service to emulate. 
Up to four types of errors to generate ([0]/[1]/[2]/[3]) can be specified with subproperties 
for this property. 

Generate error
(Subproperty)

Select the type of error to generate. 

Default None

Modifying Select from the drop-down list.

Available 
values

None

Generate FlashBlankCheck Error (BlankCheck)

Generate FlashWrite Error (Write)

Generate FlashIVerify Error (IVerify)

Address for error
(Subproperty)

Specify an address at which the error is to be generated, within the flash memory area. 
This property appears only when the [Generate error] subproperty is set to the value 
other than [None]. 

Default F1000

Modifying Directly enter from the keyboard. 

Available 
values

0xF1000 to 0xFFFFF in hexadecimal number 

Address mask value 
for error
(Subproperty)

Specify a mask value for the address, at which the error is to be generated. 
This property appears only when the [Generate error] subproperty is set to the value 
other than [None]. 

Default 0

Modifying Directly enter from the keyboard. 

Available 
values

0x0 to 0xFFFFF in hexadecimal number
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[Download File Settings] tab

This tab is used to display the detailed information categorized by the following and the configuration can be changed. 
For details on the download function, see "2.5  Download/Upload Programs".

(1)  [Download]
(2)  [Debug Information]

[Description of each category]

(1) [Download]
The detailed information on download is displayed and its configuration can be changed. 

Download files Specify the file to downloadNote 1. 
The names of files to be downloaded and the download conditions are listed in the 
lower area. 

Default [Number of files to download] 

Modifying Specify with the Download Files dialog box.
The Download Files dialog box is opened by clicking the [...] button that 
appears at right edge of this field when you select this property (you cannot 
specify the file to download on this panel). 

CPU Reset after 
download

Select whether to reset the CPU after downloading.
This property does not appear when the selected microcontroller always resets the 
CPU after downloading.

Default Yes

Modifying Select from the drop-down list.

Available 
values

Yes Resets the CPU after downloading. 

No Does not reset the CPU after downloading. 

Download Mode
(except [Simulator])

Select the download mode for downloading to the flash ROM. 

Default Speed priority

Modifying Select from the drop-down list.

Available 
values

Speed priority Fills free space between the first data and the final 
data with FFH.
Download speed will be faster because the writing 
data is reduced (default).

Data priority Retains the previous value in free space.
Download speed will be very slow because data in 
free space are read once.

Erase flash ROM 
before download
(except [Simulator])

Select whether to erase the flash ROM before downloading. 

Default No

Modifying Select from the drop-down list.
Note that changes cannot be made when the [Download Mode] property is 
set to [Data priority].

Available 
values

Yes Erases the flash ROM before downloading. 

No Does not erase the flash ROM before downloading. 
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Note 1. Files specified as build targets in a main project or sub-project cannot be deleted from the target 
files to download (These files are automatically registered as download files by default). 
See "Table 2.1  Downloadable File Formats" for downloadable file format. 

Note 2. This property setting works only for the location setting of events without the debug information.  
The location setting of events with the debug information is always moved to the beginning of the 
source text line. 

(2) [Debug Information]
The detailed information on debugging is displayed and its configuration can be changed. 

Note In some cases, lowering the upper limit may lead to poorer responsiveness since it leads to more 
frequent discarding and re-reading of debug information. 

Automatic change 
method of event set-
ting position

Select how to perform the setting again if the file is downloaded again, and the location 
(address) set for the currently set event changes to midway in the instructionNote 2. 

Default Suspend event

Modifying Select from the drop-down list.

Available 
values

Move to the head 
of instruction

Sets the event to the top address of the instruction.

Suspend event Disables the event (suspended state).

Check reserved area 
overwriting when 
downloading
[E1][E20]
[EZ Emulator]

Select whether to output a message when overwriting to an area reserved for use by 
the emulator is attempted at the time of downloading. 

Default Yes

Modifying Select from the drop-down list.

Available 
values

Yes Outputs a message when overwriting to an area reserved is 
attempted. 

No Does not output a message when overwriting to an area reserved 
is attempted. 

Execute to the speci-
fied symbol after 
CPU Reset

Select whether to execute the program to the specified symbol position after CPU reset. 

Default Yes

Modifying Select from the drop-down list.

Available 
values

Yes Executes the program to the specified symbol position after CPU 
reset. 

No Does not execute the program after CPU reset. 

Specified symbol Specify the position at which the program is stop after CPU reset. 
This property appears only when the [Execute to the specified symbol after CPU Reset] 
property is set to [Yes]. 

Default _main

Modifying Directly enter from the keyboard. 

Available 
values

Address expression from 0 to the "end address of the address space". 

The upper limit size 
of the memory usage 
[Mbytes]

Specify the memory size to be used for reading the debug informationNote.

Default 500

Modifying Directly enter from the keyboard. 

Available 
values

Decimal number between 100 and 1000
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[Hook Transaction Settings] tab

This tab is used to display the detailed information categorized by the following and the configuration can be changed.  
For details on the hook transaction, see "2.16  Use Hook Function".

(1)  [Hook Transaction Settings]

[Description of each category]

(1) [Hook Transaction Settings]
The detailed information on the hook transaction is displayed and its configuration can be changed. 
Note that the properties on this tab can be specified via the Text Edit dialog box, which is opened by clicking the 
[...] button that appears at right edge of a field when you select each property (you cannot specify the process 
directly on this panel).

Caution Up to 64 characters for one process, and up to 128 processes for each property can be set (one 
line in the [Text] area in the Text Edit dialog box is equivalent to one processing). 

Before download Specify the process to proceed right before downloading the load module file. 

Default Before download[0] ("[]" is the current number of specified processes.)

Modifying Specify with the Text Edit dialog box.

Format Either one of the following

- SFR name + space + Value
[Process] Automatically overwrites the value of SFR with Value.

- CPU register name + space + Value
[Process] Automatically overwrites the value of CPU register with Value.

- Source + space + Python script path
[Process] Automatically executes a script file specified with Python 
script path.

After download Specify the process to proceed right after downloading the load module file. 

Default After download[0] ("[]" is the current number of specified processes.)

Modifying Specify with the Text Edit dialog box.

Format Either one of the following

- SFR name + space + Value
[Process] Automatically overwrites the value of SFR with Value.

- CPU register name + space + Value
[Process] Automatically overwrites the value of CPU register with Value.

- Source + space + Python script path
[Process] Automatically executes a script file specified with Python 
script path.
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After CPU reset 
under breaking

Specify the process to proceed right after CPU reset during break. 

Default After CPU reset under breaking[0] ("[]" is the current number of specified 
processes.)

Modifying Specify with the Text Edit dialog box.

Format Either one of the following

- SFR name + space + Value
[Process] Automatically overwrites the value of SFR with Value.

- CPU register name + space + Value
[Process] Automatically overwrites the value of CPU register with Value.

- Source + space + Python script path
[Process] Automatically executes a script file specified with Python 
script path.

Before running Specify the process to proceed right before the execution of the program.

Default Before running[0] ("[]" is the current number of specified processes.)

Modifying Specify with the Text Edit dialog box.

Format Either one of the following

- SFR name + space + Value
[Process] Automatically overwrites the value of SFR with Value.

- CPU register name + space + Value
[Process] Automatically overwrites the value of CPU register with Value.

- Source + space + Python script path
[Process] Automatically executes a script file specified with Python 
script path.

After breaking Specify the process to proceed right after the program break.

Default After breaking[0] ("[]" is the current number of specified processes.)

Modifying Specify with the Text Edit dialog box.

Format Either one of the following

- SFR name + space + Value
[Process] Automatically overwrites the value of SFR with Value.

- CPU register name + space + Value
[Process] Automatically overwrites the value of CPU register with Value.

- Source + space + Python script path
[Process] Automatically executes a script file specified with Python 
script path.
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This panel is used to display the contents of the memory and change the memory value (see "2.9.1  Display/change the 
memory"). 

Furthermore, the contents of data flash memory can be displayed and changed when the selected microcontroller incor-
porates the data flash memory.

Up to a maximum of four of these panels can be opened.  Each panel is identified by the names "Memory1", "Memory2", 
"Memory3", and "Memory4" on the titlebar. 

The display contents are automatically updated when the value of the memory changes after a program is executed 
(when the execution is done in steps, the display is updated after each step).

In addition, by enabling the Real-time display update function, it is also possible to update the display contents in real-
time even while a program is being executed. 

This panel appears only when connected to the debug tool.

Remark 1. You can set the scroll range of the vertical scroll bar on this panel via the Scroll Range Settings dialog 
box which is opened by clicking the  button from [View] on the toolbar. 

Remark 2. This panel can be zoomed in and out by  in the tool bar, or by moving the mouse 
wheel forward or backward while holding down the [Ctrl] key.

Figure A.5 Memory Panel

This section describes the following. 

- [How to open]

- [Description of each area]

- [Toolbar]

- [[File] menu (Memory panel-dedicated items)]

- [[Edit] menu (Memory panel-dedicated items)]

- [Context menu]

[How to open]

- From the [View] menu, select [Memory] >> [Memory1-4].

[Description of each area]

(1) Display position specification area
It is possible to specify the display start position of the memory contents by specifying an address expression. 
Specify the following items.

Memory panel

(1)

(2)

[Toolbar]

(3) (4)
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(a) Specify an address expression 
Directly input the address expression of the memory value address to display in the text box. You can specify an 
input expression with up to 1024 characters.  The result of the expression is treated as the display start position 
address. 
Note that if an address value greater than the microcontroller address space is specified, the high-order address 
value is masked. 
In addition, an address value greater than the value expressed within 32 bits cannot be specified.

Remark 1. A symbol name at the current caret position can be complemented by pressing the [Ctrl] + 
[Space] key in this text box (see "2.19.2  Symbol name completion function"). 

Remark 2. If the specified address expression is the symbol and its size can be recognized, everything from 
the start address to the end address of that symbol is displayed selected. 

(b) Specify automatic/manual evaluation of the address expression
The timing to change the display start position can be determined by specifying in the [Move when Stop] check 
box and the [Move] button. 

(2) Address area
The address of the memory is displayed (hexadecimal number notation fixing). 
The display starts from address 0x0 by default.  However, an offset value of the start address can be set via the 
Address Offset Settings dialog box that is opened by selecting [Address Offset Value Settings...] from the context 
menu.
The address width corresponds to the one in memory space of the specified microcontroller in the project. 
This area cannot be edited. 

Caution The offset value that have been set is automatically changed in accordance with the number of 
view columns in the Memory value area.

(3) Memory value area
The value of the memory is displayed and changed. 
Specification of the display notation, display width of memory values or the number of view columns is performed 
by selecting the buttons on the toolbar or [Notation]/[Size Notation]/[View] from the context menu (see "2.9.1.2  
Change display format of values"). 
The meanings of the marks and colors displayed as memory values are as follows (character colors and back-
ground colors depend on the configuration in the [General - Font and Color] category of the Option dialog box):

[Move when Stop] The caret is moved to the address which is automatically calculated from the 
address expression after the program is stopped. 

The address expression is not automatically evaluated after the program is 
stopped. 
Click the [Move] button to manually evaluate the address expression. 

[Move] button When the [Move when Stop] check box is not checked, click this button to evalu-
ate the address expression and move the caret to the result address of the evalu-
ation. 

Display Example (Default) Description 

Character color Blue Memory value that the user is changing 
Press the [Enter] key to write to the target memory. 

Background color Standard color

(Under line)
Character color Standard color Memory value of the address whose symbol has been 

defined (Registering watch-expression can be per-
formed).Background color Standard color

Character color Brown Memory value that has been changed because of the exe-
cution of a programNote

To reset the highlighting, select the  button on the tool-
bar. 

Background color Cream

Character color Pink Memory value for which the Real-time display update 
function is being operated

Background color Standard color
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Note Just before execution of a program, only the memory value in the address range for which the 
Memory panel had been displayed becomes the target. 
In addition, the value is not highlighted if it is same for before and after the execution of the pro-
gram. 

Caution The number of view columns is automatically changed in accordance with the set value of [Size 
Notation] of the context menu. 

This area is provided with the following functions. 

(a) Pop-up display
The following contents are pop-up displayed based on the nearest existing symbol forward from the address the 
mouse is designating when hovering the mouse cursor over the memory value. 
Note that if there is no symbol information (the underlining is non-display), no pop-up display is done. 

(b) Real-time display update function
Using the real-time display update function allows you to display/modify the value of the memory contents not 
only while the program is stopped, but also in execution. 
See "2.9.1.4  Display/modify the memory contents during program execution" for details on the real-time display 
update function. 

(c) Changing memory values
Directly edit from the keyboard after moving the caret to the memory value to be edited. 
The color of the memory value changes when it is in editing.  Press the [Enter] key to write the edited value to 
the target memory (if the [Esc] key is pressed before the [Enter] key is pressed, the editing is cancelled). 
See "2.9.1.3  Modify the memory contents" for details on the method for changing the memory value. 

Character color Standard color Read/
Fetch

Current access condition of the memory 
value when the Real-time display update 
function is being operatedBackground color Palegreen

Character color Standard color Write

Background color Orange

Character color Standard color Read and 
Write

Background color Paleturquoise

Character color Gray Memory value of the read-protected area

Background color Standard color

Character color Gray Areas not memory-mapped

Background color Standard color

Character color Gray Areas not rewritable (e.g. SFR area/I/O protection area) or 
when acquisition of memory values failed

Background color Standard color

** Character color Standard color When display is specified for other than the real-time dis-
play update area during program execution or when 
acquisition of memory values failed Background color Standard color

Symbol name Indicates the name of the symbol. 

Offset value When a symbol has not been defined for the addresses, the offset value from the nearest 
symbol exists forward is displayed (hexadecimal number notation fixing). 

Display Example (Default) Description 

    variable            +  0x14

Symbol name Offset value
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(d) Searching/initializing memory value
The Memory Search dialog box is opened to search the memory contents in the specified address range by 
selecting [Find...] from the context menu (see "2.9.1.5  Search the memory contents").
In addition, the Memory Initialize dialog box is opened to change the memory contents collectively in the speci-
fied address range by selecting [Fill...] from the context menu (see "2.9.1.6  Modify the memory contents in 
batch (initialize)").

(e) Copying and pasting
By selecting a range of memory values with the mouse, the contents of the range can be copied to the clipboard 
as a character string, and these contents can be pasted to the caret position. 
These operations are performed by selecting from the context menu or selecting from the [Edit] menu. 
However, the paste operation is possible only when the character string to be pasted and the display notation 
(radix and size) of the area match. 
If the display notation does not match, a message is displayed. 
The character codes and character strings that can be handled by this area are as follows. 
If character strings other than these are pasted, a message is displayed. 

(f) Registering watch-expression
A memory value with underline indicates that a symbol has been defined in the address, and its symbol can be 
registered as a watch-expression. 
After selecting the memory value or placing the caret on the memory value, the symbol name of the address is 
registered in the Watch panel (Watch1) as a watch-expression by selecting [Register to Watch1] from the con-
text menu. 

Caution A memory value without underline cannot be registered as a watch-expression. 

(g) Saving the contents of memory values
The Data Save dialog box can be opened by selecting the [File] menu >> [Save Memory Data As...], and the 
contents of this panel can be saved in a text file (*.txt) or CSV file (*.csv). 
See "2.9.1.7  Save the memory contents" for details on the method for saving the contents of memory values. 

(4) Character strings area
Memory values converted into character code are displayed. 
The character code can be specified by selecting [Encoding] from the toolbar or context menu (ASCII code is 
selected by default). 
Furthermore, in this area, memory values converted into a floating-point value can be displayed as character 
strings.  To do this, select the following item from [Encoding] of the context menu. 

Character code ASCII

Character string 0, 1, 2, 3, 4, 5, 6, 7, 8, 9, a, b, c, d, e, f, A, B, C, D, E, F

Item Display Format Size

Half-Precision 
Float

Half-precision floating-point value 16-bit

Numeric value <sign><mantissa>e<sign><exponent>

Infinite number Inf, and -Inf

Not a number NaN

Example + 1.234e+1

Float Single-precision floating-point value 32-bit

Numeric value <sign><mantissa>e<sign><exponent>

Infinite number Inf, and -Inf

Not a number NaN

Example + 1.234567e+123
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Caution Nothing is displayed when the minimum size of a character code or a floating-point value is greater 
than "the number of bytes of display width of memory values" x "the number of bytes of the number 
of view columns".

This area is provided with the following functions. 

(a) Changing character strings
Directly edit from the keyboard after moving the caret to the character string to be edited. 
The color of the character string changes when it is in editing.  Press the [Enter] key to write the edited value to 
the target memory (if the [Esc] key is pressed before the [Enter] key is pressed, the editing is cancelled). 

Caution Character strings displayed as floating-point values cannot be searched. 

(b) Searching character strings
The Memory Search dialog box is opened to search for character strings by selecting [Find...] from the context 
menu (see "2.9.1.5  Search the memory contents").

(c) Copying and pasting
By selecting a range of character strings with the mouse, the contents of the range can be copied to the clip-
board as a character string, and these contents can be pasted to the caret position. 
These operations are performed by the selecting from the context menu or selecting from the [Edit] menu. 
However, the paste operation is possible only when [ASCII] has been selected as the character code.  If other 
than [ASCII] is selected, a message is displayed. 

[Toolbar]

Double Double-precision floating-point value 64-bit

Numeric value <sign><mantissa>e<sign><exponent>

Infinite number Inf, and -Inf

Not a number NaN

Example + 1.2345678901234e+123

Float Complex Complex number of single-precision floating-point 64-bit

<Single-precision floating-point value> <Single-precision floating-point 
value> * I

Double Complex Complex number of double-precision floating-point 128-bit

<Double-precision floating-point value> <Double-precision floating-point 
value> * I

Float Imaginary Imaginary number of single-precision floating-point 32-bit

<Single-precision floating-point value> * I

Double Imaginary Imaginary number of double-precision floating-point 64-bit

<Double-precision floating-point value> * I

Acquires the latest data from the debug tool, and updates the contents of this panel. 

Resets highlighting of values that have been changed by executing a program. 
This item is disabled during execution of a program.

Notation The following buttons to change the notation of memory values are displayed. 
The items below is disabled during execution of a program. 

Item Display Format Size
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[[File] menu (Memory panel-dedicated items)]

The following items are exclusive for the [File] menu in the Memory panel (other items are common to all the panels). 

 Hexadecimal Displays memory values in hexadecimal number (default).

 Signed Decimal Displays memory values in signed decimal number.

 Unsigned Decimal Displays memory values in unsigned decimal number.

 Octal Displays memory values in octal number.

 Binary Displays memory values in binary number.

Size Notation The following buttons to change the notation of sizes of memory values are dis-
played. 
The items below is disabled during execution of a program. 

 4 Bits Displays memory values in 4-bit width. 

 1 Byte Displays memory values in 8-bit width (default). 

 2 Bytes Displays memory values in 16-bit width. 
Values are converted depending on the endian of the target memory area.

 4 Bytes Displays memory values in 32-bit width. 
Values are converted depending on the endian of the target memory area.

 8 Bytes Displays memory values in 64-bit width. 
Values are converted depending on the endian of the target memory area.

Encoding The following buttons to change the encoding of character strings are displayed.
The items below is disabled during execution of a program. 

 ASCII Displays character strings in ASCII code (default).

 Shift_JIS Displays character strings in Shift_JIS code.

 EUC-JP Displays character strings in EUC-JP code.

 UTF-8 Displays character strings in UTF-8 code.

 UTF-16 Displays character strings in UTF-16 code.

 Half-Precision Float Displays character strings as a half-precision floating-point value. 

 Float Displays character strings as a single-precision floating-point value. 

 Double Displays character strings as a double-precision floating-point value. 

 Float Complex Displays character strings as a complex number of single-precision floating-point. 

 Double Complex Displays character strings as a complex number of double-precision floating-point. 

 Float Imaginary Displays character strings as an imaginary number of single-precision floating-
point. 

 Double Imaginary Displays character strings as an imaginary number of double-precision floating-
point. 

View The following buttons to change the display format are displayed.

 Settings Scroll Range... Opens the Scroll Range Settings dialog box to set the scroll range for this panel.

Column Number Settings... Opens the Column Number Settings dialog box to set the number of view columns 
in the Memory value area.

Address Offset Value Set-
tings...

Opens the Address Offset Settings dialog box to set an offset value for addresses 
displayed in the Address area.
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Note that all these items are disabled during execution of a program. 

[[Edit] menu (Memory panel-dedicated items)]

The following items are exclusive for [Edit] menu in the Memory panel (all other items are disabled). 
Note that all these items are disabled during execution of a program. 

[Context menu]

Save Memory Data Overwrites the contents of this panel to the previously saved text file (*.txt)/CSV file 
(*.csv) (see "(g)  Saving the contents of memory values"). 
Note that when the file has never been saved or the file is write disabled, the same oper-
ation is applied as the selection in [Save Memory Data As...]. 

Save Memory Data As... Opens the Data Save dialog box to newly save the contents of this panel to the specified 
text file (*.txt)/CSV file (*.csv) (see "(g)  Saving the contents of memory values"). 

Copy Copies the contents of the selected range to the clipboard as character string(s). 

Paste Pastes the character string(s) copied in the clipboard to the caret position. 

- To the memory value area: See "(e)  Copying and pasting". 

- To the character strings area: See "(c)  Copying and pasting". 

Find... Opens the Memory Search dialog box. 
The search is operated either in the Memory value area or the Character strings area, in 
which a caret is. 

Register to Watch1 Registers the symbol at the caret to the Watch panel (Watch1). 
At this time, since it is registered as a variable name, the symbol name that is displayed 
changes depending on the scope. 
Note that this item is disabled when no symbol has been defined in the address corre-
sponding to the memory value at the caret position (see "(f)  Registering watch-expres-
sion"). 

Find... Opens the Memory Search dialog box. 
The search is operated either in the Memory value area or the Character strings area 
(unless the floating-point value display is selected), in which a caret is. 
This item is disabled during execution of a program. 

Fill... Opens the Memory Initialize dialog box. 

Refresh Acquires the latest data from the debug tool, and updates the contents of this panel. 

Copy Copies the contents of the selected range to the clipboard as character string(s). 
This item is disabled during execution of a program. 

Paste Pasts the character string(s) copied in the clipboard to the caret position. 
This item is disabled during execution of a program. 

- To the memory value area: See "(e)  Copying and pasting". 

- To the character strings area: See "(c)  Copying and pasting". 

Notation The following cascade menus are displayed to specify the notation of memory values. 

Hexadecimal Displays memory values in hexadecimal number (default).

Signed Decimal Displays memory values in signed decimal number.

Unsigned Decimal Displays memory values in unsigned decimal number.

Octal Displays memory values in octal number.

Binary Displays memory values in binary number.
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Size Notation The following cascade menus are displayed to specify the notation of sizes of memory val-
ues. 

4 Bits Displays memory values in 4-bit width. 

1 Byte Displays memory values in 8-bit width (default). 

2 Bytes Displays memory values in 16-bit width. 
Values are converted depending on the endian of the target memory area. 

4 Bytes Displays memory values in 32-bit width. 
Values are converted depending on the endian of the target memory area.

8 Bytes Displays memory values in 64-bit width. 
Values are converted depending on the endian of the target memory area.

Encoding The following cascade menus are displayed to specify the display format in the character 
strings area. 

ASCII Displays character strings in ASCII code (default).

Shift_JIS Displays character strings in Shift_JIS code.

EUC-JP Displays character strings in EUC-JP code.

UTF-8 Displays character strings in UTF-8 code.

UTF-16 Displays character strings in UTF-16 code.

Half-Precision Float Displays character strings as a half-precision floating-point value. 

Float Displays character strings as a single-precision floating-point value. 

Double Displays character strings as a double-precision floating-point value. 

Float Complex Displays character strings as a complex number of single-precision floating-point. 

Double Complex Displays character strings as a complex number of double-precision floating-point. 

Float Imaginary Displays character strings as an imaginary number of single-precision floating-point. 

Double Imaginary Displays character strings as an imaginary number of double-precision floating-point. 

View The following cascade menus are displayed to specify the display format. 

Settings Scroll 
Range...

Opens the Scroll Range Settings dialog box to set the scroll range for this panel.

Column Number Set-
tings...

Opens the Column Number Settings dialog box to set the number of view columns in the 
Memory value area.

Address Offset Value
Settings...

Opens the Address Offset Settings dialog box to set an offset value for addresses dis-
played in the Address area.

Highlight Accessed Highlights memory values that have changed by execution of a program if this item is 
checked (default).
This item is disabled during execution of a program. 

Periodic Updating The following cascade menus are displayed to set for the real-time display update function 
(see "(b)  Real-time display update function"). 

Periodic Updating 
Options

Opens the Property panel to set for the real-time display update function. 
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This panel is used to display the results of disassembling the contents of the memory (disassembled text), and execute 
line assembly (see "2.6.4  Perform line assembly"). 

Furthermore, the instruction level debugging (see "2.7.3  Execute programs in steps") and the code coverage measure-
ment result display [IECUBE][Simulator] (see "2.13  Measure Coverage [IECUBE][Simulator]") can be performed in this 
panel. 

Up to a maximum of four of these panels can be opened.  Each panel is identified by the names "Disassemble1", 
"Disassemble2", "Disassemble3" and "Disassemble4" on the titlebar. 

The source text in the source file corresponding to the code data can also be displayed by setting to the Mixed display 
mode (default). 

This panel appears only when connected to the debug tool. 

Caution A step execution is performed in instruction level units when the focus is in this panel (see "2.7.3  Exe-
cute programs in steps"). 

Remark 1. You can set the scroll range of the vertical scroll bar on this panel via the Scroll Range Settings dialog 
box which is opened by clicking the  button from [View] on the toolbar. 

Remark 2. You can print the current screen image of this panel by selecting [Print...] from the [File] menu. 

Remark 3. This panel can be zoomed in and out by  in the tool bar, or by moving the mouse 
wheel forward or backward while holding down the [Ctrl] key.

Figure A.6 Disassemble Panel (When Mixed Display Mode Is Selected)

Disassemble panel

[Toolbar]

(1) (2) (3)
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Figure A.7 Disassemble Panel (When Disassemble Display Mode Is Selected)

Figure A.8 Disassemble Panel (When Code Coverage Measurement Result Is Displayed)

This section describes the following. 

- [How to open]

- [Description of each area]

- [Toolbar]

- [[File] menu (Disassemble panel-dedicated items)]

- [[Edit] menu (Disassemble panel-dedicated items)]

- [Context menu]

[How to open]

- From the [View] menu, select [Disassemble] >> [Disassemble1 - 4].

[Toolbar]

(1) (2) (3)

[Toolbar]

(1) (2) (3)
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[Description of each area]

(1) Event area
The lines for which events can be set are shown with the background color in white (this mean that events cannot 
be set for those lines whose background color in gray). 
In addition, the Event mark corresponding to an event that has been currently set is displayed. 
This area is provided with the following functions. 

(a) Setting/deleting breakpoints
By clicking where you want to set a breakpoint with the mouse, the breakpoint can be set easily.
The breakpoint is set to the instruction at the start address of the clicked line.
Once the breakpoint is set, the Event mark is displayed at the line that is set.  In addition, the detailed informa-
tion about the set breakpoint is reflected in the Events panel. 
When this operation is performed at a place where any one of the event marks is already being displayed, that 
event is deleted and the setting of breakpoints cannot be done. 
Note that the setting of events can be done only for those lines where the background color is shown in white. 
See "2.8.3  Stop the program at the arbitrary position (breakpoint)" for details on how to set the breakpoint. 

(b) Changes event status
Event status can be changed from the following menu displayed by right-clicking the event mark. 

(c) Pop-up display
By hovering the mouse cursor over the Event mark, the name of the event, the detailed information for the event 
and the comments added to the event are pop-up displayed. 
When multiple events have been set in the applicable place, information for each event, up to a maximum of 
three events, is listed and displayed. 

(2) Address area
The address per line to start disassembling is displayed (hexadecimal number notation fixing). 
In addition, the current PC mark (  ) that corresponds to the current PC position (PC register value) is dis-
played. 
The address width corresponds to the one in memory space of the specified microcontroller in the project. 
For the source text line in the mixed display mode, line numbers (xxx:) in the source file correspond to the start 
address are displayed. 
This area is provided with the following functions. 

(a) Pop-up display
By hovering the mouse cursor over a address or line number, the following information is pop-up displayed. 

(3) Disassemble area
The results of disassembling are displayed next to the corresponding source text as follows.

Enable Event Changes the selected event state to a Valid state.
Event occurs when the specified condition is met. 
When the event mark (  ) which indicates that multiple events have been set 
is selected, all of the events that have been set are enabled. 

Disable Event Changes the selected event state to an Invalid state.
Event does not occur when the specified condition is met. 
When the event mark (  ) which indicates that multiple events have been set 
is selected, all of the events that have been set are disabled. 

Delete Event Deletes the selected event.
When the event mark (  ) which indicates that multiple events have been set 
is selected, all of the events that have been set are deleted. 

View Event Detailed 
Setup

Opens the Events panel to display the detailed information of the selected event. 

Address Format: <Label name> + <Offset value>
Example1: main + 0x10 
Example2: sub function + 0x20 

Source line number Format: <File name> # <Line number>
Example1: main.c#40
Example2: main.c#100
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Figure A.9 Display Contents of Disassemble Area (In Case of Mixed Display Mode)

Note 1. The highlighting color depends on the configuration in the [General - Font and Color] category of 
the Option dialog box. 

Note 2. The source text can be set to non-display by clicking the  button (toggle) on the toolbar or 
removing the check for [Mixed Display] from the context menu (this option is checked by default). 

Note 3. Offset values are not displayed by default.  They can be displayed by clicking the  button on the 
toolbar or selecting [Show Offset] from the context menu. 

This area is provided with the following functions. 

(a) Line assembly
Instructions and code displayed in this panel can be edited (line assembly). 
See "2.6.4  Perform line assembly" for details on how to operate it. 

(b) Program execution by instruction level
Execution can be controlled at the instruction level unit by step executing a program in a state where there is a 
focus on this panel. 
See "2.7.3  Execute programs in steps" for details on how to operate it. 

(c) Setting of various events
Various events can be set to the addresses/lines where the caret currently exists by selecting [Bread Settings], 
[Trace Settings] or [Timer Settings] from the context menu. 
The corresponding Event mark is displayed in the Event area when an event is set.  In addition, the detailed 
information about the set event is reflected in the Events panel. 
+Note, however, that the setting of events can be done only for those lines where the background color is shown 
in white in the event area. 
See the following for details on how to set events. 

- "2.8.5  Stop the program with the access to variables/SFRs"

Label line The label is displayed when a label is defined for the address, and its correspond-
ing line is shown highlighted in lightgreen. 

PC line A line corresponding to an address of the current PC (PC register value) is shown 
highlightedNote 1. 

Breakpoint line A line at which a breakpoint is set is shown highlightedNote 1. 

Source text line The source text corresponding to the code data is displayedNote 2. 

Disassem-
ble results

Offset value The offset value from the nearest label is displayed when a label is defined for the 
addressNote 3. 

Code The code that is the target of disassembly is displayed in hexadecimal number.

Instruction Instruction is displayed as the result of disassembling. 
The mnemonics are shown highlighted in blue. 

CodeOffset value Instruction

PC line

Breakpoint line

Label line

Disassemble results

Source text line
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- "2.11.3  Collect execution history in a section"

- "2.11.4  Collect execution history only when the condition is met [IECUBE][Simulator]"

- "2.12.3  Measure execution time in a section [IECUBE][Simulator]"

Remark A breakpoint can be set or deleted easily in the Event area as well (see "(a)  Setting/deleting 
breakpoints"). 

(d) Registering watch-expression
Variable names of C language, CPU registers, SFR, and assembler symbols can be registered in the Watch 
panel as watch-expressions.
See "2.9.6.1  Register a watch-expression" for details on how to operate it. 

(e) Moving to symbol definition place
By clicking the  button on the toolbar or selecting [Go to Symbol] from the context menu in a state where the 
caret has been moved to a instruction that has referenced a symbol, the caret position is moved to the address 
where the symbol at the caret position has been defined. 
In addition, when following on this operation you click on the  button on the toolbar or select [Back to 
Address] from the context menu, the caret position is returned to the instruction that has referenced a symbol 
before the caret was moved (the address value of the instruction that has referenced a symbol is displayed in 
Address). 

(f) Jump to source line and memory 
Selecting [Jump to Source] from the context menu will open the Editor panel with the caret moved to the source 
line corresponding to the address at the current caret position (if the Editor panel is already open, the screen will 
jump to the panel). 
In addition, similarly, selecting [Jump to Memory] will open the Memory panel (Memory1) with the caret moved 
to the memory value corresponding to the address at the current caret position (if the Memory panel (Memory1) 
is already open, the screen will jump to the panel). 

(g) Code coverage measurement result display [IECUBE][Simulator]
When the coverage function is validNote, lines corresponding to the specified coverage measurement area are 
shown highlighted based on the code coverage measurement result that is acquired by executing the program. 
See "2.13  Measure Coverage [IECUBE][Simulator]" for details on the coverage measurement. 

Note [IECUBE]
The coverage function is always valid. 

(h) Saving the contents of disassembled data
The Data Save dialog box can be opened by selecting the [File] menu >> [Save Disassemble Data As…], and 
the contents of this panel can be saved in a text file (*.txt) or CSV file (*.csv).  See "2.6.2.5  Save the disassem-
bled text contents" for details on the method for saving the contents of disassembled data. 

[Toolbar]

Acquires the latest data from the debug tool, and updates the contents of this panel. 

Sets to the mixed display mode and displays the correspondence between the disas-
sembled data and the source text (default). 

Specifies the caret position so that it follows the current PC value. 

Moves the caret to the define position of the selected symbol. 

Moves the caret to the position (address) immediately before it is moved with the  
button. 

View The following buttons to set the display contents in the disassemble area are dis-
played.



R20UT4692EJ0100  Rev.1.00 Page 213 of 411
Jun 01, 2020

CS+ V8.04.00 A.  WINDOW REFERENCE

[[File] menu (Disassemble panel-dedicated items)]

The following items are exclusive for the [File] menu in the Disassemble panel (other items are common to all the pan-
els). 

Note that all these items are disabled during execution of a program. 

[[Edit] menu (Disassemble panel-dedicated items)]

The following items are exclusive for the [Edit] menu in the Disassemble panel (all other items are disabled). 

[Context menu]

[Disassemble area and Address area]

 Show Offset Displays the offset value of the label. The offset value from the nearest label is dis-
played when a label is defined for the address. 

 Show Symbol Displays the address value in the format "symbol + offset value" (default). 
Note that when a symbol has been defined as the address value, only the symbol is 
displayed. 

 Show Function Name Displays the name of the register by its function name (default). 

 Show Absolute Name Displays the name of the register by its absolute name. 

Opens the Scroll Range Settings dialog box to set the scroll range for this panel.

Save Disassemble Data Overwrites the contents of the disassembling to the previously saved text file (*.txt)/CSV 
file (*.csv) (see "(h)  Saving the contents of disassembled data"). 
Note that when the file has never been saved or the file is write disabled, the same 
operation is applied as the selection in [Save Disassemble Data As…].

Save Disassemble Data 
As…

Opens the Data Save dialog box to newly save the contents of the disassembling to the 
specified text file (*.txt)/CSV file (*.csv) (see "(h)  Saving the contents of disassembled 
data"). 

Print... Opens the Print Address Range Settings dialog box for printing the contents of this 
panel.

Copy When a line is selected, copies the contents of the selected line to the clipboard as a 
character string.
In the case of the edit mode, copies the selected character string to the clipboard. 

Rename Changes to the edit mode to edit the instruction/code at the caret position (see "2.6.4  
Perform line assembly"). 
This item is disabled during execution of a program. 

Find… Opens the Find and Replace dialog box with selecting the [Find in Files] tab. 

Replace… Opens the Find and Replace dialog box with selecting the [Replace in Files] tab. 

Move… Opens the Go to the Location dialog box to move the caret to the specified address. 

Register to Watch1 Registers the selected character string or the word at the caret position to the Watch 
panel (Watch1) as a watch-expression (the judgment of the word depends on current build 
tool).
At this time, since it is registered as a variable name, the symbol name that is displayed 
changes depending on the scope. 

Register Action Event... Opens the Action Events dialog box to set an action event to the address at the caret 
position. 
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Go to Here Executes the program from the address indicated by the current PC value to the address 
corresponding to the line at the caret position. 
This item is disabled during program execution/build (not including rapid build) execu-
tion.

Set PC to Here Sets the address of the line at the current caret position to the current PC value. 
This item is disabled during program execution/build (not including rapid build) execu-
tion.

Move… Opens the Go to the Location dialog box to move the caret to the specified address. 

Go to Symbol Moves the caret to the define position of the selected symbol. 

Back to Address Moves the caret to the position (address) immediately before it is moved by [Go to Sym-
bol]. 
Note that this item is disabled when no symbol name is displayed in the address. 

Break Settings The following cascade menus are displayed to set the break-related event. 
Note that breakpoints can be set only for lines for which events can be set (see "(1)  
Event area").

Set Hardware Break Sets a breakpoint (Hardware Break event to the address at the caret position (see "2.8.3  
Stop the program at the arbitrary position (breakpoint)").

Set Software Break
(except [Simulator])

Sets a breakpoint (Software Break event) to the address at the caret position (see "2.8.3  
Stop the program at the arbitrary position (breakpoint)").

Set Combination Break
[E1][E20]

Sets a break event (execution type) to the address at the caret position as one of the 
condition for a combination break event (see "2.8.4.1  Set a break event (execution 
type)")Note 1. 

Set Read Break to Sets a break event with read access condition to a variable at the caret or a selected 
variable (global variable/static variable inside functions/file-internal static variable)/SFR 
(see "2.8.5.1  Set a break event (access type)"). 

Set Write Break to Sets a break event with write access condition to a variable at the caret or a selected 
variable (global variable/static variable inside functions/file-internal static variable)/SFR 
(see "2.8.5.1  Set a break event (access type)"). 

Set R/W Break to Sets a break event with read/write access condition to a variable at the caret or a 
selected variable (global variable/static variable inside functions/file-internal static vari-
able)/SFR (see "2.8.5.1  Set a break event (access type)"). 

Set Read Combination 
Break to
[E1][E20]

Sets a break event with read access condition to the line at the caret or the selected vari-
able (global variable, static variable inside functions, or file-internal static variable)/SFR 
as one of the condition for a combination break event (see "2.8.5.1  Set a break event 
(access type)")Note 1. 

Set Write Combination 
Break to
[E1][E20]

Sets a break event with write access condition to the line at the caret or the selected vari-
able (global variable, static variable inside functions, or file-internal static variable)/SFR 
as one of the condition for a combination break event (see "2.8.5.1  Set a break event 
(access type)")Note 1. 

Set R/W Combination 
Break to
[E1][E20]

Sets a break event with read/write access condition to the line at the caret or the 
selected variable (global variable, static variable inside functions, file-internal static vari-
able)/SFR as one of the condition for a combination break event (see "2.8.5.1  Set a 
break event (access type)")Note 1. 

Break Option Opens the Property panel to set the break function. 

Trace Settings The following cascade menus are displayed to set the trace-related eventNote 2. 
Note that events can be set only for lines for which events can be set (see "(1)  Event 
area").
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Start Tracing Sets a trace start event to start collecting the trace data when an instruction of an 
address at the caret position is executed (see "2.11.3.1  Set a Trace event"). 
[Simulator]

In addition, the selecting of the [Use trace function] property in the [Trace] category on 
the Property panel is automatically set to [Yes]. 

Stop Tracing Sets a trace end event to stop collecting the trace data when an instruction of an address 
at the caret position is executed (see "2.11.3.1  Set a Trace event"). 
[Simulator]

In addition, the selecting of the [Use trace function] property in the [Trace] category on 
the Property panel is automatically set to [Yes]. 

Record Reading Value Sets a Point Trace event to record the access value as the trace data when a variable at 
the caret or the selected variable (global variable, static variable inside functions, file-
internal static variable) or SFR is read accessed (see "2.11.4.1  Set a Point Trace 
event"). 

Record Writing Value Sets a Point Trace event to record the access value as the trace data when a variable at 
the caret or the selected variable (global variable, static variable inside functions, file-
internal static variable) or SFR is write accessed (see "2.11.4.1  Set a Point Trace 
event"). 

Record R/W Value Sets a Point Trace event to record the access value as the trace data when a variable at 
the caret or a selected variable (global variable/static variable inside functions/file-inter-
nal static variable)/SFR is read/write accessed (see "2.11.4.1  Set a Point Trace event"). 

Record Start R/W 
Value
[E1][E20]

Sets a trace start event to start collecting the trace data when a variable at the caret or 
the selected variable (global variable, static variable inside functions, file-internal static 
variable) /SFR is read/ write accessed (see "2.11.3.1  Set a Trace event"). 

Record End R/W Value
[E1][E20]

Sets a trace end event to stop collecting the trace data when a variable at the caret or 
the selected variable (global variable, static variable inside functions, file-internal static 
variable) /SFR is read/ write accessed (see "2.11.3.1  Set a Trace event"). 

Show Trace Result Opens the Trace panel and displays the acquired trace data. 

Trace Settings Opens the Property panel to set the trace function. 

Timer Settings
[IECUBE][Simulator]

The following cascade menus are displayed to set the timer-related event (see "2.12.3  
Measure execution time in a section [IECUBE][Simulator]"). 
Note that events can be set only for lines for which events can be set (see "(1)  Event 
area").

Start timer Sets a timer start event to start measuring the execution time of the program when an 
instruction of an address at the caret position is executed. 
[Simulator]

In addition, the selecting of the [Use timer function] property in the [Timer] 
[IECUBE][Simulator] category on the Property panel is automatically set to [Yes]. 

Stop timer Sets a timer end event to stop measuring the execution time of the program when an 
instruction of an address at the caret position is executed. 
[Simulator]

In addition, the selecting of the [Use timer function] property in the [Timer] 
[IECUBE][Simulator] category on the Property panel is automatically set to [Yes]. 

View Result of Timer Opens the Events panel and displays only timer-related events. 

Clear Coverage Informa-
tion

Clears all the coverage measurement results currently being stored in the debug tool.
Note that this item appears only when the debug tool used supports the coverage func-
tion. 

Edit Disassemble Changes to the edit mode to edit the instruction of the line at the caret position (see 
"2.6.4  Perform line assembly"). 
This item is disabled during execution of a program. 
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Note 1. [E1][E20]
This item is displayed only when the selected microcontroller supports combination break events.

Note 2. [E1][E20][EZ Emulator]
This item is enabled only when the selected microcontroller incorporates the OCD trace function.

[Event area] (except [Simulator])

Edit Code Changes to the edit mode to edit the code of the line at the caret position (see "2.6.4  
Perform line assembly"). 
This item is disabled during execution of a program. 

View The following cascade menus to set the display contents in the disassemble area are 
displayed. 

Show Offset Displays the offset value of the label. The offset value from the nearest label is displayed 
when a label is defined for the address. 

Show Symbol Displays the address value in the format "symbol + offset value" (default). 
Note that when a symbol has been defined as the address value, only the symbol is dis-
played. 

Show Function Name Displays the name of the register by its function name (default). 

Show Absolute Name Displays the name of the register by its absolute name. 

Settings Scroll Range... Opens the Scroll Range Settings dialog box to set the scroll range for this panel.

Mixed Display Sets to the mixed display mode and displays the correspondence between the disas-
sembled data and the source text (default). 

Jump to Source Opens the Editor panel and jumps to the source line corresponding to the address at the 
caret position in this panel. 

Jump to Memory Opens the Memory panel (Memory1) and jumps to the memory value corresponding to 
the address at the caret position in this panel. 

Hardware Break First The type of break that can be set by a one click operation of the mouse is set as a hard-
ware breakpoint (this is reflected in the setting of the [First using type of breakpoint] prop-
erty in the [Break] category on the Property panel). 

Software Break First The type of break that can be set by a one click operation of the mouse is set as a software 
breakpoint (this is reflected in the setting of the [First using type of breakpoint] property in 
the [Break] category on the Property panel). 
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This panel is used to display the contents of the CPU register (general-purpose registers and control registers) and 
change the CPU register values (see "2.9.2  Display/change the CPU register"). 

This panel appears only when connected to the debug tool. 

Remark 1. This panel can be zoomed in and out by  in the tool bar, or by moving the mouse 
wheel forward or backward while holding down the [Ctrl] key.

Remark 2. When the separator line of each area in this panel is double-clicked, the width of the area changes to the 
shortest possible size that can display the contents of the area. 

Figure A.10 CPU Register Panel 

This section describes the following. 

- [How to open]

- [Description of each area]

- [Toolbar]

- [[File] menu (CPU Register panel-dedicated items)]

- [[Edit] menu (CPU Register panel-dedicated items)]

- [Context menu]

[How to open]

- From the [View] menu, select [CPU Register]. 

[Description of each area]

(1) [Register Name] area
The types of register are classified as categories (folders), and a list of the respective register names is displayed.  
Note that neither category names nor register names can be edited and deleted. 
The meanings of the icons are as follows: 

CPU Register panel

Indicates that the register name belonging to this category is displayed.  When you double-click 
on the icon, or click on the "-" mark, the category is closed and the register name is hidden. 

Indicates that the register name belonging to this category is hidden.  When you double-click on 
the icon, or click on the "+" mark, the category is opened and the register name is displayed. 

Indicates the name of the register.  When you double-click on the icon, or click on the "+" or "-" 
marks, the name of the register part is displayed or hidden. 

(1) (2)

[Toolbar]
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Category names and register names displayed are as follows (number of "+" marks before register names indi-
cates the depth of the display level): 

Table A.3 Category Names and Register Names in CPU Register Panel

Indicates the name of the register part. 

Category Name Register Name (Alias) Bit Width Description 

General-purpose 
register

+ AX(RP0) 16 General-purpose register (current register 
bank)

++ X(R0) 8

++ A(R1) 8

+ BC(RP1) 16

++ C(R2) 8

++ B(R3) 8

+ DE(RP2) 16

++ E(R4) 8

++ D(R5) 8

+ HL(RP3) 16

++ L(R6) 8

++ H(R7) 8

Control register + PC 20 Program counter

+ PSW 8 Program status word

++ IE 1 Interrupt enable flag

++ Z 1 Zero flag

++ RBS1 1 Register bank selection flag

++ AC 1 Auxiliary carry flag

++ RBS0 1 Register bank selection flag

++ ISP1 1 In service priority flag

++ ISP0 1 In service priority flag

++ CY 1 Carry flag

+ SP 16 Stack pointer

+ ES 8 ES register

+ CS 8 CS register
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Note "n" indicates the number of the register bank (n = 0, 1, 2, 3). 

This area is provided with the following functions. 

(a) Registering watch-expression
CPU registers/categories can be registered in the Watch panel as watch-expressions.
See "2.9.6.1  Register a watch-expression" for details on how to operate it.

Remark 1. When you have registered a watch-expression with a category as the object, all of the CPU reg-
isters belonging to that category are registered as watch-expressions. 

Remark 2. A scope specification is automatically added to a registered watch-expression. 

(2) [Value] area
The values of each CPU register are displayed and changed. 
The radix of a data value can be selected by the button on the toolbar or the context menu item.  In addition, a dis-
play format adding the value in hexadecimal number constantly can also be selected as well. 
The meanings of the colors of the CPU register values are as follows (character colors and background colors 
depend on the configuration in the [General - Font and Color] category of the Option dialog box): 

This area is provided with the following functions. 

(a) Changing the CPU register value
To edit the CPU register value, select the value to edit, then change the value directly from the keyboard after 
clicking again on it (press the [Esc] key to cancel the edit mode).
After you edit the value of the CPU register, it is written to the target memory of the debug tool by pressing the 
[Enter] key or moving the focus to outside the edit region. 

(b) Saving the contents of the CPU register
The Save As dialog box can be opened by selecting the [File] menu >> [Save CPU Register Data As…], and all 
the contents of this panel can be saved in a text file (*.txt) or CSV file (*.csv). 
See "2.9.2.4  Save the CPU register contents" for details on the method for saving the contents of the CPU reg-
ister. 

General-purpose 
register: Register 
bank nNote

+ AX(RP0): Register bank n 16 General-purpose register (Register bank n)

+ X(R0): Register bank n 8

++ A(R1): Register bank n 8

+ BC(RP1): Register bank n 16

++ C(R2): Register bank n 8

++ B(R3): Register bank n 8

+ DE(RP2): Register bank n 16

++ E(R4): Register bank n 8

++ D(R5): Register bank n 8

+ HL(RP3): Register bank n 16

++ L(R6): Register bank n 8

++ H(R7): Register bank n 8

Display Example (Default) Description 

Character color Blue The value of the CPU register that the user is changing
Press the [Enter] key to write to the target memory. 

Background color Standard color

Character color Brown The value of the CPU register that has been changed because 
of the execution of a program. 
The highlighting is rest by executing again the program. Background color Cream

Category Name Register Name (Alias) Bit Width Description 
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[Toolbar]

[[File] menu (CPU Register panel-dedicated items)]

The following items are exclusive for the [File] menu in the CPU Register panel (other items are common to all the pan-
els).

Note that all these items are disabled during execution of a program. 

[[Edit] menu (CPU Register panel-dedicated items)]

The following items are exclusive for [Edit] menu in the CPU Register panel (all other items are disabled). 

Acquires the latest data from the debug tool, and updates the contents of this panel. 
This item is disabled during execution of a program. 

Notation The following buttons to change the notation of a data value are displayed. 

 AutoSelect Displays the value of the selected item (including sub-items) in the default notation 
(default). 

 Hexadecimal Displays the value of the selected item (including sub-items) in hexadecimal number. 

 Signed Decimal Displays the value of the selected item (including sub-items) in signed decimal number. 

 Unsigned Decimal Displays the value of the selected item (including sub-items) in unsigned decimal number. 

 Octal Displays the value of the selected item (including sub-items) in octal number. 

 Binary Displays the value of the selected item (including sub-items) in binary number. 

 ASCII Displays the character string of the selected item (including sub-items) in ASCII code.  If 
the character size is 2 bytes and above, it is displayed with the characters for each 1 byte 
arranged side-by-side. 

 Float Displays the value of the selected item in Float.
Note that when the value is not 4-byte data, displays it in the default notation.

 Double Displays the value of the selected item in Double.
Note that when the value is not 8-byte data, displays it in the default notation.

Adds the value in hexadecimal number enclosing with "()" at the end of the value. 

Save CPU Register 
Data

Overwrites the contents of this panel to the previously saved text file (*.txt)/CSV file (*.csv) 
(see "(b)  Saving the contents of the CPU register"). 
Note that when the file has never been saved or the file is write disabled, the same opera-
tion is applied as the selection in [Save CPU Register Data As…]. 

Save CPU Register 
Data As…

Opens the Save As dialog box to newly save the contents of this panel to the specified text 
file (*.txt)/CSV file (*.csv) (see "(b)  Saving the contents of the CPU register"). 

Cut Deletes the selected character string and copies it to the clipboard. 
This item becomes valid only when the character string is being edited. 

Copy Copies the selected character string to the clipboard during editing. 
If a line is selected, copies the register or the category to the clipboard. 
The copied item can be pasted to the Watch panel. 

Paste Pasts the character string copied in the clipboard to the caret position. 
This item becomes valid only when the character string is being edited. 

Select All Selects all the items of this panel.

Find… Opens the Find and Replace dialog box with selecting the [Find in Files] tab. 

Replace… Opens the Find and Replace dialog box with selecting the [Replace in Files] tab. 
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[Context menu]

Register to Watch1 Registers the selected register or category to the Watch panel (Watch1). 

Copy Copies the selected character string to the clipboard during editing. 
If a line is selected, copies the register or the category to the clipboard. 
The copied item can be pasted to the Watch panel. 

Notation The following cascade menus to specify the notation of a data value are displayed. 

AutoSelect Displays the value of the selected item (including sub-items) in the default notation 
(default). 

Hexadecimal Displays the value of the selected item (including sub-items) in hexadecimal number. 

Signed Decimal Displays the value of the selected item (including sub-items) in signed decimal number. 

Unsigned Decimal Displays the value of the selected item (including sub-items) in unsigned decimal number. 

Octal Displays the value of the selected item (including sub-items) in octal number. 

Binary Displays the value of the selected item (including sub-items) in binary number. 

ASCII Displays the character string of the selected item (including sub-items) in ASCII code. 
If the character size is 2 bytes and above, it is displayed with the characters for each 1 
byte arranged side-by-side. 

Float Displays the value of the selected item in Float.
Note that when the value is not 4-byte data, displays it in the default notation.

Double Displays the value of the selected item in Double.
Note that when the value is not 8-byte data, displays it in the default notation.

Include Hexadecimal 
Value

Adds the value in hexadecimal number enclosing with "()" at the end of the value. 
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This panel is used to display the contents of the SFR and change the SFR values (see "2.9.3  Display/change the 
SFR"). 

This panel appears only when connected to the debug tool. 

Caution The SFR that cause the microcontroller to operate when it is read is read-protected and therefore cannot 
be read ("?" is displayed in the value). 
To read the value of read-protected SFR, select [Force Read Value] from the context menu. 

Remark 1. This panel can be zoomed in and out by  in the tool bar, or by moving the mouse 
wheel forward or backward while holding down the [Ctrl] key.

Remark 2. When the separator line of each area in this panel is double-clicked, the width of the area changes to the 
shortest possible size that can display the contents of the area. 

Figure A.11 SFR Panel

This section describes the following. 

- [How to open]

- [Description of each area]

- [Toolbar]

- [[File] menu (SFR panel-dedicated items)]

- [[Edit] menu (SFR panel-dedicated items)]

- [Context menu]

[How to open]

- From the [View] menu, select [SFR]. 

[Description of each area]

(1) Search area
This area is used to search for the SFR name. 

SFR panel

Specifies the character strings to search (case-insensitive).
You can either type character strings directly from the key board (up to 512 characters), or 
select one from the input history via the drop-down list (up to 10 items). 

(2) (3) (4) (5)

[Toolbar]

(1)
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Remark 1. A hidden SFR name being classified with a category can be searched (the category is opened and 
the SFR is selected).

Remark 2. After typing character strings to search, to press the [Enter] key is the same function as clicking the 
 button, and to press the [Shift] + [Enter] key is the same function as clicking the  button.

(2) [SFR] area
The types of SFR are classified as categories (folders), and a list of the respective SFR name is displayed. 
The meanings of the icons are as follows: 

Remark The category names are sorted in character code order by clicking on the header part of this area 
(the SFR names in the category are also similarly sorted).

This area is provided with the following functions. 

(a) Tree editing
The each SFR can be categorized (by folders) and displayed in the tree view. 
To create a category, Click the  button on the toolbar or select [Create Category] from the context menu after 
moving the caret to a SFR name to create a category, and then input a desired name from the keyboard (up to 
1024 characters). 
To delete a category, select the category then click the  button on the toolbar or select [Delete] from the con-
text menu.  However, the categories that can be deleted are only the empty categories. 
To rename the created category, select the category then do either one of the following. 

- Click the name again, then directly rename the category name. 

- Select the [Edit] menu >> [Rename], then directly rename the category name. 

- Press the [F2] key, then directly rename the category name. 

By directly dragging and dropping the SFR in the created category, each SFR is displayed in the categorized 
tree view. 
Also, the display order of the categories and the SFR names (upper or lower position) can be changed easily by 
drag and drop operation. 

Caution 1. Categories cannot be created within categories. 

Caution 2. SFRs cannot be added or deleted. 

(b) Registering a watch-expression
Variable names of C language, CPU registers, SFR, and assembler symbols can be registered in the Watch 
panel as watch-expressions.
See "2.9.6.1  Register a watch-expression" for details on how to operate it.

Remark 1. When you have registered a watch-expression with a category as the object, all of SFR belong-
ing to that category are registered as watch-expressions. 

Remark 2. A scope specification is automatically added to a registered watch-expression. 

(3) [Value] area
The value of SFR is displayed and changed. 
The radix of a data value can be selected by the button on the toolbar or the context menu item.  In addition, a dis-
play format adding the value in hexadecimal number constantly can also be selected as well. 

Searches up for the SFR name containing the string specified in the text box, and selects 
the SFR that is found.

Searches down for the SFR name containing the string specified in the text box, and selects 
the SFR that is found.

Indicates that the SFR name belonging to this category is displayed.  When you double-click on 
the icon, or click on the "-" mark, the category is closed and the SFR name is hidden. 
Note that no categories exist by default.  Perform Tree editing if you need a category. 

Indicates that the SFR name belonging to this category is hidden.  When you double-click on the 
icon, or click on the "+" mark, the category is opened and the SFR name is displayed. 
Note that no categories exist by default.  Perform Tree editing if you need a category. 

Indicates the name of the SFR. 
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The meanings of the marks and colors displayed as SFR values are as follows (character colors and background 
colors depend on the configuration in the [General - Font and Color] category of the Option dialog box): 

Note An SFR for which the microcontroller ends up being activated by a read operation is shown. 
To read the value of read-protected SFR, select [Force Read Value] from the context menu. 

Caution The timing for acquiring the values differs in the case of a 1 byte/2 bytes SFR and that of 1 bit SFRs 
that have been allocated to a 1 byte/2 bytes SFR.  Owing to this, there are also cases where the 
values differ even if the value of the same SFR is displayed.

Remark The values are sorted in ascending order of the numerical values by clicking on the header part of 
this area. 

This area is provided with the following functions. 

(a) Changing SFR values
To edit the SFR value, select the value to edit, then change the value directly from the keyboard after clicking 
again on it (press the [Esc] key to cancel the edit mode). 
After you edit the value of the SFR, it is written to the register of the debug tool by pressing the [Enter] key, or 
moving the focus to outside the edit region. 
See "2.9.3.4  Modify the SFR contents" for details on the method for changing the SFR value.

(b) Saving the contents of the SFR 
The Save As dialog box can be opened by selecting the [File] menu >> [Save SFR Data As...], and all the con-
tents of the SFR can be saved in a text file (*.txt) or CSV file (*.csv). 
See "2.9.3.6  Save the SFR contents" for details on the method for saving the contents of the SFR. 

(4) [Type (Byte Size)] area
The type information of each SFR is displayed in the following formats. 

- <Type of SFR> [<Access attribute> <All accessible sizes>](<Size>)

Example 1. "The case of "SFR [R/W 1.8] (1 byte)"
An SFR that is readable/writable and 1 bit accessible/8 bit accessible, and whose size is 1 byte

Example 2. "The case of "SFR [R/W 1] (1 bit)"
An SFR that is readable/writable and 1 bit accessible, and whose size is 1 byte

Remark The type information is sorted in the character code order by clicking on the header part of this 
area. 

Display Example (Default) Description 

Character color Blue The value of the SFR that the user is changing (press the 
[Enter] key to write to the target memory). 

Background color Standard color

Character color Brown The value of the SFR that has been changed because of the 
execution of a program
To reset the highlighting, select the  button on the toolbar or 
[Reset Color] from the context menu. 

Background color Cream

Character color Gray The value of the SFR that is a read-protected objectNote

Background color Standard color

Access attribute One of the following is displayed as the access attribute.

R Read only

W Write only

R/W Read/Write

All accessible 
sizes

All accessible sizes are demarcated by a comma and listed in order of the smallest size in 
bit units.

Size The size of the SFR is displayed. 
It is displayed by supplying the unit, in byte units in the event that it can be displayed in 
byte units, and in bit units in the event that it can be displayed on in bit units.
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(5) [Address] area
The address that each SFR is mapped is displayed (hexadecimal number notation fixing). 
However, in the case of the bit register, it is displayed by providing a bit offset value like the following examples.

Example 1. The case of "0xFF40"
This is allocated to the address "OxFF40"

Example 2. The case of "0xFF40.4"
This is allocated to bit 4 of the address "0xFF40.4" (bit register)

Remark The addresses are sorted in ascending order of numerical values by clicking on the header part of 
this area. 

[Toolbar]

[[File] menu (SFR panel-dedicated items)]

The following items are exclusive for the [File] menu in the SFR panel (other items are common to all the panels). 
Note that all these items are disabled during execution of a program. 

[[Edit] menu (SFR panel-dedicated items)]

The following items are exclusive for [Edit] menu in the SFR panel (all other items are disabled). 

Acquires the latest data from the debug tool, and updates the contents of this panel. 
Note that the values of read-protected SFR are not re-read. 
This item is disabled during execution of a program. 

Resets highlighting of the selected SFR whose value has been changed by executing a 
program. 
Note that this item is disabled during execution of a program. 

Adds a new category (folder).  Directly input the category name in the text box. 
There are no restrictions on the number of categories that can be created anew (how-
ever, it is not possible to create a category inside a category). 
Note that this item is disabled during execution of a program. 

Deletes the selected character string(s). 
If an empty category is in a select state, its category is deleted (it is not possible to delete 
SFRs).

Notation The following buttons to change the notation of a data value are displayed. 

 Hexadecimal Displays the value of the selected item in hexadecimal number (default).

 Signed Decimal Displays the value of the selected item in signed decimal number.

 Unsigned Decimal Displays the value of the selected item in unsigned decimal number.

 Octal Displays the value of the selected item in octal number.

 Binary Displays the value of the selected item in binary number.

 ASCII Displays the value of the selected item in ASCII code.

Adds the value in hexadecimal number enclosing with "()" at the end of the value of the 
selected item. 

Save SFR Data Overwrites the contents of this panel to the previously saved text file (*.txt)/CSV file 
(*.csv) (see "(b)  Saving the contents of the SFR"). 
Note that when the file has never been saved or the file is write disabled, the same 
operation is applied as the selection in [Save SFR Data As...]. 

Save SFR Data As... Opens the Save As dialog box to newly save the contents of this panel to the speci-
fied text file (*.txt)/CSV file (*.csv) (see "(b)  Saving the contents of the SFR"). 
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[Context menu]

Cut Deletes the selected character string(s) and copies them to the clipboard (it is not 
possible to cut SFRs/categories).

Copy Copies the contents of the selected range to the clipboard as character string(s). 
If the SFR(s)/category(s) are selected, copies them to the clipboard. 
The copied item can be pasted to the Watch panel. 

Paste If texts are in editing, pastes the contents of the clipboard to the caret position (it is 
not possible to paste SFRs/categories). 

Delete Deletes the selected character string(s). 
If an empty category is in a select state, its category is deleted (it is not possible to 
delete SFRs).

Select All If texts are in editing, selects all the character strings. 
If texts are not in editing, selects all the SFRs/categories. 

Rename Edits the name of the selected category. 

Find... Moves the focus to the text box in the Search area.

Move... Opens the Go to the Location dialog box to move the caret to the specified SFR. 

Register to Watch1 Registers the selected SFR or category to the Watch panel (Watch1). 

Refresh Acquires the latest data from the debug tool, and updates the contents of this panel. 
Note that the values of read-protected SFR are not re-read. 
This item is disabled during execution of a program. 

Force Read Value Forcibly reads once the value of the read-protected SFR. 

Move... Opens the Go to the Location dialog box. 

Create Category Adds a new category (folder).  Directly input the category name in the text box. 
There are no restrictions on the number of categories that can be created anew 
(however, it is not possible to create a category inside a category). 
Note that this item is disabled during execution of a program. 

Copy Copies the contents of the selected range to the clipboard as character string(s). 
If the SFR(s)/category(s) are selected, copies them to the clipboard. 
The copied item can be pasted to the Watch panel. 

Delete Deletes the selected character string(s). 
If an empty category is in a select state, its category is deleted (it is not possible to 
delete SFRs).

Notation The following cascade menus are displayed to specify the notation. 

Hexadecimal number Displays the value of the selected item in hexadecimal number (default).

Signed Decimal Displays the value of the selected item in signed decimal number.

Unsigned decimal number Displays the value of the selected item in unsigned decimal number.

Octal Displays the value of the selected item in octal number.

Binary Displays the value of the selected item in binary number.

ASCII Displays the value of the selected item in ASCII code.

Include Hexadecimal Value Adds the value in hexadecimal number enclosing with "()" at the end of the value of 
the selected item. 
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Reset Color Resets highlighting of the selected SFR whose value has been changed by execut-
ing a program. 
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This panel is used to display the contents of the local variable and change the local variable values (see "2.9.5  Display/
change local variables"). 

This panel appears only when connected to the debug tool. 

Caution 1. Nothing is displayed on this panel during execution of a program.  When the execution of a program is 
stopped, items in each area are displayed.

Caution 2. Because of optimization by a compiler, for blocks where variables, or the subject to be operated on, are 
not in use, there may be no variable data in the stack and registers. In this case, no variables are dis-
played that are the subject to be operated on.

Remark 1. This panel can be zoomed in and out by  in the tool bar, or by moving the mouse 
wheel forward or backward while holding down the [Ctrl] key.

Remark 2. When the separator line of each area in this panel is double-clicked, the width of the area changes to the 
shortest possible size that can display the contents of the area. 

Figure A.12 Local Variables Panel

This section describes the following. 

- [How to open]

- [Description of each area]

- [Toolbar]

- [[File] menu (Local Variables panel-dedicated items)]

- [[Edit] menu (Local Variables panel-dedicated items)]

- [Context menu]

[How to open]

- From the [View] menu, select [Local Variable]. 

[Description of each area]

(1) Scope area
Select the scope of the local variable to be displayed from the following drop-down list. 

Local Variables panel

Item Operation

Current Displays local variables in the scope of the current PC value. 

<Depth> <Function name() [file name#line 
number]>Note 1,2

Displays local variables in the scope of the calling function. 
After the program is executed, the scope that is selected is main-
tained as long as the selected scope exists. 

(2) (4)

(1)

(3) (5)

[Toolbar]
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Note 1. The calling functions displayed on theCall Stack panel are displayed. 

Note 2. When scope information that has lost its reliability, items in the list is shown in gray (the character 
color/background color when showing "Invalid" depends on the configuration in the [General - Font 
and Color] category of the Option dialog box). 

(2) [Name] area
The local variable name or function name is displayed. 
The argument of the function is also displayed as the local variable. 
In addition, the hierarchical structure is displayed in tree format for arrays, pointer variables, and structures or 
unions. 
This area cannot be edited. 
The meanings of the icons are as follows: 

Note When Auto variables are used to display local variables, accurate values cannot be displayed at a 
prologue ("{") or epilogue ("}") of a function.  The Auto variable addresses are the relative 
addresses from the address pointed to by the stack pointer (SP), so their addresses are not deter-
mined until the SP value is determined in the function. The SP is manipulated via prologues or epi-
logues, so the accurate value cannot be displayed.

This area is provided with the following functions. 

(a) Registering watch-expression
Variable names of C language can be registered in the Watch panel as watch-expressions.
See "2.9.6.1  Register a watch-expression" for details on how to operate it. 

Remark A scope specification is automatically added to a registered watch-expression. 

(b) Jump to memory
By selecting [Jump to Memory] from the context menu, the Memory panel (Memory1) opens with moving the 
caret to the source line corresponding to the address where the selected local variable is disposed (if the Mem-
ory panel (Memory1) is already open, the screen will jump to the panel). 

(3) [Value] area
The value of the local variable is displayed and changed. 
The notation of a data value can be selected by the button on the toolbar or the context menu item.  In addition, a 
display format adding the value in hexadecimal number constantly can also be selected as well. 
The meanings of the marks and colors displayed as the values of the local variables are as follows (character col-
ors and background colors depend on the configuration in the [General - Font and Color] category of the Option 
dialog box): 

Indicates the variable.  Auto, Internal Static, and Register variables are also displayedNote. 
In addition, the hierarchical structure is displayed in tree format for arrays, pointer variables, and struc-
tures or unions. 
If "+" mark exist at the top of the name, the next structure is expanded by clicking it (the mark changes 
to "-" after the expansion). 

Array All elements in the array

Pointer variables Variables that the pointer designates
If the pointer designates a pointer, add "+" mark and expand it by clicking the mark. 
Note that if the pointer designates an unknown, "?" mark is displayed. 

Structures/Unions All the member of structures/unions 

Indicates the argument. 

Indicates the function. 

Display Example (Default) Description 

Character color Blue The value of the local variable that the user is changing 
Press the [Enter] key to write to the target memory. 

Background color Standard color

Character color Brown The value of the local variable that have been changed because 
of the execution of a programNote. 
The highlighting is rest by executing again the program. Background color Cream
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Note Variables that the name stays same from the start point where the program started executing to the 
breakpoint and their values are changed are the target. 

This area is provided with the following functions. 

(a) Changing the local variable/argument value
To edit the local variable value or the argument value, select the value to edit, then change the value directly 
from the keyboard after clicking again on it (press the [Esc] key to cancel the edit mode). 
After you edit the value of the local variable or the argument, it is written to the target memory of the debug tool 
by pressing the [Enter] key or moving the focus to outside the edit region. 
See "2.9.5.2  Modify the contents of local variables" for details on the method for changing the local variable/
argument value. 

(b) Saving the contents of the local variable
The Save As dialog box can be opened by selecting the [File] menu >> [Save Local Variables Data As...], and all 
the contents of this panel can be saved in a text file (*.txt) or CSV file (*.csv).
See "2.9.5.3  Save the contents of local variables" for details on the method for saving the contents of the local 
variable. 

(4) [Type (Byte Size)] area
The type name of the local variable is displayed. The notation accords with the description of C language. 
For an array, an element number is displayed in "[]".  For a function, its size (number of bytes) is displayed in "()".
This area cannot be edited. 

(5) [Address] area
The address of the local variable is displayed. When a variable is assigned to the register, the name of the register 
is displayed. 
This area cannot be edited. 

[Toolbar]

These buttons below are disabled during execution of a program. 

Character color Gray The value of the local variable that could not be acquired. 

Background color Standard color

Acquires the latest data from the debug tool, and updates the con-
tents of this panel. 

Notation The following buttons to specify the notation of values are displayed. 

 AutoSelect Displays values on this panel in the default notation according to the 
type of variable (default). 

 Hexadecimal Displays values on this panel in hexadecimal number.

 Decimal Displays values on this panel in decimal number.

 Octal Displays values on this panel in octal number.

 Binary Displays values on this panel in binary number.

 Decimal Notation for Array Index Displays array indexes on this panel in decimal number (default).

 Hexadecimal Notation for Array Index Displays array indexes on this panel in hexadecimal number.

 Float Displays values on this panel in Float.
Note that when the value is not 4-byte data, or has the type informa-
tion, displays it in the default notation. 

 Double Displays values on this panel in Double.
Note that when the value is not 4-byte data, or has the type informa-
tion, displays it in the default notation. 

Display Example (Default) Description 
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[[File] menu (Local Variables panel-dedicated items)]

The following items are exclusive for the [File] menu in the Local Variables panel (other items are common to all the pan-
els).

Note that all these items are disabled during execution of a program. 

[[Edit] menu (Local Variables panel-dedicated items)]

The following items are exclusive for [Edit] menu in the Local Variables panel (all other items are disabled). 

[Context menu]

Adds the value in hexadecimal number enclosing with "()" at the end 
of the value. 

Encoding The following buttons to specify the encoding of character variables 
are displayed. 

Displays character variables in ASCII code (default).

Displays character variables in Shift_JIS code.

Displays character variables in EUC-JP code.

Displays character variables in UTF-8 code.

Displays character variables in UTF-16 code.

Save Local Variables Data Overwrites the contents of this panel to the previously saved text file (*.txt)/CSV file 
(*.csv) (see "(b)  Saving the contents of the local variable"). 
Note that when the file has never been saved or the file is write disabled, the same 
operation is applied as the selection in [Save Local Variables Data As...]. 

Save Local Variables Data 
As...

Opens the Save As dialog box to newly save the contents of this panel to the specified 
text file (*.txt)/CSV file (*.csv) (see "(b)  Saving the contents of the local variable"). 

Copy Copies the contents of the selected line or the character string to the clipboard. 

Select All Selects all the items of this panel.

Rename Changes to the edit mode to edit the selected local variable value (see "2.9.5.2  Modify 
the contents of local variables"). 
This item is disabled during execution of a program. 

Find... Opens the Find and Replace dialog box with selecting the [Find in Files] tab. 

Replace... Opens the Find and Replace dialog box with selecting the [Replace in Files] tab. 

Register to Watch1 Registers the selected local variable to the Watch panel (Watch1). 

Copy Copies the contents of the selected line or the character string to the clipboard. 

Notation The following cascade menus to specify the notation of values are displayed. 
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AutoSelect Displays values on this panel in the default notation according to the type of variable 
(default). 

Hexadecimal Displays values on this panel in hexadecimal number.

Decimal Displays values on this panel in decimal number.

Octal Displays values on this panel in octal number.

Binary Displays values on this panel in binary number.

Decimal Notation for 
Array Index

Displays array indexes on this panel in decimal number (default).

Hexadecimal Notation 
for Array Index

Displays array indexes on this panel in hexadecimal number.

Float Displays values on this panel in Float.
Note that when the value is not 4-byte data, or has the type information, displays it in the 
default notation. 

Double Displays values on this panel in Double.
Note that when the value is not 4-byte data, or has the type information, displays it in the 
default notation. 

Include Hexadecimal 
Value

Adds the value in hexadecimal number enclosing with "()" at the end of the value. 

Encoding The following cascade menus to specify the encoding of character variables are dis-
played. 

ASCII Displays character variables in ASCII code (default).

Shift_JIS Displays character variables in Shift_JIS code.

EUC-JP Displays character variables in EUC-JP code.

UTF-8 Displays character variables in UTF-8 code.

UTF-16 Displays character variables in UTF-16 code.

Jump to Memory Opens the Memory panel (Memory1) and jumps to the memory value corresponding to 
the address of the selected line in this panel. 
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This panel is used to display the contents of the registered watch-expressions and change their values (see "2.9.6  Dis-
play/change watch-expressions"). 

Up to a maximum of four of these panels can be opened.  Each panel is identified by the names "Watch1", "Watch2", 
"Watch3", and "Watch4" on the titlebar, and the watch-expressions can be registered/deleted/moved individually. 

Watch-expressions can be registered in this panel as well as in the Editor panel, Disassemble panel, Memory panel, 
CPU Register panel, Local Variables panel or SFR panel. 

When the panel is closed with registered watch-expressions, the panel closes but the information on the registered 
watch-expressions is retained.  Therefore, if the same panel is opened again, it is opened with the watch-expressions reg-
istered. 

The display contents are automatically updated when the value of the watch-expression changes after a program is 
executed (when the execution is done in steps, the display is updated after each step). 

In addition, by enabling the Real-time display update function, it is also possible to update the display contents in real-
time even while a program is being executed. 

This panel appears only when connected to the debug tool. 

Caution 1. It is not possible to display or change the CPU register contents during program execution.

Caution 2. In a block where a variable that is the subject of operation is not used, variable data may not always exist 
in the stack or register, due to optimization by a compiler. In this case, even when a variable that is the 
subject of operation is registered as a watch-expression, the displayed value remains marked with "?."

Remark 1. This panel can be zoomed in and out by  in the tool bar, or by moving the mouse 
wheel forward or backward while holding down the [Ctrl] key.

Remark 2. When the separator line of each area in this panel is double-clicked, the width of the area changes to the 
shortest possible size that can display the contents of the area. 

Figure A.13 Watch Panel

This section describes the following. 

- [How to open]

- [Description of each area]

- [Toolbar]

- [[File] menu (Watch panel-dedicated items)]

- [[Edit] menu (Watch panel-dedicated items)]

- [Context menu]

[How to open]

- From the [View] menu, select [Watch] >> [Watch1 - 4]. 

Watch panel

(1) (2)

[Toolbar]

(3) (4) (5)
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[Description of each area]

(1) [Watch] area
All the registered watch-expressions are displayed in a list. 
Clicking the title of the list in this area sorts the watch-expressions in the list in alphabetical order. 
Categories (folders) can be created to categorize the watch-expressions and display them in the tree view (see 
"(a)  Tree editing"). 
The meanings of the icons are as follows: 

This area is provided with the following functions. 

(a) Tree editing
Watch-expressions can be categorized (by folders) and displayed in the tree view. 
To create a category, click the  button on the toolbar or select [Create Category] from the context menu after 
moving the caret to the position to create a category, and then input a desired name from the keyboard. 
To delete a category, select the category then click the  button on the toolbar or select [Delete] from the con-
text menu. 
To rename the created category, select the category then do either one of the following. 

- Click the name again, then directly rename the category name. 

- Select the [Edit] menu >> [Rename], then directly rename the category name. 

- Press the [F2] key, then directly rename the category name. 

By directly dragging and dropping the registered watch-expression in the created category, each category is dis-
played in the categorized tree view. 
Also, the display order of the categories and the watch-expressions (upper or lower position) can be changed 
easily by drag and drop operation. 

Caution 1. Categories cannot be created within categories. 

Caution 2. Up to 1500 categories can be created in one watch panel (if this restriction is violated, a message 
appears). 

Remark Drag and drop the watch-expressions/categories in other watch panel (Watch1 to Watch4) to 
copy them. 

(b) Expand/shrink display
At the top of the watch-expression represents arrays, pointer type variables, structures/unions, and registers 
(with the name of the part), "+"/"-" mark is displayed.  Click the mark to expand the contents ("+" mark is 
changed to "-" after the expansion). 

Indicates that the watch-expression belonging to this category is displayed.  When you double-
click on the icon, or click on the "-" mark, the category is closed and the watch-expression is 
hidden. 

Indicates that the watch-expression belonging to this category is hidden.  When you double-
click on the icon, or click on the "+" mark, the category is opened and the watch-expression is 
displayed. 

Indicates that the watch-expression is a variable. 
At the top of the watch-expression represents arrays, pointer type variables, and structures/
unions, "+"/"-" mark is displayed.  Click the mark to Expand/shrink display. 

Indicates that the watch-expression is a function. 

Indicates that the watch-expression is an immediate value. 

Indicates that the watch-expression is an expression. 

Indicates that the watch-expression is SFR. 

Indicates that the watch-expression is CPU register. 
At the top of the watch-expression that has the lower level register (part of the register), "+"/"-" 
mark is displayed.  Click the mark to Expand/shrink display. 



R20UT4692EJ0100  Rev.1.00 Page 235 of 411
Jun 01, 2020

CS+ V8.04.00 A.  WINDOW REFERENCE

(c) Registering new watch-expression
There are three ways as follows to register new watch-expressions. 

Caution Up to 128 watch-expressions can be registered in one watch panel (if this restriction is violated, a 
message appears). 

<1> Register from other panels
Do either one of the following to register watch-expressions in other panels. 

- Drag and drop the target character string onto this area in the desired watch panel (Watch1 to Watch4). 

- Select [Register to Watch1] from the context menu after selecting the target character string or place the 
caret on either of the target character string (the target is automatically determined). 

- Select the [Edit] menu >> [Paste] in this area in the desired watch panel (Watch1 to Watch4) after selecting 
the [Edit] menu >> [Copy] for the target character string. 

The relationship between panels that can use this operation and targets that can be registered as watch-
expressions is as follows: 

Table A.4 Relationship between Panels and Targets That Can be Registered as Watch-Expressions

Note 1. It represents C language (C89/C99) variables.

Note 2. The scope-specification is automatically added to the registered watch-expression. 

<2> Directly register in the Watch panel
Click the  button on the toolbar or select [Add New Watch] from the context menu in the desired watch 
panel (Watch1 to Watch4) to display an entry box for a new watch-expression in the bottom of this area. 
Directly input a watch-expression from the keyboard in the [Watch] area in the entry box then press the [Enter] 
key. 
For details on the input formats of watch-expressions, see "(b)  Watch-expression and operator".

Watch-expressions can be registered with specifying the scope.  The scope specifications with watch-expres-
sion registration are as follows: 

Caution If a load module name or file name contains a space or one of the following symbols, enclose 
the name in double-quotes (" "). 
$, #, (, ), [, ], &, ^,~ , %, +, - *, /, :, ?, ', |, \, <, >, !
Example: "c:\folder\prog.abs" $file.c#func

Watch-Expression Contents When Expanded

Array All elements in the array
Select [Encoding] >> [ASCII] from the context menu to display the value as a string 
(up to 256 characters).  Note, however, that any characters that cannot be dis-
played in the encoding will be shown as periods "." or "?".

Pointer type variable Variables that the pointer designates 

Structure/Union All the member of structure/union

Register Name of the bit/bit string that constructs register 
Example) AX register

A register
X register

Panel Name Targets That can be Registered as Watch-Expressions

Editor panel Variable names of C languageNote 1, CPU registers, SFR, and assembler symbols

Disassemble panel Variable names of C languageNote 1, CPU registers, SFR, and assembler symbols

CPU Register panel CPU registersNote 2

Local Variables panel Variable names of C languageNote 1 (local variables)

SFR panel SFRNote 2
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Table A.5 Handling of a C Language Function When Registered in Watch by Specifying Scope

Note A search is made for static functions and global functions from the scope of the current PC 
value in that order. Static functions out of scope are not searched for.
Also, if functions with the same name exist, write the type of parameter expressly. (Example: 
func(int, int))

Table A.6 Handling of a C Language Variable When Registered in Watch by Specifying Scope

Note 1. If the current PC value exists in a specified function, the local variables that are not declared as 
static also comprise the subject to be searched. 

Note 2. A search is made for local variables, static variables inside a file and global variables from the 
scope of the current PC value in that order.  The local variables and the static variables inside 
a file that are out of scope are not searched for.

Table A.7 Handling of a CPU Register When Registered in Watch by Specifying Scope

Table A.8 Handling of a SFR when Registered in Watch by Specifying Scope 

Remark 1. A symbol name at the current caret position can be complemented by pressing the [Ctrl] + 
[Space] key in this area (see "2.19.2  Symbol name completion function"). 

Remark 2. Immediates are handled as a numeric value.  Also, operators can be used for immediates.

Remark 3. Arithmetic expressions using a symbol can be specified as watch-expressions.

Remark 4. If the same name exists either in C language variables, CPU registers or SFRs, and it is regis-
tered without specifying scopes, then its value will be displayed after the symbol is determined 

Scope Specification Load Module File Name Source File Name Function Name Variable Name

prog$file#func prog file func Static functions

prog$func prog Global func Global functions

file#func Current file func Static functions

func Current Current func AllNote

Scope Specification Load Module 
File Name

Source 
File Name

Function 
Name

Variable 
Name

Subject to be searched

prog$file#func#var prog file func var Static variables inside a 
static functionNote 1

prog$file#var prog file Global var Static variables inside a file

prog$var prog Global Global var Global variables

file#func#var Current file func var Static variables inside a 
static functionNote 1

file#var Current file Global var Static variables inside a file

var Current Current Current var AllNote 2

Scope Specification Register Bank Name of CPU Register

AX:RB0 Register bank 0 AX

AX:REG Current register bank AX

Scope Specification Name of SFR

P0:SFR P0

P0 P0
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in the following order. 
Variable of C language > CPU registers > SFR

Remark 5. If a local variable and a global variable exist with the same name, and its symbol name is reg-
istered without specifying scopes, then its value will be displayed after the symbol is deter-
mined based on the scope of the current PC value. 

Remark 6. If the letter "I" alone is specified as a watch-expression, it is interpreted as an imaginary key-
word. To acquire the value of a register "I," add ":REG" after the register.

<3> Register from other application 
Select a character string of a variable of C language, CPU register, SFR or assembler symbol from a external 
editor then do either one of the following. 

- Drag and drop the target character string in this area in the desired watch panel (Watch1 to Watch4). 

- Select the [Edit] menu >> [Paste] in this area in the desired watch panel (Watch1 to Watch4) after copying 
the target character string. 

Remark 1. Each watch-expression registered in each watch panel (Watch1 to Watch4) is managed in 
each panel and saved as the user information of the project. 

Remark 2. More than one watch-expression with the same name can be registered. 

Remark 3. You can export registered watch-expressions to a file and import it so that the watch-expres-
sions can be re-registered (see "2.9.6.8  Export/import watch-expressions").

(d) Editing watch-expression
To edit the registered watch-expression, double-click the watch-expression to be edited to change the watch-
expression to edit mode then directly edit from the keyboard (press the [Esc] key to cancel the edit mode). 
After editing the watch-expression, press the [Enter] key to complete the editing. 

(e) Deleting watch-expression
To delete the registered watch-expression, select the watch-expression(s) to be deleted then click the  but-
ton on the toolbar or select [Delete] from the context menu. 

(f) Setting of various events
Various events can be set to the selected watch-expression by selecting [Access Break] or [Trace Output] from 
the context menu. 
If an access event is set, the mark of the watch-expression is changed (the event mark of a break event is dis-
played under the icon of the watch-expression in layers).
When an event is set, the detailed information about the set event is reflected in the Events panel. 
Note that events are only set to the watch-expressions that are global variables, static variables inside functions, 
or file-internal static variables. 
See the following for details on how to set events. 

- "2.8.5  Stop the program with the access to variables/SFRs"

- "2.11.4  Collect execution history only when the condition is met [IECUBE][Simulator]"

(g) Jump to the address with memory definition
By selecting [Jump to Memory] from the context menu, the Memory panel (Memory1) opens with moving the 
caret to the address in which the selected watch-expression is defined (if the Memory panel (Memory1) is 
already open, the screen will jump to the panel). 
Note that this operation is disabled when more than one watch-expression is selected at the same time or the 
CPU register/SFR is selected.

(2) [Value] area
The value of the registered watch-expression is displayed and changed (if the watch-expression is a function 
pointer, the function name is displayed in this area). 
Notations and encodes can be selected by the button on the toolbar or the context menu item.  In addition, a dis-
play format adding the value in hexadecimal number constantly can also be selected as well. 
The default display format of the values is automatically decided depending on the type of the watch-expression. 

Table A.9 Display Format of Watch-Expressions (Default)

Type of Watch-Expression Display Format

char, signed char, unsigned char ASCII code with hexadecimal number 
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Note The values of floating and complex types are rounded to an approximate value (nearest whole 
value) before being displayed.

The meanings of the marks and colors displayed as the values of watch-expressions are as follows (character col-
ors and background colors depend on the configuration in the [General - Font and Color] category of the Option 
dialog box): 

Remark 1. The SFR that cause the microcontroller to operate when it is read is read-protected and therefore 
cannot be read.  To read the value of read-protected SFR, select [Force Read Value] from the con-
text menu. 

short, signed short, short int, signed short int, int, 
signed, signed int, long, signed long, long int, signed 
long int

Hexadecimal value added in "( )" following signed 
decimal value

unsigned short, unsigned short int, unsigned, unsigned 
int, unsigned long, unsigned long int

Hexadecimal value added in "( )" following unsigned 
decimal value

float, float _Complex, float _Imaginary Float (when the size is 4-byte) with hexadecimal 
number Note

double, long double, double _Complex, long double 
_Complex, double _Imaginary, long double _Imaginary

Double (when the size is 8-byte) with hexadecimal 
number Note

Pointers to char, signed char, unsigned char Characters
Encoding: ASCII 

Pointers to other than char, signed char, unsigned char Hexadecimal number

Arrays of char, signed char, unsigned char types Characters
Encoding: ASCII 

Bool Hexadecimal value added in "( )" following unsigned 
decimal value

Enumeration type Hexadecimal value added in "( )" following enumer-
ated constant 

Label, address of immediate value, EQU symbol Hexadecimal value added in "( )" following signed 
decimal value

bit symbol Hexadecimal value added in "( )" following unsigned 
decimal value

Others Hexadecimal number

Display Example (Default) Description 

Character color Blue The value of the watch-expression that the user is changing 
Press the [Enter] key to write to the target memory.

Background color Standard color

Character color Pink The value of the watch-expression that is displayed with the 
Real-time display update function

Background color Standard color

Character color Brown The value of the watch-expression that has been changed 
because of the execution of a program
To reset the highlighting, select the  button on the toolbar or 
[Reset Color] from the context menu. 

Background color Cream

Character color Gray Variable that does not exist is registered as a watch-expression 
or the value of the watch-expression cannot be retrieved (vari-
able is out of the scope)Background color Standard color

Type of Watch-Expression Display Format
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Remark 2. Each watch-expression acquires the value in the order it was registered. 
As the timing to acquire a value is different, the values displayed may be different if the same SFR 
is registered more than once.

This area is provided with the following functions. 

(a) Real-time display update function
Using the real-time display update function allows you to display/modify the value of the watch-expression not 
only while the program is stopped, but also in execution. 
See "2.9.1.4  Display/modify the memory contents during program execution" for details on the real-time display 
update function. 

(b) Changing values of watch-expressions
To edit the value of the watch-expression, change the value directly from the keyboard after double-clicking on 
the value to be edited (press the [Esc] key to cancel the edit mode). 
After you edit the value of the watch-expression, it is written to the target memory of the debug tool by pressing 
the [Enter] key, or moving the focus to outside the edit region. 
See "2.9.6.6  Modify the contents of watch-expressions" for detail on how to change values of watch-expres-
sions. 

(c) Saving the contents of watch-expressions
By selecting the [File] menu >> [Save Watch Data As...], the Save As dialog box can be opened, and all the con-
tents of this panel can be saved in a text file (*.txt) or CSV file (*.csv). 
By selecting [Save Expanded Watch Data…] from the context menu, the Save As dialog box can be opened, 
and the selected contents of watch-expressions can be saved in a text file (*.txt) or CSV file (*.csv). 
See "2.9.6.9  Save the contents of watch-expressions" for details on the method for saving the contents of 
watch-expressions. 

(3) [Type (Byte Size)] area
The type information of watch-expressions with the following format is displayed. 

Note 1. The size of the watch-expression is displayed in bytes. 
However, for bit SFR or C language bit field, the size is displayed in bits and "bits" is added to the 
end of the number. 

Note 2. Watch-expressions are handled as having the type indicated here when they are compiled.
In the case of double/long double type, type name is output in accordance with [Process double 
type / long double type as float type] property in the [Output Code] category on the [Compile 
Options] tab in the build tool's Property panel. 

(4) [Address] area
The address that each watch-expression is mapped is displayed (hexadecimal number notation fixing). 
If the watch-expression is single CPU register or is unknown, "-" or "?" is displayed instead. 

Remark When the watch-expression is the bit SFR, the bit-offset value is also displayed. 

Example When the bit register is allocated to bit 4 of the address "0xFF40"
Display example:0xFF40.4 

(5) [Memo] area
The user can write comments for the watch-expressions/categories. 

Watch-Expression Display Format

Single CPU register <Types of CPU register> (<SizeNote 1>)

Single SFR <SFR type> (<Access attribute> <Access type><SizeNote 1>)

Access attribute R: Read only
W: Write only
R/W: Read/Write only

Access type 1: Bit accessible
8: Byte accessible
16: Word accessible

Unknown ?

Others <Watch-expression type that follow the C compiler's determinationNote 2> (<SizeNote 1>)
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Each comment for a watch-expression/category written in this area is saved individually as the user information of 
the project.  Therefore, when any of the watch-expression/category is deleted, the comment corresponding to it is 
also deleted. 
Note that when arrays or register are displayed expanded, the comment cannot be input for each element. 
To edit the comment, input the character strings directly from the keyboard after double-clicking on the item to be 
edited (press the [Esc] key to cancel the edit mode). 
Up to 256 character strings can be input (line feed code is ignored). 
After editing the character strings, complete the editing by pressing the [Enter] key or moving the focus to outside 
the edit region. 

[Toolbar]

[[File] menu (Watch panel-dedicated items)]

The following items are exclusive for the [File] menu in the Watch panel (other items are common to all the panels). 
Note that all these items are disabled during execution of a program. 

Reacquires all the values of the registered watch-expression and updates the display. 
Note that read-protected SFR values are not re-read. 

Resets highlighting of the selected watch-expression whose value has been changed by 
executing a program. 
This item is disabled during execution of a program. 

Registers a new watch-expression. 
Directly input the watch-expression in the text box (see "(c)  Registering new watch-
expression") 

Adds a new category (folder). 
Directly input the category name in the text box. 
Note that up to 64 categories can be created in one watch panel (categories cannot be 
created in categories). 

Deletes the selected character string(s).
If the watch-expression(s)/category(s) are selected, deletes them (except when the 
expanded item of the watch-expression is selected). 

Notation The following buttons to change the notation of a data value are displayed. 

 AutoSelect Displays the value of the selected watch-expression in the default notation (see "Table 
A.9  Display Format of Watch-Expressions (Default)") according to the type of variable 
(default). 

 Hexadecimal Displays the value of the selected item in hexadecimal number.

 Signed Decimal Displays the value of the selected item in signed decimal number.

 Unsigned Decimal Displays the value of the selected item in unsigned decimal number.

 Octal Displays the value of the selected item in octal number.

 Binary Displays the value of the selected item in binary number.

 ASCII Displays the value of the selected item in ASCII code.

 Float Displays the value of the selected item in Float.
Note that this item becomes valid only when the selected watch-expression value is 4-
byte data.

 Double Displays the value of the selected item in Double.
Note that this item becomes valid only when the selected watch-expression value is 8-
byte data.

Adds the value in hexadecimal number enclosing with "()" at the end of the value of the 
selected item (except the item displayed in hexadecimal number). 
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[[Edit] menu (Watch panel-dedicated items)]

The following items are exclusive for [Edit] menu in the Watch panel (all other items are disabled). 

[Context menu]

Save Watch Data Overwrites the contents of this panel to the previously saved text file (*.txt)/CSV file (*.csv) 
(see "(c)  Saving the contents of watch-expressions"). 
Note that when the file has never been saved or the file is write disabled, the same opera-
tion is applied as the selection in [Save Watch Data As...]. 

Save Watch Data As... Opens the Save As dialog box to newly save the contents of this panel to the specified text 
file (*.txt)/CSV file (*.csv) (see "(c)  Saving the contents of watch-expressions"). 

Cut Deletes the selected character string(s) and copies them to the clipboard. 
If the watch-expression(s)/category(s) are selected, deletes them (except when the 
expanded item of the watch-expression is selected). 

Copy Copies the contents of the selected range to the clipboard as character string(s). 
If the watch-expression(s)/category(s) are selected, copies them to the clipboard (except 
when the expanded item of the watch-expression is selected). 

Paste If texts are in editing, pastes the contents of the clipboard to the caret position. 
If texts are not in editing and the watch-expression(s) are copied in the clipboard, registers 
them to the caret position. 

Delete Deletes the selected character string(s). 
If the watch-expression(s)/category(s) are selected, deletes them (except when the 
expanded item of the watch-expression is selected). 

Select All If texts are in editing, selects all the character strings. 
If texts are not in editing, selects all the watch-expressions/categories. 

Rename Renames the selected watch-expression/category. 

Find... Opens the Find and Replace dialog box with selecting the [Find in Files] tab. 

Replace... Opens the Find and Replace dialog box with selecting the [Replace in Files] tab. 

Access Break This item becomes valid only when the selected watch-expression is the global variable, 
the static variable inside functions, the file-internal static variable, or SFR. 
The following cascade menus are displayed to set the access break event (see "2.8.5.1  
Set a break event (access type)"). 

Set Read Break to Sets a break event with read access condition to the selected watch-expression.

Set Write Break to Sets a break event with write access condition to the selected watch-expression.

Set R/W Break to Sets a break event with read/write access condition to the selected watch-expression.

Set Read Combina-
tion Break to
[E1][E20]

Sets a break event with read access condition to the selected watch-expressionNote.

Set Write Combina-
tion Break to
[E1][E20]

Sets a break event with write access condition to the selected watch-expressionNote.

Set R/W Combination 
Break to
[E1][E20]

Sets a break event with read/write access condition to the selected watch-expressionNote.
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Trace Output
[IECUBE][Simulator]

This item becomes valid only when the selected watch-expression is a global variable, 
static variable inside functions, file-internal static variable, or SFR. 
The following cascade menus are displayed to set the trace-related event (see "2.11.4.1  
Set a Point Trace event" or "2.11.3.1  Set a Trace event"). 

Record Reading 
Value

Sets a Point Trace event to record the values in the trace memory when the selected 
watch-expression is accessed for read.

Record Writing Value Sets a Point Trace event to record the values in the trace memory when the selected 
watch-expression is accessed for write.

Record R/W Value Sets a Point Trace event to record the values in the trace memory when the selected 
watch-expression is accessed for read/write.

Record Start R/W 
Value
[E1][E20]

Sets a trace start event to start collecting the trace data when the selected watch-expres-
sion is accessed for read/write.

Record End R/W 
Value
[E1][E20]

Sets a trace end event to stop collecting the trace data when the selected watch-expres-
sion is accessed for read/write.

Trace Opens the Trace panel and displays the acquired trace data. 

Periodic Updating The following cascade menus are displayed to set for the real-time display update function 
(see "(a)  Real-time display update function"). 

Periodic Updating 
Options

Opens the Property panel to set for the real-time display update function. 

Refresh Reacquires all the values of the registered watch-expression and updates the display. 
Note that the values of read-protected SFR are not re-read. 

Force Read Value Forcibly reads once the values of the read-protected SFR. 
This item is disabled during execution of a program. 

Add New Watch Registers a new watch-expression. Directly input the watch-expression in the text box (see 
"(c)  Registering new watch-expression") 

Create Category Adds a new category (folder).  Directly input the category name in the text box. 
Note that up to 64 categories can be created in one watch panel (categories cannot be 
created in categories). 

Delete Deletes the selected character string(s). 
If the watch-expression(s)/category(s) are selected, deletes them (except when the 
expanded item of the watch-expression is selected). 

Cut Deletes the selected character string(s) and copies them to the clipboard. 
If the watch-expression(s)/category(s) are selected, deletes them (except when the 
expanded item of the watch-expression is selected). 

Copy Copies the contents of the selected range to the clipboard as character string(s). 
If the watch-expression(s)/category(s) are selected, copies them to the clipboard (except 
when the expanded item of the watch-expression is selected). 

Paste If texts are in editing, pastes the contents of the clipboard to the caret position. 
If texts are not in editing and the watch-expression(s) are copied in the clipboard, registers 
them to the caret position. 

Rename Renames the selected watch-expression/category. 

Import Watch Expres-
sion...

Opens the Open Watch Expression Data File dialog box to import watch-expressions (see 
"2.9.6.8  Export/import watch-expressions"). 

Notation The following cascade menus are displayed to specify the notation. 
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AutoSelect Displays the value of the selected watch-expression in the default notation (see "Table A.9  
Display Format of Watch-Expressions (Default)") according to the type of variable 
(default). 

Hexadecimal number Displays the value of the selected item in hexadecimal number.

Signed Decimal Displays the value of the selected item in signed decimal number.

Unsigned decimal 
number

Displays the value of the selected item in unsigned decimal number.

Octal Displays the value of the selected item in octal number.

Binary Displays the value of the selected item in binary number.

ASCII Displays the value of the selected item in ASCII code.

Include Hexadecimal 
Value

Adds the value in hexadecimal number enclosing with "()" at the end of the value of the 
selected item (except the item displayed in hexadecimal number). 

Float Displays the value of the selected item in Float.
Note that when the selected watch-expression value is not 4-byte data, or has the type 
information, displays it in the default notation (see "Table A.9  Display Format of Watch-
Expressions (Default)"). 

Double Displays the value of the selected item in Double.
Note that when the selected watch-expression value is not 8-byte data, or has the type 
information, displays it in the default notation (see "Table A.9  Display Format of Watch-
Expressions (Default)"). 

Decimal Notation for 
Array Index

Displays array indexes on this panel in decimal number (default).

Hexadecimal Nota-
tion for Array Index

Displays array indexes on this panel in hexadecimal number.

Encoding The following cascade menus are displayed to specify the character code. 

ASCII Displays the value of the selected item in ASCII code (default).

Shift_JIS Displays the value of the selected item in Shift_JIS code.

EUC-JP Displays the value of the selected item in EUC-JP code.

UTF-8 Displays the value of the selected item in UTF-8 code.

UTF-16 Displays the value of the selected item in UTF-16 code.

Size Notation The following cascade menus are displayed to specify the size notation. 

1 Bytes Displays the value of the selected item as 8-bit data.

2 Bytes Displays the value of the selected item as 16-bit data.

4 Bytes Displays the value of the selected item as 32-bit data.

8 Bytes Displays the value of the selected item as 64-bit data.

Jump to Memory Opens the Memory panel (Memory1) and jumps to the address which the selected watch-
expression is defined (see "(g)  Jump to the address with memory definition"). 

Reset Color Resets highlighting of the selected watch-expression whose value has been changed by 
executing a program. 
This item is disabled during execution of a program. 

Save Expanded Watch 
Data…

Opens the Save As dialog box to newly save the selected contents of watch-expressions 
to the specified text file (*.txt)/CSV file (*.csv) (see "(c)  Saving the contents of watch-
expressions").
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Note [E1][E20]
This item is displayed only when the selected microcontroller supports combination break events. 
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This panel is used to display the call stack information for the function call (see "2.10.1  Display call stack information"). 
This panel appears only when connected to the debug tool. 

Caution 1. Nothing is displayed on this panel during execution of a program. 
When the program is stopped, items in each area are displayed. 

Caution 2. Except for [Simulator]
If step execution is performed in source level, CS+ determines whether an interrupt is being processed 
via the NP, EP, and ID flags in the PSW register.  For this reason, if the above register or flags are 
changed (e.g. when using multiple interrupts), then call stack information may be incorrect.

Remark This panel can be zoomed in and out by  in the tool bar, or by moving the mouse 
wheel forward or backward while holding down the [Ctrl] key. 

Figure A.14 Call Stack Panel

This section describes the following. 

- [How to open]

- [Description of each area]

- [Toolbar]

- [[File] menu (Call Stack panel-dedicated items)]

- [[Edit] menu (Call Stack panel-dedicated items)]

- [Context menu]

[How to open]

- From the [View] menu, select [Call Stack]. 

[Description of each area]

(1) [Depth] area
The depth of the call is displayed. 
The line at the current PC position becomes 0 and incremented numbers from 1 is added to the calling function in 
the order. 

(2) [Call Stack] area
The current source position and the call stack information pushed on the stack (position of the calling function and 
arguments of a each function, etc.) are displayed. 
The display format in this area differs depending on the selection condition of the  /  button on the toolbar, 
or of [Show Parameter]/[Show Module File Name] from the context menu. 

Call Stack panel

(1) (2)

[Toolbar]
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Note When the argument value is character string, up to 20 characters can be displayed. 

Remark Array arguments are passed as pointers rather than arrays (C language specification). For this rea-
son, if the argument is an array, it is displayed as a pointer.

This area is provided with the following functions. 

(a) Jump to the source line/disassemble line
By selecting [Jump to Source] from the context menu, the Editor panel is opened with moving the caret to the 
source line corresponding to the calling function at the current caret position (if the Editor panel is already open, 
the screen will jump to the panel). 
In addition, similarly by selecting [Jump to Disassemble], the Disassemble panel (Disasemmble1) is opened 
with moving the caret to the address corresponding to the calling function at the current caret position (if the Dis-
assemble panel is already open, the screen will jump to the panel (Disassemble1)). 

Remark It is possible to jump to the target source line by double-clicking on that line as well. 

(b) Display of local variables
By selecting [Jump to Local Variable at This Time] from the context menu, the Local Variables panel is opened 
to display the local variables indicated by the currently selected line.

(c) Saving the contents of call stack information 
By selecting the [File] menu >> [Save Call Stack Data As...], the Save As dialog box can be opened, and all the 
contents of this panel can be saved in a text file (*.txt) or CSV file (*.csv). 
See "2.10.1.4  Save the contents of call stack information" for details on the method for saving the contents of 
call stack information. 

[Toolbar]

The buttons below are disabled during execution of a program. 

Condition Display Format

- Display arguments

- Display module file name

<Function>(<Argument>=<Argument ValueNote>, ...)[<Module file 
name>$<File name>#<Line number>] (default)

- Display arguments

- Do not display module file 
name

<Function>(<Argument>=<Argument valueNote>, ...)[<File Name>#<Line 
number>]

- Do not display arguments

- Display module file name

<Function>()[<Module file name>$<File name>#<Line number>]

- Do not display arguments

- Do not display module file 
name

<Function>()[<File name>#<Line number>]

Acquires the latest data from the debug tool, and updates the contents of this panel. 

Notation The following buttons to specify the notation of values are displayed. 

 AutoSelect Displays values on this panel in the default notation according to the type of variable (default). 

 Hexadecimal Displays values on this panel in hexadecimal number.

 Decimal Displays values on this panel in decimal number.

 Octal Displays values on this panel in octal number.

 Binary Displays values on this panel in binary number.

Encoding The following buttons to specify the encoding of character variables are displayed. 



R20UT4692EJ0100  Rev.1.00 Page 247 of 411
Jun 01, 2020

CS+ V8.04.00 A.  WINDOW REFERENCE

[[File] menu (Call Stack panel-dedicated items)]

The following items are exclusive for the [File] menu in the Call Stack panel (other items are common to all the panels). 
Note that all these items are disabled during execution of a program. 

[[Edit] menu (Call Stack panel-dedicated items)]

The following items are exclusive for [Edit] menu in the Call Stack panel (all other items are disabled). 

[Context menu]

 ASCII Displays character variables in ASCII code (default).

 Shift_JIS Displays character variables in Shift_JIS code.

 EUC-JP Displays character variables in EUC-JP code.

 UTF-8 Displays character variables in UTF-8 code.

 UTF-16 Displays character variables in UTF-16 code.

Displays the call stack information with the module file name (default).

Displays the call stack information with the parameters (arguments) of the function call 
(default).

Save Call Stack Data Overwrites the contents of this panel to the previously saved text file (*.txt)/CSV file 
(*.csv) (see "(c)  Saving the contents of call stack information"). 
Note that when the file has never been saved or the file is write disabled, the same 
operation is applied as the selection in [Save Call Stack Data As...]. 

Save Call Stack Data As... Opens the Save As dialog box to newly save the contents of this panel to the specified 
text file (*.txt)/CSV file (*.csv) (see "(c)  Saving the contents of call stack information"). 

Copy Copies the contents of the selected line to the clipboard. 

Select All Selects all the items of this panel.

Find... Opens the Find and Replace dialog box with selecting the [Find in Files] tab. 

Replace... Opens the Find and Replace dialog box with selecting the [Replace in Files] tab. 

Copy Copies the contents of the selected line to the clipboard. 

Show Module File Name Displays the call stack information with the module file name (default).

Show Parameter Displays the call stack information with the parameters (arguments) of the function call 
(default).

Notation The following cascade menus to specify the notation of values are displayed. 

AutoSelect Displays values on this panel in the default notation according to the type of variable 
(default). 

Hexadecimal Displays values on this panel in hexadecimal number.

Decimal Displays values on this panel in decimal number.

Octal Displays values on this panel in octal number.

Binary Displays values on this panel in binary number.

Encoding The following cascade menus to specify the encoding of character variables are dis-
played. 
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ASCII Displays character variables in ASCII code (default).

Shift_JIS Displays character variables in Shift_JIS code.

EUC-JP Displays character variables in EUC-JP code.

UTF-8 Displays character variables in UTF-8 code.

UTF-16 Displays character variables in UTF-16 code.

Jump to Disassemble Opens the Disassemble panel (Disassemble1) and jumps to the address corresponding 
to the calling function of the selected line in this panel. 

Jump to Source Opens the Editor panel and jumps to the source line corresponding to the calling func-
tion of the selected line in this panel. 

Jump to Local Variable at 
This Time

Opens the Local Variables panel to display the local variable corresponding to the 
selected line. 
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This panel is used to display trace data recording the execution history of the program (see "2.11  Collect Execution His-
tory of Programs"). 

The trace data displays by mixing the disassembled text and source text by default, but it is also possible to display 
either one of these by selecting the Display mode. 

After the execution of the program is stopped, the display position is automatically updated such that the latest trace 
data is displayed. 

This panel appears only when connected to the debug tool. 

Caution 1. [E1][E20][EZ Emulator]
The trace function is supported only when the selected microcontroller incorporates the OCD trace func-
tion.  For details on the OCD trace function, see "Table 2.11  Operation Specifications of OCD Trace 
Function". 

Caution 2. [Simulator]
4 bytes of the final address of the code flash area (when a code flash area is 0x0 - 0x1FFFF, 0x1FFFC - 
1FFFFF corresponds to it) and the RAM area which can be fetched cannot be fetched (a message of 
"Stopped by accessing to no map area." will appear). 

Remark 1. When the separator line of each area in this panel is double-clicked, the width of the area changes to the 
shortest possible size that can display the contents of the area. 

Remark 2. This panel can be zoomed in and out by  in the tool bar, or by moving the mouse 
wheel forward or backward while holding down the [Ctrl] key.

Figure A.15 Trace Panel

This section describes the following. 

- [How to open]

- [Description of each area]

- [Toolbar]

- [[File] menu (Trace panel-dedicated items)]

- [[Edit] menu (Trace panel-dedicated items)]

- [Context menu]

[How to open]

- From the [View] menu, select [Trace]. 

- On the Editor panel/Disassemble panel, select [Trace Settings] >> [Show Trace Result] from the context menu.

Trace panel

(1) (2) (3) (4)

[Toolbar]

(6)(5)
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[Description of each area]

(1) [Number] area
The trace number corresponding to the trace frame is displayed. 

(2) [Time (h:min:s,ms,s,ns)] area [IECUBE][Simulator]
This area displays the time required from the execution start of the program to the execution start of an instruction 
of each frame or generation of memory access cause. 
The time is displayed in units of "hours, minutes, seconds, milliseconds, microseconds and nanoseconds". 
If overflow occurs, this area is displayed in invalid color (gray).

Remark 1. [IECUBE]
The precision of the time depends on the setting of the [Rate of frequency division of trace time tag] 
property on the [Trace] category on the [Debug Tool Settings] tab of the Property panel.

Remark 2. [Simulator]
The question of whether to set the time display as an integrated value or differential value depends 
on the setting of the [Accumulate trace time] property on the [Trace] category on the [Debug Tool 
Settings] tab of the Property panel.

(3) [Line/Address] area
The address of the assemble code or the line number of a source file is displayed.
The notation of a data value can be selected by the button on the toolbar or the context menu item. 
The display formats are as follows: 

Remark Since the following execution histories are not displayed, the line numbers displayed are not con-
secutive numbers.

- CPU register access

- Operand access

- Invalid fetch 

(4) [Source/Disassemble] area
The collected trace data is displayed as follows. 
The items displayed in this area differ depending on the selection of the display mode (see "(a)  Display mode"). 

Figure A.16 Display Contents of [Source/Disassemble] Area (Default)

Type of Display Line Display Format

Instruction (disassemble results) <Address>

Source text <File name>#<Line number>

Other than above -

Label The label is displayed when a label is defined for the address. 

Offset value The offset value from the nearest label is displayed when a label is defined for 
the address. 

Label 

Offset value Instruction (disassemble results)

Break cause

Source text
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Note 1. [IECUBE][Simulator]
When there is a memory access, a symbol will be interpreted as a variable and displayed only if a 
symbol is assigned to the accessed address.  Note, however, that only variables of up to 2 bytes 
are supported.  If multiplication or other code is processed by the standard libraries, the label of the 
SADDR area used by the standard library may be shown.

Note 2. At a frame for which not all the trace data was fetched, "(LOST)" is displayed.  In this case, the cor-
responding line is shown in error color (the error color depends on the configuration in the [General 
- Font and Color] category of the Option dialog box). 

This area is provided with the following functions. 

(a) Display mode
It is possible to select the following three display modes by selection of a button on the toolbar or the context 
menu. 

(b) Jumping to source line or disassemble
By selecting [Jump to Source] from the context menu, the Editor panel opens with moving the caret to the 
source line corresponding to the line at the current caret position (if the Editor panel is already open, the screen 
will jump to the panel). 
In addition, similarly by selecting [Jump to Disassemble], the Disassemble panel (Disasemmble1) is opened 
with moving the caret to the address corresponding to the fetch address of the line at the current caret position 
(if the Disassemble panel is already open, the screen will jump to the panel (Disassemble1)). 

(c) Linking with other panels
By clicking the  /  button on the toolbar, or selecting [Window Connecting] >> [Connect Source Window]/
[Connect Disassemble Window] from the context menu, it is possible to link and display the corresponding 
places on the Editor panel/Disassemble panel, with the address of the caret position on this panel used as the 

Source text The corresponding source text is displayed when the Mixed display mode or 
Source display mode is selected. 
However, when a place where no debugging information is present is exe-
cuted, "<No Debug Information>" is displayed.
[IECUBE][Simulator]
When the value of a variableNote 1 or an SFR that is accessed during execu-
tion of a source line can be analyzed, that value is displayed in the following 
format at the end of the source line. 

- <<<Variable name = Variable value>>>

- <<<SFR name = SFR value>>>
Example: a=b; <<<a=5>>>

The results of the Point Trace are displayed as same as format above.

Instruction (disassemble 
results)

The corresponding instructions are displayed as the result of disassembling 
when the Mixed display mode or Disassemble display mode is selectedNote 2. 
The mnemonics are shown highlighted.

Break cause
[IECUBE][Simulator]

The reason why the program has broken down is displayed. 

Reset cause
[IECUBE]

The reason why CPU reset has occurred is displayed. 

Display Mode Displayed Content

Mixed display mode Displays the instruction (disassemble results), labels, source text (correspond-
ing source line), point trace results, reset causes [IECUBE], and break causes 
(default). 

Disassemble display mode Displays the instruction (disassemble results), labels, point trace results, reset 
causes [IECUBE], and break causes. 

Source display mode Displays the source text (corresponding source line) reset causes [IECUBE], 
and break causes. 
However, when a place where no debugging information is present is exe-
cuted, "<No Debug Information>" is displayed.
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pointer (no movement of the focus is done). 

(d) Pop-up display
By hovering the mouse cursor over a line, all the area (item) data corresponding to that line is pop-up displayed 
in tandem shape. 

(e) Saving trace data 
The Data Save dialog box can be opened by selecting the [File] menu >> [Save Trace Data As...], and the con-
tents of this panel can be saved in a text file (*.txt) or CSV file (*.csv). 
See "2.11.9  Save the contents of execution history" for details on the method for saving trace data. 

(5) [Address] area [IECUBE][Simulator]
The target address of memory access is displayed.
However, in the event of access to SFR, the SFR name is displayed instead of the address (when a plurality is 
accessed these are displayed in the following lines).
The radix of a data value can be selected by the button on the toolbar or the context menu item. 

(6) [Data] area [IECUBE][Simulator]
The accessed data value and the access type at that time are displayed. 
However, CPU register access is not displayed.
The notation of a data value can be selected by the button on the toolbar or the context menu item. 
The display format of the data value and the access type are as follows (character colors and background colors 
depend on the configuration in the [General - Font and Color] category of the Option dialog box): 

[Toolbar]

Display Example (Default) Memory Access Type

Character color Standard color Read access

Background color Palegreen

Character color Standard color Write access

Background color Orange

Character color Standard color Read and write access

Background color Paleturquoise

Character color Standard color Vector read access

Background color Palegreen

Acquires the latest data from the debug tool, and updates the contents of this panel. 
This item is disabled while the tracer is running. 

Clears the trace memory and the display of this panel (initialized). 
This item is disabled while the tracer is running.

[IECUBE][Simulator]
Starts the tracer operation.
The content currently being displayed in this panel is cleared. 
This item is disabled while the tracer is running.

[IECUBE][Simulator]
Stops the tracer operation.
The contents of trace data newly acquired are displayed.
This item is disabled while the tracer is stopped.

Opens the Trace Search dialog box. 

R Data value

W Data value

RW Data value

VECT Data 
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[[File] menu (Trace panel-dedicated items)]

The following items are exclusive for the [File] menu in the Trace panel (other items are common to all the panels). 
Note that all these items are disabled during execution of a program. 

[[Edit] menu (Trace panel-dedicated items)]

The following items are exclusive for [Edit] menu in the Trace panel (all other items are disabled). 

[Context menu]

Notation The following buttons to change the notation of a data value are displayed. 
This item is disabled while the tracer is running.

Displays values on this panel in hexadecimal number (default).

Displays values on this panel in decimal number.

Displays values on this panel in octal number.

Displays values on this panel in binary number.

[IECUBE][Simulator]
Links with the Editor panel. 

[IECUBE][Simulator]
Links with the Disassemble panel. 

[IECUBE][Simulator]
Sets to the Mixed display mode as the display mode (default).
This item is disabled while the tracer is running.

[IECUBE][Simulator]
Sets to the Disassemble display mode as the display mode.
This item is disabled while the tracer is running.

[IECUBE][Simulator]
Sets to the Source display mode as the display mode.
This item is disabled while the tracer is running.

Save Trace Data Overwrites the contents of this panel to the previously saved text file (*.txt)/CSV file (*.csv) 
(see "(e)  Saving trace data"). 
Note that when the file has never been saved or the file is write disabled, the same opera-
tion is applied as the selection in [Save Trace Data As...]. 
This item is disabled while the tracer is running.

Save Trace Data As... Opens the Data Save dialog box to newly save the contents of this panel to the specified 
text file (*.txt)/CSV file (*.csv) (see "(e)  Saving trace data").
This item is disabled while the tracer is running.

Copy Copies the contents of the selected line to the clipboard (multiple line selections impossi-
ble). 
This item is disabled while the tracer is running.

Find... Opens the Trace Search dialog box. 

Clear Trace Clears the trace memory and the display of this panel (initialized). 
This item is disabled while the tracer is running.

Start Trace
[IECUBE][Simulator]

Starts the tracer operation.
The content currently being displayed in this panel is cleared. 
This item is disabled while the tracer is running.

Stop Trace
[IECUBE][Simulator]

Stops the tracer operation.
The contents of trace data newly acquired are displayed.
This item is disabled while the tracer is stopped.
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Find... Opens the Trace Search dialog box. 
This item is disabled while the tracer is running.

Copy Copies the contents of the selected line to the clipboard (multiple line selections impossi-
ble). 
This item is disabled while the tracer is running.

Mixed Display Sets to the Mixed display mode as the display mode.
This item is disabled while the tracer is running. 

Disassemble View Sets to the Disassemble display mode as the display mode.
This item is disabled while the tracer is running.

Source View Sets to the Source display mode as the display mode.
This item is disabled while the tracer is running.

Notation The following cascade menus are displayed to specify the notation. 
This item is disabled while the tracer is running.

Hexadecimal number Displays values on this panel in hexadecimal number (default).

Decimal Displays values on this panel in decimal number.

Octal Displays values on this panel in octal number.

Binary Displays values on this panel in binary number.

Window Connecting
[IECUBE][Simulator]

The following cascade menus are displayed to link with other panels (see "(c)  Linking with 
other panels"). 

Connect Source Win-
dow

Links with the Editor panel. 

Connect Disassem-
ble Window

Links with the Disassemble panel. 

Jump to Disassemble
[IECUBE][Simulator]

Opens the Disassemble panel (Disassemble1) and jumps to the fetch address corre-
sponding to the line at the caret position in this panel. 

Jump to Source
[IECUBE][Simulator]

Opens the Editor panel and jumps to the source line corresponding to the line at the caret 
position in this panel. 

Jump to Memory
[IECUBE][Simulator]

Opens the Memory panel and jumps to the memory value corresponding to the line at the 
caret position in this panel. 
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This panel is used to display the detailed information about the events that are set on the Editor panel/Disassemble 
panel/Watch panel.  On this panel, you can change the setting state of the event between valid/invalid and delete the 
event (see "2.15  Manage Events"). 

This panel appears only when connected to the debug tool. 

Remark 1. The available event types depend on the type of the selected microcontroller and of the debug tool in 
use.  Refer to the descriptions under "See ..." sentences in the category "Description" in "Table A.11  
Event Type".  Alternatively, see "2.15.7.1  Maximum number of enabled events". 

Remark 2. The events that have been set on the Function List panel or Variable List panel of the analyze tool (Pro-
gram Analyzer) are also managed on this panel.

Remark 3. This panel can be zoomed in and out by  in the tool bar, or by moving the mouse 
wheel forward or backward while holding down the [Ctrl] key.

Remark 4. When the separator line of each area in this panel is double-clicked, the width of the area changes to the 
shortest possible size that can display the contents of the area. 

Figure A.17 Events Panel

This section describes the following. 

- [How to open]

- [Description of each area]

- [Toolbar]

- [[Edit] menu (Events panel-dedicated items)]

- [Context menu]

[How to open]

- From the [View] menu, select [Event]. 

- [IECUBE][Simulator]
On the Editor panel/Disassemble panel, select [Timer Settings] >> [View Result of Timer] from the context menu. 

[Description of each area]

(1) [Name] area
A list of the event names that have currently been set is displayed in the following format. 

Events panel

(1) (2)

[Toolbar]

(3)
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Remark It is possible to limit the event to be displayed by clicking the button on the toolbar (see "[Toolbar]"). 

(a) Check box
The setting state of the event is displayed/changed. 
Note that the Event mark is changed depending on the setting state of the event. 

Remark 1. Both of the Timer Start event and Timer Stop event is must be set for the Timer Result event.  
Therefore, it is not possible to set a particular event to a valid state by only the setting of one of 
these (at the same time as both events are set, they are treated as grouped events as a Timer 
Result). 

Remark 2. It is not possible to set the Run-Break Timer event to an invalid/suspended state. 

Remark 3. The setting of the Unconditional Trace event and the Trace event to valid or invalid state is exclu-
sively controlled.  Therefore, the Unconditional Trace event, which is a built-in event, is valid 
state by default, but if either a trace start event/trace end event is set, it automatically becomes 
invalid state, and the Trace event, which is a event name that is collectively called with a trace 
start event and a trace end event, becomes valid state.  Conversely, if the set Trace event is 
invalid state, the Unconditional Trace event automatically becomes valid state.

(b) Event mark
The event mark shows the type of event, and in addition shows the current setting state. 
The meanings of the marks displayed are as follows: 

Table A.10 Event Mark

Valid state Event occurs when the specified condition is met. 
It is possible to set the event to an invalid state by removing the check. 

Invalid state Event does not occur when the specified condition is met. 
It is possible to set the event to a valid state by removing the check. 

Suspended state The conditions that have been specified cannot be set with the program of the 
debugging target. 
It is not possible to operate the check box. 

Event Type Valid State Invalid 
State

Suspended 
State

Note

Hardware Break -

Software Break -

Combination Break -

Break at start of function A break event that can be set via the 
analyze tool. 

Access break to variable

Unconditional Trace None -

Run-Break Timer None None -

Trace Displayed on only the Events panel

Trace start Displayed on only the Editor panel/
Disassemble panel

Trace end

Timer Result Displayed on only the Events panel

(a) (b) (c)
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Note 1. There is one or more event with valid state. 

Note 2. There is no event with valid state and at least one event with invalid state. 

Note 3. All the set events are suspended state.

(c) Event name
The event type and ID number are displayed as the event name. 
A number from 0001 is automatically provided as the ID number for each event (no renumbering of the ID num-
ber is done even in the event that an event that has been set once is deleted). 
Event types that are displayed are as follows: 

Table A.11 Event Type

Timer start Displayed on only the Editor panel/
Disassemble panel

Timer end

Point Trace -

Printf (Action event) -

Setting of two or more 
events

   Note 1    Note 2     Note 3 Displayed on only the Editor panel/
Disassemble panel

Event Type Description 

Hardware Break
(BreakNote 1)

Breaks the program when the condition is met while the debug tool monitors 
the break condition all the time during program execution. 
-> See "2.8.3  Stop the program at the arbitrary position (breakpoint)"
-> See "2.8.4  Stop the program at the arbitrary position (break event)"
-> See "2.8.5  Stop the program with the access to variables/SFRs"

Software Break
(BreakNote 1)

Breaks the program when the instruction, which an address code to break is 
rewritten for the break instruction, is executed. 
-> See "2.8.3  Stop the program at the arbitrary position (breakpoint)"

Combination Break Breaks the program when, while the debug tool successively is checking plural 
break conditions during program execution, the combination condition is met.
-> See "2.8.4  Stop the program at the arbitrary position (break event)"
-> See "2.8.5  Stop the program with the access to variables/SFRs"

Break at start of function This event type is a Hardware Break (execution type) that is set in the Function 
panel of the analyze tool (Program Analyzer).

Access break to variable This event type is a Hardware Break (access type) that is set in the Variable 
panel of the analyze tool (Program Analyzer).

Unconditional Trace Automatically collects the trace data with start of a program execution, and 
stops collecting the trace data with stop of the program execution. 
This event cannot be deleted because of the built-in eventNote 2 (this event is 
set to a Valid state by default).
-> See "2.11.2  Collect execution history until stop of the execution"

Run-Break Timer Automatically measures the execution time of a program with start of the pro-
gram execution, and stops the measurement with stop of the program execu-
tion.  This event cannot be deleted because of the built-in eventNote 2 (this 
event is set to a Valid state by default).
-> See "2.12.2  Measure execution time until stop of the execution"

Trace Starts/stops collecting the trace data when the condition specified with a trace 
start event and a trace end event is met (this event is displayed when either a 
trace start event or a trace end event is set). 
-> See "2.11.3  Collect execution history in a section"

Event Type Valid State Invalid 
State

Suspended 
State

Note
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Note 1. A breakpoint that is set by a one click operation of the mouse is displayed "Break" (see "2.8.3.1  
Set a breakpoint").

Note 2. This is set in the debug tool by default. 

(2) [Detail Information] area
Detailed information about each event is displayed. 
The contents of the information that is displayed differ depending on the event type as follows: 

Caution For an access-related event to which the detailed event conditions have been set via the Detail dia-
log box (for access events), "[Refer To A Detail Dialog]" may be displayed in this area.  If this is the 
case, refer to the contents of the Detail dialog box (for access events). 

Table A.12 Detailed Information with Event Type

Timer Result Starts/stops measuring the execution time of a program when the condition 
specified with a timer start event and a timer end event is met (this event is dis-
played when either a timer start event or a timer end event is set). 
-> See "2.12.3  Measure execution time in a section [IECUBE][Simulator]"

Point Trace Records the information as the trace data only when accessing the specified 
variable or SFR during execution of a program. 
-> See "2.11.4  Collect execution history only when the condition is met 
[IECUBE][Simulator]"

Printf Executes printf command in software processing after temporary stopping a 
program in execution at an arbitrary position (action event). 
-> See "2.14.1  Inset printf"

Event Type Displayed ContentNote 1

Hardware Break
(Condition: execution)

Format1 <Condition to occur> <File name#Line number> <Address>

Example Before Execution  main.c#39 0x100

After Execution sub.c#100 0x200

Before Execution      - 0x300

Execution main.c#39 0x300   [Simulator]

Format2 <Condition to occur> <Symbol + Offset> <Address>

Example Before Execution   funcA + 0x10 0x100

After Execution funcB + 0x20 0x200

Before Execution         - 0x300

Hardware Break
(Condition: access)

Format1 <Condition to occur> <File name#Variable name> <Address(range)> 
<Comparison condition> <Comparison value>

Example Read  main.c#variable1 0x100 - 0x101  == 0x5

Write sub.c#variable2 0x200 - 0x200  == 0x7

Read/Write sub2.c#variable3 0x300 - 0x303  == 0x8

Format2 <Condition to occur> <File name#Function name#Variable name> 
<Address(range)> <Comparison condition> <Comparison value>

Example Read  main.c#func1#variable1 0x100 - 0x101 == 0x10

Format3 <Condition to occur> <Variable name> <Address(range)> <Comparison 
condition> <Comparison value>

Example Write  variable1 0x100 - 0x101  == 0x10

Event Type Description 
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Software Break Format1 <Condition to occur> <File name#Line number> <Address>

Example Before Execution   main.c#40 0x102

Before Execution  sub.c#101 0x204

Format2 <Condition to occur> <Symbol + Offset> <Address>

Example Before Execution   funcA + 0x12 0x102

Combination Break
(Condition: execution/
access)

Format <Combination condition>
<Detailed information of combination break event>

Example OR

-  After execution main.c#100 0x300

-  After execution funcA + 0x10 0x100

- Write sub.c#variable2 0x200 - 0x200 == 0x7

-  Read/Write sub2.c#variable3 0x300 - 0x303 == 0x8

Unconditional Trace Format -

Example -

Run-Break Timer Format Total: <Total execution time>

Example Total:  1000ms

Total:  OVERFLOW

Trace
(Condition: execution)

Format Total of Start/End: <Total number of trace start/trace end events> Note 2

<Start/End> <Detailed information of trace start/trace end event>

Example Total of Start/End: 4

- Start After Execution main.c#100 0x300

- Start After Execution funcA + 0x100 0x300

- End After Execution main.c#200 0x100

- End After Execution funcA + 0x10 0x100

Timer Result
(Condition: execution)

Format Total:<Total execution time >  Total of Start/End: <Total number of timer 
start event/timer end event>Note 2

- <Total execution time> <Pass Count> <Average> <Max> <Min>

- <Start/End> <Detailed information of timer start event/timer end event>

Example Total: 10ms Total of Start/End: 4

- Total: 10ms Pass Count: 5 Average: 2ms Max: 4ms   Min: 1ms

- Start After Execution main.c#100 0x300

- Start After Execution funcA + 0x30 0x100

- End After Execution main.c#100 0x300

- End After Execution funcA + 0x50 0x100

Event Type Displayed ContentNote 1
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Note 1. Following are the details on the display format.

Point Trace
(Condition: access)

Format1 <Condition to occur> <Variable name> <Variable address>

Example Read  variable1 0x100 

Format2 <Condition to occur> <File name#Variable name> <Variable address>

Example Write sub.c#variable2 0x200 

Format3 <Condition to occur> <File name#Function name#Variable name> <Vari-
able address>

Example Read/Write sub.c#func1#variable3 0x300 

Printf
(Action event)

Format <Condition to occur> <File name#Line number> <Address> <Setting of 
Printf event>

Example Before Execution  main.c#39 0x100 aaa, bbb, ccc

After Execution sub.c#100 0x200   Result of aaa : aaa

<Condition to 
occur>

Displays one of the following conditions.
For other than [Simulator]

Execution: Before Execution or After Execution
Access: Read, Write, Read/Write

[Simulator]
Execution: Execution
Access: Read, Write, Read/Write

<File name#Line 
number>

Shows the line number of the source.  Display format is the same as the 
watch type scope specification expression. 
If there are multiple load module files that are downloaded, <Load module 
name$File name#Line number> is displayed.
For those events set in the Disassemble panel, display <Line number> in 
the format <Symbol + offset> in the condition below. 

- Line information exists and the specified position that the event is set not 
the top of the line information 

- Line information does not exist and symbol information exists.

Show <Line number> in "-" in the following condition. 

- Line information and symbol information does not exist.

<Variable name> Shows the variable name in the source file. Display format is the same as 
the watch type scope specification expression.

<Comparison 
condition>

Condition to compare (==) is shown. If the comparison value is not specified, 
comparison condition is not shown.

<Comparison 
value>

Comparison value is shown. If the comparison value is not specified, com-
parison condition is not shown.

<Address> Address in the memory area is shown (only in hex number).

<Combination 
condition>

One of the following conditions is displayed:
OR, Sequential

<Start/End> Shows whether the contents of the detailed information is start event or the 
stop event.

Event Type Displayed ContentNote 1
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Note 2. Click this line to display the detailed information of the lower lines. 

(3) [Comment] area
The user can write comments for each event that has been set. 
To input comments, click on this area, or select [Edit Comment] form the context menu after selecting the event in 
which you want to input comments, and then input directly the desired text from the keyboard (the edit mode is 
cancelled by pressing down the [Esc] key). 
After editing the comments, complete the editing by pressing the [Enter] key or moving the focus to outside the 
edit region.  Up to a maximum of 256 characters can be inputted for the comments, and this is saved as the set-
tings of the user during use. 

[Toolbar]

<Pass Count> Shows the measurement result of the pass count of the timer.
If a timer overflow occurs (see "2.12.4  Measurable time ranges"), or if the 
illegal value was acquired, "OVERFLOW" is displayed.
If measurements have not been performed yet, "Not measured" is dis-
played.

<Total> Shows the measurement result of the timer total execution time.
The unit is either of ns/s,/ms/s/min/clock (if, however, the unit is in "min", a 
value in "s" unit also appears). 
If a timer overflow occurs (see "2.12.4  Measurable time ranges"), or if the 
illegal value was acquired, "OVERFLOW" is displayed.
If measurements have not been performed yet, "Not measured" is dis-
played.

<Average> Shows the measurement result of average execution of the timer.
The unit is either of ns/s,/ms/s/min/clock (if, however, the unit is in "min", a 
value in "s" unit also appears). 
If a timer overflow occurs (see "2.12.4  Measurable time ranges"), or if the 
illegal value was acquired, "OVERFLOW" is displayed.
If measurements have not been performed yet, "Not measured" is dis-
played.

<Max> Shows the measurement result of the maximum execution time of the timer.
The unit is either of ns/s,/ms/s/min/clock (if, however, the unit is in "min", a 
value in "s" unit also appears). 
If a timer overflow occurs (see "2.12.4  Measurable time ranges"), or if the 
illegal value was acquired, "OVERFLOW" is displayed.
If measurements have not been performed yet, "Not measured" is dis-
played.

<Min> Shows the measurement result of the minimum execution time of the timer.
The unit is either of ns/s,/ms/s/min/clock (if, however, the unit is in "min", a 
value in "s" unit also appears). 
If a timer overflow occurs (see "2.12.4  Measurable time ranges"), or if the 
illegal value was acquired, "OVERFLOW" is displayed.
If measurements have not been performed yet, "Not measured" is dis-
played.

<Set print event> Shows the variable expression and the character strings specified in the 
Action Events dialog box.

Deletes the selected event and event condition.
Note that it is not possible to delete the built-in events (Unconditional Trace event and Run-
Break Timer event). 

Displays events related to Hardware Break (default). 

(except [Simulator])
Displays events related to Software Break (default). 
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Note 1. [E1][E20][EZ Emulator]
This button is only available when the selected microcontroller incorporates the OCD trace function.

Note 2. Events other than Trace events, Timer Result events and built-in events (Unconditional Trace events/
Run-Break Timer events) can be objects of this button. 

[[Edit] menu (Events panel-dedicated items)]

The following items are exclusive for [Edit] menu in the Events panel (all other items are disabled). 

[Context menu]

Displays events related to the traceNote 1 (default). 

[IECUBE][Simulator]
Displays events related to the timer (default). 

Displays events related to the action event (Printf event) (default). 

Displays events related to the built-in event (Unconditional Trace event/Run-Break Timer 
event) (default). 

Opens the Editor panel and jumps to the source line corresponding to the address where 
the selected eventNote 2 is being set. 

Opens the Disassemble panel and jumps to the disassemble results corresponding to the 
address where the selected eventNote 2 is being set. 

Opens the Memory panel and jumps to the memory corresponding to the address where 
the selected eventNote 2 is being set. 

Delete Deletes the selected event and event condition.
Note that it is not possible to delete the built-in events (Unconditional Trace event and 
Run-Break Timer event). 

Select All Selects all the events displayed on the panel.

Find... Opens the Find and Replace dialog box with selecting [Find in Files] tab. 

Replace... Opens the Find and Replace dialog box with selecting [Replace in Files] tab. 

Enable Event Enables the selected event (valid state).
Note that this item is disabled if the selected event is a valid state.

Disable Event Disables the selected event (invalid state).
Note that this item is disabled if the selected event is an invalid state.

Delete Deletes the selected event.
Note that it is not possible to delete the built-in events (Unconditional Trace event and 
Run-Break Timer event). 

Select All Selects all the events of this panel.
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Note 1. [E1][E20][EZ Emulator]
This button is only available when the selected microcontroller incorporates the OCD trace function.

Note 2. Events other than Trace events, Timer Result events and built-in events (Unconditional Trace events/
Run-Break Timer events) can be objects of this button. 

View Select The following cascade menus are displayed to limit the event type to be displayed.
All of the items have been selected by default. 

Hardware Break Displays events related to Hardware Break. 

Software Break Displays events related to Software Break. 

Timer Event Displays events related to the timer. 

Trace Event Displays events related to the traceNote 1. 

Action Event Displays events related to action events (Printf events). 

Built-in Event Displays events related to built-in events (Unconditional Trace event or Run-Break Timer 
event). 

Timer Settings The following cascade menus are displayed to do the settings related to the timer.
Note that this item is enabled only when a timer-related event has been selected. 

Init Timer Initializes the timer used by the selected event (except for Run-Break Timer). 

Nanosecond Displays the result of a selected event measured by a timer in nanosecond (ns) units.

Microsecond Displays the result of a selected event measured by a timer in microsecond (s) units. 

Millisecond Displays the result of a selected event measured by a timer in millisecond (ms) units.

Second Displays the result of a selected event measured by a timer in second (s) units.

Minute Displays the result of a selected event measured by a timer in minute (min) units. 

Clock Displays the result of a selected event measured by a timer in clock units. 

Jump to Memory Opens the Memory panel (Memory1) and jumps to the memory corresponding to the 
address where the selected eventNote 2 is being set. 

Jump to Disassemble Opens the Disassemble panel (Disassemble1) and jumps to the disassemble results cor-
responding to the address where the selected eventNote 2 is being set. 

Jump to Source Opens the Editor panel and jumps to the source line corresponding to the address where 
the selected eventNote 2 is being set. 

Edit Condition... Opens one of the following dialog box to edit the selected event

- For an execution-related event
Detail dialog box (for execution events)

- For an access-related event
Detail dialog box (for access events)

- For a Combination Break event
Combination Condition dialog box [E1][E20]

- For an action event (Printf event)
Action Events dialog box

Edit Comment Sets to the edit mode to input comments for the selected event. 
When comments are already present, all of that character string is set to a select state. 
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This panel is used to display operation logs for various components (debug tool, design tool, build tool, etc.) provided by 
CS+, in addition to results of batch searches by the Find and Replace dialog box and a Printf event (see "2.14.1  Inset 
printf"). 

The messages are classified by the message origination tool and displayed on the individual tabs. 

Remark This panel can be zoomed in and out by  in the tool bar, or by moving the mouse 
wheel forward or backward while holding down the [Ctrl] key.

Figure A.18 Output Panel

This section describes the following. 

- [How to open]

- [Description of each area]

- [[File] menu (Output panel-dedicated items)]

- [[Edit] menu (Output panel-dedicated items)]

- [Context menu]

[How to open]

- From the [View] menu, select [Output]. 

[Description of each area]

(1) Message area
The output messages of each tool, search results and results by a Printf event are displayed. 
In the case of search results (batch search), every time a search is performed, a new message will be displayed 
after the previous message is cleared (except for the [All Messages] tab).
The colors of message display differ with the type of message as shown below (character colors and background 
colors depend on the configuration in the [General - Font and Color] category of the Option dialog box). 

This area is provided with the following functions. 

Output panel

Message Type Display Example (Default) Description 

Normal message Character color Black Displayed with information notices

Background color White

Warning mes-
sage

Character color Blue Displayed with warnings about opera-
tions 

Background color Standard color

Error message Character color Red Displayed when there is a critical error, or 
when execution is not possible due to a 
operational mistake Background color Light gray

(1)

(2)
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(a) Tag jump
By double-clicking on the output message, the Editor panel is opened and the number of the corresponding line 
in the corresponding file is displayed. 
This allows you to jump from error messages that are output when building, etc. to the corresponding error line 
in the source file. 

(b) Help display
If there is a caret on the line where a warning message or error message is being displayed, you can select 
[Help for Message] from the context menu. You can also display help for that line's message by pressing the 
[F1] key. 

(c) Saving a log
The Save As dialog box can be opened by selecting the [File] menu >> [Save Output-tab name As...], and the 
contents that are displayed on the currently selected tab can be saved in a text file (*.txt) (messages on dese-
lected tabs will not be saved). 

(2) Tab selection area
Select the tab that indicates the origin of message. 
The following tabs are available for the debug tool. 

Caution Even if a new message is output on a deselected tab, tab selection will not automatically switch.  In 
this case, "*" mark will be added in front of the tab name, indicating that a new message has been 
output. 

[[File] menu (Output panel-dedicated items)]

The following items are exclusive for the [File] menu in the Output panel (other items are common to all the panels). 
Note that all these items are disabled during execution of a program. 

[[Edit] menu (Output panel-dedicated items)]

The following items are exclusive for [Edit] menu in the Output panel (all other items are disabled). 

Tab Name Description 

All Messages Displays operation logs for all components (debug tool, design tool, build tool, etc.) 
provided by CS+ in order of output.

Debug Tool Displays messages output from the debug tool.
Display only operation logs for the debug tool out of those for various components 
(debug tool, design tool, build tool, etc.) provided by CS+.

Find and Replace Displays the batch search results from the Find and Replace dialog box. 

Save Output-tab name Overwrites the contents that are displayed on the currently selected tab to the preciously 
saved text file (see "(c)  Saving a log"). 
Note that when the file has never been saved or the file is write disabled, the same opera-
tion is applied as the selection in [Save Output-tab name As...]. 
This item is disabled while building. 

Save Output-file name 
As...

Opens the Save As dialog box to newly save the contents that are displayed on the cur-
rently selected tab to the specified text file (*.txt) (see "(c)  Saving a log"). 

Copy Copies the contents of the selected range to the clipboard as character string(s). 

Select All Selects all the messages displayed on the currently selected tab. 

Find... Opens the Find and Replace dialog box with selecting [Quick Find] tab. 

Replace... Opens the Find and Replace dialog box with selecting [Replace in Files] tab. 
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[Context menu]

Copy Copies the contents of the selected range to the clipboard as character string(s). 

Select All Selects all the messages displayed on the currently selected tab. 

Clear Deletes all the messages displayed on the currently selected tab. 

Tag Jump Opens the Editor panel and jumps to the number of the corresponding line in the corre-
sponding file of the message at the caret position. 

Stop Searching Cancels the search currently being executed.
This item is disabled when a search is not being executed.

Help for Message Displays help for the massage on the current caret position. 
This item only applies to warning messages and error messages. 
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This dialog box is used to display the state of the memory mapping.

Figure A.19 Memory Mapping Dialog Box

This section describes the following. 

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- On the [Debug Tool Settings] tab of the Property panel, click the [...] button displayed by selecting one of the values of 
the [Memory mappings] property in the [Memory] category. 

Caution This dialog box cannot be opened during execution of a program. 

[Description of each area]

(1) Added memory mapping specification area
This area is always invalid. 

(2) [Memory mapped list] area

(a) List display
Information about the microcontroller's internal memory mapping is displayed. 
This area cannot be edited.

Memory Mapping dialog box

Memory type Displays the memory types. 

Address range Displays the address range as <Start address> - <End address>. 
Display is fixed as "0x"-prefixed hexadecimal numbers. 

Size Displays size as a decimal number (unit: bytes/KbytesNote). 

(1)

(2)

[Function buttons]



CS+ V8.04.00 A.  WINDOW REFERENCE

R20UT4692EJ0100  Rev.1.00 Page 268 of 411
Jun 01, 2020

Note Only in the case of multiple of 1024, displays in kilobyte units.

(b) Button

[Function buttons]

Access width Displays the access width (unit: bits). 

Button Function

Remove This button is always invalid.

Button Function

OK Closes this dialog box.

Cancel Closes this dialog box.

Help Displays the help for this dialog box. 
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This dialog box is used to select files for downloading and configure download conditions (see "2.5  Download/Upload 
Programs"). 

Note that files specified as build targets in a project (main project or sub-project) are automatically registered as down-
load targets (they can be unregistered). 

Caution This dialog box cannot be opened during execution of a program. 

Figure A.20 Download Files Dialog Box

This section describes the following. 

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- On the [Download File Settings] tab of the Property panel, click the [...] button displayed by selecting the [Download 
files] property in the [Download] category. 

[Description of each area]

(1) [Download file list] area 

(a) List display
Displays a list of files to download.  The names of files specified as build targets in a project (main project or 
sub-project) are displayed by default (they can be removed). 
Files are downloaded in the order that they are displayed here. 
To add a new file to be downloaded, click the [Add] button in this area, then in the [Download file property] area, 
specify the download conditions of the file to add. 

(b) Button

Download Files dialog box

Button Function

Up Moves the selected file up one row in the list. 
Clicking this for the top file in the list has no effect. 

Down Moves the selected file down one row in the list.
Clicking this for the bottom file in the list has no effect. 

(1)

(2)

[Function buttons]
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Remark 1. By hovering the mouse cursor over a file name, the pass information of the file is pop-up dis-
played. 

Remark 2. By dragging a file name with the mouse, the display order in the list can be changed. 
Note, however, that the order of a project build target cannot be changed. 

(2) [Download file property] area

(a) [Download file information] 
This area is used to display or edit the download conditions of the file selected in the [Download file list] area. 
It can also be used to specify the download conditions of new download files added via the [Add] button. 

Add Adds an empty item "-" to the list, and selects it. 
Specify the download conditions of the file to add in the [Download file property] area. 
Note that this button will be disabled if 20 files have already been registered. 

Remove Removes the selected file from the list. 
Note, however, that this button is disabled if the selected file is a project build target. 

File Specify the name of the file to download.

Default File name (but it will be blank for newly added files)

Modifying Directly enter from the keyboard, or specify with the Select Down-
load File dialog box that is opened by clicking the [...] buttonNote 1 
appears at right by selecting this item.

Available values See "Table 2.1  Downloadable File Formats"
Up to 259 characters

File type Specify the type of the file to download.   

Default Load module file

Modifying Select from the drop-down list.

Available values Load module file Specifies a load module file (*.abs).

Hex file Specifies an Intel HEX file (*.hex).

S-record file Specifies a Motorola S-record file (*.mot).

Binary data file Specifies an binary file (*.bin).

Offset Specify the offset from the address at which the file's download is to start. 
Note that this item appears only when [File type] or [S-record file] is set to [Hex file].

Default 0

Modifying Directly enter from the keyboard. 

Available values 0x0 to 0xFFFFF in hexadecimal number

Start address Specify the address at which to start the file's download. 
Note that this item appears only when [File type] is set to [Binary data file].

Default 0

Modifying Directly enter from the keyboard. 

Available values 0x0 to 0xFFFFF in hexadecimal number

Button Function
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Note 1. When a file specified as build target in the project is selected in the [Download file list] area, or 
when the program is executing, the [...] button does not appear. 

Note 2. If the symbol information have not been downloaded, the source level debugging cannot be per-
formed.

Note 3. When [Yes] is selected, the time taken for downloading and the memory usage on the host 
machine will increase.  We recommend selecting [No] in this item if you do not intend to use the 
symbol name completion function.

[Function buttons]

Download object Specify whether to download the object information from the specified file. 
Note that this item appears only when [File type] is set to [Load module file].

Default Yes

Modifying Select from the drop-down list.

Available values Yes Downloads object information.

No Does not download object information.

Download sym-
bol information

Specify whether to download the symbol information from the specified fileNote 2. 
Note that this item appears only when [File type] is set to [Load module file].

Default Yes

Modifying Select from the drop-down list.

Available values Yes Downloads symbol information.

No Does not download symbol information.

Generate the 
information for
input completion

Select whether to generate the information for the Symbol name completion function 
when downloadingNote 3. 
Note that this item appears only when [File type] is set to [Load module file].

Default Yes

Modifying Select from the drop-down list.

Available values Yes Generates the information for the symbol name com-
pletion function. (i.e. uses the symbol name comple-
tion function.)

No Does not generate the information for the symbol 
name completion function. (i.e. does not use the sym-
bol name completion function.)

Button Function

OK Finishes configuring the download files, and closes this dialog box. 

Cancel Cancels any changes to the download files, and closes this dialog box. 

Help Displays the help for this dialog box. 
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This tab is used to configure action events (see "2.14  Set an Action into Programs"). 
This dialog box appears only when connected to the debug tool. 

Caution Also see "2.15.7  Notes for setting events" for details on Printf events (e.g. limits on the number of 
enabled events). 

Figure A.21 Action Events Dialog Box

This section describes the following. 

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- On the Editor panel, move the caret to the line where you wish to set an action event, then select [Register Action 
Event...] from the context menu.

- On the Disassemble panel, move the caret to the address where you wish to set an action event, then select [Register 
Action Event...] from the context menu.

- On the Events panel, select an action event, then select [Edit Condition...] from the context menu. 

[Description of each area]

(1) Tab selection area
Select a tab to switch the type of an action event to be set.
This dialog box has the following two tabs.

- [Printf event] tab

Caution If this dialog box is opened by selecting [Edit Condition...] from the context menu, this area does not 
appear. 

Action Events dialog box

[Function buttons]

(1)

(2)
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(2) Event condition setting area
Use this area to configure detailed condition of an action event.
For details on how to setup an action event, see the section explaining the corresponding tab.

[Function buttons]

Button Function

OK Finishes configuring the action event, and sets it at the position specified in this dialog box. 

Cancel Cancels the action event settings and closes this dialog box.

Help Displays the help for this dialog box. 



CS+ V8.04.00 A.  WINDOW REFERENCE

R20UT4692EJ0100  Rev.1.00 Page 274 of 411
Jun 01, 2020

[Printf event] tab

Use this tab to configure Printf events as action events (see "2.14  Set an Action into Programs"). 
A Printf event momentarily stops the execution of the program at a specified location, and executes the printf command 

via software processing.  When a Printf event is set, the program momentarily stops immediately before executing the 
command at the location where this event is set, and the value of the variable expression specified in this dialog box is 
output to the Output panel. 

This dialog box appears only when connected to the debug tool. 

Figure A.22 Action Events Dialog Box: [Printf event] Tab

This section describes the following. 

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- On the Editor panel, move the caret to the line where you wish to set a Printf event, then select [Register Action 
Event...] from the context menu.

- On the Disassemble panel, move the caret to the address where you wish to set a Printf event, then select [Register 
Action Event...] from the context menu.

- On the Events panel, select a Printf event, then select [Edit Condition...] from the context menu. 

[Description of each area]

(1) [Output string] area
Type in the string to add to the Output panel directly via the keyboard (up to 1024 characters). 
Note that the output string can only be one line (spaces allowed). 

(2) [Variable expression] area
Specify the variable expression(s) for the Printf event. 
Type a variable expression directly into the text box (up to 1024 characters). 

[Function buttons]

(1)

(2)

(3)
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You can specify up to 10 variable expressions for a single Printf event by separating them with commas (","). 
If this dialog box opens with a variable expression selected in the Editor panel/Disassemble panel, the selected 
variable expression appears as the default. 
The basic input format that can be specified as variable expressions and the values output by Printf event are as 
follows: 

Table A.13 Relationship between Variable Expressions and Output Value (Printf Event) 

Note 1. It represents C language (C89/C99) variables.

Note 2. If the label name or EQU symbol name includes a "$", be sure to enclose the name in "{ }" (e.g. 
{$Label}). 
Any imaginary number must be multiplied by an uppercase "I" (e.g. 1.0 + 2.0*I). When you specify 
the CPU register name "I", add ":REG" (e.g. I:REG) to distinguish it from the keyword "I" that indi-
cates an imaginary number.

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space] 
key in this text box (see "2.19.2  Symbol name completion function"). 

(3) [Address] area
Specify the address at which to set the Printf event.
You can either type an address expression directly into the text box (up to 1024 characters), or select them from 
the input history via the drop-down list (up to 10 items).  The address of the location currently being specified is 
displayed by default. 

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space] 
key in this text box (see "2.19.2  Symbol name completion function"). 

Note that the output result format by the Printf event in the Output panel are as follows: 

Figure A.23 Output Result Format of Printf Event 

Variable Expression Output Value 

Variable name of C languageNote 1 Value of C language variable

Variable expression [Variable expression] Element of array 

Variable expression.Member name Member of structure/union

Variable expression -> Member name Member of structure/union that pointer designates 

*Variable expression Value of pointer variable

&Variable expression Location address

(Type name) Variable expression Value cast to a specified type

CPU register name Value of a CPU register

SFR name Value of a SFR 

Label nameNote 2, EQU symbol nameNote 2 and 
immediate address 

Values of label, EQU symbol and immediate address 

Specified-characters  Variable-expression-1 = Value-1, Variable-expression-2 = Value-2, ... 

Specified characters Characters specified with [Output string]

Variable expression 1 - 10 Characters specified with [Variable expression]

Value 1 - 10 Value of variable corresponds to " Variable expression 1 - 10 ".
The value is displayed in the default notation (see "Table A.9  Display Format of 
Watch-Expressions (Default)") according to the type of the variable (note, however, 
that "?" will be displayed if the specified variable expression cannot be obtained).  
Moreover, the value in hexadecimal number enclosing with "()" is also displayed (note, 
however, that "-" will be displayed if the value cannot be displayed in that notation).
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[Function buttons]

Button Function

OK Finishes configuring the Printf event, and sets it at the caret position in the Editor panel/
Disassemble panel.

Cancel Cancels the Printf event settings and closes this dialog box.

Help Displays the help for this dialog box. 
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This dialog box is used to set the number of view columns of memory values on the Memory panel. 

Figure A.24 Column Number Settings Dialog Box

This section describes the following. 

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- On the Memory panel, select [View] >> [Column Number Settings…] from the context menu. 

[Description of each area]

(1) [Column Number] area
Directly enter a decimal value as the number of columns you want to display. 
The settable range depends on [Size Notation] currently being set on the Memory panel, as follows:   

Note Only an even number is specifiable (if an odd number is specified, then it will be changed to a value 
one greater than such odd number). 

[Function buttons]

Column Number Settings dialog box

Size Notation Settable Range

4 Bits 2 - 512Note

1 Byte 1 - 256

2 Bytes 1 - 128

4 Bytes 1 - 64

8 Bytes 1 - 32

Button Function

OK Displays memory values in the specified number of columns. 

Cancel Cancels the settings and closes this dialog box. 

Help Displays the help for this dialog box. 

(1)

[Function buttons]
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This dialog box is used to set an offset value of the start address in the address area on the Memory panel. 

Figure A.25 Address Offset Settings Dialog Box

This section describes the following. 

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- On the Memory panel, select [View] >> [Address Offset Value Settings...] from the context menu. 

[Description of each area]

(1) [Address Offset Value] area
Directly enter a hexadecimal value as an offset value for the address display. 
The settable range depends on the number of bytes of the memory currently being displayed in a line on the Mem-
ory panel, as follows:   

- Settable range: 0x0 - ("Set value of [Size Notation]" x "The number of view columns") -1

Example When "Set value of [Size Notation]" is 1 byte and "The number of view columns" is 16 columns: 

[Function buttons]

Address Offset Settings dialog box

Offset Value Displayed Content of Address Area

0x0 (default) 0000
0010
0020

0x1 0001
0011
0021

0x2 0002
0012
0022

Button Function

OK Displays memory addresses with the specified offset value.

Cancel Cancels the settings and closes this dialog box. 

Help Displays the help for this dialog box. 

(1)

[Function buttons]
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This dialog box is used to initialize memory (see "2.9.1.6  Modify the memory contents in batch (initialize)"). 
The memory area in the specified address range is repeatedly overwritten with the specified initial data pattern. 

Figure A.26 Memory Initialize Dialog Box

This section describes the following. 

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- On the Memory panel, select [Fill…] from the context menu. 

[Description of each area]

(1) Range specification area
Specify the range of memory address to initialize via the [Start address/symbol] and [End address/symbol].  You 
can either type address expressions directly into the text boxes (up to 1024 characters), or select them from the 
input history via the drop-down list (up to 10 items). 
The results of calculating the address expressions you have entered are treated as start and end addresses, 
respectively. 
Note that address values greater than the microcontroller address space cannot be specified. 

Caution You cannot specify the range of address aligned across the different endian area.

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space] 
key in each text box (see "2.19.2  Symbol name completion function"). 

(2) [Initialize data] area
Specify the initial value(s) with which to overwrite the memory. 
You can either type the initial value into the text box directly in hexadecimal number (the value need not start with 
"0x"), or select one from the input history via the drop-down list (up to 10 items). 
You can specify more than one initial value.  Specify up to 16 values of up to 4 bytes (8 characters) each, sepa-
rated by spaces. 
Each initial value is parsed from the end of the string, with each two characters interpreted as a byte. 
If the string has an odd number of characters, then the first character is interpreted as one byte. 
Note that if a initial value consists of more than one byte, then the target memory is overwritten with the value con-
verted into an array of bytes of the specified address range's endian, as follows.

Memory Initialize dialog box

Input Character Strings 
(Initial Value)

How Data is Overwritten (in Bytes)

Little Endian Big Endian

1 01 01

0 12 00 12 00 12

(1)

(2)

[Function buttons]
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[Function buttons]

00 012 345 00 12 00 45 03 00 00 12 03 45

000 12 000345 00 00 12 45 03 00 00 00 12 00 03 45

Button Function

OK The memory area in the specified address range is repeatedly overwritten with the speci-
fied initial data pattern.  If the end address is reached in the middle of the pattern, then 
writing ends at that point. 

Cancel Cancels the memory initialization and closes this dialog box. 

Help Displays the help for this dialog box. 

Input Character Strings 
(Initial Value)

How Data is Overwritten (in Bytes)

Little Endian Big Endian
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This dialog box is used to search memory (see "2.9.1.5  Search the memory contents"). 
Search in either the Memory value area or Character strings area where the caret was located in the Memory panel 

immediately before this dialog box opened. 

Figure A.27 Memory Search Dialog Box

This section describes the following. 

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- On the Memory panel, select [Find…] from the context menu. 

[Description of each area]

(1) [Search Data] area
Specify data to search. 
You can either type a value directly into the text box (up to 256 bytes), or select one from the input history via the 
drop-down list (up to 10 items). 
If the search is performed in the Memory value area of the Memory panel, the value must be entered in the same 
display format (notation and size) as that area. 
If the search is performed in the Character strings area, then the target of the search must be a string.  The speci-
fied string is converted into the encoding format displayed in that area, and searched for. 
If a memory value was selected immediately prior to opening this dialog box, then that value will appear as default. 

(2) [Search Range] area
Select the range to search from the following drop-down list. 

(3) [Address] area
This item is only enabled if [Specify address range] is selected in the [Search Range] area. 
Specify the range of memory address to search via the start and end addresses.  You can either type address 
expressions directly into the text boxes (up to 1024 characters), or select them from the input history via the drop-
down list (up to 10 items). 
The results of calculating the address expressions you have entered are treated as start and end addresses, 
respectively. 

Memory Search dialog box

Specify address range Searches in the address range specified in the [Address] area.

Memory mapping Searches within the selected memory mapping range.
This list item displays the memory mappings set in the Memory Mapping dialog 
box (except the non-mapped area). 

Display format: <memory type> <address range> <size>

(1)

(2)

(3)

[Function buttons]
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Note that if an address value greater than the microcontroller address space is specified, the high-order address 
value is masked. 
In addition, an address value greater than the value expressed within 32 bits cannot be specified. 

Remark 1. A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space] 
key in each text box (see "2.19.2  Symbol name completion function"). 

Remark 2. If the start address field is left blank, it is treated as if "0x0" were specified.

Remark 3. If the end address field is left blank, then it is treated as if the maximum value in the microcon-
troller's address space were specified.

[Function buttons]

Button Function

Search Backward Searches upward within the range specified in the [Address] area or the [Search Range] 
area.  The location found by the search is selected in the Memory panel. 
Note that if an illegal value is specified or while the program is being executed, a message 
will appear, and the memory search will not be performed. 
If focus moves to this dialog box while the memory panel is hidden or another panel has 
focus, then this button will be disabled.

Search Forward Searches downward within the range specified in the [Address] area or the [Search 
Range] area.  The location found by the search is selected in the Memory panel. 
Note that if an illegal value is specified or while the program is being executed, a message 
will appear, and the memory search will not be performed. 
If focus moves to this dialog box while the memory panel is hidden or another panel has 
focus, then this button will be disabled.

Cancel Cancels the memory search and closes this dialog box. 

Help Displays the help for this dialog box. 
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This dialog box is used to specify the address range to print the contents of the Disassemble panel. 

Figure A.28 Print Address Range Settings Dialog Box

This section describes the following.

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- On the Disassemble panel, select [Print...] from the [File] menu. 

[Description of each area]

(1) Range specification area
Select a range to print from the following option buttons. 

(a) [Current display area] (default)
Prints only the contents of the Disassemble panel currently being displayed. 

(b) [Current selected area]
Prints only the range currently being selected in the Disassemble panel. 
Note, however, that this option button will be disabled when nothing is selected in the Disassemble panel. 

(c) [Range of specified]
Specify the range of address to print via [Start address] and [End address]. You can either type address expres-
sions directly into the text boxes (up to 1024 characters), or select them from the input history via the drop-down 
list (up to 10 items). 

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + 
[Space] key in each text box (see "2.19.2  Symbol name completion function"). 

[Function buttons]

Print Address Range Settings dialog box

Button Function

OK Closes this dialog box and opens the Windows dialog box to print the contents of 
the specified range of the Disassemble panel.

[Function buttons]

(1)
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Cancel Cancels the range specification and closes this dialog box.

Help Displays the help for this dialog box.

Button Function
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This dialog box is used to search trace data (see "2.11.8  Search the trace data"). 
The search can be performed at the instruction or source level. 

Figure A.29 Trace Search Dialog Box

This section describes the following. 

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- On the Trace panel, select  button on the toolbar.

- On the Trace panel, select [Find…] from the context menu. 

[Description of each area]

(1) Tab selection area
Select a tab to switch the level of the search. 
This dialog box has the following two tabs. 

- [Instruction Level] tab

- [Source Level] tab

(2) Search parameter setup area
Use this area to configure detailed search parameters. 
For details on the window elements and how to configure the parameters for a particular tab, see the section for 
the tab in question. 

Trace Search dialog box

(1)

[Function buttons]

(2)
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[Function buttons]

Button Function

Search Backward Searches upward (in the direction of larger to smaller numbers) within the specified range. 
Search matches are selected in the Trace panel. 
Note that if an illegal value is specified or while the program is being executed, a message 
will appear, and the trace data search will not be performed. 
If focus moves to this dialog box while the Trace panel is hidden or another panel has 
focus, then this button will be disabled.

Search Forward Searches forward (in the direction of smaller to larger numbers) within the specified range. 
Search matches are selected in the Trace panel. 
Note that if an illegal value is specified or while the program is being executed, a message 
will appear, and the trace data search will not be performed. 
If focus moves to this dialog box while the Trace panel is hidden or another panel has 
focus, then this button will be disabled.

Cancel Cancels the trace data search and closes this dialog box. 

Help Displays the help for this dialog box. 
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[Instruction Level] tab

Use this tab to search the acquired trace data at the instruction level. 

Caution If the Trace panel is set to Source display mode, then performing an instruction level search via this tab 
will not perform the target search correctly. In order to perform an instruction level search, set the mode 
to Mixed display mode or Disassemble display mode.

Figure A.30 Trace Search Dialog Box: [Instruction Level] Tab

This section describes the following. 

- [How to open]

- [Description of each area]

[How to open]

- On the Trace panel, select  button on the toolbar.

- On the Trace panel, select [Find…] from the context menu. 

[Description of each area]

(1) [Search condition] area

(a) [Fetch Address]
Specify the fetch address if it is a required search parameter. 
You can either type address expressions directly into the text boxes, or select them from the input history via the 
drop-down lists (up to 10 items). 
The fetch address can also be specified as a range.  In this case, specify a range by specifying address expres-
sions in both the left and right text boxes. 
If the right-hand text box is blank or contains the text [(Input value when range is specified)], then the fixed 
address specified in the left-hand text box will be searched. 
Note that if an address value greater than the microcontroller address space is specified, the high-order address 
value is masked. 

(1)

(2)
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In addition, an address value greater than the value expressed within 32 bits cannot be specified.

(b) [Mnemonic] 
Specify the mnemonic if it is a required search parameter. 
The specified character strings in this area are searched within the [Source/Disassemble] area of the Trace 
panel.
You can either type a mnemonic directly into the text boxes, or select one from the input history via the drop-
down list (up to 10 items). 
Searches are case-insensitive, and partial matches are also allowed.

(c) [Access Address] [IECUBE][Simulator]
Specify the access address if it is a required search parameter. 
You can either type address expressions directly into the text boxes, or select them from the input history via the 
drop-down lists (up to 10 items). 
The access address can also be specified as a range.  In this case, specify a range by specifying address 
expressions in both the left and right text boxes. 
If the right-hand text box is blank or contains the text [(Input value when range is specified)], then the fixed 
address specified in the left-hand text box will be searched. 
Note that if an address value greater than the microcontroller address space is specified, the high-order address 
value is masked. 
In addition, an address value greater than the value expressed within 32 bits cannot be specified.

(d) [Access Status] [IECUBE][Simulator]
This item is only enabled if a value for [Access Address] [IECUBE][Simulator] is specified. 
Select the access type from the following drop-down list. 
Select [No Specification] if you do not wish to limit access types. 

(e) [Data] [IECUBE][Simulator]
This item is only enabled if a value for [Access Address] [IECUBE][Simulator] is specified. 
Specify the access data. 
You can either type the data directly into the text boxes (in hexadecimal number), or select it from the input his-
tory via the drop-down list (up to 10 items). 
The data can also be specified as a range.  In this case, specify a range by specifying data in both the left and 
right text boxes. 
If the right-hand text box is blank or contains the text [(Input value when range is specified)], then the fixed data 
specified in the left-hand text box will be searched. 

(2) [Search range] area

(a) [Number]
Specify the range within the trace data to search via the number displayed in the [Number] area of the Trace 
panel. 
Specify the starting number in the left text box, and the ending number in the right text box ("0" to "last number" 
are specified by default). 
You can either type the numbers directly into the text boxes (in base-10 format), or select them from the input 
history via the drop-down lists (up to 10 items). 
If the left-hand text box is left blank, it is treated as if "0" were specified. 
If the right-hand text box is left blank, it is treated as if the last number were specified. 

(No Specification)

Read/Write

Read

Write

Vector Read

DMA



R20UT4692EJ0100  Rev.1.00 Page 289 of 411
Jun 01, 2020

CS+ V8.04.00 A.  WINDOW REFERENCE

[Source Level] tab

Use this tab to search the acquired trace data at the source level. 

Caution If the Trace panel is set to Disassemble display mode, then performing an source level search via this tab 
will not perform the target search correctly.  In order to perform an source level search, set the mode to 
Mixed display mode or Source display mode.

Figure A.31 Trace Search Dialog Box: [Source Level] Tab

This section describes the following. 

- [How to open]

- [Description of each area]

[How to open]

- On the Trace panel, select  button on the toolbar.

- On the Trace panel, select [Find…] from the context menu. 

[Description of each area]

(1) [Search object] area
Select the search object from the following option buttons. 

The execution part is retrieved specify-
ing the source line 

Finds the execution location in the specified source line (default).
Only [Source and Line] will be enabled as a search parameter. 

The execution part is retrieved specify-
ing the function 

Finds the execution location in the specified function. 
Only [Function Name] will be enabled as a search parameter. 

(1)

(3)

(2)
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(2) [Search condition] area

(a) [Source and Line]
This item is only enabled if [The execution part is retrieved specifying the source line] is selected. 
The specified character strings in this area are searched within the [Line/Address] area of the Trace panel.
You can either type the character strings of the source line to be find directly into the text box, or select them 
from the input history via the drop-down list (up to 10 items). 
Searches are case-insensitive, and only complete matches are retrieved.

Example 1. main.c#40

Example 2. main.c

Example 3. main

(b) [Function Name]
This item is only enabled if [The execution part is retrieved specifying the function] is selected. 
You can either type the function name to be find directly into the text box, or select it from the input history via 
the drop-down list (up to 10 items). 
Searches are case-insensitive, and only complete matches are retrieved.

(c) [Variable Name] [IECUBE][Simulator]
This item is only enabled if [The execution part is retrieved specifying the global variable] is selected. 
You can either type the variable name to be find directly into the text box, or select it from the input history via 
the drop-down list (up to 10 items). 
Searches are case-insensitive, and only complete matches are retrieved.

(d) [Kind] [IECUBE][Simulator]
This item is only enabled if [The execution part is retrieved specifying the global variable] is selected. 
Select the access type ([Reference/Substitution], [Reference], or [Substitution]) from the drop-down list. 

(e) [Value] [IECUBE][Simulator]
This item is only enabled if [The execution part is retrieved specifying the global variable] is selected. 
Specify the accessed variable value in hexadecimal number. 
You can either type a variable value directly into the text box, or select one from the input history via the drop-
down list (up to 10 items). 
The variable value can also be specified as a range.  In this case, specify a range by specifying variable values 
in both the left and right text boxes. 
If the right-hand text box is blank, then access locations with the fixed variable values specified in the left-hand 
text box will be searched for. 

(3) [Search range] area

(a) [Number]
Specify the range within the trace data to search via the number displayed in the [Number] area of the Trace 
panel. 
Specify the starting number in the left text box, and the ending number in the right text box ("0" to "last number" 
are specified by default). 
You can either type the numbers directly into the text boxes (in base-10 format), or select them from the input 
history via the drop-down lists (up to 10 items). 
If the left-hand text box is left blank, it is treated as if "0" were specified. 
If the right-hand text box is left blank, it is treated as if the last number were specified. 

The execution part is retrieved specify-
ing the global variable 
[IECUBE][Simulator]

Finds the location at which the specified global variable was 
accessed. 
Only [Variable Name] [IECUBE][Simulator], [Kind] [IECUBE][Simula-
tor] and [Value] [IECUBE][Simulator] will be enabled as a search 
parameters. 
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This dialog box is used to display and modify detailed information on the combination break event selected in the Events 
panel. 

Figure A.32 Combination Condition Dialog Box

This section describes the following. 

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- On the Events panel, move the caret to the combination break event [E1][E20], then select [Edit Condition...] from the 
context menu.

[Description of each area]

(1) Tab selection area
In this product version, the [Break] tab is displayed in this area. 

(2) [Combination] area
Select the combination condition from the following drop-down list. 

Caution When [OR] is selected, up to two break events can be specified.
When [Sequential] is selected, break event can be specified for the 1st to 2nd position. 

Combination Condition dialog box [E1][E20]

OR The condition is satisfied when one of the events listed in the [Object event] area is encoun-
tered (default).

Sequential The condition is satisfied when the events listed in the [Object event] area are encountered 
in the specified sequence. 

(1)

[Function buttons]

(2)

(3)

(4)
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(3) [Object event] area

(a) Display of the list
This area lists the detailed information on the object events to be combined.
When [Sequential] is specified in the [Combination] area, numbers are allocated to each item from the top of the 
list to indicate the order in which the conditions are to be satisfied.

(b) Buttons
The following buttons are enabled only when [Sequential] is selected in the [Combination] area. 

(4) [Reset event] area

(a) Display of the list
This area is always invalid. 

[Function buttons]

Button Function

Up Moves the event serial number upward in the target event list.

Down Moves the event serial number downward in the target event list. 

R Event This button is always invalid. 

Button Function

OK Applies the detailed settings specified in the dialog box to the combination break and closes 
this dialog box.

Cancel Cancels the save and closes this dialog box.

Help Displays the help for this dialog box.
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This dialog box is used to display and modify detailed information on an execution-related event selected in the Events 
panel. 

Note that the execution-related events refer to the following events in the Events panel.

- Hardware Break event (execution type)

- Execution-related break event in detailed information on Combination Break event [E1][E20]

- Execution-related event as start and end condition in detailed information on Trace event

- Execution-related event as start and end condition in detailed information on Timer Result event [IECUBE][Simula-
tor]

Figure A.33 Detail Dialog Box (for Execution Events) [IECUBE]

Figure A.34 Detail Dialog Box (for Execution Events) [E1][E20][EZ Emulator]

Figure A.35 Detail Dialog Box (for Execution Events) [Simulator]

Detail dialog box (for execution events)

(1)

[Toolbar]

(2)

[Function buttons]

(1)

(2)

[Toolbar]

[Function buttons]

(1)

(2)

[Toolbar]

[Function buttons]
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This section describes the following.

- [How to open]

- [Description of each area]

- [Toolbar]

- [Function buttons]

[How to open]

- On the Events panel, move the caret to any one of the following events, and then select [Edit Condition...] from the 
context menu.

- Hardware Break event (execution type)

- Execution-related break event in detailed information on Combination Break event [E1][E20]

- Execution-related event as start and end condition in detailed information on Trace event

- Execution-related event as start and end condition in detailed information on Timer Result event 
[IECUBE][Simulator]

[Description of each area]

(1) Event conditions setting area

(a) [Address Condition]
Specify the address condition.

Compare condition
[IECUBE]
[Simulator]

Specify the condition to compare address.

Default Specified address (==)

Modifying Select from the drop-down list

Available 
values

Specified address (==) Specifies the address with [Address].

Greater than or equal to (>=)

Less than or equal to (<=)

Inside the range (<=Values<=) Specifies the range with [Start address] 
and [End address].

Outside the range !(<=Val-
ues<=)

Address Specify the address.
[IECUBE][Simulator]

This item appears only when [Specified address (==)], [Greater than or equal to 
(>=)] or [Less than or equal to (<=)] is selected in [Compare condition].

Default The current set value

Modifying Directly enter from the keyboard.

Available 
values

Address expression within the valid range
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(b) [Pass Count] [IECUBE][Simulator]
Specify the pass count condition. 

Caution [IECUBE]
A value other than "1" cannot be specified as the pass count condition for an execution-related 
event (before execution). 

(2) Description area
This area displays a simple description of the item selected in the Event conditions setting area. 

Start address
[IECUBE]
[Simulator]

Specify the start address. 
[IECUBE][Simulator]

This item appears only when [Inside the range (<=Values<=)] or [Outside the range 
!(<=Values<=)] is selected in [Compare condition].

Default The current set value

Modifying Directly enter from the keyboard.

Available 
values

Address expression within the valid range

End address
[IECUBE]
[Simulator]

Specify the end address. 
[IECUBE][Simulator]

This item appears only when [Inside the range (<=Values<=)] or [Outside the range 
!(<=Values<=)] is selected in [Compare condition].

Default The current set value

Modifying Directly enter from the keyboard.

Available 
values

Address expression within the valid range

Use the address 
mask
[Simulator]

Specify whether to specify an address mask.

Default No

Modifying Select from the drop-down list

Available 
values

Yes Specifies an address mask.

No Does not specify an address mask.

Mask value
[Simulator]

Specify the value of address mask.
This item appears only when [Use the address mask] is set to [Yes].

Default The current set value

Modifying Directly enter from the keyboard.

Available 
values

Hexadecimal number up to five digits

Pass count Specify a pass count.
The relevant event occurs when the event condition is met as many times as the spec-
ified pass count.

Default 1

Modifying Directly enter from the keyboard.

Available 
values

1 to 65535 in decimal number
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[Toolbar]

[Function buttons]

Displays all categories in the Event conditions setting area.

Hides categories in the Event conditions setting area and rearranges only setting items in the 
ascending order

This button is always invalid. 

Button Function

OK Applies detailed settings made in this dialog box to execution-related events and closes this 
dialog box.

Cancel Cancels the save and closes this dialog box.

Help Displays the help for this dialog box.
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This dialog box is used to display and modify detailed information on an access-related event selected in the Events 
panel. 

Note that the access-related events refer to the following events in the Events panel.

- Hardware Break event (access type)

- Access-related break event in detailed information on Combination Break event [E1][E20]

- Access-related event as start and end condition [E1][E20] in detailed information on Trace event

- Access-related event in detailed information on Point Trace event 

Figure A.36 Detail Dialog Box (for Access Events) [IECUBE]

Figure A.37 Detail Dialog Box (for Access Events) [E1][E20][EZ Emulator]

Detail dialog box (for access events)

(1)

(2)

[Toolbar]

[Function buttons]

(1)

(2)

[Toolbar]

[Function buttons]
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Figure A.38 Detail Dialog Box (for Access Events) [Simulator]

This section describes the following.

- [How to open]

- [Description of each area]

- [Toolbar]

- [Function buttons]

[How to open]

- On the Events panel, move the caret to any one of the following events, and then select [Edit Condition...] from the 
context menu.

- Hardware Break event (access type)

- Access-related break event in detailed information on Combination Break event [E1][E20]

- Access-related event as start and end condition [E1][E20] in detailed information on Trace event

- Access-related event in detailed information on Point Trace event 

[Description of each area]

(1) Event conditions setting area

(a) [Address]
Specify the address condition.

(1)

(2)

[Toolbar]

[Function buttons]
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Compare condition
[IECUBE]
[Simulator]

Specify the condition to compare address.

Default The current set value

Modifying Select from the drop-down list

Available 
values

Specified address (==) Specifies the address with 
[Address].

Greater than or equal to (>=)

Less than or equal to (<=)

Inside the range (<=Values<=) Specifies the range with [Start 
address] and [End address].

Outside the range !(<=Values<=)

Address Specify the address.
[IECUBE][Simulator]

This item appears only when [Specified address (==)], [Greater than or equal to 
(>=)] or [Less than or equal to (<=)] is selected in [Compare condition].

Default The current set value

Modifying Directly enter from the keyboard.

Available 
values

Address expression within the valid range

Start address
[IECUBE]
[Simulator]

Specify the start address. 
[IECUBE][Simulator]

This item appears only when [Inside the range (<=Values<=)] or [Outside the range 
!(<=Values<=)] is selected in [Compare condition].

Default The current set value

Modifying Directly enter from the keyboard.

Available 
values

Address expression within the valid range

End address
[IECUBE]
[Simulator]

Specify the end address. 
[IECUBE][Simulator]

This item appears only when [Inside the range (<=Values<=)] or [Outside the range 
!(<=Values<=)] is selected in [Compare condition].

Default The current set value

Modifying Directly enter from the keyboard.

Available 
values

Address expression within the valid range

Use the address 
mask
[Simulator]

Specify whether to specify an address mask.

Default No

Modifying Select from the drop-down list

Available 
values

Yes Specifies an address mask.

No Does not specify an address mask.
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(2) [Data Condition]
Specify the data condition. 

Mask value
[Simulator]

Specify the value of address mask.
This item appears only when [Use the address mask] is set to [Yes].

Default The current set value

Modifying Directly enter from the keyboard.

Available 
values

Hexadecimal number up to five digits

Access type Specify the type of access.

Default The current set value

Modifying Select from the drop-down list

Available 
values

Read Sets a read access as the type of access.

Write Sets a write access as the type of access.

Read/Write Sets a read and a write access as the type of access.

Access size Specify the access size.

Default The current set value

Modifying Select from the drop-down list

Available 
values

No conditions Sets no access size.
True for all access sizes.

1byte Sets 1-byte as the access size.

2byte Sets 2-byte as the access size.

Compare condition Specify the condition to compare the data.

Default The current set value

Modifying Select from the drop-down list

Available 
values

No conditions Specifies no data value. 

Specified value (==) Specifies the data with [Compare data].

Any other value (!=)
[IECUBE][Simulator]

Greater than or equal to (>=)
[IECUBE][Simulator]

Less than or equal to (<=)
[IECUBE][Simulator]

Inside the range (<=Values<=)
[IECUBE][Simulator]

Specifies the range with [Lower data] 
and [Upper data].

Outside the range !(<=Val-
ues<=)
[IECUBE][Simulator]
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(a) [Pass Count] [IECUBE][Simulator]
Specify the pass count condition. 

(3) Description area
This area displays a simple description of the item selected in the Event conditions setting area. 

Compare data Specify the data to compare.
This item appears only when [Specified value (==)], [Any other value (!=)], [Greater than 
or equal to (>=)] or [Less than or equal to (<=)] is selected in [Compare condition].

Default The current set value

Modifying Directly enter from the keyboard.

Available 
values

Hexadecimal number up to five digits

Lower data
[IECUBE]
[Simulator]

Specify the lower data for the range in [Compare condition].
This item appears only when [Inside the range (<=Values<=)] or [Outside the range 
!(<=Values<=)] is selected in [Compare condition].

Default The current set value

Modifying Directly enter from the keyboard.

Available 
values

Hexadecimal number up to five digits

Upper data
[IECUBE]
[Simulator]

Specify the upper data for the range in [Compare condition].
This item appears only when [Inside the range (<=Values<=)] or [Outside the range 
!(<=Values<=)] is selected in [Compare condition].

Default The current set value

Modifying Directly enter from the keyboard.

Available 
values

Hexadecimal number up to five digits

Use the data mask Specify whether to specify a data mask.

Default No

Modifying Select from the drop-down list

Available 
values

Yes Specifies a data mask.

No Does not specify a data mask.

Mask value Specify the value of data mask.
This item appears only when [Use the data mask] is set to [Yes].

Default The current set value

Modifying Directly enter from the keyboard.

Available 
values

Hexadecimal number up to five digits

Pass count Specify a pass count.
The relevant event occurs when the event condition is met as many times as the spec-
ified pass count.

Default 1

Modifying Directly enter from the keyboard.

Available 
values

1 to 65535 in decimal number



CS+ V8.04.00 A.  WINDOW REFERENCE

R20UT4692EJ0100  Rev.1.00 Page 302 of 411
Jun 01, 2020

[Toolbar]

[Function buttons]

Displays all categories in the Event conditions setting area.

Hides categories in the Event conditions setting area and rearranges only setting items in the 
ascending order

This button is always invalid. 

Button Function

OK Applies detailed settings made in this dialog box to access-related events and closes this 
dialog box.

Cancel Cancels the save and closes this dialog box.

Help Displays the help for this dialog box.
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This dialog box is used to set the scroll range of the vertical scroll bar on the Memory panel/Disassemble panel. 
By setting the appropriate range, it is possible to improve the operability of a mouse (e.g. dragging) because the size of 

the vertical scroll bar on the panel is changed suitably. 

Caution After setting a scroll range via this dialog box, the scroll range is not updated automatically even if the 
address evaluated by the address expression is changed because of such as a line assembly.

Remark It is possible to move outside the scroll range by using the [Page Up]/[Page Down]/[Up]/[Down] key, a 
button at either end of the scroll bar or a menu item related to the jump function. 

Figure A.39 Scroll Range Setting Dialog Box

This section describes the following.

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- On the Memory panel, click the  button from [View] on the toolbar.

- On the Memory panel, select the [View] menu >> [Settings Scroll Range...] from the context menu.

- On the Disassemble panel, click the  button from [View] on the toolbar.

- On the Disassemble panel, select the [View] menu >> [Settings Scroll Range...] from the context menu.

[Description of each area]

(1) [Start address] area
Specify the start address of the range of scrolling.
You can either type an address expression directly into the text box (up to 1024 characters), or select it from the 
input history via the drop-down list (up to 10 items).
Note that the setting of the scroll range is not performed if "All" is selected in the drop-down list at this time (the 
scroll range is not limited). 

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space] 
key in this text box (see "2.19.2  Symbol name completion function").   

(2) [End address] area
Specify the end address of the range of scrolling.
You can either type an address expression directly into the text box (up to 1024 characters), or select it from the 
input history via the drop-down list (up to 10 items).
Note that this area becomes invalid if [Start address] is specified with [All]. 

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space] 
key in this text box (see "2.19.2  Symbol name completion function"). 

Scroll Range Settings dialog box

(1)

[Function buttons]

(2)
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[Function buttons]

Button Function

OK Sets the specified scroll range for the target panel.
Moves the caret to the start address, from the beginning of the area displayed in 
the target panel. 

Cancel Cancels the jump and closes this dialog box.

Help Displays the help for this dialog box.
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This dialog box is used to move the caret to a specified position. 

Figure A.40 Go to the Location Dialog Box

This section describes the following. 

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- Focus the Disassemble panel, and then select [Go to...] from the [Edit] menu.

- Focus the SFR panel, and then select [Go to...] from the [Edit] menu.

- On the Disassemble panel, select [Go to…] from the context menu. 

- On the SFR panel, select [Go to…] from the context menu. 

[Description of each area]

(1) [Address/Symbol], or [SFR] area
Specify the location to which the caret jumps.
You can either type a location directly into the text box (up to 1024 characters), or select one from the input history 
via the drop-down list (up to 10 items). 
The data to specify various depending on the target panel, as follows: 

Remark If this dialog box is opened from the Disassemble panel, a symbol name at the current caret posi-
tion can be complemented by pressing the [Ctrl] + [Space] key in this text box (see "2.19.2  Symbol 
name completion function").   

[Function buttons]

Go to the Location dialog box

Target Panel Data Specified 

Disassemble panel Address expression

SFR panel SFR name

Button Function

OK Moves the caret to the specified location, from the beginning of the area displayed in the tar-
get panel. 

Cancel Cancels the jump and closes this dialog box. 

Help Displays the help for this dialog box. 

(1)

[Function buttons]
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This dialog box is used to save data displayed in the Disassemble panel, Memory panel, or Trace panel, and save 
uploaded data (see "2.5.3  Execute uploading"). 

This dialog box appears only when connected to the debug tool. 

Figure A.41 Data Save Dialog Box

This section describes the following. 

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- With the Disassemble panel in focus, select [Save Disassemble Data As…] form the [File] menu. 

- With the Memory panel in focus, select [Save Memory Data As…] form the [File] menu. 

- With the Trace panel in focus, select [Save Trace Data As…] form the [File] menu. 

- From the [Debug] menu, select [Upload…].

[Description of each area]

(1) [File Name] area
Specify the name of the file to save. 
You can either type a filename directly into the text box (up to 259 characters), or select one from the input history 
via the drop-down list (up to 10 items). 
You can also specify the file by clicking the […] button, and selecting a file via the Select Data Save File dialog 
box. 
When only the name of the file is specified, i.e. path information is not included, the file will be in the project folder.

(2) [File Type] area
Select the format in which to save the file from the following drop-down list. 
The available file formats will differ as follows depending on the type of data being saved. 

(a) When saving the displayed content of a panel

Note The data is saved with entries separated by commas (,). 
If the data contains commas, each entry is surrounded by double quotes ("") in order to avoid ille-
gal formatting. 

Data Save dialog box

Text files (*.txt) Text format (default)

CSV (Comma-Separated Variables) (*.csv) CSV formatNote

[Function buttons]

(3)

(1)

(2)
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(b) When saving upload data

Remark See "2.5.3  Execute uploading" for details on uploading. 

(3) [Save Range xxx] area
Specify the range of data to save. 
You can either type ranges directly into the text boxes, or select them from the input history via the drop-down lists 
(up to 10 items). 
The method of specifying the ranges will differ as follows depending on the type of data to be saved. 

Note These are the numbers shown in the [Number] area of the Trace panel. 

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space] 
key in each text box (see "2.19.2  Symbol name completion function").   

[Function buttons]

Displayed List Items File Format

Intel Hex format (*.hex) Intel Hex format

Motorola S-record (*.mot) Motorola S type format 

Binary data (*.bin) Binary format

Type of Data Description 

Disassemble panel Specify the range of addresses to save via the start and end addresses. 
Ranges can be entered as base-16 numbers or as address expressions. 
When a range is selected in the panel, that range is specified by default. 
When there is no selection, then the range currently visible in the panel is speci-
fied. 

Memory panel Specify the range of memory to save via the start and end addresses. 
Ranges can be entered as base-16 numbers or as address expressions. 
When a range is selected in the panel, that range is specified by default.
When there is no selection, then the range currently visible in the panel is speci-
fied. 

Trace panel - Specifying a range to save 
Specify the trace range to save via the start and end trace numbersNote. 
Ranges can only be entered as base-10 numbers. 

- Saving all trace data
From the drop-down list to the left, select [All Trace Data].  The text box to the 
right is disabled.  All currently acquired trace data will be saved. 

The range currently visible in the panel is specified by default.

Upload data Specify the range of memory to save via the start and end addresses. 
Ranges can be entered as base-16 numbers or as address expressions. 

Button Function

Save Saves the data to a file with the specified filename, in the specified format. 

Cancel Cancels the save and closes this dialog box. 

Help Displays the help for this dialog box. 
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This dialog box is used to specify the range for skipping step execution.

Figure A.42 Specified Section Dialog Box

This section describes the following. 

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- On the [Debug Tool Settings] tab of the Property panel, click the [...] button displayed by selecting the [Target section] 
property in the [Step function] category. 

[Description of each area]

(1) [Specified section list] area 

(a) List display
This area is used to display the list of the range for skipping step execution.
To add a new section, click the [Add] button in this area, then in the [Specified section property] area, specify 
the sections to add.

(b) Button

Specified Section dialog box

Button Function

Up Moves the selected section up one row in the list. 
Clicking this for the top section in the list has no effect.

(1)

(2)

[Function buttons]
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(2) [Specified section property] area

(a) [Select section] 
This area is used to display or edit the section selected in the [Specified section list] area. 
It can also be used to specify the new sections added via the [Add] button.

[Function buttons]

Down Moves the selected section down one row in the list.
Clicking this for the bottom section in the list has no effect.

Add Adds an empty item "-" to the list, and selects it.  
Specify the section to add in the [Specified section property] area. 

Remove Removes the selected section from the list. 

Section select 
type

Specify the method for specifying the section.

Default Section name

Modifying Select from the drop-down list.

Available values Section name Specifies the range by the section name.

Start and end 
address

Specifies the range by the start and end address.

Section name Specify the section name. 
Note that this item appears only when [Section select type] is set to [Section name].

Modifying Directly enter from the keyboard. 

Start address Specify the start address. 
Note that this item appears only when [Start and end address] is set to [Section name].

Modifying Directly enter from the keyboard. 

End address Specify the end address. 
Note that this item appears only when [Start and end address] is set to [Section name].

Modifying Directly enter from the keyboard. 

Button Function

OK Finishes configuring the target sections, and closes this dialog box. 

Cancel Cancels any changes to the target sections, and closes this dialog box. 

Help Displays the help for this dialog box. 

Button Function
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This panel displays the functions that access variables in the form of an orthogonal table.

Figure A.43 Functions and Variables Access Table Panel

This section describes the following.

- [How to open]

- [Description of each area]

- [Toolbar]

[How to open]

- From the [View] menu, select [Functions and Variables Access Table].

[Description of each area]

(1) Table area

(a) [Orthogonal Table] tab
In the active project, the functions that access variables are displayed in an orthogonal table.
This information is created using the cross reference information and map information. If no information is dis-
played, click  (button for running a build with the build option for generating the orthogonal table made valid) 
on the right edge of the toolbar and generate information.

The state of functions accessing variables which has been acquired by statically analyzing the C source pro-
gram is also displayed.

- A cell containing "R" indicates that the value of the variable has been read. The number in parentheses indi-
cates the number of locations at which the variable was read from within the function.

- A cell containing "W" indicates that the value of the variable has been written. The number in parentheses 
indicates the number of locations at which the variable was written to within the function.

Double-clicking the variable name or cell which shows the state of access to the variable displays that definition 
in an editor.

(2) Tab selection area
There is the [Orthogonal Table] tab which displays the functions that access variables in the form of an orthogonal 
table.

[Toolbar]

The toolbar is displayed only when the compiler in use supports generation of cross reference information.

Functions and Variables Access Table panel

(1)

[Toolbar]

(2)
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If the build option related to generation of the cross reference information is invalid, clicking on 
this button validates the build option and runs a build. If a file is being edited by the text editor 
at the time, the file is saved.
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This panel is central to the functionality of the solution for measuring current consumption.
See "2.17  Measuring Current Consumption [E2][Simulator]" for details on the solution for measuring current consump-

tion.

Caution 1. Monitoring points are not supported when the MCU is RL78/G10.

Caution 2. There will be some error in the results of measurement. For the specifications of the measurement of cur-
rent consumption, e.g. the maximum current consumption, the maximum time over which measurement 
is possible, the resolution of measurements of current consumption, etc., refer to the E2 Emulator User's 
Manual.

Figure A.44 Measuring Current Consumption Panel

This section describes the following.

- [How to open]

- [Description of each area]

- [Toolbar]

- [Context menu]

[How to open]

- From the [Debug] menu, select [Debug Solutions] >> [Measuring Current Consumption].

- On the Solution List panel, click the [Go] button of Measuring Current Consumption.

[Description of each area]

(1) Warning display area
This area shows warning messages if there are inconsistencies between the conditions for measurement of cur-
rent consumption and the conditions to be set before the debug tool is connected.
This area is hidden when there is no warning to be reported.

(2) Graph display area
This area shows the measured results for current consumption with the current represented by the y axis and time 
by the x axis of the graph.

Measuring Current Consumption panel [E2][Simulator]

(2)

(4)

(3)

(1)

[Toolbar]
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This area also has the following lines which can be dragged.

When a cursor or marker is dragged, information in the information display area is updated accordingly.
The supplementary lines for searching are used to simply specify the threshold current which is the basis of the 
search.

Remark While current consumption is being measured, the display of data is cleared and the cursor and 
markers cannot be dragged.

With the simulator, when the mouse cursor is hovered over a point on the graph, the following window pops up to 
display the values for current consumption by the individual modules.

Figure A.45 Window Displaying the Values for Current Consumption by Individual Modules

(3) Information display area
This area displays particular values from the graph of the measured data that is displayed in the graph area.

(a) [Average current]
The average of the values for current between markers A and B is displayed.
When there are no markers, the average value over the whole range of measured data is displayed in the case 
of the simulator and blank space is displayed in the case of the E2 emulator.

(b) [Maximum current]
The maximum of the values for current between markers A and B is displayed.
When there are no markers, the maximum value over the whole range of measured data is displayed in the 
case of the simulator and blank space is displayed in the case of the E2 emulator.

(c) [Current]
The values for current at the position of the cursor is displayed.
When the cursor is not displayed, this item becomes blank.

(d) [Time]
The time at the position of the cursor is displayed.
When the cursor is not displayed, this item becomes blank.

(e) [Marker A]
The time at the position of marker A is displayed.
When marker A is not displayed, this item becomes blank.

(f) [Marker B]
The time at the position of marker B is displayed.
When marker B is not displayed, this item becomes blank.

(g) [B - A]
The time between markers A and B is displayed.
When markers are not displayed, this item becomes blank.

Supplementary Line Description

Cursor Red vertical line

Marker A, Marker B Green vertical line

Supplementary lines for search-
ing

Orange horizontal line
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(4) Monitor point list display area [E2]
This area displays a list of monitoring points that have been set and is used to specify the settings for building and 
downloading when monitor points are set.

Caution This area is not displayed when the MCU is RL78/G10.

(a) [Hold the build options for monitor point specified when measuring]
When building proceeds with the function for automatically inserting nop instructions for monitoring points, the 
options for use in building are reflected in the properties of the build tool.

Caution This check box is only effective when the compiler for the current active project is CC-RL 
V1.05.00 or later.

(b) [Monitor point list]
A list of monitoring points that are currently set is displayed.
When the measured results are displayed in the graph display area and a cell is double-clicked with each line of 
the list selected, the cursor in the graph display area is moved to the position of the monitoring point that is indi-
cated by that line.

The following describes the individual components.

<1> Check box
Monitoring points for which the check boxes are selected are valid in the measurement of current consump-
tion.

<2> Cursor
Displays the cursor in the graph display area at the position of the monitoring point on the given line.
When the cursor is selected for a point, the background color of the cell changes to red.

<3> Count
Displays how many times the monitoring point on the given line has been crossed during measurement.

<4> Location
Displays the position of the monitoring point on the given line in the format "file-name#line-number (address)".

Example main.c#16(0xFFF0E)

Caution Addresses are only displayed when they have already been determined during measurement.

<5> Line Color
In the graph display area, the color of the vertical line is displayed at the position corresponding to the moni-
toring point on the given line.

[Toolbar]

[E2]

Executes the program and starts measurement of current consumption.
When V1.05.00 or later of the CC-RL compiler is selected for the active project, 
rebuilding and downloading are performed to insert nop instructions at the positions 
corresponding to monitoring points in the source file registered in the active project.
However, even if the RRM or DMM function is enabled, the setting is ignored during 
the measurement of current consumption.

[E2][Except RL78/G10]

Executes the program and starts measurement of current consumption.
Rebuilding and downloading are not performed to insert nop instructions at the posi-
tions corresponding to monitoring points.
Note that this button appears when V1.05.00 or later of the CC-RL compiler is 
selected for the active project.
However, even if the RRM or DMM function is enabled, the setting is ignored during 
the measurement of current consumption.

[Simulator]

Selects whether current consumption is to be measured during the execution of a 
program.

Has the same functionality as the same button on the Debug toolbar in the Main win-
dow.
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Opens the Current Consumption Measurement Condition Setting dialog box [E2] to 
set measurement conditions.

Opens the Current Consumption Measurement Trigger Condition Setting dialog box 
[E2], which is used to set trigger conditions for measurement.

Moves marker A in the graph display area to the corresponding position.

Moves marker B in the graph display area to the corresponding position.

Moves the cursor in the graph display area to the corresponding position.

Switches between showing and hiding the cursor, marker A, marker B, and the sup-
plementary lines for searching in the graph display area.

Searches for the first position that matches the condition set with the supplementary 
lines for searching and the search mode.
When the position is found, the cursor in the graph display area is moved to that 
position.

Searches for the first position before the cursor position that matches the condition 
set with the supplementary lines for searching and the search mode.
When the position is found, the cursor in the graph display area is moved to that 
position.

Searches for the first position after the cursor position that matches the condition set 
with the supplementary lines for searching and the search mode.
When the position is found, the cursor in the graph display area is moved to that 
position.

Searches for the last position that matches the condition set with the supplementary 
lines for searching and the search mode.
When the position is found, the cursor in the graph display area is moved to that 
position.

Selects a search mode from among , , , and .
"Under threshold", "In range", "Out of range" or "Monitor point" can be selected as 
the search mode.

Opens the Current Consumption Measurement Search dialog box [E2][Simulator] to 
specify and search the detailed conditions.

Selects whether movement of the cursor in the graph display area is linked with the 
Editor panel.
When this icon is selected and the cursor is stopped on a monitoring point, the posi-
tion of source code where the monitoring point has been set is opened in the Editor 
panel.

Selects whether movement of the cursor in the graph display area is linked with the 
Disassemble panel.
When this icon is selected and the cursor is stopped on a monitoring point, the posi-
tion of source code where the monitoring point has been set is opened in the Disas-
semble panel. When movement of the cursor is also linked with the Editor panel, 
linking with the Editor panel is given priority.

Opens the Save Current Values dialog box [E2] or the Save File dialog box [Simula-
tor] to save the data on current in the measured results of current consumption in a 
file with the CSV format.
The file saved by this button can be displayed in the graph display area by clicking 
on .

Reads the CSV file saved by using  and displays it in the graph display area.

Opens the Save File dialog box to save the measured results for current consump-
tion and settings of conditions for measurement in a file with the CSV or Microsoft 
Office Excel book format.
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[Context menu]

Clears the graph showing the measured results in the graph display area.

Clears the graph of the data which has been read by using  in the graph display 
area.

Save Results of Current Val-
ues

Opens the Save Current Values dialog box [E2] or the Save File dialog box [Simula-
tor] to save the data on current in the measured results of current consumption in a 
file with the CSV format.
The file saved by this menu can be displayed in the graph display area by selecting 
the [Load Results of Current Values] menu.

Load Results of Current Val-
ues

Reads the CSV file saved by using the [Save Results of Current Values] menu and 
displays it in the graph display area.

Clear Measurement Result Clears the graph showing the measured results in the graph display area.

Clear Loaded Data Clears the graph of the data which has been read by using the [Save Results of Cur-
rent Values] menu in the graph display area.

Time Unit The following cascade menus are displayed to switch the time unit of the X axis in 
the graph display area.

Second Switches the time unit of the X axis in the graph display area to seconds.

Millisecond Switches the time unit of the X axis in the graph display area to milliseconds.

Microsecond Switches the time unit of the X axis in the graph display area to microseconds.

Zoom In The following cascade menus are displayed to zoom in the display ranges of the X 
and Y axes in the graph display area.

Zoom In Zooms in the display ranges of the X and Y axes in the graph display area.

Zoom In X Axis Zooms in the display ranges of the X axe in the graph display area.

Zoom In Y Axis Zooms in the display ranges of the Y axe in the graph display area.

Zoom Out The following cascade menus are displayed to zoom out the display ranges of the X 
and Y axes in the graph display area.

Zoom Out Zooms out the display ranges of the X and Y axes in the graph display area.

Zoom Out X Axis Zooms out the display ranges of the X axe in the graph display area.

Zoom Out Y Axis Zooms out the display ranges of the Y axe in the graph display area.

Reset Zoom Restores the display ranges of the X and Y axes in the graph display area to the ini-
tial values.
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This dialog box is used to set measurement conditions in the Measuring Current Consumption panel [E2][Simulator].

Figure A.46 Current Consumption Measurement Condition Setting Dialog Box

This section describes the following. 

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- On the Measuring Current Consumption panel [E2][Simulator], click the  button on the toolbar.

[Description of each area]

(1) [Operation after record memory is full]
Select the operation of the debugger after the recording memory of the emulator becomes full during the measure-
ment of current consumption from the following drop-down list.

(2) [Sampling time]
Select the sampling time during the measurement of current consumption.
The following sampling times can be selected.

1us, 2us, 5us, 10us, 20us, 50us, 100us, 200us, 500us, 1ms

(3) [Acquisition condition] area
Make settings regarding conditions for writing to the recording memory of the emulator.

(a) [Condition]
Select the type of condition for writing to the recording memory of the emulator from the following drop-down list.

Current Consumption Measurement Condition Setting dialog box [E2]

Overwrite to the record mem-
ory and continue execution

Continue to execute the program and to record data by overwriting the data 
from the beginning of the recording memory.

Stop recording Only stop writing to the recording memory but continue to execute the pro-
gram.

Stop program Stop both writing to the recording memory and execution of the program.

All Record all measured data without restrictions.

(2)

(1)

(3)

[Function buttons]
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(b) [Channel]
When "During detecting an external trigger input" is selected for [Condition], select "ch0" or "ch1" as the external 
trigger input channel from the extended interface of the E2 emulator that is to be detected.

(c) [External trigger input type]
When "During detecting an external trigger input" is selected for [Condition], select "High" or "Low" as the level 
of the external trigger input signal to be detected.

(d) [Monitor points range]
When "During monitor points" is selected for [Condition], select the two target monitoring points.
Monitoring points that have currently been specified for the project are displayed in a drop-down list.
The measured data will only be recorded from the time the monitoring point set in the left side has been 
detected until detection of the monitoring point set on the right side.

[Function buttons]

During detecting an external trigger 
input

Record the measured data with use of the function for detecting an 
external trigger input in the extended interface of the E2 emulator only 
while the external trigger input is detected.

During monitor points Record the measured data only over the time from detection of the 
monitoring point for starting measurement until detection of the moni-
toring point for ending measurement.

Button Function

OK Reflects the settings of the measurement conditions that were made in this dialog box to 
the Measuring Current Consumption panel [E2][Simulator].

Cancel Nullifies settings and closes this dialog box.

Help Displays the help for this dialog box.
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This dialog box is used to set trigger conditions in the Measuring Current Consumption panel [E2][Simulator].

Figure A.47 Current Consumption Measurement Trigger Condition Setting Dialog Box

This section describes the following. 

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- On the Measuring Current Consumption panel [E2][Simulator], click the  button on the toolbar.

[Description of each area]

(1) [Use trigger function]
Specify whether to use the trigger function.

(2) [Trigger action settings] area
Set the operation of the E2 emulator on detection of the trigger.

Current Consumption Measurement Trigger Condition Setting dialog box [E2]

(2)

(1)

(3)

[Function buttons]
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(a) [Action when detecting a trigger]
Select the operation on detection of the trigger from the following drop-down list.

(b) [Channel]
When "Output external trigger signal" is selected for [Action when detecting a trigger], select "ch0" or "ch1" as 
the external trigger output channel of the extended interface of the E2 emulator.

(c) External trigger output type
Select [High pulse] or [Hold High level during the current meets the condition] as the type of signal for output as 
the external trigger.
When [High pulse] is selected, specify the width of the pulse as a decimal value between 1 and 65535 (in micro-
seconds).

(3) [Trigger condition settings] area
Set the trigger conditions.

(a) [Condition]
Select the type of change in values for current as the trigger condition from the following drop-down list.

(b) [Current value]
Specify the specific value or range of values for current to serve as the trigger condition in microamperes.
Specify one value for current when "Over threshold" or "Under Threshold" is selected for [Condition], and two 
values for current when "In range" or "Out of Range" is selected for [Condition].

Caution For a range of current values, the value entered in the left field for entry must be lower than that 
in the right field.

(c) [Specify detecting width]
When "Over threshold", "Under Threshold", or "In range" is selected for [Condition], specify whether the trigger 
is only detected when the change in the value for current continues for a specific period or at the instant the 
required change in the value is detected.
To select detection of the trigger, select the check box and specify the condition for the interval and the interval.

<1> Condition for the interval
Select the condition for the interval from the following drop-down list.

<2> Interval
Specify a multiple of the sampling time selected for [Sampling time] in the Current Consumption Measure-
ment Condition Setting dialog box [E2].
The actual interval is the specified multiple of the sampling time.

Stop program Stop execution of the program.

Output external trigger signal Output the external trigger signal by using the function for output of an 
external trigger signal from the extended interface of the E2 emulator.

Over threshold Detect the moment when the current being measured becomes or exceeds a 
specified value.

Under Threshold Detect the moment when the current being measured becomes or falls below 
a specified value.

In range Detect the moment when the current being measured enters a specified 
range of values.

Out of Range Detect the moment when the current being measured leaves a specified 
range of values.

Over threshold Detect the trigger when the condition specified for [Condition] continues to be satis-
fied for at least the specified interval.

In range Detect the trigger only when the condition specified for [Condition] continues to be 
satisfied within the specified interval.
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[Function buttons]

Button Function

OK Reflects the settings of the trigger conditions that were made in this dialog box to the Mea-
suring Current Consumption panel [E2][Simulator].

Cancel Nullifies settings and closes this dialog box.

Help Displays the help for this dialog box.



CS+ V8.04.00 A.  WINDOW REFERENCE

R20UT4692EJ0100  Rev.1.00 Page 322 of 411
Jun 01, 2020

This dialog box is used to specify and search the detailed conditions in the Measuring Current Consumption panel 
[E2][Simulator].

Figure A.48 Current Consumption Measurement Search Dialog Box

This section describes the following. 

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- On the Measuring Current Consumption panel [E2][Simulator], click the  button on the toolbar.

[Description of each area]

(1) [Searching option] area
Specify the search conditions.

(a) [Condition]
Select the type of the search conditions from the following drop-down list.

Current Consumption Measurement Search dialog box [E2][Simulator]

Over threshold Detect the moment when the current being measured becomes or exceeds a 
specified value.

Under Threshold Detect the moment when the current being measured becomes or falls below 
a specified value.

[Function buttons]

(1)
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(b) [Current value]
Specify the specific value or range of values for current to serve as the search condition in microamperes.
Specify one value for current when "Over threshold" or "Under Threshold" is selected for [Condition], and two 
values for current when "In range" or "Out of Range" is selected for [Condition].

Caution For a range of current values, the value entered in the left field for entry must be lower than that 
in the right field.

(c) [Specify detecting width] [E2]
When "Over threshold", "Under Threshold", or "In range" is selected for [Condition], specify whether the data is 
only searched when the change in the value for current continues for a specific period or at the instant the 
required change in the value is detected.
To search the data, select the check box and specify the condition for the interval and the interval.

<1> Condition for the interval
Select the condition for the interval from the following drop-down list.

<2> Interval
Specify a multiple of the sampling time selected for [Sampling time] in the Current Consumption Measure-
ment Condition Setting dialog box [E2].
The actual interval is the specified multiple of the sampling time.

(d) [Monitor point] [E2]
When "Monitor point" is selected for [Condition], select "All" or the current monitoring point as the target monitor-
ing point.

[Function buttons]

In range Detect the moment when the current being measured enters a specified 
range of values.

Out of Range Detect the moment when the current being measured leaves a specified 
range of values.

Monitor point [E2] Detect the specified monitoring point.

Over threshold Detect the data when the condition specified for [Condition] continues to be satisfied 
for at least the specified interval.

In range Detect the data only when the condition specified for [Condition] continues to be sat-
isfied within the specified interval.

Button Function

Find First Searches the whole of the measured data from its start for points that satisfy the conditions 
specified in this dialog box.

Find Previous Searches forward in time from the position of the cursor in the graph display area in the 
Measuring Current Consumption panel [E2][Simulator] for the points that satisfy the condi-
tions specified in this dialog box.

Find Next Searches backward in time from the position of the cursor in the graph display area in the 
Measuring Current Consumption panel [E2][Simulator] for the points that satisfy the condi-
tions specified in this dialog box.

Find Last Searches the whole of the measured data from its end for points that satisfy the conditions 
specified in this dialog box.

Close Nullifies settings and closes this dialog box.

Help Displays the help for this dialog box.
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This dialog box is used to save the values for current in the Measuring Current Consumption panel [E2][Simulator].

Figure A.49 Save Current Values Dialog Box

This section describes the following. 

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- On the Measuring Current Consumption panel [E2][Simulator], click the  button on the toolbar.

[Description of each area]

(1) [File Name] area
Specify the name of the file to save. 
You can either type a filename directly into the text box (up to 259 characters), or select one from the input history 
via the drop-down list (up to 10 items). 
You can also specify the file by clicking the [Reference…] button, and selecting a file via the Select Current Values 
Data Save File dialog box. 
When only the name of the file is specified, i.e. path information is not included, the file will be in the project folder.

(2) [Save range] area
Specify the range in time of values for current to be saved by specifying the times (in microseconds) where saving 
is to start and end. The numbers are decimal.
You can either type ranges directly into the text boxes, or select them from the input history via the drop-down lists 
(up to 10 items). 
When "All data" is selected, the values for current from the minimum time as the start time to the maximum time as 
the end time will be saved.

[Function buttons]

Save Current Values dialog box [E2]

Button Function

Save Saves the data to a file with the specified filename, in the CSV format. 

Cancel Cancels the save and closes this dialog box. 

Help Displays the help for this dialog box. 

(2)

(1)

[Function buttons]
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This panel is used to configure the virtual target system and operate the virtual components.
With this panel, the results of data that have been input to and output from peripheral I/O modules can be confirmed.
Note that this panel is only available when the simulator for the active project supports peripheral function simulations.

Figure A.50 Virtual Board panel [Simulator]

This section describes the following.

- [How to open]

- [Description of each area]

[How to open]

- From the [View] menu, select [Virtual Board].

[Description of each area]

(1) Virtual board area
This area is used to operate the virtual target system.
It supports the following components.
These components can be operated while the program is running.

Virtual Board panel [Simulator]

Light Emitting Diode
An LED can be connected to any pin, and the output from the pin can be 
indicated by switching the LED on or off.

 (with brightness control) Light Emitting Diode
An LED can be connected to any pin, and PWM control can be used to con-
trol the apparent brightness by switching the LED on and off.
The display on the LED is not correct if the PWM cycle is greater than 100 
ms.

 Digital input switch (push type)
A button can be connected to any pin. A digital input value can be given to 
the connected pin by clicking the displayed button.

(1) (3)

(2)
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Note At present, this component is only available for use with devices of the RL78/L12 group.

(2) Button area
These buttons are used to add components.
This area is valid while the program is stopped.

 Digital input switch (toggle type)
A button can be connected to any pin. A digital input value can be given to 
the connected pin by clicking the displayed button.

Used for inputting analog data. Any data within a given range can be set. 
Any value within a specified range can be assigned to a pin connected to an 
A/D converter.

Used for inputting analog data. Any data within a given range can be set. 
The gas concentration sensor value (PPM) is converted to a voltage for a 
pin connected to. Any value within a specified range can be assigned to the 
pin.

 Switch for vibration sensing
A button can be connected to any pin. A digital input value can be given to 
the connected pin by clicking the displayed button.

 Buzzer for an alarm machine
A button can be connected to any pin. The output of the pin is indicated by 
both sound and image.

Temperature sensor
The voltage produced from the specified temperature can be applied to a 
pin to which the A/D converter is connected.
Relational expression between temperature and input voltage:

Voltage (V) input to the connected pin = 
(conversion_factor[mV/ ℃ ] x specified_temperature[ ℃ ] + 
conversion_offset[mV]) / 1000.0

Fan motor
The fan is made to rotate by the input of a digital signal from the connected 
pin.
The rotational velocity can be controlled by the duty ratio of the PWM signal.

DC motor
The motor is made to rotate by the input of a digital signal from the con-
nected pin.
The rotational velocity can be controlled by the duty ratio of the PWM signal.

 Shading sensor
A specified voltage value can be output to the connected pin in response to 
covering the red light-emitting part by the hand-image icon. 

 Wireless-charging transmitter
When a PWM signal is being input through the connected pin, a sphere 
revolves around the component to indicate that charging is in progress.

 Infrared receiver
Clicking on the component leads to the output of the signal which has been 
specified for the connected pin.

 8x8 Segments LCD for internal driverNote

Segments of this LCD are illuminated in response to control signals sent 
from the LCD driver in the MCU. You can control the correspondence 
between the MCU's control signals and segments in the property area.
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(3) Property area
This area is used to display or edit the properties of the component.
The properties of the component selected while the program is stopped are displayed.
The following items are displayed in this area.

Add component Adds a part.
The default setting for the type of component is LED. Select the component to be 
used from [Type] in the property area.
Drag the component to move it to the position where it is to be placed.
Clicking on the delete button in the upper-right corner of the selected component 
deletes that component.

Type Select the part.

Subtype Select an LED with or without brightness control.
This property is displayed when the component is an LED.

LED without Brightness Control The LED is turned on or off.

LED with Brightness Using PWM The LED has brightness control.

Name Specify the name of the part.

Connected to Select the name of the pin to which the LED is to be connected.

Color Select the color of the LED.
This property is displayed when the component is an LED.
The following colors can be selected.

Red, green, blue

Active Level Select the active state.
This property is displayed when the component is an LED or switch.

Active High Sets the active level to High.

Active Low Sets the active level to Low.

Appearance Select the type of the switch.
This property is displayed when the component is a switch.

Push Sets the push switch.

Toggle Sets the toggle switch.

Min Input Value Display or specify the lower limit of an input value.
This property is displayed when the component is a potentiometer, a gas sensor, or 
a temperature sensor.
For a temperature sensor, the minimum input value is automatically calculated from 
the conversion factor and the conversion offset (- conversion_offset[mV] / 
conversion_factor[mV/ ℃ ]).

Max Input Value Display or specify the upper limit of an input value.
This property is displayed when the component is a potentiometer, a gas sensor, or 
a temperature sensor.
For a temperature sensor, the maximum input value are automatically calculated 
from the following formula.

(max_input_voltage[V] - conversion_offset[mV] / 1000.0) / 
(conversion_factor[mV/ ℃ ] / 1000.0)

Input Step Display or specify the minimum size of the variation in an input value.
This property is displayed when the component is a potentiometer, a gas sensor, or 
a temperature sensor.
For a potentiometer, the value displayed or entered in the text box is the stepping 
width.
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- Copyright
The Virtual Board Panel may use the copyrighted components specified in the file below.
CS+ install folder\CC\vboard\licenses-abstract.txt

Initial Input Value Select the initial value when the CPU is reset.
This property is displayed when the component is a potentiometer, a gas sensor, or 
a temperature sensor.

On Reset Select the operation when the CPU is reset.
This property is displayed when the component is a potentiometer, a gas sensor, or 
a temperature sensor.

Hold The state immediately before the CPU was 
reset is retained after the CPU has been 
reset.

Initialize Specify the value which has been selected in 
[Initial Input Value] when the CPU is reset.

Sound Select the mute of the buzzer.
This property is displayed when the component is a buzzer.

Conversion Factor Specify a factor for the conversion of each input value to a voltage value.
This property is displayed when the component is a gas sensor or a temperature 
sensor.

Conversion Offset Specify an offset for the conversion of each input value to a voltage value.
This property is displayed when the component is a temperature sensor.

Max Input Voltage [V] Specify the maximum voltage value that can be input to the connected port.

COM/SEG Signal View or change the current settings of control signals to be sent to the 8x8-segment 
LCD for use with the on-chip driver.
This property initially shows the current setting for the number of digits and whether 
the control signals have been selected.
Selecting this property produces a button in the displayed area.
Clicking on the button brings up the control interface shown below.

Enter the desired number of digits and select the control signals for the individual 
segments. Click on the [OK] button to complete the settings.
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This window appears automatically by default after connecting to the debug tool when a microcontroller whose Simula-
tor supports peripheral function simulations is selected and [Simulator] is selected as the debug tool to use (see "2.18  Use 
the Simulator GUI [Simulator]"). 

In Simulator GUI, other windows (Signal Data Editor window, Timing Chart window, I/O Panel window, and Serial win-
dow) are manipulated from this window. 

Caution 1. When a microcontroller whose Simulator does not support peripheral function simulations (instruction 
simulation version) is selected, this window cannot be opened. 

Caution 2. This window and windows opened from it cannot be docked to the CS+ Main window. 

Caution 3. The help for this window will not be displayed even if the [F1] key on the keyboard is pressed when no 
window opened from this window is opened.
To open the help for this window, select the [Help] menu >> [Main Window] on this window. 

Caution 4. The [x] button on this window's titlebar is invalid (it is invalid even if using the Aero function of Windows 
Vista).  If you wish to close this window, perform the configuration of the Property panel (see "2.18  Use 
the Simulator GUI [Simulator]").
In addition, do not use the [Alt] + [F4] key to close this window. 

Remark The language of titlebar/menubar of this window and windows opened from it depends on the setting of 
[Regional and Language Options] in [Control Panel] of the host machine used (if this setting is set to 
[Japan]/[Japanese], their titlebar/menubar are displayed in Japanese). 

Figure A.51 Simulator GUI Window

This section describes the following.

- [How to open]

- [Description of each area]

[How to open]

- This window appears automatically by default after connecting to the debug tool when a microcontroller whose Simu-
lator supports peripheral function simulations is selected and [Simulator] is selected as the debug tool to use. 

Simulator GUI window

(1)

(2)

(3)
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[Description of each area]

(1) [Menubar]

(a) [File] menu

(b) [Edit] menu
This menu varies depending on the window currently having the focus. 
For details on this menu items, see "[Dedicated menu]" section in the Signal Data Editor window, Timing Chart 
window, I/O Panel window, or Serial window.

(c) [View] menu
This menu varies depending on the window currently having the focus.
For details on this menu items, see "[Dedicated menu]" section in the Signal Data Editor window, Timing Chart 
window, I/O Panel window, or Serial window.

(d) [Parts] menu
This menu is added when the I/O Panel window is opened.
For details on this menu items, see the [Parts] menu/[Parts] toolbar.

(e) [Figure] menu
This menu is added when the I/O Panel window is opened.
For details on this menu items, see the [Figure] menu/[Figure] toolbar.

(f) [Option] menu

(g) [Simulator] menu

New File... Opens a new window for the Simulator GUI window.
Same operation as the  button. 

Open... Opens the files handled in the Simulator GUI window.
Same operation as the  button. 

Close Closes the window currently having the focus. 

Save Overwrites the contents of the window currently having the focus to the file handled in 
the Simulator GUI window.
Same operation as the  button. 

Save As... Saves the contents of the window currently having the focus to the specified file.

ToolBar Switches on/off display of the toolbar corresponding to the cascade menu.

Simulator Standard Selects whether the [Simulator Standard] toolbar is displayed or not. 

Simulator Tools Selects whether the [Simulator Tool] toolbar is displayed or not. 

Signal Data Editor Selects whether the [Signal Data Editor] toolbar is displayed or not. 

Timing Chart Selects whether the [Timing Chart] toolbar is displayed or not. 

Parts Selects whether the [Parts] toolbar is displayed or not. 

Figure Selects whether the [Figure] toolbar is displayed or not. 

Customize... Opens the Customize dialog box.

Signal Data Editor Opens the Signal Data Editor window.
Same operation as the  button. 

Timing Chart Opens the Timing Chart window.
Same operation as the  button. 

I/O Panel Opens the I/O Panel window.
Same operation as the  button. 

Serial Opens the Serial window.
Same operation as the  button. 
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(h) [Window] menu

(i) [Help] menu

(2) [Toolbar]

(a) [Simulator Standard] toolbar

(b) [Simulator Tool] toolbar

(c) [Signal Data Editor] toolbar 
This toolbar can be used when the Signal Data Editor window has the focus.
For details on this toolbar, see the [Signal Data Editor toolbar].

(d) [Timing Chart] toolbar
This toolbar can be used when the Timing Chart window has the focus.
For details on this toolbar, see the [Timing Chart toolbar].

(e) [Parts] toolbar
This toolbar can be used when the I/O Panel window has the focus.
For details on this toolbar, see the [Parts] menu/[Parts] toolbar.

(f) [Figure] toolbar
This toolbar can be used when the I/O Panel window has the focus.
For details on this toolbar, see the [Figure] menu/[Figure] toolbar.

(3) [Window display area]
This area is used to display various windows (Signal Data Editor window, Timing Chart window, I/O Panel window, 
or Serial window). 

Close All Closes all windows, except this window.

Cascade Cascade display of the windows in this window.

Tile Cascade display of the windows in this window.

Arrange Icons Rearranges the icons in this window.

Main Window Displays the help for this window.

Current Window Displays the help for the current window.

Opens a new window for the Simulator GUI window.

Opens the files handled in the Simulator GUI window.

Overwrites the contents of the window currently having the focus to the file handled in the Simula-
tor GUI window.

Undoes the immediately preceding operation. 

Restores the status undone by the  button. 

Cuts the selected range and saves it to the clipboard.

Copies the selected range and saves it to the clipboard.

Pastes the clipboard contents. 

Opens the Search Data dialog box.

Displays the contents of the help.

Opens the Signal Data Editor window.

Opens the Timing Chart window.

Opens the Serial window.

Opens the I/O Panel window.
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The displayed window can be changed in size or an icon can be created in this area.
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This dialog box is used to set or change the color and fonts for the Signal Data Editor window, Timing Chart window or 
Serial window. 

Figure A.52 Customize Dialog Box: [Color] Tab (For Timing Chart Window)

Figure A.53 Customize Dialog Box: [Font] Tab

This section describes the following. 

- [How to open]

- [[Color] tab]

- [[Font] tab]

- [Function buttons]

[How to open]

- With the Signal Data Editor window, Timing Chart window or Serial window in focus, select [Customize...] from the 
[Option] menu.

Customize dialog box

[Function buttons]

(1)

[Function buttons]

(1)
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[[Color] tab]

(1) Color setting area
Set and change the color of each part in the window.

[[Font] tab]

(2) Font setting area
Set and change the text font of each part in the window.

[Function buttons]

List The parts for which color change is possible are displayed in list form. 
The parts displayed differ depending on the target window. 

Color The currently set color of the part is displayed when that part is selected from the list.

[Change...] button The color currently set for the relevant part of each listed item can be changed.

List The parts for which font change is possible are displayed in list form.

Font The current font name of the part is displayed, when that part is selected from the list. 

Size The current font size of the part is displayed, when that part is selected from the list. 

[Change...] button The font currently set for the relevant part of each listed item can be changed.

Button Function

OK Validates the settings and closes this dialog box.

Cancel Cancels the settings and closes this dialog box. 

Apply Cannot be selected.

Help Displays the help for this dialog box. 
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This window is used to create and edit the signal data that is input to input pins. 
The created signal data can be input to the input pin during simulation by selecting the [Edit] menu >> [Signal Input].  

This data can also be saved to the signal data file (*.wvi) by selecting the [File] menu >> [Save]/[Save As...] or by saving 
the project file. 

The saved file contents can be restored by selecting the [File] menu >> [Open...] or by loading the project file.

Caution 1. If the saved signal data file is opened or the project file is opened while Simulator GUI is running with a 
microcontroller different from the one used when the signal data file was created, the settings of pins that 
are not provided in the microcontroller will not be restored.

Caution 2. The main clock and sub clock cannot be input from this window. Set the main clock/sub clock oscillation 
frequency on the [Connect Settings] tab in the Property panel.

Caution 3. If inputting of signals is started during program break, the signals will actually be input when the program 
is resumed from the break.

Remark 1. The following data can be displayed or edited in this window:

- Newly created signal data 

- Previously created signal data files 

- File of signal data previously obtained by performing simulation and saving the results as output signal 
data

Remark 2. On the titlebar of this window, "Project file name + Serial number (from 0).wvi" is displayed when the proj-
ect file has been loaded.  However, after having loaded a project file of PM+, then if you save a file as the 
project file of CS+, "Project file name +  CS+ Serial number (from 0).wvi" is displayed on the titlebar. 

Figure A.54 Signal Data Editor Window

This section describes the following. 

- [How to open]

- [Description of each area]

- [Dedicated menu (Signal Data Editor window)]

- [Signal Data Editor toolbar]

- [Context menu]

- [Operation]

Signal Data Editor window

(1)

(2)
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[How to open]

- Click the  button

- Select [Signal Data Editor] from the [Simulator] menu.

[Description of each area]

(1) Information bar
It can be specified whether this area is displayed or not, by selecting the [View] menu >> [Information Bar].

(2) Client area

Select the unit of the wait time from the drop-down list.
The wait time unit can be changed by selecting the [Edit] menu >> [Time unit]. 

If this button is clicked while the program is running, signal input starts.
If this button is clicked while the program is stopped, signal input starts auto-
matically the next time the program execution is started.

If this button is clicked while the program is running, signal input is stopped.
If this button is clicked while the program is stopped, signal input does not start 
automatically even if the program execution is started.

The current signal input line (line highlighted with yellow) is returned to the 
beginning.

(a) Pin area Displays the input pin names. 
The input pin to be used is selected via the Select Pin dialog box that is opened by click-
ing the  button on the toolbar or selecting the [Edit] menu >> [Select Pin...].
Data input to pins can be enabled/disabled by selecting the [Edit] menu >> [Pin Status].

(b) Line number 
area

Displays line number.
This area is used when performing editing in line units.
Note that up to 1,048,576 (= 1M) lines can be specified as the signal data. 

(c) Mark area Displays the loop information for the specified input value. 
The loop information is specified by selecting from the context menu or the [Edit] menu 
>> [Mark] in the relevant field.
The following marks are displayed after the loop information has been specified. 

Loop start location (endless loop) 

Loop start location (with loop count) 

Loop end location

(b) (c) (d) (e)

(a)
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[Dedicated menu (Signal Data Editor window)]

(1) [Edit] menu

(d) Wait area Displays as "wait time" the timing at which the specified input value is input to the pins.
The wait time is specified by directly writing numeric values in the relevant field.
Note that numeric values (decimal code) from 0 to 4,294,967,295 can be specified (val-
ues that exceed 4,294,967,295 can be set by using one more line). 
The wait time unit can be changed by selecting the [Edit] menu >> [Time unit]. 

(e) Data area Displays the input value input to the pins. 
The input value is specified by directly writing numeric value in the relevant field.
Note that the input rules differ as follows according to the pin type.

Digital pins Any one of the following one character

0 LOW signal

1 HIGH signal

Z Hi-Z signal (case insensitive)

Analog pins A decimal value from 0 to 5000 (unit: mV)

Undo Cannot be selected.

Redo Cannot be selected.

Cut Cuts the selected range and saves it to the clipboard.

Copy Copies the selected range and copies it to the clipboard.

Paste Pastes the contents of the clipboard to the selected location.

Delete Deletes the selected range.

Select All Selects all display data.

Find Cannot be selected.

Select Pin... Opens the Select Pin dialog box. The pin(s) for which input signal data is to be cre-
ated or edited is (are) selected in this dialog box.

Time unit Selects the wait time unit. 

main clock Main clock (default)

usec Microsecond

msec Millisecond 

Pin Status Selects the input status of the selected pin.

Valid Enables data input to the pin (default).

Invalid Disables data input to the pin.

Mark Sets a mark to the selected Mark area.

Loop Start Sets the loop start mark.

Loop End Sets the loop end mark.

Loop Dialog Opens the Loop dialog box. Sets the details of loop information.

Signal Input Inputs signal data to the simulator. 
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(2) [View] menu

(3) [Option] menu

[Signal Data Editor toolbar] 

[Context menu]

The following context menus are available at each area in the Client area. 

(1) Pin area

(2) Line number

(3) Mark area

Start Starts signal input. 

Stop Stops signal input.

Reset Returns the current signal input line to the beginning. 

Information Bar Selects whether the information bar is displayed or not.

Customize... Opens the Customize dialog box.

Opens the Select Pin dialog box. 
The pin(s) for which input signal data is to be created or edited is (are) selected in this dialog 
box.

If this button is clicked while the program is running, signal input starts.
If this button is clicked while the program is stopped, signal input starts automatically the next 
time the program execution is started.

If this button is clicked while the program is running, signal input is stopped.
If this button is clicked while the program is stopped, signal input does not start automatically 
even if the program execution is started.

The current signal input line (line highlighted with yellow) is returned to the beginning.

Valid Enables data input to the pin (default). 

Invalid Disables data input to the pin.

Select Pin... Opens the Select Pin dialog box.  The pin(s) for which input signal data is to be created 
or edited is (are) selected in this dialog box.

Cut Cuts the selected range and saves it to the clipboard.

Copy Copies the selected range and copies it to the clipboard.

Paste Pastes the contents of the clipboard to the selected location.

Delete Deletes the selected range.

Cut Cuts the selected cell and saves it to the clipboard.

Copy Copies the selected cell and copies it to the clipboard.

Paste Pastes the contents of the clipboard to the selected location.

Delete Deletes the selected cell.

Loop Start Sets the loop start mark.
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(4) Wait area

(5) Data area

[Operation]

(1)  Pin selection
(2)  Creating signal data
(3)  Data copy and paste
(4)  Single-line editing
(5)  Signal input
(6)  Operation at CPU reset

(1) Pin selection
To create the signal data, it is first necessary to select the pin to be used. 
Open the Select Pin dialog box by clicking the  button on the toolbar or selecting the [Edit] menu >> [Select 
Pin...], and select the pin to be used.  Once a pin is selected, its name is displayed in Pin area. 

(2) Creating signal data
Create the signal data input to each pin.

(a) Setting of input value
In the Data area, specify the value that is input to each pin (see "Data area").

(b) Setting of input timing
In the Wait area, specify the timing at which the input value is input to each pin as "wait time" (see "Wait area").

(c) Setting of the loop information
When loop processing for the signal data specified in step (a) and (b) is needed, specify the loop information. 
To specify the loop information, select [Loop Start] from the context menu on the loop start position in the Mark 
area, and select [Loop End] on the loop stop position.
At this time, the loop count can be specified.  In this case, specify the loop count via the Loop dialog box that is 
opened by selecting [Loop Dialog...] from the context menu.
The corresponding loop information marks are displayed if the setting of the loop information is completed (see 
"Mark area").

(3) Data copy and paste
The set values in Mark area/Wait area/Data area can be copied and pasted. 
However, copied data can be pasted only in the same area. 

Loop End Sets the loop end mark.

Loop Dialog Opens the Loop dialog box. Sets the details of loop information.

Cut Cuts the data in the selected cell and saves it to the clipboard. The data in the selected 
cell becomes 0.

Copy Copies the data in the selected cell and copies it to the clipboard.

Paste Pastes the contents of the clipboard to the selected location.

Delete Deletes the data in the selected cell. The data in the selected cell becomes 0.

Cut Cuts the data in the selected cell and saves it to the clipboard. The data in the selected 
cell becomes "Z" (Hi-Z).

Copy Copies the data in the selected cell and copies it to the clipboard.

Paste Pastes the contents of the clipboard to the selected location.

Delete Deletes the data in the selected cell. The data in the selected cell becomes "Z" (Hi-Z). 

Start Signal Input Starts signal input. 

Stop Signal Input Stops signal input.

Reset Signal Input Returns the current signal input line to the beginning. 



CS+ V8.04.00 A.  WINDOW REFERENCE

R20UT4692EJ0100  Rev.1.00 Page 340 of 411
Jun 01, 2020

(4) Single-line editing
Single lines can be edited by selecting Line number area. 
The method is the same as that described in "(3)  Data copy and paste". 
Data pasted during line paste (insertion) is inserted immediately before the selected line.

(5) Signal input
Input the created signal data to the input pins of the simulator while simulation is executed. 
At this time, the line whose signal is currently being input (current line) is highlighted in yellow during program 
breaks (this can be changed via [Inputted current line] item in the Customize dialog box), in order to display signal 
input progress.
There are the following types of signal data input operations: 

Remark The signal data input to the selected pin can be controlled by selecting the [Edit] menu >> [Pin Sta-
tus] >> [Valid]/[Invalid].

(6) Operation at CPU reset
When CPU reset occurs, the current signal input line returns to the beginning. 
If a CPU reset occurs during signal input, input continues from the beginning (same operation as the  button).

Copy When one or more (a range of) cells are selected, these cells can be copied by selecting the 
[Edit] menu >> [Copy] (or pressing the [Ctrl] + [C] key).

Paste When one or more (a range of) cells are selected, these cells can be pasted by selecting the 
[Edit] menu >> [Paste] (or pressing the [Ctrl] + [V] key).
When multiple (a range of) cells are selected, the copied data is pasted to the cells repeatedly.

Signal input start Click the  button, or select the [Edit] menu >> [Signal Input] >> [Start]. 
As a result, signal input starts from the current signal input line (highlighted line). 

Signal input stop Click the  button, or select the [Edit] menu >> [Signal Input] >> [Stop]. 
This stops signal input. 

Signal reset Click the  button, or select the [Edit] menu >> [Signal Input] >> [Reset]. 
This returns the current signal input line to the beginning. If signal reset was performed dur-
ing signal input, input continues from the beginning.
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This dialog box is used to perform detailed settings (loop start/stop and loop count) related to the loop information in the 
Signal Data Editor window. 

Figure A.55 Loop Dialog Box

This section describes the following. 

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

On the Signal Data Editor window, any one of the following:

- Double-click the Mark area. 

- Select the Mark area, then select [Mark] >> [Loop Dialog...] from the [Edit] menu. 

[Description of each area]

(1) Loop information setting area

[Function buttons]

Loop dialog box

Start of Loop Select this check box to set the Start of Loop.

Endless loop Select this option button to set the Endless Loop.

Loop count Select this option button to set the Loop Count.
Sets the count value by spin button.

0 Skip loop 

1 to 99 Perform loop the specified count.

End of Loop Select this check box to set the End of Loop.

Button Function

OK Validates the settings and closes this dialog box.

Cancel Cancels the settings and closes this dialog box. 

[Function buttons]

(1)
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This dialog box is used when selecting pins displayed in the Signal Data Editor window and the Timing Chart window. 
The pin information set in this dialog box can be saved as a pin information file (*.pin) by clicking the [Save] button. 

Moreover, the saved file contents can be restored by clicking the [Load] button. 

Figure A.56 Select Pin Dialog Box

This section describes the following. 

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

On the Signal Data Editor window/Timing Chart window, any one of the following:

- Click the  button.

- Select [Select Pin...] from the [Edit] menu.

[Description of each area]

(1) Connection pins setting area
Up to 256 pins can be selected by using the scrollbar located on the right side of the pin name setting area. 

Remark For the pin names that can be specified, see the user's manual of the microcontroller that is used. 

Select Pin dialog box

Pin Name This area is used to specify the pin name to be connected. 
The connection pins can be specified either via direct input or through selection from 
the drop-down list. 

Analog Select this check box to use the specified pin as an analog pin. 

Function Name This area is used to set a function name for the pin name.
When a character string is input in this area, this character string is displayed as a 
function name in the pin name part.  If nothing is specified, the pin name is displayed. 

(1)
[Function buttons]
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[Function buttons]

Button Function

OK Validates the settings and closes this dialog box. 
The pin name (or display name) is applied in the Pin field of the window from where this 
dialog box was called up.

Save Saves the display contents to the pin information file (*.pin). 

Load Loads the pin setting information of the specified file (*.pin).

Clear Deletes the settings.

Cancel Cancels the settings and closes this dialog box.
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This window is used to display the output signals and input signals for pins in the form of a timing chart. 
This window allows time measurement in main clock units. 
The browsed signal data can be saved to the timing chart file (*.wvo) by selecting the [File] menu >> [Save]/[Save As...].  

Moreover, the saved file contents can be restored by selecting [File] menu >> [Open...]. 
If the project file is saved, signal data is not saved but information of the set pins is saved. (Solely saving the project file 

is sufficient if saving of the measurement result is unnecessary.) 

Caution 1. If the saved timing chart file is opened or the project file is opened while Simulator GUI is running with a 
microcontroller different from the one used when the timing chart file was created, the settings of pins 
that are not provided in the microcontroller will not be restored.

Caution 2. The main clock and sub clock waveforms cannot be displayed in this window. In addition, when using the 
external bus interface function, the waveforms of pins used for the external bus interface function cannot 
be displayed.

Figure A.57 Timing Chart Window

This section describes the following.

- [How to open]

- [Description of each area]

- [Dedicated menu (Timing Chart window)]

- [Timing Chart toolbar]

- [Context menu]

- [Operation]

[How to open]

- Click the  button.

- Select [Timing Chart] from the [Simulator] menu.

[Description of each area]

(1) Information bar
It can be specified whether this area is displayed or not, by selecting the [View] menu >> [Information Bar].

Timing Chart window

Clock/time count from simulation start until marker A location.

Clock/time count from simulation start until marker B location.

Clock/time count between markers A and B. (Displayed as absolute value.)

(1)

(2)
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Remark 1. Up to 4,294,967,262 clocks can be counted from the simulation start up to the marker position. 
When the count reaches the maximum value, the counter is cleared to 0 and starts counting again.

Remark 2. The menu for setting the magnify ratio appears dimmed during program execution, so changing the 
ratio is unavailable.

(2) Client area

Remark 1. When the buffer is full, the data will be overwritten by the latest data starting from the oldest data 
because the buffer storing the pin data is in a ring buffer format. 
The upper limit of the buffer size is one of the following.

- The number of pin change points: 4,096

- The number of clocks: 2,147,483,631

- Horizontal draw width: 134,217,711 pixels

Remark 2. The colors and fonts can be changed via the Customize dialog box that is opened by selecting the 
[Option] menu >> [Customize...]. 

Select from the drop-down list the time unit for the location information of markers A 
and B.
This item can also be set by using [Time unit] in the [Edit] menu or [Time unit] from the 
context menu.

Selects the waveform data display magnification ratio from the drop-down list.
If a part of waveform data may be lost as a result of changing the display magnification 
ratio, the confirmation dialog box is displayed.

Pin Name area Displays the names of the pins for which timing chart display is performed. Pin 
selection is performed by selecting the [Edit] menu >> [Select Pin...] to open the 
Select Pin dialog box. 

Marker area Displays the 2 marker headers. These markers can be moved by dragging them 
with the mouse over this area.

Maker A

Maker B

Waveform area Performs timing chart display for the data of the pins specified in the Pin area. 
The following color distinctions are used according to the signal by default.

Green The HIGH and LOW signals of the pins

Red High-impedance signals

Blue Unsampled signals

Pin area

Marker area

Waveform area
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[Dedicated menu (Timing Chart window)]

(1) [Edit] menu

(2) [View] menu

(3) [Option] menu

[Timing Chart toolbar]

Clear Deletes all the waveform data.

Find... Opens the Search Data dialog box. 
Waveform data search is performed in this dialog box.

Search backward Searches for the change point of the selected pin in the backward direction (toward 
the left).

Search forward Searches for the change point of the selected pin in the forward direction (toward the 
right).

Select Pin... Opens the Select Pin dialog box. The pin for which the waveform data is to be dis-
played is selected in this dialog box.

Time unit Selects the time unit.

main clock Main clock (default)

usec Microsecond 

msec Millisecond 

Waveform Switches on/off display of the Maker area and Waveform area.

Information Bar Switches on/off display of the information bar.

Zoom Selects the waveform data display magnification ratio from a cascade menu.
If a part of waveform data may be lost as a result of changing the display magnifica-
tion ratio, the confirmation dialog box is displayed. 

x 1/32 Sets the magnification ratio to 1/32.

x 1/16 Sets the magnification ratio to 1/16.

x 1/8 Sets the magnification ratio to 1/8.

x 1/4 Sets the magnification ratio to 1/4.

x 1/2 Sets the magnification ratio to 1/2.

x 1 Sets the magnification ratio to 1.

x 2 Sets the magnification ratio to 2.

x 4 Sets the magnification ratio to 4.

x 8 Sets the magnification ratio to 8.

x 16 Sets the magnification ratio to 16.

x 32 Sets the magnification ratio to 32.

Customize... Opens the Customize dialog box. 

Deletes all the waveform data.

Searches for the change point of the selected pin in the backward direction (toward the 
left).



R20UT4692EJ0100  Rev.1.00 Page 347 of 411
Jun 01, 2020

CS+ V8.04.00 A.  WINDOW REFERENCE

[Context menu]

The following context menus are available in the Client area. 

[Operation]

(1)  Pin selection
(2)  Display of timing chart
(3)  Clearing of timing chart
(4)  Timing measurement for timing chart
(5)  Data search function
(6)  Operation at reset

(1) Pin selection
To display the timing chart, it is first necessary to select the pin to be displayed. 
Open the Select Pin dialog box by selecting the [Edit] menu >> [Select Pin...] and select the pin to be edited. Once 
a pin is selected, its name is displayed in the Pin Name area. 

(2) Display of timing chart 
The waveforms of the selected pins are displayed in timing chart form through execution of the program. 

Remark The simulation speed can be increased by hiding the timing chart. 
To hide the timing chart, select the [View] menu >> [Waveform] (deselect this item). 
When the timing chart is hidden, the Maker area and Waveform area appear dimmed and "Display 
OFF" is displayed in the center.

(3) Clearing of timing chart
Timing chart display is cleared by selecting the [Edit] menu >> [Clear]. 

Searches for the change point of the selected pin in the forward direction (toward the 
right).

Opens the Select Pin dialog box. The pin for which the waveform data is to be displayed is 
selected in this dialog box.

Selects the waveform data display magnification ratio from the drop-down list.
If a part of waveform data may be lost as a result of changing the display magnification 
ratio, the confirmation dialog box is displayed. 

Clear Deletes all the waveform data.

Find... Opens the Search Data dialog box. 
Waveform data search is performed in this dialog box.

Search backward Searches for the change point of the selected pin in the backward direction (toward the 
left).

Search forward Searches for the change point of the selected pin in the forward direction (toward the 
right).

Select Pin... Opens the Select Pin dialog box. The pin for which the waveform data is to be displayed is 
selected in this dialog box.

Waveform Switches on/off display of the Maker area and Waveform area.

Time unit Selects the time unit. 

Zoom Selects the waveform data display magnification ratio.
If a part of waveform data may be lost as a result of changing the display magnification 
ratio, the confirmation dialog box is displayed. 

Move MakerA Moves marker A to the cursor location. The same action can be accomplished by pressing 
the [Shift] key + left-clicking.

Move MakerB Moves market B to the cursor location. The same action can be accomplished by pressing 
the [Ctrl] key + left-clicking.
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(4) Timing measurement for timing chart
The timing between two points can be measured by marking 2 locations using markers A and B. 
The time of each marker and the time between markers are displayed in the information bar. 
Each marker can be placed at the target position by dragging the marker head.  Moreover, it can also be placed at 
the position of the current mouse cursor by selecting [Move MarkerA]/[Move MarkerB] from the context menu. 
The marker that is clicked last becomes the selected marker and can be subjected to the Data search function. 

Figure A.58 Maker A And Maker B

(5) Data search function
There are two data search functions for timing charts.

(a) Simple search 
Simple search is a function used to search change points for one pin. 
Select the name of the pin for which the search is to be performed in the Pin area and then select the [Edit] 
menu >> [Search backward] or [Search forward]. 
As a result, the selected marker moves to the data position at which the change point was detected. 

(b) Detailed search
In the case of detailed search, search using a combination of data of multiple pins can be executed. 
The search data is set in theSearch Data dialog box displayed by selecting the [Edit] menu >> [Find...]. 
The selected marker moves to the data position that was hit, similarly to simple search results.

(6) Operation at reset
If CPU reset or Simulator GUI reset occurs, the displayed waveforms of the timing chart are all cleared. 

Selected markers Unselected makers

A B A B
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This dialog box is used to search the signal data displayed in the Timing Chart window in detail. 

Caution 1. Analog I/O signals cannot be searched. 

Caution 2. This dialog box cannot be opened during program execution.

Figure A.59 Search Data Dialog Box

This section describes the following.

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

On the Timing Chart window, any one of the following:

- Click the  button.

- Select [Find...] from the [Edit] menu.

[Description of each area]

(1) Search pin setting area
When multiple search conditions have been specified, the signal data that meets all these search conditions is 
searched. 
Up to 48 search conditions can be specified by using the scrollbar located on the right side.

Search Data dialog box

Pin Name This area is used to specify the pin name to be searched.
The pins can be specified either via direct input or through selection from the drop-down 
list. 
Inputting noting makes an area off-limit to data search and input in the corresponding 
[Search Data] is disabled.

Search Data Selects the data from drop-down list. The data is searched for the pin to be specified. 

------ Don't care

Rising Edge Searches the rising edge of signal data.

Falling Edge Searches the falling edge of signal data.

Rise/Fall Edge Searches the rising/falling edge of the signal data. 

High Searches the signal data that is HIGH.

Low Searches the signal data that is LOW.

Hi Z Searches the signal data that is high impedance. 

(1)

(1)

[Function buttons]
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[Function buttons]

Direction Selects the data search direction by selecting one of the exclusive option buttons. When 
the [Next] button is clicked, the search is performed in the direction specified in this area. 

Backward Searches the data backward (data older than the current location).

Forward Searches the data forward (data newer than the current location). 
(default)

Button Function

Next Searches in the direction specified. When this button is clicked again following search 
completion, the next data is searched.

Cancel Stops the data search and closes the dialog box.
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This window is used to configure a dummy target system, and manipulate created connected parts.
A dummy target system can be constructed by creating and setting connected parts (figure objects and part objects) in 

this window. The connected parts for which settings have been performed can be moved to any location within the win-
dow, and you can manipulate them during simulation to control signal processing. 

Information about parts that are placed in the window can be saved to the I/O panel file (*.pnl) by selecting the [File] 
menu >> [Save]/[Save As...] or by saving the project file. 

The saved file contents can be restored by selecting the [File] menu >> [Open...] or by loading the project file.

Caution 1. If the saved I/O panel file is opened while Simulator GUI is running with a microcontroller different from 
the one used when the file was created, information of the parts connected to the pins that are not pro-
vided in the microcontroller will not be restored (the [Pin Name] item in the property dialog boxes for parts 
remains blank). 

Caution 2. If inputting of signals is started (by an event such as clicking a button) during program break, the signal 
level will change in actuality when the program is resumed from the break.

Remark On the titlebar of this window, "Project file name + Serial number (from 0).pnl" is displayed when the proj-
ect file has been loaded.  However, after having loaded a project file of PM+, then if you save a file as the 
project file of CS+, "Project file name + CS+ Serial number (from 0).pnl" is displayed on the titlebar. 

Figure A.60 I/O Panel Window

This section describes the following.

- [How to open]

- [Description of each area]

- [Dedicated menu/toolbar (I/O Panel window)]

- [Context menu]

- [Operation]

[How to open]

- Click the  button.

- Select [I/O Panel...] from the [Simulator] menu.

[Description of each area]

(1) Client area
This area is used to create and set connected parts (figure objects and part objects) in order to construct a dummy 
target system (see "[Operation]"). 

I/O Panel window

(1)
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[Dedicated menu/toolbar (I/O Panel window)]

The menu items and buttons on the toolbar, which are used to perform operations related to this window, are described 
below.

(1) [Edit] menu
Select this menu to perform basic editing actions on created objects. 

(2) [View] menu
Select this menu to switch the toolbar/status bar display status in this window, or to show/hide various types of 
information in this window.

(3) [Parts] menu/[Parts] toolbar
This menu and toolbar are used to select connected parts (part objects) provided by Simulator GUI when newly 
creating or placing parts (see "(3)  Creating part objects"). 
In this menus, similar operations can be performed using the buttons on the [Parts] toolbar.

Undo Undoes the immediately preceding operation, such as object move. 
Undo can restore up to 5 previous changes.

Redo Restores the status undone by the [Undo] command.

Cut Cuts the selected range and saves it to the clipboard.

Copy Pastes the contents of the clipboard.

Paste Pastes the contents of the clipboard.

Delete Deletes the selected range.

Select All Selects all the objects in the window.

Group Groups the selected objects.

UnGroup Ungroups the selected objects.

Bring to Front Brings the selected object to the front.

Send to Back Sends the selected object to the back.

Bring Forward Brings the selected object one panel forward.

Send Backward Sends the selected object one panel backward.

ToolBar Switches on and off the display of two toolbars (Figure/Object).

StatusBar Switches on and off display of the statusbar.

Parts List... Opens the Parts List dialog box. 
A list of all the figure/part objects in this window is displayed.

Grid Shows/hides the window grid.

Properties Opens the property dialog box of the selected figure/part object.

Menu Item But-
ton

Function

Button Digital input switch
A button can be connected to any pin. A digital input value can be given to 
the connected pin by clicking the displayed button.e.g.) 

Analog Button Analog input switches
A button can be connected to any pin. An analog input value can be given 
to the connected pin by clicking the displayed button.e.g.) 
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(4) [Figure] menu/[Figure] toolbar
This menu and toolbar are used to set the operation mode of this window, and select connected parts (figure 
objects) when newly creating or placing parts (see "(2)  Creating figure objects"). 
In this menus, similar operations can be performed using the buttons on the [Figure] toolbar.

Key Matrix A key matrix consists of multiple pins connected in a matrix array, wherein 
each contact represents a key, and clicking a key results in a specific 
state.
A key matrix can be connected to any pin, and data can be input using 
multiple keys.

e.g.) 

Level Gauge Used for inputting analog data such as power supply voltage. Any data 
within a given range can be set. 
Any value within a specified range can be assigned to a pin connected to 
an A/D converter. 

e.g.) 

LED Light Emitting Diode
An LED can be connected to any pin, and the output from the pin can be 
indicated by switching the LED on or off. e.g.) 

7-Segment LED A product that consists of 7 LEDs configured to represent a numeric fig-
ure. 
When the output from the pin assigned to the digit signal is active, the cor-
responding 7-segment LED switches on or off.

e.g.) 

14-Segment LED A product that consists of 14 LEDs configured to represent an alphabetic 
character. When the output from the pin assigned to the digit signal is 
active, the corresponding 14-segment LED switches on or off. e.g.) 

Matrix LED A product that consists of multiple LEDs arranged in a matrix array. 
When the output from an assigned pin is active, the corresponding 14-
segment LED switches on or off.e.g.) 

Buzzer A buzzer connected to a pin indicates the output information from the con-
nected pin with a bitmap.

e.g.) 

Pull up / Pull down... Opens the Pull up/Pull down dialog box.
Whether a pin is connected to a pull-up/down resistor can be specified via 
this dialog box. 

Menu Item Button Function

Select Changes this window's operation mode to the Edit mode.
The cursor shape changes into an arrow, enabling the edit of objects.

Menu Item But-
ton

Function
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[Context menu]

In the Edit mode, the following context menus are available.

Simulation Mode Changes this window's operation mode to the Simulation mode.
The cursor shape changes into a hand, enabling simulation of input to con-
nected parts (part objects).

Line Changes the cursor shape into a cross (+), enabling the drawing of lines.

Rectangle Changes the cursor shape into a cross (+), enabling the drawing of rectangles. 

Rounded Rectan-
gle

Changes the cursor shape into a cross (+), enabling the drawing of rectangles 
with rounded corners. 

Ellipse Changes the cursor shape into a cross (+), enabling the drawing of ellipses. 

Polygon Changes the cursor shape into a cross (+), enabling the drawing of polygons.

Fan-shaped Changes the cursor shape into a cross (+), enabling the drawing of fan shapes.

Text Changes the cursor shape into a cross (+), enabling the drawing of text.

Paste Bitmap... - Pastes the selected bitmap file in this window

Color of Line... Opens the Color dialog box.
The color of the lines of the selected object can be changed to the selected 
color in this dialog box.

Color of Fill... Opens the Color dialog box.
The color used for the selected object can be changed to the selected color in 
this dialog box.

Font... - Opens the Font dialog box.
The font of the selected object can be changed to the selected font in this dialog 
box.

Style of Line Selects the line style from a cascade menu. The lines of the selected object are 
changed.

16pt Sets the line thickness to 16 pt.

12pt Sets the line thickness to 12 pt.

8pt Sets the line thickness to 8 pt.

4pt Sets the line thickness to 4 pt.

2pt Sets the line thickness to 2 pt.

1pt Sets the line thickness to 1 pt.

No line Does not draw lines.

Dotted Line Style Selects the dotted line style from a cascade menu. The lines of the selected 
object are changed.

Solid Line Draw solid lines.

Dash Line Draw dashed lines.

Dotted Line Draw dotted lines.

DashDot Line Draw DashDot lines.

DashDotDot Line Draw DashDotDot lines.

Menu Item Button Function
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[Operation]

How to create objects (figure objects and part objects) to construct a dummy target system, and manipulate them is as 
follows: 

(1)  Edit mode
(2)  Creating figure objects
(3)  Creating part objects
(4)  Placing objects
(5)  Inputting text
(6)  List display of objects
(7)  The detailed setting for objects
(8)  Simulation mode

(1) Edit mode
Change the operation mode of this window to "edit mode" to create objects. 
The edit mode can be set by any one of the following methods. 

- Select the [Figure] menu >> [Select]. 

- Click the  button on the toolbar.

- Select the [Edit] menu >> [Select All]. 

(2) Creating figure objects

(a) Line
Select the [Figure] menu >> [Line] or click the  button on the toolbar. 

-> The mouse cursor changes to a cross (+) shape and line drawing becomes possible. 
Drag the cursor from the line start position to the end position. 

-> The line start position and the line end position are connected by a straight line. (The line thickness and 
shape are the default settings.)

(b) Rectangle/Rounded rectangle/Fan shape
Select the [Figure] menu >> [Rectangle]/[Rounded Rectangle]/[Ellipse]/[Fan-shaped] or click the  /  /  
/  button on the toolbar.

-> The mouse cursor changes to a cross (+) shape and each drawings becomes possible.
Drag the mouse cursor from the top left corner to the bottom right corner of the drawing area (rectangular area). 

-> The corresponding figure is displayed in the drawing area, with the mouse position forming the lower right 
corner. 

Drop the figure to fix its size.
-> Rectangles are drawn in the same size as the rectangular area, and other figure shapes are drawn in a 
size that fits in the rectangular area. (The line thickness and shape are the default settings.)

Copy Copies the selected objects.

Paste Pastes the contents of the clipboard.

Delete Deletes the selected objects.

Group Selects from a cascade menu.

Group Groups the selected objects.

Ungroup Ungroups the selected objects.

Order Selects from a cascade menu.

Bring to Front Brings the selected object to the front.

Send to Back Sends the selected object to the back.

Bring Forward Brings the selected object one panel forward.

Send Backward Sends the selected object one panel backward.

Properties Opens the property dialog box of the selected figure/part object. 
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(c) Polygon
Select the [Figure] menu >> [Polygon] or click the  button on the toolbar. 

-> The mouse cursor changes to a cross (+) shape and polygon drawing becomes possible.
Click at each position marking an apex of the polygon.

-> The apexes are linked by a straight line in the order in which they were clicked.
Drawing of the polygon is completed by double-clicking.

-> The line thickness and shape are the default settings. 

(d) Pasting a bitmap
You can use an arbitrary bitmap file as a figure object.
Select the [Figure] menu >> [Paste Bitmap], and then select the bitmap file (*.bmp) to be pasted. 

-> The corresponding bitmap file is pasted in the default position in this window. 

(e) Changing the figure object style
The color or line style of the created figure object can be changed by any one of the following methods. 

- Specify with the [Style] tab of the Object Properties dialog box that is opened by double-clicking the figure 
object. 

- Select the [Figure] menu >> [Color of Line]/[Color of Fill]/[Style of Line]/[Dotted Line Style] or click the  / 
 /  /  button on the toolbar.

(3) Creating part objects
You can create part objects by using connected parts provided by Simulator GUI. 

(a) Selecting a part object
Select the part object to be created from the [Parts] menu or the toolbar. 

-> The mouse cursor changes to a cross (+) shape.
Click any location.

-> The corresponding part object is created and placed with the clicked location as the top left corner (default 
size). 

(b) Changing the part object style
The style of the created part object can be changed via the [Style] tab of the corresponding property dialog box 
that is opened by double-clicking the part object. 
For details on the modifiable items, see the section of the property dialog box which is corresponding to the part 
object (the items differ depending on the part object). 

(4) Placing objects

(a) Grid display
A grid is displayed by selecting the [View] menu >> [Grid].

(b) Selecting objects
The selected types and methods are indicated below.
The selected object(s) is displayed surrounded by a tracker indicating its selected status. 

- Single selection
Click the object to be selected.

- Multiple selections
Click the objects to be selected while pressing the [Shift] key.

- Range selection 
Drag from the top left corner of the area including the object to be selected, and drop at the lower right corner.

- Select all 
Select [Edit] menu>> [Select All]. 

(c) Moving objects
After selecting the object to be moved (multiple selections possible), then drag and drop it at the move destina-
tion. 

Remark Objects can be moved using the arrow keys on the keyboard. 
If more than half of the part bitmap is hidden when the window size is reduced, however, the 
selected part cannot be moved by using the arrow keys.
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(d) Changing object size
After selecting the object whose size is to be changed, then drag the tracker displayed. 

(e) Cut/Copy/Paste/Delete/Group/UnGroup an object
After selecting the object, select the corresponding item from the [Edit] menu. 

(f) Changing object sequence (Bring to Front/Send to Back/Bring Forward/Send Backward)
After selecting the object, select the corresponding item from the [Edit] menu. 

(5) Inputting text
Select [Figure] menu >> [Text] or click the  button on the toolbar.

-> The mouse cursor changes to a cross (+) shape.
Drag the mouse cursor from the top left corner of the character drawing area (rectangular area) to the lower right 
corner. 

-> This rectangular area serves as the character drawing area.
Click in the character drawing area. 

-> The cursor is displayed and character input becomes possible.

(6) List display of objects
Figure objects and part objects created in this window can be displayed as a list by selecting the [View] menu >> 
[Parts List], in addition to display in this window. 

(7) The detailed setting for objects
Each created object requires the detailed setting (pin connection information, etc.) in accordance with the target 
system to be used. 

(a) Figure objects
The detailed setting can be performed via the [Object Connection] tab of the Object Properties dialog box that is 
opened by double-clicking the target figure object. 
By connecting a object to an output pin, show/hide of the object can be switched depending on the output status 
of the connected pin.

(b) Part objects
The detailed setting can be performed via the [xxx Connection] tab of the property dialog box that is opened by 
double-clicking the target part object. 
For details on the settable items, see the section of the property dialog box which is corresponding to the part 
object (the items differ depending on the part object). 

(8) Simulation mode
The part objects whose settings have been completed can be manipulated during simulation (input values can be 
fed to the simulator).  Accordingly you can check the I/O results from these displayed part objects in this window. 
Change the operation mode of this window to "simulation mode" to manipulate part objects. 
The simulation mode can be set by any one of the following methods (the mouse cursor changes to a hand 
shape).

- Select the [Figure] menu >> [Simulation Mode]. 

- Click the  button on the toolbar.

Remark For details on input operation, see the section of the property dialog box which is corresponding to 
the part object 

Here, the part (14-segment LED in this 
case) can be moved using the arrow keys.

Here, the part (14-segment LED in this case) 
cannot be moved using the arrow keys.
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This property dialog box is used to set or change the pin connection information of buttons, which are one of the con-
nection parts in the I/O Panel window. 

Input to the simulator can be done from pin-connected buttons in the Simulation mode. 
There are two types of button display styles, figure and bitmap. These styles can be changed on the [[Style] tab].

Figure A.61 Parts Button Properties Dialog Box: [Button Connection] Tab

Figure A.62 Parts Button Properties Dialog Box: [Style] Tab

This section describes the following.

- [How to open]

Parts Button Properties dialog box

[Function buttons]

(1)

[Function buttons]

(1) (2)
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- [[Button Connection] tab]

- [[Style] tab]

- [Function buttons]

- [Operation]

[How to open]

On the I/O Panel window, any one of the following:

- Double-click a part object "Button".

- Select [Properties...] form the context menu on a part object "Button".

- Select a part object "Button", and then select [Properties...] form the [View] menu.

[[Button Connection] tab]

(1) Pin connection information setting area

Remark For the pin names that can be specified, see the user's manual of the microcontroller that is used.

Label This area is used to specify the part name. The part name input here is displayed on 
the button. Moreover, it is also displayed in the Parts List dialog box as the label.

Pin Name This area is used to specify the pin name to be connected. The connection pins can 
be specified either via direct input or through selection from the drop-down list.

Active Level The active state is selected with a option button, as follows: 

LOW Sets the active level to LOW.

HIGH Sets the active level to HIGH (default). 

Type Button types are selected using option buttons, as follows:

Push Makes the button a Push button (default). 
The [Hold Time] item must be specified. 

Toggle Makes the button a Toggle button.

Group Makes the button a Group button. 
The [Group Name] item must be specified. 

Group Name This area is used to input the button's group name. Input to this area is possible only 
when [Group] has been selected in [Type]. 

Hold Time Specify the time (hold time) for which the input value is to be held (default: 0.5msec). 
The settable range is from 0.001 to 999 (msec). 
Input to this area is possible only when [Push] has been selected in [Type]. 

default Specify the button status after CPU reset.

Not change at 
reset.

Maintains the button status after CPU reset.

inactive Buttons are non-depressed after CPU reset (default). 

active Buttons are depressed after CPU reset.
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[[Style] tab]

(1) Style information setting area

(2) Preview area
This area displays the style of the button currently being specified.

[Function buttons]

Figure Select this option button to display the button with the following specified figure.

Shape Select the figure shape. Two shapes can be selected: rectangle and ellipse. 

shadow Cannot be selected.

Line Specify and change the figure line, as follows.
You can change the color of figure line by clicking the pull-down button. 

Thickness Specifies the line thickness. 
Specification is made either using a spin button or through direct 
input. 
A value from 1 to 100 can be specified. 

Active Specifies the color of the line during active display.

Inactive Specifies the color of the line during inactive display.

Fill up Specify and change the figure filling, as follows.
You can change the color of figure filling by clicking the pull-down button. 

Active Specifies the fill color during active display.

Inactive Specifies the fill color during inactive display.

Bitmap Select this option button to display the button with the following specified bitmap (default).

Selection list Select a bitmap to be used from the selection list. 
The selectable bitmaps appear in the selection list.

[Add] button Opens the Entry Bitmap dialog box below to add a new bitmap to the selection 
list. 
The bitmap file to be added can be specified either through file selection using 
the [...] button, or through direct input.

[Delete] button Deletes the currently selected bitmap from the selection list.
Note that only the bitmap that have been added by user can be deleted.

Button Function

OK Validates the settings and closes this dialog box.

Cancel Cancels the settings and closes this dialog box. 

Apply Cannot be selected.
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[Operation]

In the Simulation mode, by clicking the displayed button, data can be input to the pin connected to the button.
The input format differs depending on the button type (push, toggle, group).

Figure A.63 Connected Parts Display Example (Button)

Help Displays the help for this dialog box. 

Push button Clicking this button causes the active value to be loaded to the connected pin. 
The active value is held during the hold time, after which it changes to the original value. 

Toggle button Clicking this button loads the active value to the connected pin. 
The active value is held during the hold time, after which it changes to the original value. 

Group button Clicking this button loads the active value to the connected pin. 
The value of the Group button having the same group name returns to the original value. 

Button Function
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This property dialog box is used to set or change the pin connection information of analog buttons, which are one of the 
connection parts in the I/O Panel window. 

Input to the simulator can be done from pin-connected analog buttons in the Simulation mode. 
There are two types of analog button display styles, figure and bitmap. These styles can be changed on the [[Style] tab]. 

Figure A.64 Analog Button Properties Dialog Box: [Analog Button Connection] Tab

Figure A.65 Analog Button Properties Dialog Box: [Style] Tab

This section describes the following. 

- [How to open]

Analog Button Properties dialog box

[Function buttons]

(1)

[Function buttons]

(1) (2)
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- [[Analog Button Connection] tab]

- [[Style] tab]

- [Function buttons]

- [Operation]

[How to open]

On the I/O Panel window, any one of the following:

- Double-click a part object "Analog Button".

- Select [Properties...] form the context menu on a part object "Analog Button".

- Select a part object "Analog Button", and then select [Properties...] form the [View] menu.

[[Analog Button Connection] tab]

(1) Pin connection information setting area

Remark For the pin names that can be specified, see the user's manual of the microcontroller that is used. 

Label This area is used to specify the part name. The part name input here is displayed on the 
button. Moreover, it is also displayed in the Parts List dialog box as the label.

Pin Name This area is used to specify the pin name to be connected. The connection pins can be 
specified either via direct input or through selection from the drop-down list.

Active Specify the active state.

Check box Analog buttons are created by the number of selected check 
boxes.

Label Directly input the name to be displayed on each analog button.

Voltage(mV) Directly input the voltage to be input when each analog button is 
clicked, in mV units.

Arrange Specify the button arrangement using the option button.
This setting is available if two or more analog buttons have been created in the Active area.
This setting is ignored if there is only one analog button or no analog buttons have been cre-
ated.

Row Analog buttons will be arranged horizontally (default). 

Column Analog buttons will be arranged vertically.

default Maintains the analog button operation after CPU reset.

Not change at reset. Maintains the analog button status immediately before CPU reset, 
after CPU reset.

inactive All of the analog buttons are non-depressed after CPU reset 
(default).

Active is 'xxx'yyy(mV) The analog button specified with "'xxx'(yyymV) " is depressed after 
CPU reset.

Inactive Specify the input level when no analog buttons are depressed.
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[[Style] tab]

(1) Style information setting area

(2) Preview area
This area displays the style of the analog button currently being specified.

[Function buttons]

Figure Select this option button to display the analog button with the following specified figure.

Shape Select the figure shape. Two shapes can be selected: rectangle and ellipse. 

shadow Cannot be selected.

Line Specify and change the figure line, as follows.
You can change the color of figure line by clicking the pull-down button. 

Thickness Specifies the line thickness. 
Specification is made either using a spin button or through direct 
input. 
A value from 1 to 100 can be specified. 

Active Specifies the color of the line during active display.

Inactive Specifies the color of the line during inactive display.

Fill up Specify and change the figure filling, as follows.
You can change the color of figure filling by clicking the pull-down button. 

Active Specifies the fill color during active display.

Inactive Specifies the fill color during inactive display.

Bitmap Select this option button to display the analog button with the following specified bitmap (default).

Selection list Select a bitmap to be used from the selection list. 
The selectable bitmaps appear in the selection list.

[Add] button Opens the Entry Bitmap dialog box below to add a new bitmap to the selection 
list. 
The bitmap file to be added can be specified either through file selection using 
the [...] button, or through direct input.

[Delete] but-
ton

Deletes the currently selected bitmap from the selection list.
Note that only the bitmap that have been added by user can be deleted.

Button Function

OK Validates the settings and closes this dialog box.

Cancel Cancels the settings and closes this dialog box. 

Apply Cannot be selected.
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[Operation]

In the Simulation mode, while an analog button is depressed, the specified analog voltage value is input to the specified 
pin.

Clicking the depressed analog button again restores the button to its original state.

Figure A.66 Connected Parts Display Example (Analog Button)

Help Displays the help for this dialog box. 

Button Function
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This property dialog box is used to set or change the pin connection information of a key matrix, which is one of the con-
nection parts in the I/O Panel window. 

Input to the simulator can be done from pin-connected keys in the Simulation mode. 
A key matrix consisting of input pins and output pins of up to 16 x 16 can be set. 
Either figure or bitmap can be selected as the key matrix display style. These styles can be changed on the [[Style] tab]. 

Caution When connecting a key matrix to pins, also perform the Pull up/Pull down settings for the connection 
pins. When a key is pressed, the output value of the output pin connected to that key is input to the input 
pin connected to that key. The value when the key is not pressed is the value specified in the Pull up/Pull 
down dialog box.
If the Pull up/Pull down settings are not performed, the input pin becomes the high-impedance state. 
Consequently, the operation of the function that is connected to the input pin becomes undefined.

Figure A.67 Parts Key Properties Dialog Box: [Key Matrix Connection] Tab

Parts Key Properties dialog box

[Function buttons]

(1)
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Figure A.68 Parts Key Properties Dialog Box: [Style] Tab

This section describes the following.

- [How to open]

- [[Key Matrix Connection] tab]

- [[Style] tab]

- [Function buttons]

- [Operation]

[How to open]

On the I/O Panel window, any one of the following:

- Double-click a part object "Key matrix".

- Select [Properties...] form the context menu on a part object "Key matrix".

- Select a part object "Key matrix", and then select [Properties...] form the [View] menu.

[[Key Matrix Connection] tab]

(1) Pin connection information setting area

Label This area is used to specify the part name. The part name input here is also displayed in the 
Parts List dialog box as the label.

(1) (2)

[Function buttons]
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Remark For the pin names that can be specified, see the user's manual of the microcontroller that is used. 

[[Style] tab]

(1) Style information setting area

Pin Name This area is used to specify the pin name to be connected (input pins and output pins). The 
connection pins can be specified either via direct input or through selection from the drop-
down list.
This area can be used to set 16 x 16 pins using the scrollbar. 

In0 - In15 Specify input pins.

Out0 - Out15 Specify output pins.

N00 - Nff This area is where the text strings displayed on the keys of the key 
matrix are specified. Text strings of any length can be specified. 
The default description string (N number) is not displayed on the keys.

Hold Time Specify the time (hold time) for which the input value is to be held (default: 0.5msec). The set-
table range is from 0.001 to 999 (msec). 
Moreover, when multiple keys for input to the same input pin are pressed during the hold time, 
only the key that was clicked last is valid. 

default Specify the key matrix operation after CPU reset.

Not change at 
reset.

The key matrix status does not change after CPU reset.

inactive No key matrix buttons are depressed after CPU reset (default).

Figure Select this option button to display the key matrix with the following specified figure.

Shape Select the figure shape. Two shapes can be selected: rectangle and ellipse. 

shadow Cannot be selected.

Line Specify and change the figure line, as follows.
You can change the color of figure line by clicking the pull-down button. 

Thickness Specifies the line thickness. 
Specification is made either using a spin button or through direct 
input. 
A value from 1 to 100 can be specified. 

Active Specifies the color of the line during active display.

Inactive Specifies the color of the line during inactive display.

Fill up Specify and change the figure filling, as follows.
You can change the color of figure filling by clicking the pull-down button. 

Active Specifies the fill color during active display.

Inactive Specifies the fill color during inactive display.
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(2) Preview area
This area displays the style of the key matrix currently being specified.

[Function buttons]

[Operation]

In the Simulation mode, the following operation can be done. 

(1)  Inputting multiple keys simultaneously
(2)  Locking the key input value

(1) Inputting multiple keys simultaneously
To enter two keys, simultaneously press the key to be input and right-click the mouse to enter the wait status. 
Then, click the other key. This releases the wait status and enables simultaneous input of both keys. Multiple keys 
can be simultaneously input by setting the wait status for multiple keys, but if input is to be performed to the same 
input pin, the key that was input last is valid.

(2) Locking the key input value
To enter two keys, simultaneously press the key to be input and right-click the mouse to enter the wait status. 
Then, click the other key. This releases the wait status and enables simultaneous input of both keys. Multiple keys 
can be simultaneously input by setting the wait status for multiple keys, but if input is to be performed to the same 
input pin, the key that was input last is valid

Bitmap Select this option button to display the key matrix with the following specified bitmap (default).

Selection list Select a bitmap to be used from the selection list. 
The selectable bitmaps appear in the selection list.

[Add] button Opens the Entry Bitmap dialog box below to add a new bitmap to the selection 
list. 
The bitmap file to be added can be specified either through file selection using 
the [...] button, or through direct input.

[Delete] but-
ton

Deletes the currently selected bitmap from the selection list.
Note that only the bitmap that have been added by user can be deleted.

Button Function

OK Validates the settings and closes this dialog box.

Cancel Cancels the settings and closes this dialog box. 

Apply Cannot be selected.

Help Displays the help for this dialog box. 
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Figure A.69 Connected Parts Display Example (Key Matrix)
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This property dialog box is used to set or change the pin connection information of level gauge, which are one of the 
connection parts in the I/O Panel window. 

Input to the simulator can be done from pin-connected level gauge in the Simulation mode. 
Note that the connection pin must be an analog input pin. 
There are two types of level gauge display styles, slide and dial. These styles can be changed on the [[Style] tab].

Figure A.70 Parts Level Gauge Properties Dialog Box: [Level Gauge Connection] Tab

Figure A.71 Parts Level Gauge Properties Dialog Box: [Style] Tab

This section describes the following.

Parts Level Gauge Properties dialog box

(1)

[Function buttons]

(1)

(2)

[Function buttons]
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- [How to open]

- [Level Gauge Connection] tab]

- [[Style] tab]

- [Function buttons]

- [Operation]

[How to open]

On the I/O Panel window, any one of the following:

- Double-click a part object "Level Gauge".

- Select [Properties...] form the context menu on a part object "Level Gauge".

- Select a part object "Level Gauge", and then select [Properties...] form the [View] menu.

[Level Gauge Connection] tab]

(1) Pin connection information setting area

Remark For the pin names that can be specified, see the user's manual of the microcontroller that is used.

[[Style] tab]

(1) Style information setting area

Label This area is used to specify the part name. The part name input here is also dis-
played in the Parts List dialog box as the label.

Pin Name This area is used to specify the pin name to be connected. The connection pins can 
be specified either via direct input or through selection from the drop-down list.

Maximum input This area is used to set the maximum level gauge input value (default: 5000mV).
The settable range is from 0 to 65535. 
The operation range of the level gauge displayed in the I/O Panel window is deter-
mined by this specified value. 

When CPU reset Specify the level gauge operation after CPU reset.

before CPU Reset Maintains the level gauge status of immediately before CPU 
reset, after CPU reset.

Set default voltage The level gauge is set to the specified value after CPU reset 
(default).
Specify the value in mV units.
Input a value from 0 to "Maximum input:". (default: 0 mV)

Slide Select this option button to display the level gauge with the side-type.

Form Select the slide direction (vertical or horizontal) from the drop-down list.

Color This area is used to specify or change the slide color. 
You can change the color by clicking the pull-down button. 
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(2) Preview area
This area displays the style of the level gauge currently being specified.

[Function buttons]

[Operation]

In the Simulation mode, analog input from the level gauge is performed through manipulation of the displayed slider or 
dial. 

The value specified in [Maximum input] is the maximum value that can be input. 
Input is enabled by selecting the [Figure] menu >> [Simulation Mode]. 

Figure A.72 Connected Parts Display Example (Level Gauge)

Dial Select this option button to display the level gauge with the dial-type (default).

Color of Mark This area is used to specify or change the color of the mark indicating the 
operating point. 
You can change the color by clicking the pull-down button. 

Selection list Select a bitmap to be used from the selection list. 
The selectable bitmaps appear in the selection list.

[Add] button Opens the Entry Bitmap dialog box below to add a new bitmap to the selec-
tion list. 
The bitmap file to be added can be specified either through file selection 
using the [...] button, or through direct input.

[Delete] button Deletes the currently selected bitmap from the selection list.
Note that only the bitmap that have been added by user can be deleted.

Button Function

OK Validates the settings and closes this dialog box.

Cancel Cancels the settings and closes this dialog box. 

Apply Cannot be selected.

Help Displays the help for this dialog box. 
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Caution If you drag and drop the dial's operation point (red circle) or the slider's knob away from the level gauge, 
then the voltage displayed in the level gauge will change, but the voltage actually output by the level 
gauge will not change. Make sure to always drag and drop over the level gauge.

Dial-type level gauge The displayed analog value changes as the operating point (red circle) on the dial is 
moved by dragging it with the mouse. When this analog value has become the value that 
is to be input, release the operating point. As a result, the displayed analog value is input. 
The operating point can also be moved by clicking the desired location on the dial.

Slide-type level gauge The displayed analog value changes as the slider button is moved by dragging it with the 
mouse. When this analog value has become the value that is to be input, release the but-
ton. As a result, the displayed analog value is input. The button can also be moved by 
clicking the desired location on the slider. 
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This property dialog box is used to set or change the pin connection information of LED, which are one of the connection 
parts in the I/O Panel window. 

A pin-connected LED displays the information output from the simulator through lit/unlit display in the Simulation mode. 
There are two types of LED display styles, figure and bitmap. These styles can be changed on the [[Style] tab]. 

Figure A.73 Parts Led Properties Dialog Box: [LED Connection] Tab

Figure A.74 Parts Led Properties Dialog Box: [Style] Tab

This section describes the following.

- [How to open]

Parts Led Properties dialog box

[Function buttons]

(1)

(1) (2)

[Function buttons]
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- [[LED Connection] tab]

- [[Style] tab]

- [Function buttons]

- [Operation]

[How to open]

On the I/O Panel window, any one of the following:

- Double-click a part object "LED".

- Select [Properties...] form the context menu on a part object "LED".

- Select a part object "LED", and then select [Properties...] form the [View] menu.

[[LED Connection] tab]

(1) Pin connection information setting area

Remark For the pin names that can be specified, see the user's manual of the microcontroller that is used.

[[Style] tab]

(1) Style information setting area

Label This area is used to specify the part name. The part name input here is also dis-
played in the Parts List dialog box as the label.

Pin Name This area is used to specify the pin name to be connected (output pin). The connec-
tion pins can be specified either via direct input or through selection from the drop-
down list.

Active Level The active state is selected with a option button, as follows:

LOW Sets the active level to LOW.

HIGH Sets the active level to HIGH (default). 

Figure Select this option button to display the LED with the following specified figure.

Shape Select the figure shape. Two shapes can be selected: rectangle and ellipse. 

shadow Cannot be selected.

Line Specify and change the figure line, as follows.
You can change the color of figure line by clicking the pull-down button. 

Thick-
ness

Specifies the line thickness. 
Specification is made either using a spin button or through direct 
input. 
A value from 1 to 100 can be specified. 

Active Specifies the color of the line during active display.

Inactive Specifies the color of the line during inactive display.

Fill up Specify and change the figure filling, as follows.
You can change the color of figure filling by clicking the pull-down button. 

Active Specifies the fill color during active display.

Inactive Specifies the fill color during inactive display.
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(2) Preview area
This area displays the style of the LED currently being specified.

[Function buttons]

[Operation]

In the Simulation mode, the output status (active/inactive) of the connected pins is displayed in real-time using two types 
of bitmaps or figures. 

Figure A.75 Connected Parts Display Example (LED)

Bitmap Select this option button to display the LED with the following specified bitmap (default).

Selection list Select a bitmap to be used from the selection list. 
The selectable bitmaps appear in the selection list.

[Add] button Opens the Entry Bitmap dialog box below to add a new bitmap to the selection 
list. 
The bitmap file to be added can be specified either through file selection using 
the [...] button, or through direct input.

[Delete] button Deletes the currently selected bitmap from the selection list.
Note that only the bitmap that have been added by user can be deleted.

Button Function

OK Validates the settings and closes this dialog box.

Cancel Cancels the settings and closes this dialog box. 

Apply Cannot be selected.

Help Displays the help for this dialog box. 

When active:

When inactive:
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This property dialog box is used to set or change the pin connection information of 7-segment LED and 14-segment 
LED, which are one of the connection parts in the I/O Panel window. 

A LED connected to pins displays the information output from the simulator in the Simulation mode.
The segment LED display styles can be changed on the [[Style] tab]. 

Figure A.76 Parts Segment LED Properties Dialog Box: [SegmentLED Connection] Tab

Figure A.77 Parts Segment LED Properties Dialog Box: [Style] Tab

This section describes the following.

- [How to open]

Parts Segment LED Properties dialog box

[Function buttons]

(1)

(2) (3)

(1)

[Function buttons]
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- [[SegmentLED Connection] tab]

- [[Style] tab]

- [Function buttons]

- [Operation]

[How to open]

On the I/O Panel window, any one of the following:

- Double-click a part object "7-segment LED"/"14-segment LED".

- Select [Properties...] form the context menu on a part object "7-segment LED"/"14-segment LED".

- Select a part object "7-segment LED"/"14-segment LED", and then select [Properties...] form the [View] menu.

[[SegmentLED Connection] tab]

(1) Pin connection information setting area

(2) Segment signal setting area

Remark For the pin names that can be specified, see the user's manual of the microcontroller that is used. 

Label This area is used to specify the part name. The part name input here is also dis-
played in the Parts List dialog box as the label.

Grid type Select the grid signal allocation method from the following. 
As a result of the selection, the setting in the Digit signal setting area changes. 

Digit Connects each segment LED to 1 grid pin. Digit signal settings are 
performed in the Digit signal setting area (default). 
16 digits can be specified for the digit signal.  A segment LED of up 
to 16 digits can be created with 1 segment LED part.

Customize Cannot be selected.

Segment Signal This area is used to specify the pins (output pins) to be connected to the 
segment signals of the 7-segment LED/14-segment LED, as well as their active 
level.

Figure This area displays the bitmap of the 7-segment LED/14-segment LED 
at the top left. When "Pin Name:" is input, the corresponding location 
is indicated. 

Pin Name The connection pins can be specified either via direct input or through 
selection from the drop-down list.
The number of segment pins to be connected is 8 in the case of a 7-
segment LED, and 15 in the case of a 14-segment LED. Connection to 
all the segment pins is possible by using the scroll bar on the right 
side. 

Active 
Level

The active status can be selected with a option button, as follows:

LOW Sets the active level to LOW.

HIGH Sets the active level to HIGH (default). 
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(3) Digit signal setting area

Remark For the pin names that can be specified, see the user's manual of the microcontroller that is used. 

[[Style] tab]

(1) Style information setting area

[Function buttons]

Digit Signal This area is used to specify 7-segment LED/14-segment LED digits, grid signal con-
nection pins (output pins), and their active level. The connection method changes as 
follows according to what is specified for [Grid type]. 
When [Digit] selected 
Perform digit signal setting. The maximum number of digit pins that can be con-
nected is 16. Connection to all the digit pins can be done by using the scroll bar on 
the right side of the area. 
When [Customize] selected 
Cannot be selected.

Pin Name The connection pins can be specified either via direct input or 
through selection from the drop-down list. As the setting signal, 
specify the connection pins in a series from the lowermost digit.

Active Level The active status can be selected with a option button, as follows:

LOW Sets the active level to LOW.

HIGH Sets the active level to HIGH (default). 

Full up LED This area is used to set and change related to the filling of each cell of the object are 
performed.  You can change the color by clicking the pull-down button. 

Active Color Specifies the fill color during active display. 

Inactive Color Specifies the fill color during inactive display.

Frame Line of LED This area is used to set and change related to the frame of each cell of the object are 
performed. 

Color of Line Specifies and changes the line color.
You can change the color by clicking the pull-down button. 

Dotted/Solid Line Specifies and changes the line shape (dotted/solid).
The desired line shape can be selected from the drop-down list. 
The line shape can be specified only when the line thickness is 
"1" in [Thickness of Line]. 

Thickness of Line Specifies and changes the line thickness. 
The desired line thickness can be specified either via direct input 
or through selection from the spin button.A value in the range of 
1 to 100 (decimal) can be specified. 

Button Function

OK Validates the settings and closes this dialog box.

Cancel Cancels the settings and closes this dialog box. 

Apply Cannot be selected.

Help Displays the help for this dialog box. 
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[Operation]

In the Simulation mode, as the results of 1 simulation, the output information of the connection pins is received and dis-
play is performed accordingly. When both the digit/grid signals and segment signals are active output, the segment LED of 
the corresponding digit/grid light. 

Figure A.78 Connected Parts Display Example (7-segment LED)
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This property dialog box is used to set or change the pin connection information of matrix LED, which are one of the 
connection parts in the I/O Panel window. 

A pin-connected matrix LED displays the information output from the simulator through lit/unlit display in the Simulation 
mode.

There are two types of matrix LED display styles, figure and bitmap. These styles can be changed on the [[Style] tab]. 

Figure A.79 Parts Matrix Led Properties Dialog Box: [Matrix LED Connection] Tab

Figure A.80 Parts Matrix Led Properties Dialog Box: [Style] Tab

This section describes the following.

- [How to open]

Parts Matrix Led Properties dialog box

[Function buttons]

(2)

(1)

(3)

(1) (2)

[Function buttons]
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- [[Matrix LED Connection] tab]

- [[Style] tab]

- [Function buttons]

- [Operation]

[How to open]

On the I/O Panel window, any one of the following:

- Double-click a part object "Matrix LED".

- Select [Properties...] form the context menu on a part object "Matrix LED".

- Select a part object "Matrix LED", and then select [Properties...] form the [View] menu.

[[Matrix LED Connection] tab]

(1) [Label]

(2) Row direction signals setting area

Remark For the pin names that can be specified, see the user's manual of the microcontroller that is used.

(3) Column direction signals setting area

Remark For the pin names that can be specified, see the user's manual of the microcontroller that is used.

Label This area is used to specify the part name. The part name input here is also dis-
played in the Parts List dialog box as the label.

Row Signal This area is used to specify the output pins connected to the matrix LED row direc-
tion signals and their active level.

Pin Name A maximum of 16 pins can be connected. Connection to all the row 
direction signals can be done by using the scrollbar located on the 
right side of the pin name input area. 

Active Level The active status can be selected with a option button, as follows:

LOW Sets the active level to LOW.

HIGH Sets the active level to HIGH (default). 

Column Signal This area is used to specify the output pins connected to the matrix LED column 
direction signals and their active level.

Pin Name The connection pins can be specified either via direct input or 
through selection from the drop-down list.A maximum of 16 pins can 
be connected. Connection to all the column direction signals can be 
done by using the scrollbar located on the right side of the pin name 
input area.

Active Level The active status can be selected with a option button, as follows:

LOW Sets the active level to LOW.

HIGH Sets the active level to HIGH (default). 
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[[Style] tab]

(1) Style information setting area

(2) Preview area
This area displays the style of the matrix LED currently being specified.

[Function buttons]

Figure Select this option button to display the matrix LED with the following specified figure.

Shape Select the figure shape. Two shapes can be selected: rectangle and ellipse. 

shadow Cannot be selected.

Line Specify and change the figure line, as follows.
You can change the color of figure line by clicking the pull-down button. 

Thickness Specifies the line thickness. 
Specification is made either using a spin button or through direct 
input. 
A value from 1 to 100 can be specified. 

Active Specifies the color of the line during active display.

Inactive Specifies the color of the line during inactive display.

Fill up Specify and change the figure filling, as follows.
You can change the color of figure filling by clicking the pull-down button. 

Active Specifies the fill color during active display.

Inactive Specifies the fill color during inactive display.

Bitmap Select this option button to display the matrix LED with the following specified bitmap (default)

Selection list Select a bitmap to be used from the selection list. 
The selectable bitmaps appear in the selection list.

[Add] button Opens the Entry Bitmap dialog box below to add a new bitmap to the selection 
list. 
The bitmap file to be added can be specified either through file selection using 
the [...] button, or through direct input.

[Delete] button Deletes the currently selected bitmap from the selection list.
Note that only the bitmap that have been added by user can be deleted.

Button Function

OK Validates the settings and closes this dialog box.

Cancel Cancels the settings and closes this dialog box. 

Apply Cannot be selected.
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[Operation]

In the Simulation mode, as the results of 1 simulation, the output information of the connection pins is received and dis-
play is performed accordingly. When the matrix intersection of a row pin and column pin is active, the corresponding LED 
lights.

Figure A.81 Connected Parts Display Example (Matrix LED)

Help Displays the help for this dialog box. 

Button Function
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This property dialog box is used to set or change the pin connection information of a buzzer, which is one of the connec-
tion parts in the I/O Panel window. 

The pin-connected buzzer displays the information output from the connected pins as a bitmap in the Simulation mode.
The buzzer output can be checked as "display".
There are two types of buzzer display styles, figure and bitmap. These styles can be changed on the [[Style] tab]. 

Figure A.82 Parts Buzzer Properties Dialog Box: [Buzzer Connection] Tab

Figure A.83 Parts Buzzer Properties Dialog Box: [Style] Tab

This section describes the following.

- [How to open]

Parts Buzzer Properties dialog box

[Function buttons]

(1)

(1) (2)

[Function buttons]
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- [[Buzzer Connection] tab]

- [[Style] tab]

- [Function buttons]

- [Operation]

[How to open]

On the I/O Panel window, any one of the following:

- Double-click a part object "Buzzer".

- Select [Properties...] form the context menu on a part object "Buzzer".

- Select a part object "Buzzer", and then select [Properties...] form the [View] menu.

[[Buzzer Connection] tab]

(1) Pin connection information setting area

Remark For the pin names that can be specified, see the user's manual of the microcontroller that is used.

[[Style] tab]

(1) Style information setting area

Label This area is used to specify the part name. The part name input here is also dis-
played in the Parts List dialog box as the label.

Pin Name This area is used to specify the pin name to be connected (output pin). The connec-
tion pins can be specified either via direct input or through selection from the drop-
down list.

Active Level The active state is selected with a option button, as follows:

LOW Sets the active level to LOW.

HIGH Sets the active level to HIGH (default). 

Output Form This item is not allowed to change.

Figure Select this option button to display the buzzer with the following specified figure.

Shape Select the figure shape. Two shapes can be selected: rectangle and ellipse. 

shadow Cannot be selected.

Line Specify and change the figure line, as follows.
You can change the color of figure line by clicking the pull-down button. 

Thickness Specifies the line thickness. 
Specification is made either using a spin button or through direct 
input. 
A value from 1 to 100 can be specified. 

Active Specifies the color of the line during active display.

Inactive Specifies the color of the line during inactive display.

Fill up Specify and change the figure filling, as follows.
You can change the color of figure filling by clicking the pull-down button. 

Active Specifies the fill color during active display.

Inactive Specifies the fill color during inactive display.
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(2) Preview area
This area displays the style of the buzzer currently being specified.

[Function buttons]

[Operation]

In the Simulation mode, the active level output of the connected pins can be expressed as a bitmap.
The following bitmaps are displayed according to the pin's output value (active/inactive). 

Figure A.84 Connected Parts Display Example (Buzzer)

Bitmap Select this option button to display the buzzer with the following specified bitmap (default).

Selection list Select a bitmap to be used from the selection list. 
The selectable bitmaps appear in the selection list.

[Add] button Opens the Entry Bitmap dialog box below to add a new bitmap to the selection 
list. 
The bitmap file to be added can be specified either through file selection using 
the [...] button, or through direct input.

[Delete] button Deletes the currently selected bitmap from the selection list.
Note that only the bitmap that have been added by user can be deleted.

Button Function

OK Validates the settings and closes this dialog box.

Cancel Cancels the settings and closes this dialog box. 

Apply Cannot be selected.

Help Displays the help for this dialog box. 

When active:

When inactive:
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This dialog box is used to set or change the pin connection information of the pull-up/pull-down resistors, which are one 
of the connection parts of the I/O Panel window. 

The setting method for these connection parts differs from those for other parts. The connection information of all the 
pins is managed as a group in this dialog box.

Figure A.85 Pull up/Pull down Dialog Box

This section describes the following.

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- With the I/O Panel window in focus, click the  button or select [Pull up/Pull down...] from the [Parts] menu.

[Description of each area]

(1) Connection information display area

Pull up/Pull down dialog box

Pin name Displays the names of the pins that can be connected to pull-up/pull-down resistors.

Pull Up/Pull Down Displays the connected status of the pins.

Pull Up Indicates pull-up resistor is connected.

Pull Down Indicates pull-down resistor connected.

- Indicates no pull-up/pull-down resistor connected.

[Function buttons]

(1)
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[Function buttons]

Buttons Changes the pin connection information of the pull-up/pull-down resistors.

Pull Up Connects the pins selected to pull-up resistors. 
When connection is completed, "Pull Up" is displayed.

Pull Down Connects the pins selected to pull-down resistors. 
When connection is completed, "Pull Down" is displayed.

Disconnect Cancels the connected status of the pins selected.
When connection is completed, "-" is displayed. 

Button Function

OK Validates the settings and closes this dialog box.

Cancel Cancels the settings and closes this dialog box. 
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This property dialog box is used to set or change the connection information fed to the pins of figure object (including 
text and bitmap) of the I/O Panel window. 

Show/hide can be switched for each pin-connected object by the output status of the connected pins in the Simulation 
mode. 

The default status of each signal is active HIGH. Display styles can be changed on the [[Style] tab].

Figure A.86 Object Properties Dialog Box: [Object Connection] Tab

Figure A.87 Object Properties Dialog Box: [Style] Tab

This section describes the following.

- [How to open]

- [[Object Connection] tab]

Object Properties dialog box

[Function buttons]

(1)

(1)

[Function buttons]
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- [[Style] tab]

- [Function buttons]

[How to open]

On the I/O Panel window, any one of the following:

- Double-click a figure object.

- Select [Properties...] form the context menu on a figure object.

- Select a figure object, and then select [Properties...] form the [View] menu.

[[Object Connection] tab]

(1) Pin connection information setting area

Remark For the pin names that can be specified, see the user's manual of the microcontroller that is used.

Pin Connect Select the method for connecting objects and output pins by clicking the corresponding 
option buttons, and specify the output pin name.
As a result of the connection, figure display is switched by the ON/OFF status of the con-
nected output pin.

No Connection The object and pin are not connected (default). 
Objects not connected to pins are always in the displayed sta-
tus. 

Static Connection Connects the figure to 1 output pin.
The connection pin can be specified in [Pin Name] either via 
direct input or through selection from the drop-down list. During 
simulation, the object is displayed when the specified output 
signal data is active.

Dynamic Connection Connects the figure to 2 output pins.
The connection pin can be specified in [Pin Name1] and [Pin 
Name2] either via direct input or through selection from the 
drop-down list. During simulation, the object is displayed when 
the specified output signal 1 data and the specified output sig-
nal 2 data are both active. 

Active Level The common active status of each output signal can be selected from the option buttons. 

LOW Sets the active level to LOW.

HIGH Sets the active level to HIGH (default). 
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[[Style] tab]

(1) Style information setting area

Note At this time, if the object that have been pasted from a bitmap file, it becomes invisible.

[Function buttons]

Fill up Specifies and changes settings related to each object fillingNote, as follows:
The area to be filled differs according to the object. 

- Line
Not applicable 

- Rectangle, Ellipse, Rounded Rectangle
Inside area enclosed by contour lines 

- Polygon
Inside area enclosed by lines linking apexes 

- Text
Inside text box 

- Bitmap
Inside figure drawing area 

Color Specifies and changes settings of color 
You can change the color by clicking the pull-down button. 

Line This area is used to perform settings and changes related to the lines of objects. 
The definition of line for each type of object is provided below.

- Line
All areas of the object 

- Rectangle, Ellipse, Rounded Rectangle
Contour line of the figure 

- Polygon
Lines that link the apexes of the polygon 

- Text
Contour lines of the text box

- Bitmap
Contour lines of figure drawing area 

Color Specifies and changes the line color.
You can change the color by clicking the pull-down button. 

Dotted/
Solid

Specifies and changes line shapes (dotted line/solid line). 
The desired line shape can be selected from the drop-down list. 
Note that this item can be changed only when [Thickness] is set to "1".

Thickness Specifies and changes the line thickness. 
The desired line thickness can be specified either via direct input or 
through selection from the spin button.
A value in the range of 1 to 100 (decimal) can be specified.

Button Function

OK Validates the settings and closes this dialog box.

Cancel Cancels the settings and closes this dialog box. 

Apply Cannot be selected.

Help Displays the help for this dialog box. 
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This dialog box displays all the figure objects created in the I/O Panel window as well as the pin connection status of 
part objects. 

The pin connection settings for each object can be changed in the property dialog box, which can be opened by double-
clicking the relevant object listed in this dialog box, or selecting the relevant object listed in this dialog box and then select-
ing the [View] menu >> [Properties...].

Figure A.88 Parts List Dialog Box

This section describes the following.

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- With the I/O Panel window in focus, select [Parts List...] form the [View] menu.

[Description of each area]

(1) Pin connection status display area

Parts List dialog box

Label Displays the label (name) attached to the object. Nothing is displayed for objects that 
do not have a label.

[Function buttons]

(1)
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[Function buttons]

Parts Displays the part category.

rectangle Straight line, rectangle, ellipse, rounded rectangle, fan shape

polygon Polygon

text Text

bitmap Bitmap

button Push button, pull button, group button

analog button Analog button

key Key matrix

level gauge Level gauge

led LED

7segment led 7-segment LED

14segment led 14-segment LED

matrix led Matrix LED

buzzer Buzzer

groups Grouped part

Pin Name Displays the pins connected to parts.
"-" is displayed for parts that are connected to multiple pins, and a blank is displayed 
for parts that are unconnected.

Active Level Displays the active value set for the part. 
"-" is displayed for parts that are connected to multiple pins, and a blank is displayed 
for parts that are unconnected.

Button Function

Close Closes the this dialog box.
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This window is used to communicate with the serial interface provided in the CPU. 
Since this window operates as the serial interface of the remote node of the CPU, transmission data from CPU turns 

into reception data in this window, and transmission data from this window turns into reception data in the CPU. 
The following two types of files can be handled in this window. 
The transmission/reception data displayed in the top area in this window can be saved to the serial log data file (*.log) 

(CSV format) by selecting the [File] menu >> [Save]/[Save As...]. 
Moreover, the transmission data created in the lower part of this window can be saved to the serial transmission data file 

(*.ser) (CSV format) by clicking the [Save] button (the contents can be restored by clicking the [Load] button). 
Saving/restoring the created data can also be performed by saving/loading the project file.  In this case, however, data is 

not saved as a CSV format text file but saved into the project file.

Caution 1. If the saved serial transmission data file is opened or the project file is opened while Simulator GUI is run-
ning with a microcontroller different from the one used when the file was created, the settings of the serial 
interface that are not provided in the microcontroller will not be restored.

Caution 2. Multiple instances of this window can be opened. After opening this window, select the serial interface to 
be verified in the Serial selection area. 

Figure A.89 Serial Window

This section describes the following.

- [How to open]

- [Description of each area]

- [Dedicated menu (Serial window)]

- [Context menu]

Serial window

(2)

(3)

(1)
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[How to open]

- Click the  button.

- Select [Serial] from the [Simulator] menu.

[Description of each area]

(1) Serial selection area
Selects the serial interface to be used.

Note Once selected, the serial interface cannot be changed. 
If you wish to change the serial interface, newly open another Serial window.

(2) Log display area
Displays the transmission/reception data. 
The display timing is when all the bits constituting the data have been received or sent. 
Only data from which the start bit, stop bit, and parity bit have been deleted is displayed in this area. 
The notation of data can be changed by selecting the [View] menu>> [Numeric Representation] >> [Binary]/[Hexa-
decimal]. 
Log display is cleared upon debugger or simulator reset.

(3) Serial editor area
This area is where the transmission data is created. 
This area can be shown or hidden by selecting the [View] menu >> [Serial Editor]. 

Selects the serial interface to be used from the list of provided serial interfaces (drop-
down list)Note.

Selects the transfer mode (master or slave) when IICA has been selected from the 
list of serial interfaces.

Selects the time information unit applied to [Wait] in the Serial editor area from the 
drop-down list.
The time information unit can be changed by selecting the [Edit] menu >> [Time unit]. 

Time Displays the time from the completion of reception/transmission of the previous data 
until completion of reception/transmission of the current data. 
The time information unit is specified by selecting the [Edit] menu >> [Time unit].

Send Data Displays the data sent by this window (data received by the CPU). 

Receive Data Displays the data received by this window (data sent by the CPU).

Status Displays the status during data reception. 
When an error occurs, one of the following marks is displayed. When everything is 
normal, nothing is displayed. 

P Parity error (mismatching parity bit) 

F Framing error (stop bit not detected) 

No. This is a number assigned sequentially from the beginning. It cannot be directly written. 
The maximum number is 9,999 lines.

Wait Specifies the time from the completion of transmission or reception of the immediately previous 
data until the start of transmission or reception of next data.Valid during transmission using the 
[Auto send] button and during reception using the [Auto receive] button. 
The time information unit is the unit selected by selecting the [Edit] menu >> [Time unit]. 
The wait value is input by placing the cursor in the Wait field to be edited and double-clicking. 
One wait value can be written per operation.
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Caution The help for this window will not be displayed even if the [F1] key on the keyboard is pressed while 
the cursor is placed in this area.

Remark When the CSI selected in this window is set to master mode, the clock must be supplied for recep-
tion. To perform reception, transmission of dummy data is therefore required.

Data This area is used to edit transmission data. 
Data can be directly input by placing the cursor in the data field and double-clicking. 
Data suffixed by "0x" is treated as hexadecimal data, and data suffixed by "0b" is treated as binary 
data. The default code is the hexadecimal code. 
If a bit length different from that specified in the Format (UART) dialog box or Format (CSI) dialog 
box is specified, data from the lower bit is valid. 
One data can be written per operation. 

Button Format Opens the Format (UART) dialog box, Format (CSI) dialog box, or Format (IIC) dia-
log box. 

All Clear Clears all Serial editor area.

Load Loads the contents of the previously saved serial transmission data file (*.ser) and 
restores them in the Serial editor area. 
A file created for UART cannot be loaded as a file for CSI and vice versa.

Save Saves the contents of the Serial editor area to the specified serial transmission data 
file (*.ser). 

Send Sends one of the data selected in the Serial editor area. 
The next data becomes selected upon completion of transmission. 
If no data is selected, the first data is sent. 

Auto Send Makes the data selected in the Serial editor area the first data, and automatically 
transfers from the data to the bottom of the area. The data transmission time interval 
is the time specified for Wait. 

Receive The [Send] button is switched to [Receive] when this window is used as the recep-
tion side of IICA.
Cancels the wait state and starts data reception.

Auto 
Receive

The [Auto Send] button is switched to [Auto Receive] when this window is used as 
the reception side of IICA.
Cancels the wait state at time interval specified in the Serial editor area and auto-
matically receives data. The data reception time interval is the time specified for 
Wait.

Start This button is activated when IICA is selected from the list of serial interfaces in the 
Serial selection area, and master mode is selected as the transfer mode. 
Pressing it generates a start condition, which starts serial transfer. 

Stop This button is activated when IICA is selected from the list of serial interfaces in the 
Serial selection area, and master mode is selected as the transfer mode. 
Pressing it generates a stop condition, which stops serial transfer. 

Send 
Address

This button is activated when IICA is selected from the list of serial interfaces in the 
Serial selection area, and master mode is selected as the transfer mode. 
Pressing it sends the address of the slave which is to be the other party in communi-
cations.
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[Dedicated menu (Serial window)]

(1) [Edit] menu

(2) [View] menu

(3) [Option] menu

[Context menu]

The following context menus are available in the Serial editor area. 

Insert Inserts a new line immediately before the selected line.

Cut Cuts the selected range and saves it to the clipboard.

Copy Copies the selected range and copies it to the clipboard.

Paste Pastes the contents of the clipboard to the selected location.

Delete Deletes the selected range.

Time unit Selects the time unit.

main clock Main clock (default)

usec Microsecond

msec Millisecond

Format... Opens the Format (UART) dialog box, Format (CSI) dialog box, or Format (IIC) dia-
log box.

Serial Editor Selects whether Serial editor area is displayed or not.

Numeric Representa-
tion

Changes the notation of the Log display area display method.

Binary Displays binary numbers.

Hexadecimal Displays hexadecimal numbers.

Customize... Opens the Customize dialog box.

Insert Inserts a new line immediately before the selected line.

Cut Cuts the selected range and saves it to the clipboard.

Copy Copies the selected range and copies it to the clipboard.

Paste Pastes the contents of the clipboard to the selected location.

Delete Deletes the selected range.
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This dialog box is used to set the serial format for the asynchronous serial interface (UART). 

Figure A.90 Format (UART) Dialog Box

This section describes the following.

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

On the Serial window with the UART serial interface, any one of the following:

- Click the [Format] button.

- Select [Format...] from the [Edit] menu

[Description of each area]

(1) Serial format setting area

Format (UART) dialog box

Baud rate Directly input the serial baud rate value as an integer. (Unit: bps)

Transfer Direction Select the transfer direction.

MSB first Sets MSB first as the transfer direction.

LSB first Sets LSB first as the transfer direction (default). 

Data bit length Select the bit length of the transmission data from the drop-down list, or specify it through 
direct input (default:7).

Stop bit length Select the stop bit length from the drop-down list (default:1).

Parity Select the parity information (none parity (default) /odd parity/even parity/0 parity).

[Function buttons]

(1)
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Remark For the selectable range, see the user's manual of the microcontroller that is used. 

[Function buttons]

Repeat Select this item to repeat data transfer when the [Auto Send] button in the Serial window 
has been clicked. 

Following transmission of the last data during automatic transmission, 
returns to the beginning of the data and performs automatic transmission.

Following transmission of the last data during automatic transmission, stops 
transmission (default).

Button Function

OK Validates the settings and closes this dialog box.

Cancel Cancels the settings and closes this dialog box. 
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This dialog box is used to specify the serial format for the 3-wire serial interface (CSI). 

Figure A.91 Format (CSI) Dialog Box

This section describes the following.

- [How to open]

- [Description of each area]

- [Function buttons]

- [Transmission/reception when 3-wire serial interface (CSI) is selected]

[How to open]

On the Serial window with the CSI serial interface, any one of the following:

- Click the [Format] button.

- Select [Format...] from the [Edit] menu

[Description of each area]

(1) Serial format setting area

Format (CSI) dialog box

Master, Slave Select the transfer mode.

Master Operates this window as a master. 
Setting of [Transfer Clock] is required for generating the clock during 
communication.

Slave Operates this window as a slave (default). 
Communication is performed using the clock of the serial interface pro-
vided in the CPU.

Transfer Clock Directly input the transfer clock value (unit: kHz). 
Values with decimals can also be set. This item must be set when master is selected.

[Function buttons]

(1)
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Remark For the selectable range, see the user's manual of the microcontroller that is used.

Table A.14 Data Clock Phase Settings

Transfer Direction Select the transfer direction.

MSB first Sets MSB first as the transfer direction (default). 

LSB first Sets LSB first as the transfer direction.

Data bit length Select the bit length of the transmission data from the drop-down list, or specify it 
through direct input (default: 8). 

Data Phase Select the transmission/reception timing to set the data phase. The data clock phase 
is set in combination with "Clock Phase" as shown in "Table A.14  Data Clock Phase 
Settings".

Normal Transmits/receives data at the normal 3-wire serial transmission/recep-
tion timing (default).

Precede Transmits/receives data at a timing half a clock of the operation clock 
earlier than the normal 3-wire serial transmission/reception timing.

Clock Phase Select the transmission/reception clock waveform to set the clock phase. The data 
clock phase is set in combination with "Data Phase" as shown in "Table A.14  Data 
Clock Phase Settings".

Normal Operates on the normal 3-wire serial clock.
Transfer starts at the falling edge of the clock (default). 

Reverse Operates on the reverse clock of the normal 3-wire serial clock. Trans-
fer starts at the rising edge of the clock.

Repeat Select this item to repeat data transfer when the [Auto Send] button in the Serial win-
dow has been clicked. 

Following transmission of the last data during automatic transmission, 
returns to the beginning of the data and performs automatic transmis-
sion. 

Following transmission of the last data during automatic transmission, 
stops transmission.

Data 
Phase 

Clock 
Phase

Data Clock Phase

Normal Normal

Precede Normal
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[Function buttons]

[Transmission/reception when 3-wire serial interface (CSI) is selected]

The Serial window when CSI serial interface is selected always operates in the transmission/reception mode regardless 
of whether [Master] or [Slave] is selected in this dialog box.

Accordingly, when only wanting to reception data in the Serial window when "Slave" is selected, execute as follows 
(Reception setting when CSI serial slave is selected):

(1) Set [Repeat]
Select the [Repeat] check box in this dialog box

(2) Set Wait time
Set the Wait time to 0 as a dummy setting in the Serial window, and then click the [Auto Send] button

Normal Reverse

Precede Reverse

Button Function

OK Validates the settings and closes this dialog box.

Cancel Cancels the settings and closes this dialog box. 

When [Master] is selected Data is transmitted or received immediately after clicking the [Send] button or the [Auto 
Send] button in the Serial editor area. 

When [Slave] is selected Data becomes ready to be transmitted or received after clicking the [Send] button or the 
[Auto Send] button in the Serial editor area. 
Data starts to be transmitted or received when the CSI clock signal is received in the 
data transmission/reception ready status. This ready status is released when data trans-
mission or reception is completed. (Even if the CSI clock is received, data is not trans-
mitted or received in other than the data transmission/reception ready status.)

Data 
Phase 

Clock 
Phase

Data Clock Phase
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This dialog box is used to set the serial format for the serial interface (IICA). 

Figure A.92 Format (IIC master) Dialog Box

Figure A.93 Format (IIC slave) Dialog Box

This section describes the following.

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

On the Serial window with the IICA serial interface, any one of the following:

- Click the [Format] button.

- Select [Format...] from the [Edit] menu

Format (IIC) dialog box

[Function buttons]

(1)

[Function buttons]

(1)
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[Description of each area]

(1) Format (IIC master) setting area

(2) Format (IIC slave) setting area

Transfer Clock Directly inputs the transfer clock value (unit: kHz).
Values may include decimal fractions.

IICWL Directly inputs the width at low level of the serial clock.

IICWH Directly inputs the width at high level of the serial clock.

Slave Addr Directly inputs the address of the slave which is to be the other party.

Transmit / Receive Selects the direction of transfer.

Transmit This window is to transmit data.

Receive This window is to receive data.

WTIM Selects the time until waiting.

8 clock The state becomes waiting after eight clock cycles.

9 clock The state becomes waiting after nine clock cycles.

Repeat Selects this item to repeat data transfer when the [Auto Send] or [Auto Receive] button in 
the Serial window has been clicked. 

- In the case of automatic transmission
Following transmission of the last data during automatic transmission, 
returns to the beginning of the data and performs automatic transmis-
sion.

- In the case of automatic reception
Following reception of the last data during automatic reception, returns 
to the beginning of the Wait time and performs automatic reception.

(default) - In the case of automatic transmission
Following transmission of the last data during automatic transmission, 
stops transmission.

- In the case of automatic reception
Following reception of the last data during automatic reception, stops 
reception.

Match Addr Specifies the local address of this window by direct input.

WTIM Selects the time until waiting.

8 clock The state becomes waiting after eight clock cycles.

9 clock The state becomes waiting after nine clock cycles.
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[Function buttons]

Repeat Selects this item to repeat data transfer when the [Auto Send] or [Auto Receive] button in 
the Serial window has been clicked. 

- In the case of automatic transmission
Following transmission of the last data during automatic transmission, 
returns to the beginning of the data and performs automatic transmis-
sion.

- In the case of automatic reception
Following reception of the last data during automatic reception, returns 
to the beginning of the Wait time and performs automatic reception.

(default) - In the case of automatic transmission
Following transmission of the last data during automatic transmission, 
stops transmission.

- In the case of automatic reception
Following reception of the last data during automatic reception, stops 
reception.

Button Function

OK Validates the settings and closes this dialog box.

Cancel Cancels the settings and closes this dialog box. 
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